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USA

❖❖❖❖ FCC Requirements
1. This equipment complies with Part 68 of the FCC rules. On the cover of this equipment is a label

that contains, among other information, the FCC registration number and ringer equivalence
number (REN) for this equipment. If requested, this information must be provided to the tele-
phone company.

2. The following is applicable only for an equipment using an analog G3 line. 
This equipment uses the RJ11C USOC jack.
An FCC compliant telephone cord and modular plug is provided with this equipment. This equip-
ment is designed to be connected to the telephone network or premises wiring using a compat-
ible modular jack that is Part 68 compliant. See the Operating Instructions for details.

3. The REN is used to determine the quantity of devices which may be connected to the telephone
line. Excessive REN's on the telephone line may result in the devices not ringing in response to
an incoming call. Typically, the sum of the REN's should not exceed five (5.0). Contact the tele-
phone company to determine the maximum REN for the calling area.

4. If this equipment causes harm to the telephone network, the telephone company will notify you
in advance that temporary discontinuance of service may be required. But if advance notice is
not practical, the telephone company will notify the customer as soon as possible. Also, you will
be advised of your right to file a complaint with the FCC if you believe it is necessary.

5. The telephone company may make changes to its facilities, equipment, operations, or proce-
dures that could affect the operation of the equipment. If this happens, the telephone company
will provide advance notice so that you can make the necessary modifications to maintain unin-
terrupted service.

6. In the event of operation problems (document jam, copy jam, communication error indication),
refer to the solving problems section in this manual.

7. If you cannot correct the problem, please contact the RICOH CORP. CUSTOMER SUPPORT
DEPT. at 1-800-FASTFIX for repair or warranty information. If the equipment is causing harm
to the telephone network, the telephone company may request you to disconnect the equipment
from the network until the problem is resolved.

8. This equipment cannot be used with telephone company-provided coin service. Connection to
Party Line Service is subject to state tariffs.

❖❖❖❖ WHEN PROGRAMMING EMERGENCY NUMBERS AND/OR MAKING TEST CALLS TO
EMERGENCY NUMBERS:
1. Remain on the line and briefly explain to the dispatcher the reason for the call before hanging up.
2. Perform such activities in the off-peak hours, such as early morning hours or late evenings.

CANADA

The Industry Canada label identifies certified equipment. This certification means that the equipment
meets telecommunications network protective, operational, and safety requirements as prescribed in
the appropriate Terminal Equipment Technical Requirements document(s). The department does not
guarantee the equipment will operate to the user's satisfaction.
Before installing this equipment, users should ensure that it is permissible to be connected to the facil-
ities of the local telecommunications company. The equipment must also be installed using an accept-
able method of connection. The customer should be aware that compliance with the above conditions
may not prevent degradation of service in some situations.
Repairs to certified equipment should be coordinated by a representative designated by the supplier.
Any repairs or alterations made by the user to this equipment, or equipment malfunctions, may give the
telecommunications company cause to request the user to disconnect the equipment.
User should ensure for their own protection that the electrical ground connections of the power utility,
telephone lines, and internal metallic water pipe system, if present, are connected together. This pre-
caution may be particularly important in rural areas.
Caution: Users should not attempt to make such connections themselves, but should contact the ap-
propriate electric inspection authority, or electrician, as appropriate.
The Ringer Equivalence Number (REN) assigned to each terminal device  provides an indication of the
maximum number of terminals allowed to be connected to a telephone interface. The termination on
an interface may consist of any combination of devices subject only to the requirement that the sum of
the Ringer Equivalence Numbers of all the devices does not exceed 5.

In accordance with IEC 60417, this machine uses the following symbols for the main power switch: 
aaaa means POWER ON.
bbbb means POWER OFF.

Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information in the Basic Features manual before using this machine. It contains
important information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Laser Safety:

CDRH Regulations

This equipment complies with requirements of 21 CFR subchapter J for class 1 laser products. This
equipment contains a 5 milliwatt,  760–800 nanometer wavelength, GaAIAs laser diode. This equip-
ment does not emit hazardous light, since the beam is totally enclosed  during all customer modes of
operation and maintenance.

Warning: 

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

For good copy quality, the supplier recommends that you use genuine toner from the supplier.

The supplier shall not be responsible for any damage or expense that might result from the use of parts
other than genuine parts from the supplier with your office products. 

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Power Source:

115V, 60Hz

Please be sure to connect the power cord to a power source as above. For details about power source,
see Chapter 10, “Connecting the Power and Switching On” in the Advanced Features manual.

Declaration of Conformity

Product Name: Facsimile

Model Number: 3725/F9103/LF310AG/3310L

Responsible party: Ricoh Corporation

Address: 5 Dedrick Place, West Caldwell, NJ 07006

Telephone number: 973-882-2000

This device complies with part 15 of FCC Rules.

Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and

2. this device must accept any interference received,

including interference that may cause undesired operation.

Copyright © 2001
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NOTICE

R CAUTION:

 
Use of controls, adjustments or performance of procedures other than those
specified herein may result in hazardous radiation exposure.
Shielded interconnect cables must be employed with this equipment to ensure
compliance with the pertinent RF emission limits governing this device.

Note to users in the United States of America

----Notice:
This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential in-
stallation. This equipment generates, uses and can radiate radio frequency ener-
gy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be deter-
mined by turning the equipment off and on, the user is encouraged to try to cor-
rect the interference by one more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which

the receiver is connected.
• Consult the dealer or an experienced radio /TV technician for help.

----Warning
Changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.

Direct (or indirect reflected) eye contact with the laser beam may cause serious eye damage. 
Safety precautions and interlock mechanisms have been designed to prevent any possible laser 
beam exposure to the operator.
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Note to users in Canada

----Note:
This Class B digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada

----Avertissement:
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Can-
ada.

----Notice about the Telephone Consumer Protection Act (Valid in USA 
only).

The Telephone Consumer Protection Act of 1991 among other things makes it
unlawful for any person to send any message via a telephone fax machine unless
such message clearly contains in a margin at the top or bottom of each transmit-
ted page or on the first page of the transmission, the date and time it is sent and
an identification of the business, other entity, or other individual sending the
message and the telephone number of the sending machine or such business,
other entity or individual. This information is transmitted with your document
by the TTI (Transmit Terminal Identification) feature. In order for you to meet
the requirement, your machine must be programmed by following the instruc-
tions in the accompanying Operation Manual. In particular, please refer to the
chapter of Installation. Also refer to the TTI (Transmit Terminal Identification)
programming procedure to enter the business identification and telephone
number of the terminal or business. Do not forget to set the date and time.
Thank you.
For this machine, TTI is called FAX HEADER.
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Safety Information

When using this machine, the following safety precautions should always be fol-
lowed.

Safety During Operation

In this manual, the following important symbols are used: 

R WARNING:

 

R WARNING:
Indicates a potentially hazardous situation which, if instructions 
are not followed, could result in death or serious injury.

R CAUTION:
Indicates a potentially hazardous situation which, if instructions are not 
followed, may result in minor or moderate injury or damage to property.

• Connect the power cord directly into a wall outlet and never use an ex-
tension cord.

• Disconnect the power plug (by pulling the plug, not the cable) if the 
power cable or plug becomes frayed or otherwise damaged.

• To avoid hazardous electric shock or laser radiation exposure, do not 
remove any covers or screws other than those specified in this manu-
al.

• Turn off the power and disconnect the power plug (by pulling the plug, 
not the cable) if any of the following occurs:

• You spill something into the machine.

• You suspect that your machine needs service or repair.

• The external housing of your machine has been damaged.

• Do not incinerate spilled toner or used toner. Toner dust might ignite 
when exposed to an open flame.

• Disposal can take place at our authorized dealer.

• Dispose of the used toner cartridge in accordance with the local regu-
lations.
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R CAUTION:

 
• Protect the machine from dampness or wet weather, such as rain and snow.

• Unplug the power cord from the wall outlet before you move the machine. 
While moving the machine, you should take care that the power cord will not 
be damaged under the machine.

• When you disconnect the power plug from the wall outlet, always pull  the 
plug (not the cable).

• Do not allow paper clips, staples, or other small metallic objects to fall inside 
the machine.

• Keep toner (used or unused) and toner cartridge out of the reach of children.

• For environmental reasons, do not dispose of the machine or expended 
supply waste at household waste collection points. Disposal can take place 
at an authorized dealer.

• The inside of the machine could be very hot. Do not touch the parts with a 
label indicating the “hot surface”. Otherwise an injury might occur.

• Our products are engineered to meet high standards of quality and function-
ality, and we recommend that you use only the expendable supplies avail-
able at an authorized dealer.
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Important Safety Instructions

Grounding

In order to prevent potentially hazardous electrical shock, provide means of
connecting to the protective grounding conductor in the building, wiring those
grounding conductors of power cable and 3 pins plug.

Important Safety Instructions

Caution

When using your telephone equipment, basic safety precautions should always
be followed to reduce the risk of fire, electric shock and injury to persons, includ-
ing the following:
• Do not use this product near water, for example, near a bath tub, wash bowl,

kitchen sink or laundry tub, in a wet basement or near a swimming pool.
• Avoid using a telephone during an electrical storm. There may be a remote

risk of electric shock from lightning.
• Do not use a telephone in the vicinity of a gas leak to report the leak.
• Use only the power cord and batteries indicated in this manual. Do not dis-

pose of batteries in a fire. They may explode. Check with local codes for pos-
sible special disposal instructions.

Save these instructions.

IMPORTANTES MESURES DE SÉCURITÉ

Certalnes mesures de sécurité doivent être prises pendant l'utilisation de matéri-
al téléphonique afin de réduire les risques d'incendle , de choc électrique et de
blessures. En voici quelquesunes:
• Ne pas utiliser l'appareil près de l'eau, p.ex., près d'une balgnoire, d'un lava-

bo, d'un évier de cuisine, d'un bac à laver, dans un sous-sol humide ou près
d'une piscine.

• Éviter d'utiliser le téléphone (sauf s'il s'agit d'un apparell sans fil) pendant un
orage électrique. Ceci peut présenter un risque de choc électrique causé par la
foudre. 

• Ne pas utiliser l'appareil téléphonique pour signaler une fulte de gaz s'il est
situé près de la fuite. 

• Utiliser seulement le cordon d'alimentation et le type de piles indiqués dans
ce manual. Ne pas jeter les piles dans le feu: elles peuvent exploser. Se con-
former aux ègrlements pertinents quant à l'élimination des piles.

Conserver ces instructions.
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Positions of Labels and Hallmarks for 
RRRRWARNING and RRRRCAUTION

This machine has labels and hallmarks for RWARNING,RCAUTION at the
positions shown below. For safety, please follow the instructions and handle  the
machine as indicated.
The inside of the machine becomes very hot. Do not touch the inside. Doing so
could result in a burn.

A 
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ENERGY STAR Program

• Low-power Mode
At the factory, this fax machine is set to enter the low power mode after no op-
eration takes place for more than 5 minutes. To exit the low power mode, press
the {{{{Energy Saver/Clear Modes}}}} key. The machine starts printing in about 40 sec-
onds in the Energy Saving Standby mode, or in about 30 seconds in the Fax
Standby Mode.

❖❖❖❖ Specification

As an ENERGY STAR Partner, we have determined 
that this machine model meets the ENERGY STAR 
Guidelines for energy efficiency.

The ENERGY STAR Guidelines intend to establish an international energy-saving system for 
developing and introducing energy-efficient office equipment to deal with environmental is-
sues, such as global warming.

When a product meets the ENERGY STAR Guidelines for energy efficiency, the Partner shall 
place the ENERGY STAR logo onto the machine model.

This product was designed to reduce the environmental impact associated with office equip-
ment by means of energy-saving features, such as Low-power mode.

Low-power mode Power Consumption 1.2W

Default Time 5 minutes
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Energy Saving Modes

Energy Saving mode enables you to avoid using unnecessary power and econo-
mize on electricity. Although we recommend you use this mode from the view-
point of environmental consciousness, you can also turn it off.
When you install this machines for the first time, Energy Saving mode is turned
on by default.

Two types of Energy Saving mode are available:
• Fax Standby: Use when you receive faxes regularly.
• Energy Saving Standby: Use when you wish to economize on power con-

sumption.
Choose the one that best suits your circumstances.

Even though the operation panel display goes out in Energy Saving mode, Indi-
cators that flash or light during communication or reception still work. When the
Receive File indicator lights, exit Energy Saving mode and take the appropriate
action.

You can turn Energy Saving mode on or off with User Parameter.  When the ma-
chine is shipped, Energy Saving Standby is selected on.
The machine enters Energy Saving mode when:
• Nobody uses the machine for about 5 minutes (the machine automatically en-

ters Energy Saving mode)
• The user holds down the Energy Saver key for about 2 seconds.

To exit Energy Saving mode:
• In Energy Saving Standby mode, press the Energy Saver key.
• In FAX Standby mode, press any key.
• Set a document.
• Pick up the optional handset or the external telephone handset.

Energy Saving 
Mode Type

Status How long before 
you can print after 
exiting Energy Sav-
ing mode

Power 
consumption

Fax Standby Display turns off 

The machine maintains the heating 
roller temperature at half the full tem-
perature; warm up takes less time. 
(Heater half cool)

Within about 
30 seconds

40W

Energy Saving 
Standby

Display turns off  

The machine lets the heating roller cool 
to room temperature; warm-up takes 
longer.(Heater off)

Within about 
40 seconds

1.2W
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Note
❒ When you load paper in Energy Saving mode, no error will be displayed even

if the cassette is not pushed right in.
❒ After loading paper, press the Energy Saver key and check that "READY” is

shown on the display.

The Manual Receive indicator goes out in Energy Saving mode even if Manual
Receive is turned on.

Reception in Energy Saving mode
In Energy Saving mode, documents that have been stored in memory are still
sent and the machine can still receive messages.

When a message is received in Energy Saving mode, the machine prints it and
returns to Energy Saving mode.

Limitation
It is not possible to enter Energy Saving mode when an original is set.

Recycled Paper

In accordance with the ENERGY STAR Program, we recommend use of recycled
paper which is environmentally friendly. Please contact your sales representa-
tive for recommended paper.
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How to Read this Manual

Symbols

The following set of symbols is used in this manual.

R WARNING:
This symbol indicates a potentially hazardous situation that might result in
death or serious injury when you misuse the machine without following the in-
structions under this symbol. Be sure to read the instructions, all of which are de-
scribed in the Safety Information section.

R CAUTION:
This symbol indicates a potentially hazardous situation that might result in mi-
nor or moderate injury or property damage that does not involve personal injury
when you misuse the machine without following the instructions under this
symbol. Be sure to read the instructions, all of which are described in the Safety
Information section.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates information or preparations required prior to operating.

Note
This symbol indicates precautions for operation, or actions to take after abnor-
mal operation.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

{ }
Keys built into the operation panel of the machine.
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Manuals for This Machine

Two Facsimile Reference manuals are provided, the Basic Features manual and
the Advanced Features manual. Please refer to the manual that suits your needs.

Basic Features (this manual)

The Basic Features manual explains the most frequently used fax functions and
operations. 

Advanced Features

The Advanced Features manual describes more advanced functions, and also
explains settings for key operators.

❖❖❖❖ Chapter 1 Transmission Options
Explains about sending at a specific time without having to be by the machine
and also taking advantage of off-peak telephone line charges.

❖❖❖❖ Chapter 2 Job Information 
Explains about erasing a fax message stored in memory and checking the con-
tents of any files in memory.

❖❖❖❖ Chapter 3 Other Transmission Features 
Explains about useful features for transmission. You can find out about dial-
ing numbers easily.

❖❖❖❖ Chapter 4 Reception Features
Explains about reception features. You can find out about screening out mes-
sage from anonymous senders. 

❖❖❖❖ Chapter 5 Copying 
Explains about copying operations and functions.

❖❖❖❖ Chapter 6 Facsimile User Tools
Explains about programming frequently used functions for User Function
Key and setting the Date and Time.

❖❖❖❖ Chapter 7 Key Operator Settings
Explains about functions the key operator handles . You can find out how to
change the user parameter settings. 

❖❖❖❖ Chapter 8 Solving Operation Problems
Explains about things you should do when an Error Report is printed and
power is turned off.
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❖❖❖❖ Chapter 9 Maintaining Your Machine
Explains about changing the paper size in the paper trays, cleaning the scan-
ner and so on.

❖❖❖❖ Chapter 10 Installation
Explains about installation considerations, connecting to a telephone line,
and connecting the power.

❖❖❖❖ Chapter 11 Appendix 
You can check the specifications for this machine.
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1. Getting Started

Guide to Components

Front View

1. ADF Cover
Cover for the document feeder (ADF).

2. Release Button
Push this button to open the document
feeder.

3. Document Feeder (ADF) 
Originals will be fed automatically.

4. Output Tray
Received fax messages and copies are
stacked here.

5. Control Panel
Operate the machine using keys and
watching the display on the Control Pan-
el.

6. Front Cover
Open this cover when changing the toner
cassette and the photo conductor unit in-
side the machine.

7. Main Paper Tray
Load paper here.

8. Paper Tray Unit (Option)
You can load more paper here.

9. Lower Right Cover
Open this cover to remove jammed paper
fed from the optional paper tray unit.

10. Bypass Tray 
A fax message can be printed, and the
original is copied on the paper placed
here.
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11. Right Cover
Open this cover to remove jammed paper
fed from the paper tray.

12. Original Output Tray
Scanned originals are stacked here.

13. Original Tray 
Place originals here for sending a fax and
copying.

14. Original guide
Adjust the original guide to match the
size of the originals.

Side View

1. Output tray guide
Pull out and raise the end fence to sup-
port large papers.

2. Power Switch
The power switch turns your machine on
and off.

3. Handset (Option)
This permits voice communication.

4. G3 Line Connector

5. External Telephone Connector

6. Memory Card Slot
Insert an optional memory card here.

7. Ventilation hole
Prevents overheating. Do not obstruct
the ventilation hole by placing an object
near it. If the machine overheats, a fault
might occur.
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Control Panel

1. User Function keys
Each of these can be programmed for
rapid access to frequently used functions.

❖❖❖❖ Functions Programmed by Default

2. {{{{Trans. Option}}}} key
Press to change the transmission option
settings. The indicator lights when op-
tion settings are changed.

3. {{{{Job Information}}}} key
Press to search for information on a spe-
cific job.

4. LCD display
This guides you through tasks and in-
forms you of the machine status. A mes-
sage appears here.

5. {{{{Cancel}}}} key
Press to cancel an operation or return to
the previous display.

6. Add Toner indicator 
Blinks when toner is about to runout and
lights continuously when toner has run
out.

7. Load Paper indicator
Lights when a paper tray is empty or the
paper tray is not fully inserted.

8. 0000 1111 keys
Press to move the cursor or select func-
tions.

9. Receive File indicator
Lights when a message has been received
into memory.

10. {{{{OK}}}} key
Press to answer " Yes " to a question dis-
played on the display. 

11. {{{{Speed Dial}}}} key
Press to select a Speed Dial.

12. {{{{Pause/Redial}}}} key
Pause: Inserts a pause when you are dial-
ing or storing a fax number. A pause can-
not be inserted as the first digit.
Redial: Press to redial one of the last ten
numbers.

Key Function

F1 Print Journal

F2 FAX Header Print

F3 TX Result Report

F4 Group Dial

F5 Dial Option
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13. {{{{On Hook Dial}}}} key
Use to dial a number from the numeric
keypad without having to lift the hand-
set.

14. {{{{Energy Saver/Clear Modes}}}} key
Energy Saver: Hold down 2 seconds to
select or deselect energy saver mode.
When the machine is not used for a fixed
period, the machine goes into energy sav-
er mode automatically.
Clear Modes: Press to clear any selected
settings and return the machine to its pre-
vious condition.

15. {{{{Copy}}}} key
Press to copy the original currently load-
ed in the feeder.

16. Quick Dial keys
Use to dial numbers with a single touch
or to enter letters and symbols. Also use
for the Group Dial function.

17. Quick Dial Key Flip Plate
Flip down to access Quick Dials {{{{01}}}} to
{{{{15}}}}, and flip up to access Quick Dials
{{{{16}}}} to {{{{30}}}}.

Note
❒ Make sure the plate is flat against the

control panel.

18. {{{{User Tools}}}} key
Press to enter User Tools mode. These
tools allow you to customize the default
settings.

19. {{{{Help}}}} key
Press the Help key when you want to
print a help list.

20. {{{{Resolution}}}} key
Press to switch between Standard, Auto,
Detail and Fine. When the indicator is
not lit, Standard is selected.

21. {{{{Halftone}}}} key
Select halftone when faxing or copying
photographs or illustrations with fine
gradations. Also can be used for color
originals.

22. Status Indicators
These indicators keep you informed
about the current status of the unit. 

• hAlarm 
When the alarm indicator flashes,
check the display and read the mes-
sage to identify the problem (such as a
paper jam or open cover). 

• 0Communicating 
Lights during fax transmission or re-
ception. 

23. {{{{Memory Trans.}}}} key
Press this key to switch between Memory
Transmission and Immediate Transmis-
sion modes.
When the indicator is not lit, Immediate
Transmission is selected, and when the
indicator is lit, Memory Transmission is
selected.

24. Number keys 
Use to dial fax numbers or enter the num-
ber of copies.

25. {{{{Start}}}} key
Press to start all tasks.

26. {{{{Clear/Stop}}}} key
Clear: Deletes one character or digit.
Stop: Interrupts the current operation
(transmission, scanning, copying or
printing).
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Starting the Machine

To start the machine, turn on the
power switch.

Note
❒ This machine automatically enters

Energy Saver mode if you do not
use the machine for a while. 

Turning On the Power

AAAA Confirm that the power cord is
plugged into the outlet firmly.

BBBB Turn on the power switch. 

Turning Off the Power

Important
❒ Make sure that 100% is shown on

the Fax standby display before you
turn off the power switch or you
unplug the power cord. Fax files
programed in memory will be de-
leted 12 hours or more after you
turn off the power switch or you
unplug the power cord. The stor-
age time might be shorter if the
surrounding temperature is low or
the machine has been on for less
than a week.  

❒ Fax files programmed in memory
will not be deleted while the op-
tional memory card is installed.
When you install the memory card
to the machine, make sure that
100% is shown on the display and
turn off the power switch.

AAAA Turn off the power switch. 
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Reading the Display

The machine status and instructions are shown on the display.

Note
❒ This machine automatically returns to the standby display if you do not use

the machine for a certain period of time. You can select the period in Fax Reset
Timer. See p.64 “Setting the Fax Reset Timer”, <Advanced Features> .

Reading the Display and Using Keys

A Display for the machine status or currently selected function.
B Display for the messages.

Items which can be selected or specified.
C Display for items which can be selected.

Note
❒ Press  0 or 1  to display another function on the LCD display or move the

brackets to select another values.
❒ Press the {{{{OK}}}} key to set a selected function or entered value, and return

to the previous display. 
❒ Press the {{{{Cancel}}}} key to cancel the selected function or entered value, and

return to the previous display.

Standby Display

While the machine is in standby dis-
play (immediately after it is turned on
or after the {{{{Cancel}}}} key is pressed),
the following display is shown. 

Note
❒ To return the machine to standby

display, do one of the following:
• If you have set the original and

have not pressed the {{{{Start}}}}
key, remove the original.

• If you have not set an original,
press the {{{{Cancel}}}} key.

• If you are in User Tools mode,
press the {{{{User Tools}}}} key or the
{{{{Cancel}}}} key.

StellaF1EN-3_FM.book  Page 18  Monday, November 12, 2001  11:38 AM



Reading the Display

19

1

Communication Display

While the machine is communicating,
the status is displayed.

❖❖❖❖ Display during Memory Transmission
or Reception: 
The destination's name or fax
number appears on the top of the
LCD display.

Note
❒ Even when the machine is send-

ing or receiving a fax message
from/into memory, you can
still scan the next original into
memory. 

❖❖❖❖ Immediate Transmission:

Display Prompts

Depending on the situation, the ma-
chine will show various prompts on
the display.

❖❖❖❖ Instructions and Requests

❖❖❖❖ Questions

❖❖❖❖ Selections

❖❖❖❖ Status
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Transmission Modes

There are two types of transmission.

❖❖❖❖ Memory Transmission 
When a fax document is stored in
memory, then transmission starts
automatically. 
This makes it convenient when
you would like to take documents
back in a hurry. 
You can send the same message to
more than one destination in a sin-
gle operation. This technique is re-
ferred to as Broadcasting.

❖❖❖❖ Immediate Transmission
The machine dials immediately,
and transmits the fax while scan-
ning.
It is convenient when you would
like to send a document immedi-
ately, and would like to check
whether you have successfully
connected with the other party's
fax machine.
A fax document is not stored in
memory.

Important
❒ If there is a power failure, the pow-

er switch is turned off, or the plug
is pulled out for a certain period of
time, all documents stored in
memory are deleted. As soon as
power is restored, the Power Fail-
ure Report is printed to help you
identify deleted documents. See
p.103 “Power Failure Report”,
<Advanced Features> . 

Transmitter (This machine)

Receiver

Receiver

Receiver

GDRH230E

GDRH240E

Transmitter
(This machine)

Receiver
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Switching between Memory 
Transmission and Immediate 
Transmission

Press the {{{{Memory Trans.}}}} key to
switch between Memory Transmis-
sion and Immediate Transmission.
When the indicator of the {{{{Memory
Trans.}}}} key is not lit, Immediate
Transmission is selected. When the
indicator of the {{{{Memory Trans.}}}} key is
lit, Memory Transmission is selected. 

Note
❒ You can set whether the machine is

in Memory Transmission mode or
Immediate Transmission mode
right after the power is turned on
with the User Parameters (Switch
00 Bit 6). See p.85 “User Parame-
ters”, <Advanced Features>  .

❒ You can set whether the Transmis-
sion mode returns to the default
mode after each transmission with
the User Parameters (Switch 01 Bit
7). See p.85 “User Parameters”,
<Advanced Features>  .
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Setting Originals

You can set your originals in the Doc-
ument Feeder. 

❖❖❖❖ How to set A4, B5, A5, 51/2"××××81/2", 
81/2"××××11, 81/2"x14" and 8"x13" size 
originals

❖❖❖❖ How to set A5 and 81/2"×××× 51/2"size 
originals

Note
❒ When sending a fax, the image

output at the other end depends on
the size and direction of paper
used in the receiver's terminal. If
the receiver does not use paper of
the same size and direction as that
of the original, the fax image size
m ay  b e  r e d u c e d  o n  o u t p u t ,
trimmed at the both edges, or di-
vided into two or more sheets.
When sending an important origi-
nal, we recommend that you ask
the receiver about the size and di-
rection of the paper used in their
terminal.

❒ Make sure that all ink, correcting
fluid, etc., has completely dried be-
fore setting your original. If it is
st i ll  wet,  the scanner will  be
marked and those marks will ap-
pear on the received image.

❒ You can set the original any time
up until you press the {{{{Start}}}} key.
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Loading Originals in the 
Document Feeder

Use the Document Feeder to scan in a
stack of originals in one operation.
The Document Feeder can handle sin-
gle-sided originals.

Note
❒ The maximum document length is

600mm (23.7”) with manual assis-
tance.

❒ Place all the originals to be sent in
a single stack. 

❒ Do not open the Document Feeder
while it is scanning the originals or
your document could be jammed.

❒ If an original jams, press the
{{{{Clear/Stop}}}} key, and then remove
the original carefully. 

❒ If your original is bent or folded,
flatten it before you set it. 

Reference
For information about the sizes
and number of originals that can
be placed in the Document Feeder,
see p.127 “Originals”, <Advanced
Features> .

AAAA Adjust the document guide to
match the size of your originals.
Align the edges of your originals
and stack them in the Document
Feeder face up. Adjust the docu-
ment guide to match the size of
the originals again.

Note
❒ Set the originals gently.

Reference
For details about unsuitable
originals, see p.127 “Originals
unsuitable for the Document
Feeder (ADF)”, <Advanced Fea-
tures> ”.

Original Sizes Difficult to 
Detect

The machine finds it difficult to detect
the size of the following kinds of orig-
inals.
• Originals with index tabs, tags, or

projecting parts
• Transparent originals, such as

OHP transparencies or translucent
paper

• Dark originals with many charac-
ters or drawings

• Originals which partially contain
solid printing

• Originals which have solid print-
ing at their edges
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Memory Transmission

Memory Transmission is convenient
because:
• Fax documents can be scanned

much more quickly. Your scanned
document is stored in the memory,
and then sent automatical ly,
meaning you do not have to wait
for your document to send.

• While your fax document is being
sent, another user can operate the
machine (people do not have to
wait long to use the fax machine).

• You can send the same document
to more than one place with the
same operation. (Broadcasting)

• There are two kinds of Memory
Transmission: Parallel and Nor-
mal. See p.31 “Parallel Memory
Transmission”, <Advanced Fea-
tures> .

Important
❒ If there is a power failure (power

switch is off) or the plug is pulled
out for a certain period of time, all
the files stored in memory are de-
leted. As soon as the power switch
is turned on, the Power Failure Re-
port is printed to help you identify
deleted files. See p.103 “Power
Failure Report”, <Advanced Fea-
tures> .

Limitation
❒ If memory is full (0% appears on

the display), Memory Transmis-
sion is disabled. Use Immediate
Transmission instead.

Note
❒ Maximum number of Memory

Transmission files: 140 
❒ Maximum number of destinations

per Memory Transmission: 140 
❒ Combined total number of desti-

nations that can be stored: 300 
❒ The theoretical maximum number

of destinations you can enter with
the number keys is 69, but this will
depend on the amount of memory
currently available.

❒ The number of pages that you can
store in memory depends on the
original images and the scan set-
tings. You can store up to 240 stan-
dard pages  ( ITU-T #1  char t ,
Resolution: Standard, Original
Type: Text). 

❒ You can set whether the machine
returns to the default transmission
mode after every transmission
with the User Parameters. See p.85
“User Parameters”, <Advanced Fea-
tures> (Switch 01, Bit 7) .

AAAA Make sure that the Memory
Transmission indicator is lit. 

If it is not lit, press the {{{{Memory
Trans.}}}} key.
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BBBB Set the original.

Note
❒ Do not open the Document

Feeder while it is scanning in
originals.

Reference
p.23 “Setting Originals” 

CCCC Select any scan settings you re-
quire. See p.32 “Scan Settings”.

DDDD Dial. If you wish to send the same
message to more than one desti-
nation, press the {{{{OK}}}} key, and
then dial another destination. Re-
peat this step for all destinations.

If you make a mistake, press the
{{{{Clear/Stop}}}} key, and then enter the
correct number again.

Note
❒ When specifying a destination

using a Quick Dial, the destina-
tion is added even if you did not
press the {{{{OK}}}} key.

Reference
p.34 “Dialing” 

EEEE Press the {{{{Start}}}} key.

The machine starts scanning the
original.
The machine calls the destination.
The name or fax number which is
programmed as the Own Name or
Own Fax Number at the other end
is shown on the top of the display.

Reference
p.41 “Own Name/Fax Head-
er/Own Fax Number” 

After transmission, the machine
will return to standby display. 

StellaF1EN-3_FM.book  Page 26  Monday, November 12, 2001  11:38 AM



Canceling a Memory Transmission

27

2

Canceling a Memory Transmission

Before the Start Key is 
Pressed

AAAA Press the {{{{Energy Saver / Clear
Modes}}}} key.

Note
❒ When you have already set the

original, you can also cancel the
transmission by removing the
original from the machine.

While the Original is Being 
Scanned

AAAA Press the {{{{Clear/Stop}}}} key.

The machine will stop storing the
original and the data will not be
sent.

During Transmission

Use this procedure to cancel a trans-
mission after the original has been
scanned.

Note
❒ If transmission finishes while you

are carrying out this procedure, it
will not be canceled.

❒ If you cancel a message while it is
being sent, transmission is halted
as soon as you finish this proce-
dure. However, some pages of
your message may have already
been sent and will be received at
the other end. 

AAAA Press the {{{{Job Information}}}} key,
and confirm that " 1. Cancel TX /
RX " is displayed.

The Information menu is shown.

BBBB Press the {{{{OK }}}} key.
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CCCC Display the file you want to de-
lete. 

Enter the file number with the
number keys, or search using 0 or
1.

DDDD Press the {{{{OK}}}} key.

EEEE Press 0000 or 1111 to select " Yes " 

FFFF Press the {{{{OK}}}} key.

The file is erased, and the machine
will return to standby display

While the Original is Awaiting 
Transmission

Note
❒ Pages already being sent to the

destination cannot be canceled,
even if you cancel the transmis-
sion. The transmission may be sent
before you can cancel it, even if
you start canceling the transmis-
sion before it is fully sent. 

AAAA Press the {{{{Job Information}}}} key,
and confirm that "1. Cancel TX /
RX" is displayed. 

BBBB Press the {{{{OK}}}} key. 

CCCC Display the file you want to de-
lete. 

Enter the file number with the
number keys, or search using 0 or
1. 

If you are unable to find the file, it
has already been sent. 

DDDD Press the {{{{OK}}}} key. 

EEEE Press 0000 or 1111 to select " Yes ”.

FFFF Press the {{{{OK}}}} key. 

The file is erased, and the machine
will return to standby display
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Immediate Transmission

Immediate Transmission is conve-
nient when:
• You wish to send a document im-

mediately as it is scanning.
• You wish to quickly check whether

you have successfully connected
with the other party's fax machine.

• Your machine's memory is getting
full.

The machine dials immediately after
you press the {{{{Start}}}} key. The mes-
sage is scanned and transmitted page
by page without being stored in
memory.

Note
❒ You can only specify one destina-

tion for Immediate Transmission.
❒ You can set whether the machine is

in Memory Transmission mode or
Immediate Transmission mode
right after the power is turned on
with the User Parameters.

❒ The machine does not redial with
immediate transmission.

AAAA Check that the Memory Trans-
mission indicator is not lit.

If it is lit, press the {{{{Memory Trans.}}}}
key.

BBBB Set your original.

Reference
p.23 “Setting Originals” 

CCCC Select any scan settings you re-
quire. See p.32 “Scan Settings”.

DDDD Dial.

If you make a mistake, press the
{{{{Clear/Stop}}}} key, and then enter the
correct number again.

Reference
p.34 “Dialing” 
See p.21 “Chain Dial”, <Ad-
vanced Features> .

EEEE Press the {{{{Start}}}} key.

The machine calls the destination.
While it is dialing, the number or
name which is programmed as the
Own Name or Own Fax Number
in the machine of the other party is
shown on the display. When con-
nected, the machine starts scan-
ning the original.
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Reference
p.41 “Own Name/Fax Head-
er/Own Fax Number” 

After transmission the machine
will return to standby display.
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Canceling an Immediate Transmission

Before the Start key is Pressed

AAAA Press the {{{{Energy Saver / Clear
Modes}}}} key. 

Note
❒ When you have already set the

original, you can also cancel the
transmission by removing the
original from the machine.

After the Start key is Pressed

AAAA Press the {{{{Clear/Stop}}}} key, and
then remove the original.

Note
❒ If the transmission finishes

while you are carrying out this
procedure, it will not be can-
celed.
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Scan Settings

You may wish to send many different
types of fax messages. Some of these
may be difficult to reproduce at the
other end. However, your machine
has three settings that you can adjust
to help you transmit your document
with the best possible image quality. 

❖❖❖❖ Resolution:
Standard, Detail, Fine, Auto

❖❖❖❖ Original Type:
Halftone

Resolution

Images and text are scanned into the
machine by converting them to a se-
quence of dots. The frequency of dots
determines the quality of the image
and how long it takes to transmit.
Therefore, images scanned at high
resolution (Fine) have high quality
but transmission takes longer. Con-
versely, low resolution (Standard)
scanning results in less quality but
your original is sent more quickly.
Choose the setting that matches your
needs based upon this trade off be-
tween speed and image clarity.

❖❖❖❖ Standard (8××××3.85 lines/mm, 200××××100dpi)
Select for originals containing nor-
mal sized characters. 

❖❖❖❖ Detail (8××××7.7 lines/mm, 200××××200dpi)
Select for originals containing
small characters or when you re-
quire greater clarity. This resolu-
tion is twice as fine as Standard. 

❖❖❖❖  Fine (8××××15.4 lines/mm, 200××××400dpi)
Select for originals with very fine
details or when you require the
best possible image clarity. This
resolution is four times as fine as
Standard.

❖❖❖❖ Auto (8××××3.85 lines/mm, 200××××100dpi)
and (8××××7.7 lines/mm, 200××××200dpi)
Select for originals containing nor-
mal size characters and small size
characters. The machine will
choose either Standard or Detail
for originals automatically. 

Limitation
❒ If the other party's machine does

not support the resolution at
which you are sending, this ma-
chine automatically switches to a
resolution which is supported.

❒ Sending with Fine resolution re-
quires that the other party's ma-
chine has the capability to receive
fax messages at Fine resolution. 

Note
❒ The resolution returns to the de-

fault setting after every transmis-
sion. You can change this with the
User Parameters (Switch01, Bit7).
See  p.85 “User Parameters”, <Ad-
vanced Features> .

❒ Auto resolution can be selected
when the machine is in memory
transmission mode and it can not
be selected when the machine is in
immediate transmission mode.

❒ Standard Memory Transmission is
used instead of Parallel Memory
Transmission when Auto resolu-
tion is selected.

❒ Auto resolution can not be selected
when copying.
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❒ Usually, transmission takes short-
er when Auto resolution is select-
ed than Detail  reso lution is
selected. However, transmission
for some originals containing nor-
mal size characters and small size
characters takes longer because
resolution modes are changed.

AAAA Press the {{{{Resolution}}}} key to
switch between resolutions. The
indicators above the key show the
current selection. When none of
the indicators are lit, Standard is
selected.

Original Type

If your original contains photographs
or colored illustrations, select Half-
tone to optimize image clarity. 

❖❖❖❖ Halftone 
Select Halftone to send an original
containing a halftone image such
as a photograph or a color original.

Note
❒ If you select Halftone, resolution is

automatically set to Detail. Even if
you do not select Halftone again,
the resolution will not return to
Standard.

❒ If you select Halftone, the trans-
mission will take longer than when
it is not selected. 

❒ You can set whether the machine
returns to the Original Type de-
fault setting after every transmis-
sion with the User Parameters
(Switch 01 Bit 7). See p.85 “User
Parameters”, <Advanced Features> .

AAAA Press the {{{{Halftone}}}} key.
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Dialing

There are four main ways to dial a
number:

❖❖❖❖ Entering Numbers Directly 
See p.34 “Entering Numbers Di-
rectly” 

❖❖❖❖ Using Quick Dials:
See p.35 “Using Quick Dials” 

❖❖❖❖ Using Speed Dials:
See p.36 “Using Speed Dials” 

❖❖❖❖ Using Groups
See p.37 “Using Groups” 

Entering Numbers Directly

Enter numbers directly using the
number keys on the right side of the
operation panel.

Note
❒ Maximum length of a fax number:

254 digits.
❒ You can insert pauses and tones in

a fax number. See p.35 “Pause”,
p.35 “Tone” 

AAAA Make sure that the machine is in
standby display.

BBBB Set your original and select any
scan settings you require.

CCCC Enter the fax number with the
number keys.
The digits appear on the display as
you enter them.

Note
❒ If you make a mistake, press the

{{{{Clear/Stop}}}}  key and enter
again.

❒ If you wish to send this message
to more than one destination,
press the {{{{OK}}}} key, and then en-
ter the next destination. 

DDDD Press the {{{{Start}}}} key.

----Limitations when dialing with 
the number keys 

Fax numbers entered with the num-
ber keys are stored in internal memo-
ry (separate from memory for storing
original data). Therefore, using the
number keys, you cannot program 69
or more numbers for the following:
• Destinations specified in a Memo-

ry Transmission (including Polling
Reception)

• Destinations specified in a Group 
For example, when 60 destinations
are registered in a Group with the
number keys, only 9 destinations can
be dialed for Memory Transmission
from the number keys.
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Note
❒ If a memory file is awaiting trans-

mission and the "Exceeded the
Max.Cannot Add" message is dis-
played when dialing with the
number keys, you cannot dial any
more numbers. That is because the
fax numbers have been dialed with
the number keys for some of the
files awaiting transmission. When
these files have been sent and their
fax numbers are deleted from
memory, additional fax numbers
can be dialed.

❒ The display shows the percentage
of free memory space for storing
originals. Since fax numbers are
stored in separate memory, dialing
fax numbers with the number keys
does not change the percentage on
the display.

Pause

Press the {{{{Pause/Redial}}}} key when di-
aling or storing a number to insert
about a two-second pause. 

Note
❒ You cannot insert a pause before

the first digit of a fax number.
❒ A pause is shown as a "-" on the

display. 
❒ You can insert a pause in numbers

stored in Quick Dials and Speed
Dials.

Tone

This function allows a machine con-
nected to a pulse dialing line to send
tone signals (for example if you want
to use a special service on a tone dial-
ing line). When you press the {{{{pppp}}}}
key, the machine dials the number us-
ing tone signals. 

Note
❒ You cannot place a tone before the

first digit of a fax number.
❒ Some services may not be available

when using the {{{{pppp}}}} key.
❒ A tone is shown as a "•" on the dis-

play. 

Using Quick Dials

You can specify destinations simply
by pressing the Quick Dial.
You must program the destination's
fax number in a Quick Dial before-
hand.
Additionally, you can store a name
for the destination in Quick Dials. 

Note
❒ To register, edit, or delete a Quick

Dial, see p.46 “Quick Dial” 
❒ To check the contents of all Quick

dials, print the quick Dial list. See
p.56 “Printing Reports/Lists”,
<Advanced Features> .

❒ You can have the label stored with
a Quick Dial printed on the first
page received at the other end.

Reference
p.34 “Dialing” 
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AAAA Make sure that the machine is in
standby display.

BBBB Set your original and select any
scan settings you require.

CCCC Press the Quick Dial key in which
the destination's number is pro-
grammed.

If the destination's name has been
stored, the name is shown on the
display. If it is not, the fax number
is shown.

Note
❒ If you make a mistake, press the

{{{{Clear/Stop}}}} key and try again.
❒ If you wish to dial another des-

tination, press the {{{{OK}}}} key and
dial another fax number.

DDDD Press the {{{{Start}}}} key.

Using Speed Dials

You can specify destinations simply
by pressing the {{{{Speed Dial}}}} key and a
Speed Dial code (00 to 49).
You must store the destination's fax
number in a Speed Dial beforehand.
Additionally, you can store a name
for the destination in Speed Dials. 

Note
❒ To register, edit, or delete Speed

Dial entries, see p.52 “Speed Dial” 
❒ To check the contents of all Speed

Dials, print the Speed Dial list. See
p.56 “Printing Reports/Lists”,
<Advanced Features> .

❒ You can use codes 00-49 for Speed
Dials.

❒ If a search letter is registered with
a Speed Dial, you can find this
number quickly using the Tele-
phone Directory function. See p.22
“Telephone Directory”, <Advanced
Features> .

❒ You can have the label stored with
a Speed Dial printed on the first
page received at the other end.

AAAA Make sure that the machine is in
standby display.

BBBB Set your original and select any
scan settings you require.

StellaF1EN-3_FM.book  Page 36  Monday, November 12, 2001  11:38 AM



Dialing

37

2

CCCC Press the {{{{Speed Dial}}}} key.

DDDD Enter the two digit code (00 to 49)
for the destination with the num-
ber keys.

Note
❒ When a name is stored for the

destination, the name is dis-
played, and when no name is
stored, the fax number is dis-
played.

❒ If you wish to dial another des-
tination, press the {{{{OK}}}} key and
dial another fax number.

❒ If you make a mistake, press the
{{{{Clear/Stop}}}} key, and try again.

EEEE Press the {{{{Start}}}} key.

Using Groups

You can store multiple destinations as
a single Group and simply specify a
particular Group.
You must store the destinations' fax
number in a Group beforehand.
Additionally, you can store destina-
tion names and a Group name in
Groups.
The method for specifying Groups
differs according to the way they
were programmed.
• When programmed in a Quick Di-

al: Press the Quick Dial key.
• When not programmed in a Quick

Dial: Use the User Function Key.
Group Dial is assigned to {{{{F4}}}} as a
default setting. If this setting is
changed, program the Group func-
tion in a User Function key ( {{{{F1}}}}
to {{{{F5}}}} ). When you want to speci-
fy a destination, press the User
Function key in which the Group
Function is programmed, and then
press the Group number with the
number keys. See p.53 “User Func-
tion Keys”, <Advanced Features> .

Limitation
❒ You cannot use Immediate Trans-

mission to send Groups. You can
only use Memory Transmission.

Note
❒ Quick Dials programmed for

Groups cannot be used for any oth-
er function.

❒ To register, edit, or delete Groups,
see p.57 “Groups” 

❒ To check the contents of all Groups,
print the Group Dial list. See p.56
“Printing Reports/Lists”, <Ad-
vanced Features> .
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When Specifying a Group with a Quick 
Dial

Make sure that the Memory Trans-
mission indicator is lit, if not, press
the {{{{Memory Trans.}}}} key to light it.

Note
❒ You must register Groups to Quick

D ia l s  b e fo r eh a n d .  S e e  p . 57
“Groups” 

AAAA Make sure that the machine is in
standby display.

BBBB Set your original and select any
scan settings you require.

CCCC Press the Quick Dial key in which
the Group is programmed.

Note
❒ If you make a mistake, press the

{{{{Clear/Stop}}}} key and try again.
❒ If you wish to dial another des-

tination, press the {{{{OK}}}} key,
and then dial another fax num-
ber.

DDDD Press the {{{{Start}}}} key.

When Specifying a Group with the Group 
key

Make sure that the Memory Trans-
mission indicator is lit, if not, press
the {{{{Memory Trans.}}}} key to light it.

Note
❒ Group Dial is assigned to {{{{F4}}}} as a

default setting. If this setting is
changed, you must program the
Group function in a User Function
key beforehand. See p.53 “User
Function Keys”, <Advanced Fea-
tures> .

AAAA Make sure that the machine is in
standby display.

BBBB Set your original and select any
scan settings you require.

CCCC Press the User Function key pro-
grammed with the Group func-
tion.

DDDD Enter the Group number (1 to 5)
with the number keys.

Note
❒ If you want to specify another

Group, press the {{{{OK}}}} key, and
then repeat step C above.

❒ If you make a mistake, press the
{{{{Clear/Stop}}}} key, and the dis-
play will return to that in step B.

EEEE Press the {{{{Start}}}} key.
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Reception Modes

The machine can treat incoming fax
messages and telephone calls in three
ways.

❖❖❖❖ Manual Receive
Use this mode if your line is shared
by a fax machine and a telephone
but you wish to answer all calls
yourself and decide whether they
are fax documents or telephone
calls. You must manually press the
{{{{Start}}}} key to receive a fax.
The machine will ring continuous-
ly until you answer the call, so you
have to be near the machine at all
times. 

❖❖❖❖ Auto Receive
Use this mode if you have a dedi-
cated fax line. The machine as-
sumes all calls are fax documents.
It will ring once to alert you of an
incoming call, and then starts re-
ceiving.

❖❖❖❖ Auto Select
In this mode, the machine rings a
number of times. You can answer
the call while the machine is ring-
ing. If you do not answer the call,
the machine automatically chang-
es to receive fax messages.

Note
❒ You can change the number of

rings. See p.61 “Setting the Auto
Ring Time”, <Advanced Fea-
tures> . 

❒ When the other party send a fax
message, the machine changes
to receive the fax message auto-
matically.

❒ You can connect a telephone an-
swering machine with Auto Se-
lect.

❒ Set a smaller number of rings
for the telephone answering
machine than for the fax ma-
chine.

❒ It could not be work correctly
depends on a telephone an-
swering machine.

Selecting the Reception Mode

Select the Reception Mode using the
following procedure.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.
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DDDD Press 0000 or 1111 until " 3. Setup " is
displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press 0000 or 1111 until “ 5. Reception
Mode “ is displayed.

GGGG Press the {{{{OK}}}} key. 

HHHH Press 0000 or 1111 to select the recep-
tion mode.

IIII Press the {{{{OK}}}} key.

JJJJ Press the {{{{User Tools}}}} key to re-
turn to the standby display.
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Own Name/Fax Header/Own Fax Number

Make sure that all necessary settings
are made before connecting your ma-
chine to the telephone line.

❖❖❖❖ Own Name
This should be your name or com-
pany name, in 20 characters or less.
During communication, if the oth-
er party's fax machine supports
Own Name, this replaces the Own
Fax Number that follows. This
name will appear on the display of
the other party's fax machine, and
the name registered on that ma-
chine will appear on yours.

Limitation
❒ The registered name will not be

used unless the other party has
the same machine of the same
make that supports the Own
Name function.

❖❖❖❖ Fax Header
This is ordinarily your name or
company name. Your fax header
can be up to 32 characters long,
and is printed on the header of ev-
ery page you send.

❖❖❖❖ Own Fax Number (Required by inter-
national law)
This is your fax machine's phone
number that must include country
and area codes using 20 characters
or less. During any communica-
tion, your Own Fax Number ap-
pears on their display. (Conversely
their Own Fax Number appears on
your display.)

Note
❒ In some areas, the Own Fax

Number is preprogrammed by
your service representative, and
cannot be re-programmed by
the user.

Important
❒ When sending a fax, your Own Fax

Number is required by interna-
tional law. You cannot legally con-
nect a fax machine to the telephone
system if the Own Fax Number is
not programmed. 

Note
❒ You can confirm the Own Name,

Fax Header, and Own Fax Number
settings in the User Parameters
List. See p.90 “Printing the User
Parameter List”, <Advanced Fea-
tures> .
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Registering

The following procedure describes
how to make initial settings. 

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until "2. Fax Fea-
tures" is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 3. Setup " is
displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press 0000 or 1111 until "6. Fax Infor-
mation" is displayed. 

GGGG Press the {{{{OK}}}} key. 

Confirm that " 1. Own Name " is
displayed.

HHHH Press the {{{{OK}}}} key. 

IIII Enter your Own Name. 

Note
❒ If you want to erase a character

in  t he  n am e ,  p re s s  t h e
{{{{Clear/Stop}}}} key. 

Reference
See p.67 “Entering Charac-
ters”for how to enter characters.

JJJJ Press the {{{{OK}}}} key. 

Your Own Name is programmed. 

KKKK Press 0000 or 1111 until " 2. Fax Header
" is displayed. 
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LLLL Press the {{{{OK}}}} key. 

The programmed Own Name is
displayed. 

MMMM Enter your Fax Header. 

If your Fax Header is the same as
your Own Name, go to step N. 

NNNN Press the {{{{OK}}}} key. 
Your Fax Header is programmed. 

OOOO Press 0000 or 1111 until " 3. Own Fax
Number " is displayed. 

PPPP Press the {{{{OK}}}} key. 

QQQQ Enter your Own Fax Number. 

Note
❒ The format of the number is

normally as follows: Interna-
tional Dial Prefix, Your Country
Code, Your Area Code (do not
insert a pause after your Area
Code), followed by your tele-
phone number. Check the Inter-
national Dialing Prefix and the
Country Code with your local
telecommunications operator.

Characters you can enter include
numerals 0-9, plus symbols (+),
and spaces.

RRRR Press the {{{{OK}}}} key. 

Your Own Fax Number is pro-
grammed. 

SSSS Press the {{{{User Tools}}}} key to re-
turn to standby display. 
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Editing 

The following procedure describes
how to edit initial settings.

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 3. Setup " is
displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press 0000 or 1111 until "6. Fax Infor-
mation" is displayed. 

GGGG Press the {{{{OK}}}} key. 

HHHH Press 0000 or 1111 to select the item
that you want to edit. 

IIII Press the {{{{OK}}}} key. 

JJJJ Press the {{{{Clear/Stop}}}} key, and
then reenter  the Number or
Name.

KKKK Press the {{{{OK}}}} key. 

LLLL Press the {{{{User Tools}}}} key to re-
turn to standby display. 
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Deleting 

The following procedure describes
how to delete initial settings.

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 3. Setup " is
displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press 0000 or 1111 until "6. Fax Infor-
mation" is displayed. 

GGGG Press the {{{{OK}}}} key. 

HHHH Press 0000 or 1111 to select the item
that you want to delete. 

IIII Press the {{{{OK}}}} key. 

JJJJ Press the {{{{Clear/Stop}}}} key.

KKKK Press the {{{{OK}}}} key. 

LLLL Press the {{{{User Tools}}}} key to re-
turn to standby display. 
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Quick Dial

To save time, you can program a fax
number that you use often into a
Quick Dial key. Then, whenever you
are sending a message to that loca-
tion, just press that Quick Dial key to
dial.

Registering 

The following procedure describes
how to register fax numbers in Quick
Dial keys. There are 30 Quick Dials
available. 
You can register the following items
in each key:
• Destination fax number (up to 254

digits)
• Destination name (up to 20 charac-

ters)
• Label Insertion (whether to print

the destination name on faxes sent
to this number)

Important
❒ We recommend that you print the

Quick Dial list and keep it when
you program or change fax num-
bers .  See  p .56  “Print ing  Re-
ports/Lists”, <Advanced Features> .

Limitation
❒ When a registered Quick Dial key

is being used for a standby Memo-
ry Transmission, the message "
This Dial is in Use. Cannot
Change. " is shown and you can-
not change the destination for this
key.

Note
❒ You can confirm fax numbers

stored in Quick Dials on the Quick
Dial List. See p.56 “Printing Re-
ports/Lists”, <Advanced Features> .

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

Confirm that " 1. Program / Delete
" is displayed. 

DDDD Press the {{{{OK}}}} key. 

Confirm that " 1. Prog. Quick Dial "
is displayed. 
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EEEE Press the {{{{OK}}}} key.

FFFF Display the number of the Quick
Dial key you want to register.

Press a Quick Dial key, or search
using 0 or 1.

Note
❒ If a Quick Dial has already been

registered, the contents are dis-
played. Press 0 or 1 to select a
Quick Dial  that is not  pro-
grammed, and then press the
{{{{OK}}}} key.

GGGG Enter a fax number with the num-
ber keys.

Note
❒ If you make a mistake, press the

{{{{Clear/Stop}}}} key and try again.
❒ If you press the {{{{Pause/Redial}}}}

key, the last 10 fax numbers di-
aled are displayed. Press 0 or
1 to select the fax number you
want to specify, and then press
the {{{{OK}}}} key.

❒ Make sure a Dial Option is
stored in one of the User Func-
tion keys, and then enter the
other party's fax number, and
then press the User Function
key that contains the Dial Op-
tion. You can specify SUB or
SEP, SID and PWD. See p.25
“SEP Code”, <Advanced Fea-
tures>  or p.26 “SUB Code”,
<Advanced Features> .

HHHH Press the {{{{OK}}}} key.

The fax number is programmed.

IIII Enter the destination name.

Note
❒ Under rare circumstances, gar-

bled characters may appear
during name registration if you
use the {{{{Pause/Redial}}}} key to
display the fax number of par-
ties located in other countries. If
this happens, simply delete the
garbled characters using 0 or
1 and the {{{{Clear/Stop}}}} keys,
then go on to enter the name.

JJJJ Press the {{{{OK}}}} key.

The name is programmed.

KKKK Press 0000 or 1111 to select "On" or
"Off". 

Note
❒ Label insertion allows the re-

ce iver ' s  name  tha t  i s  pro-
grammed in Quick Dial  or
Speed Dial to be printed on the
fax when it is received at the
other end. See p.8 “Label Inser-
tion”, <Advanced Features> .
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LLLL Press the {{{{OK}}}} key.

If you want to store another Quick
Dial, go to step E.

MMMM Press the {{{{User Tools}}}} key to re-
turn to standby display.

Editing 

The following procedure describes
how to edit fax numbers registered in
Quick Dial keys.

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

Confirm that " 1. Program / Delete
" is displayed. 

DDDD Press the {{{{OK}}}} key. 

Confirm that " 1. Prog. Quick Dial "
is displayed. 

EEEE Press the {{{{OK}}}} key.

FFFF Display the number of the Quick
Dial key you want to edit.

Press a Quick Dial key, or search
using 0 or 1.

GGGG Press the {{{{OK}}}} key.

HHHH Press the {{{{Clear/Stop}}}} key, and
then reenter the fax number with
the number keys.

Note
❒ If you make a mistake, press the

{{{{Clear/Stop}}}} key and try again.
❒ If you press the {{{{Pause/Redial}}}}

key, the last 10 fax numbers di-
aled are displayed. Press 0 or
1 to select the fax number you
want to specify, and then press
the {{{{OK}}}} key.

❒ Make sure a Dial Option is
stored in one of the User Func-
tion keys, and then enter the
other party's fax number and
press the User Function key that
contains the Dial Option. You
can specify SUB or SEP, SID and
PWD. See p.25 “SEP Code”,
<Advanced Features> or p.26
“SUB Code”, <Advanced Fea-
tures> .

IIII Press the {{{{OK}}}} key.
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JJJJ Press the {{{{Clear/Stop}}}} key, and
then reenter the destination
name.

Note
❒ Under rare circumstances, gar-

bled characters may appear
during name registration if you
use the {{{{Pause/Redial}}}} key to
display the fax number of par-
ties located in other countries. If
this happens, simply delete the
garbled characters using 0 or
1 and the {{{{Clear/Stop}}}} keys,
and then go on to enter the
name.

KKKK Press the {{{{OK}}}} key.

The name is programmed.

LLLL Press 0000 or 1111 to select "On" or
"Off". 

Note
❒ Label insertion allows the re-

ce ive r ' s  name that  i s  p ro -
grammed in Quick Dial  or
Speed Dial to be printed on the
fax when it is received at the
other end. See p.8 “Label Inser-
tion”, <Advanced Features> .

MMMM Press the {{{{OK}}}} key.

If you want to store another Quick
Dial, go to step E.

NNNN Press the {{{{User Tools}}}} key to re-
turn to standby display.

Deleting 

The following procedure describes
how to delete fax numbers registered
in Quick Dial keys.

Limitation
❒ When a Quick Dial key is being

used for a standby Memory Trans-
mission, the message " This Dial
is in Use. Cannot Delete. " is
shown and you cannot delete the
destination for this key.

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

Confirm that " 1. Program / Delete
" is displayed. 

DDDD Press the {{{{OK}}}} key.
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EEEE Press 0000 or 1111 until " 2. Del. Quick
Dial " is displayed.

FFFF Press the {{{{OK}}}} key.

GGGG Display the Quick Dial key that
you want to delete.

Press a Quick Dial key or search by
pressing 0 or 1.

The number of the Quick Dial key
and the fax number or name are
displayed.

HHHH Press the {{{{OK}}}} key.

The stored data (fax number and
name) is deleted.

If you want to delete another
Quick Dial key, go to step F.

IIII Press the {{{{User Tools}}}} key to re-
turn to standby display.

Quick Dial Key Label (Dial label)

You can print a template that can be
used to make labels for Quick Dial
keys. The template will have destina-
tion or Group names programmed in
Quick Dial keys.

Limitation
❒ Set the label paper to landscape in

the Bypass Tray. Portrait position
will print the wrong size.

Note
❒ To print the label template, see

p.56 “Printing Reports/Lists”,
<Advanced Features> .
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Label paper

AUG. 21. 2002  11:22AM
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Speed Dial

Registering 

If you register numbers in Speed Di-
als, you can specify the fax number
simply by pressing the {{{{Speed Dial}}}}
key, and entering a two-digit Speed
Dial number. 
The following procedure describes
how to register fax numbers in Speed
Dials.
You can register the following items
in a Speed Dial:
• Destination fax number (up to 50

numbers, up to 254 digits for each
number)

• Destination name (up to 20 charac-
ters)

• A Telephone Directory search let-
ter (A to Z)

• Label Insertion (whether to print
the destination name on faxes sent
to this number)

Important
❒ We recommend that you print the

Speed Dial list and keep it when
you register or change a destina-
tion.

Limitation
❒ When a registered Speed Dial is be-

ing used for a standby Memory
Transmission, the message " This
Dial is in Use. Cannot Change.
" is shown and you cannot change
the destination for this Quick Dial. .

Note
❒ You can specify codes 00 to 49.
❒ You can confirm the contents of

Speed Dial numbers in the Speed
Dial List. See p.56 “Printing Re-
ports/Lists”, <Advanced Features> .

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

Confirm that " 1. Program / Delete
" is displayed. 

DDDD Press the {{{{OK}}}} key.

EEEE Press 0000 or 1111 until " 3. Prog.
Speed Dial " is displayed.

FFFF Press the {{{{OK}}}} key. 
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GGGG Display the number of the Speed
Dial you want to register (00 to
49). 

Enter the Speed Dial number with
the number keys, or search using
0 or 1.

Note
❒ If you make a mistake, press the

{{{{Clear/Stop}}}} key and try again.
❒ If a Speed Dial number has al-

ready been stored, the contents
are displayed. Press 0 or 1 to
select an unprogrammed num-
ber, then press the {{{{OK}}}} key.

HHHH Enter a fax number with the num-
ber keys.

Note
❒ If you make a mistake, press the

{{{{Clear/Stop}}}} key and try again.
❒ If you press the {{{{Pause/Redial}}}}

key, the last 10 fax numbers di-
aled are displayed. Press 0 or
1 to select the fax number you
want to specify, and then press
the {{{{OK}}}} key.

IIII Press the {{{{OK}}}} key. 

The fax number is programmed.

JJJJ Enter the Destination name. 

Note
❒ If a destination name is already

registered in the Speed Dial, the
name is shown on the display. If
you wish to change the destina-
t i o n  n a m e ,  p r es s  t h e
{{{{Clear/Stop}}}} key, and then enter
another name.

KKKK Press the {{{{OK}}}} key. 

The search letter is registered. 

LLLL Press 0000 or 1111 to select "On" or
"Off". 

Note
❒ Label insertion allows the desti-

n a t i o n  n a m e  t h a t  i s  p r o -
grammed in Quick Dial  or
Speed Dial to be printed on the
fax when it is received at the
other end. See p.8 “Label Inser-
tion”, <Advanced Features> .

MMMM Press the {{{{OK}}}} key. 

If you want to store another Speed
Dial number, go to step F. 

NNNN Press the {{{{User Tools}}}} key to re-
turn to standby display. 
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Editing

The following procedure describes
how to edit registered Speed Dial
numbers.

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

Confirm that " 1. Program / Delete
" is displayed. 

DDDD Press the {{{{OK}}}} key.

EEEE Press 0000 or 1111 until " 3. Prog.
Speed Dial " is displayed.

FFFF Press the {{{{OK}}}} key. 

GGGG Display the number of the Speed
Dial you want to edit (00 to 49). 

Enter the Speed Dial number with
the number keys, or search using
0 or 1.

HHHH Press the {{{{OK}}}} key. 

IIII Press the {{{{Clear/Stop}}}} key, and
then reenter a fax number with
the number keys.

Note
❒ If you make a mistake, press the

{{{{Clear/Stop}}}} key and try again.
❒ If you press the {{{{Pause/Redial}}}}

key, the last 10 fax numbers di-
aled are displayed. Press 0 or
1 to select the fax number you
want to specify, and then press
the {{{{OK}}}} key.

JJJJ Press the {{{{OK}}}} key. 
The fax number is programmed.

KKKK Press the {{{{Clear/Stop}}}} key, and
then reenter the Destination
name. 

LLLL Press the {{{{OK}}}} key. 

The search letter is registered. 
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MMMM Press 0000 or 1111 to select "On" or
"Off". 

Note
❒ Label insertion allows the desti-

n a t io n  n a m e  t ha t  i s  p ro -
grammed in Quick Dial  or
Speed Dial to be printed on the
fax when it is received at the
other end. See p.8 “Label Inser-
tion”, <Advanced Features> .

NNNN Press the {{{{OK}}}} key. 

If you want to edit another Speed
Dial number, go to step F. 

OOOO Press the {{{{User Tools}}}} key to re-
turn to standby display. 

Deleting 

The following procedure describes
how to delete fax numbers in Speed
Dials.

Limitation
❒ If a registered Speed Dial is being

used for a standby Memory Trans-
mission, the message " This Dial
is in Use. Cannot Delete. " is
shown and you cannot delete the
destination for this Speed Dial.

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

Confirm that " 1. Program / Delete
" is displayed. 

DDDD Press the {{{{OK}}}} key. 
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EEEE Press 0000 or 1111 until " 4. Del. Speed
Dial " is displayed. 

FFFF Press the {{{{OK}}}} key.

GGGG Display the Speed Dial number
you want to delete (00 to 49). 

Enter the Speed Dial number with
the number keys or search using 0
or 1. 

The Speed Dial number and the fax
number or name are displayed.

HHHH Press the {{{{OK}}}} key. 

The programmed data (fax num-
ber and name) is deleted. 

If you want to delete another
name, go to step F. 

IIII Press the {{{{User Tools}}}} key to re-
turn to standby display. 
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Groups

If you regularly broadcast documents
to the same set of destinations, you
can combine these numbers into a
group. Then just select the group and
each number will be dialed in se-
quence automatically. 
There are two ways of programming
Groups: 

❖❖❖❖ Registering groups in Quick Dial keys
If you register a group in a Quick
Dial key, you can specify that
group by pressing a Quick Dial
key. However, if you use Quick
Dial keys to register groups, you
will be able to register fewer Quick
Dial keys . 

Note
❒ You cannot register another

function (Quick Dials) in a
Quick Dial key already used for
a group.  Also, you cannot regis-
ter groups in a Quick Dial key
already used for another func-
tion. 

❖❖❖❖ Assigning the Group Functions to the
Group key
To assign the Group Function to
the Group key, you must first as-
sign the Group function to a User
Function key. To send a fax, press
the Group key, and then enter the
group number (1 to 5). To select a
Group using a Group key, one
more step is required than when
using a Quick Dial key. However,
multiple Groups (a maximum of
five) can be stored in a Group key,
thus leaving the Quick Dial keys to
be used more effectively.

Registering 

You can register the following items
in a Group:
• Destination fax numbers
• Group name (up to 20 characters)
You can enter destination numbers
using Quick Dial keys, Speed Dials,
or the number keys.

Note
❒ You can register up to 5 Groups.
❒ The maximum number of destina-

tions you can register in a Group is
140.

❒ The combined maximum number
of destinations you can register in
all Groups is 149. This 149 can be
composed of up to 30 Quick Dial
numbers, 50 Speed Dial numbers
and 69 numbers entered directly
with the number keys.

❒ The number of destinations that
can be registered with the number
keys depends on how the machine
is used. In theory you can register
up to a combined maximum of 69
destinations with the number keys
for all groups.

❒ If you register 69 destinations with
the number keys, Memory Trans-
mission using the number keys be-
comes unavailable ,  and only
Immediate Transmission is avail-
able.
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❒ If you register a Group with the
number keys when a file is waiting
to be transmitted, a message is
shown. You sometimes cannot reg-
ister any more destinations even
when the number of specified des-
tination is 68 or less.

❒ It is recommended that you print
the Group Dial list and keep it
when you register or change desti-
nations. See p.56 “Printing Re-
ports/Lists”, <Advanced Features> .

❒ If you register the same destination
in different Groups, it is only
counted as one item.

❒ The table below shows how to
count numbers.

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

Confirm that " 1. Program / Delete
" is displayed. 

DDDD Press the {{{{OK}}}} key. 

EEEE Press 0000 or 1111 until " 5. Prog.
Group Dial " is displayed. 

FFFF Press the {{{{OK}}}} key. 

Group1 Group2 Total 
Number of 
items

Quick Dial 
[01]     

Quick Dial 
[01]

9

Quick Dial 
[03]

Quick Dial 
[05]

Quick Dial 
[05]

Speed Dial 
[02]

Speed Dial 
[02]

Speed Dial 
[04]

Speed Dial 
[04]

Speed Dial 
[06]

Speed Dial 
[09]

Number 
keys  
12345678

Number 
keys  
12345678

Number 
keys  
87654321
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GGGG Display the number of the Group
you want to register (1 to 5). 

Enter the group number with the
number keys, or search using 0 or
1. 

Note
❒ If you make a mistake, press the

{{{{Cancel}}}} key and try again.
❒ If a group has already been

stored, the contents are dis-
played. Press 0 or 1 to select a
group number that is not pro-
grammed, and then press the
{{{{OK}}}} key. 

❒ If a group is programmed, but
no name is specified, the group
number only is displayed on the
lower line of the display. 

HHHH Specify the destination using one
of the following three methods: 

Enter the fax number with the
number keys. 

Press a Quick Dial key. 

Press the {{{{Speed Dial}}}} key, and
then enter a Speed Dial number. 

IIII Press the {{{{OK}}}} key. 

The destination is programmed. 

JJJJ Press the 0000 or 1111 to select " Add "
or " Exit ". 

KKKK Press the {{{{OK}}}} key. 

If you selected " Exit ", go to step M. 

LLLL Repeat step GGGG to KKKK for all the des-
tinations you want to register in
the Group. 

MMMM Enter the Group name. 

Note
❒ If the Group name is already

registered, it is shown on the
display. If you wish to change
the Group name, press the
{{{{Clear/Stop}}}} key, and then enter
another name.

NNNN Press the {{{{OK}}}} key to register the
Group. 

OOOO Press 0000 or 1111 to select "Yes" or
"No" to be programmed in the
Quick Dial key. Then press the
{{{{OK}}}} key.

If you selected " No ", go to step R. 

PPPP Press the Quick Dial key you
want to register in the Group. 

QQQQ Press the {{{{OK}}}} key. 
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RRRR Press the {{{{User Tools}}}} key to re-
turn to standby display. 

Editing

You can edit the group name or add
destinations for programmed groups.
To edit a destination: 
• For destinations programmed in

Quick Dial or Speed Dial, edit the
contents of the programmed Quick
Dial or Speed Dial. 

• For destinations programmed
with the number keys, delete the
destination you want to edit from
the group, and then program the
new destination. 

Editing a Group Name

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

Confirm that " 1. Program / Delete
" is displayed. 

DDDD Press the {{{{OK}}}} key. 

EEEE Press 0000 or 1111 until " 5. Prog.
Group Dial " is displayed. 

FFFF Press the {{{{OK}}}} key. 

GGGG Display the number of the group
you want to edit (1 to 5). 

Enter the group number with the
number keys, or search using 0 or
1. 

HHHH Press the {{{{OK}}}} key. 

IIII Press 0000 or 1111 to select "No". 

JJJJ Press the {{{{OK}}}} key. 
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KKKK Press the {{{{Clear/Stop}}}} key, and
then enter the new name. 

Note
❒ If you want to delete a character

o f  t h e  n am e ,  p r e s s  t he
{{{{Clear/Stop}}}} key. 

❒ If you press the {{{{Cancel}}}} key,
the display will return to that
shown for step E. 

LLLL Press the {{{{OK}}}} key. 

The name is changed. 

MMMM Press 0000 or 1111 to select "Yes" if the
group was programmed in a
Quick Dial, or select "No" if it was
not. 

NNNN Press the {{{{OK}}}} key. 

If you selected "No", go to step P .

Note
❒ If you want to edit a pro-

grammed Quick Dial key, press
the Quick Dial key, and then the
{{{{OK}}}} key. 

OOOO Press the {{{{OK}}}} key.

If you want to program another
group name, go to step F. 

PPPP Press the {{{{User Tools}}}} key to re-
turn to standby display. 

Adding a Fax Number to a Group

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

Confirm that " 1. Program / Delete
" is displayed. 

DDDD Press the {{{{OK}}}} key. 

EEEE Press 0000 or 1111 until " 5. Prog.
Group Dial " is displayed. 

FFFF Press the {{{{OK}}}} key. 
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GGGG Display the number of the group
to which you want to add a num-
ber (1 to 5). 

Enter the group number with the
number keys, or search using 0 or
1. 

HHHH Press the {{{{OK}}}} key. 

IIII Press 0000 or 1111 to select "Yes". 

JJJJ Press the {{{{OK}}}} key

Note
❒ If you have finished adding des-

tinations, select "Exit" and go to
step Q.

KKKK Press 0000 or 1111 to select "Add". 

LLLL Press the {{{{OK}}}} key.

MMMM Specify the destination using one
of the following three methods:

Enter the fax number with the
number keys. 

Press a Quick Dial key. 

Press the {{{{Speed Dial}}}} key and en-
ter a Speed Dial number. 

Note
❒ If you specify a Quick Dial or

Speed Dial  that is  not pro-
grammed, " This key is Not
Programmed " is displayed. Re-
specify the destination. 

NNNN Press the {{{{OK}}}} key. 
The destination is added. 

OOOO To add another destination, re-
peat steps KKKK to NNNN. 

PPPP If you have finished adding desti-
nations, select "Exit".

QQQQ Press the {{{{OK}}}} key. 

Note
❒ If you want to change the group

name, press the {{{{Clear/Stop}}}} key
and enter the new name.
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RRRR Press the {{{{OK}}}} key. 

SSSS Press 0000 or 1111 to select "Yes" if the
group was programmed in a
Quick Dial, or select "No" if it was
not. 

TTTT Press the {{{{OK}}}} key. 

If you selected "No", go to step V. 

Note
❒ If you want to edit a pro-

grammed Quick Dial, press the
Quick Dial key, and then the
{{{{OK}}}} key. 

UUUU Press the {{{{OK}}}} key. 

If you want to add another destina-
tion to the group, go to step F. 

VVVV Press the {{{{User Tools}}}} key to re-
turn to standby display. 

Deleting

The following procedure describes
how to delete a destination from a
group. 
• When you delete a destination

from a group programmed in a
Quick Dial or a Speed Dial, the
contents of the Quick Dial or Speed
Dial are not deleted. 

To delete a destination from a group

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

Confirm that " 1. Program / Delete
" is displayed. 

DDDD Press the {{{{OK}}}} key. 
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EEEE Press 0000 or 1111 until " 5. Prog.
Group Dial " is displayed. 

FFFF Press the {{{{OK}}}} key. 

GGGG Display the group number for the
destination you want to delete (1
to 5). 

Enter the group number with the
number keys, or search using 0 or
1. 

HHHH Press the {{{{OK}}}} key. 

IIII Press 0000 or 1111 to select "Yes". 

JJJJ  Press the {{{{OK}}}} key.

KKKK Press 0000 or 1111 to select "Delete". 

LLLL Press the {{{{OK}}}} key.

MMMM Press 0000 or 1111 to display the desti-
nation you want to delete. 

NNNN  Press the {{{{OK}}}} key. 

To delete another destination, re-
peat steps L to N.

OOOO If you are finished deleting desti-
nations, press 0000 or 1111 to select
"Exit". 

PPPP Press the {{{{OK}}}} key.

QQQQ Press the {{{{OK}}}} key. 

RRRR Press 0000 or 1111 to select "Yes" if the
group was programmed in a
Quick Dial, or select "No" if it was
not. 
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SSSS Press the {{{{OK}}}} key. 

If you selected "No", go to step U. 

Note
❒ If you want to edit a pro-

grammed Quick Dial key, press
the Quick Dial key and then the
{{{{OK}}}} key. 

TTTT Press the {{{{OK}}}} key. 

If you want to delete another desti-
nation from the group, go to step
F. 

UUUU Press the {{{{User Tools}}}} key to re-
turn to standby display. 

To delete an entire group

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

Confirm that " 1. Program / Delete
" is displayed. 

DDDD Press the {{{{OK}}}} key. 

EEEE Press 0000 or 1111 until " 6. Del. Group
Dial " is displayed. 

FFFF Press the {{{{OK}}}} key. 

GGGG Display the number of the group
you want to delete (1 to 5). 

Enter the group number with the
number keys, or search using 0 or
1. 

HHHH Press the {{{{OK}}}} key. 

The entire Group is deleted. 

IIII Press the {{{{User Tools}}}} key to re-
turn to standby display. 
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----To change and delete Quick 
Dials programmed as groups:

To store an entire group under a dif-
ferent Quick Dial key, or to delete the
group from the Quick Dial key alto-
gether, perform the following proce-
dure:
A Press the {{{{User Tools}}}} key. 
B Press 0 or 1 until " 2. Fax Fea-

tures " is displayed.
C Press the {{{{OK}}}} key. 
D Press the {{{{OK}}}} key, and then press

0 or 1 to display "5. Prog. Group
Dial". 

E Press the {{{{OK}}}} key. 
F Enter the group number (1 to 5). 
G Press the {{{{OK}}}} key.
H Press 0 or 1 to select "No", and

then press the {{{{OK}}}} key.
I Press the {{{{OK}}}} key. 
J If you want to change the Quick

Dial key, press "Yes", and if you
want to delete the Quick Dial key,
press "No". 

K Press the {{{{OK}}}} key. 
If you selected "No" in step J, the
Quick Dial key is deleted. Go to
step N. 

L If you want to change the Quick
Dial key, press the new Quick Dial
key. 

M Press the {{{{OK}}}} key. 
The Quick Dial key is changed. 

N Press the {{{{User Tools}}}} key to return
to standby display. 
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Entering Characters

This section describes how to enter characters. 

Available Characters

• Letters:
ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvwxyz

• Symbols:
– _ (space) . , ( ) / @ & $ ! ' # p % + : ; < = > ? ^ [ ] ` { | } ∼

• Numbers:
0123456789

Keys

1. Quick Dial 01 to 09 or Quick Dial
16 to 24 (A to Z)
Press these keys to enter upper and lower
case letters.
Every time you press the same Quick
Dial key, one of the three letters printed
on a Quick Dial key is displayed. For ex-
ample, when you press Quick Dial 01, the
letter displayed changes in the order A →
B → C → A as you press the key. Press 1
to move the cursor and enter the next
character. 

2. {{{{Shift}}}} key (Quick Dial 13 or 28)
Use to switch between upper and lower
case.

3. {{{{Space}}}} key (Quick Dial 14 or 29)
Press to enter a space.

4. {{{{Symbols}}}} key (Quick Dial 15 or
30)
Press to enter symbols.

5. 0000 or 1111
Use to move the cursor left or right and to
select a symbol.

6. Number keys
Use to enter numbers.
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7. {{{{Clear/Stop}}}} key
Deletes the character at the cursor posi-
tion. If the cursor is placed to the right of
the last character at the right end of a line,
that character will be deleted.

How to Enter Characters

The following procedure describes
how to enter characters.

Note
❒  When you enter a character, it is

shown at the position of the cursor.
If there is a character at the cursor
position, the entered character is
shown before the character.

AAAA Enter letters, symbols or num-
bers.

Characters are entered and the cur-
sor moves.
• For letters, press the Quick Dial

keys (01 to 09 or 16 to 24). When
the desired letter is displayed,
press 1.

• For symbols, press the {{{{Sym-
bols}}}} key and 0 or 1 to select
the symbol, and then press the
{{{{OK}}}} key.

• For numbers, press the number
key.

Note
❒ When you make a mistake,

press the {{{{Clear/Stop}}}} key.
❒ When you want to insert a char-

acter, move the cursor to the
character right of the position
you want to enter the character.
Now the inserted character is
shown left of the cursor posi-
tion.

BBBB Press the {{{{OK}}}} key.

----Wild Cards
When you register other parties' Own
Name or Own Fax Numbers for multi-
ple destinations, you can register a se-
quence of characters common to these
identifications as a wild card instead of
registering every identification.
If a destination has an Own Name or
Own Fax Number containing a wild
card, the machine determines that the
destination matches the registered
destination. 

❖❖❖❖ Not using a wild card

❖❖❖❖ Using a wild card

Note
❒ You can register up to 30 wild

cards.
❒ Compare identifications by ne-

glecting spaces.
❒ You can use wild cards for the fol-

lowing functions:
• Memory Lock 

See p.72 “Memory Lock”, <Ad-
vanced Features> .

• Forwarding
See p.76 “Forwarding”, <Ad-
vanced Features> .

Destination to be 
registered 
(Own Name)

Number of regis-
tered identifications 

NEW YORK 
BRANCH 

HONG KONG 
BRANCH

SYDNEY BRANCH 

3

Destination to be 
registered 
(Own Name)

Number of regis-
tered identifications 

BRANCH 1
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 Loading Paper in the Main Paper Tray

If there is no paper in the main paper
tray, the B indicator on the control
panel lights.
Use the following procedure to load
the paper.

Important
❒ When loading paper, be careful

not to pinch your fingers inside the
machine.

❒ Before loading paper, make sure
that the machine is not outputting
a copy or received document.

Note
❒ Regarding paper types and sizes

that can be used, see p.128 “Pa-
per”, <Advanced Features> .

❒ If you want to change the paper
size, see p.62 “Changing the Paper
Size Setting”, <Advanced Features>
.

AAAA Make sure that the main paper
tray is not being used.

BBBB Pull out the main paper tray until
it stops.

CCCC Push the metal plate down, and
then square the paper and load it
in the tray.

Important
❒ Do not stack paper over the lim-

it mark.

❒ If paper is left in the main paper
tray and you add paper, a mis-
feed might occur.

Note
❒ Shuffle the paper before setting

it in the tray.

DDDD Push the main paper tray in until
it stops.
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Adjusting Volume

You can change the volume of the fol-
lowing sounds the machine makes.

❖❖❖❖ On Hook
Sounds when you press the {{{{On
Hook Dial}}}} key.

❖❖❖❖ Transmission
Sounds when the machine send a
message.

❖❖❖❖ Reception
Sounds when the machine receives
a message.

❖❖❖❖ Dialing
After pressing the {{{{Start}}}} key, this
sound is made until the line con-
nects to the destination.

❖❖❖❖ Key Tone
Sounds when keys on the Control
panel are pressed.

❖❖❖❖ Alarm
The sound to signal something go-
ing amiss.

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

Confirm that " 1. Program / Delete
" is displayed. 

DDDD Press 0000 or 1111 until " 3. Setup " is
displayed. 

EEEE Press the {{{{OK}}}} key. 

Confirm that " 1. Monitor Volume
" is displayed.

FFFF Press the {{{{OK}}}} key. 

GGGG Press 0000 or 1111 to select the item
you want to adjust, and then press
the {{{{OK}}}} key. 
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HHHH Press 0000 or 1111 to adjust the vol-
ume. 

IIII Press the {{{{OK}}}} key. 

The volume is adjusted. 

If you want to adjust another item,
repeat steps G to I. 

JJJJ Press the {{{{User Tools}}}} key to re-
turn to standby display. 
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Clearing Original Jams 

If an original is jammed, the hindica-
tor on the Control Panel blinks and “
Clear Misfed Original (S) “ is dis-
played.
Perform the following procedure to
clear the jammed original.

AAAA Open the ADF cover.

BBBB While pushing the release button,
lift the ADF unit.

CCCC Remove the original.

DDDD Close the ADF unit and ADF cov-
er making sure it clicks firmly
into place.
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Clearing a Copy, Fax, or Print Jam

If a copy, fax, or printed paper is
jammed, the hindicator on the Con-
trol Panel blinks and “ Clear Misfed
Paper “ is displayed.
Perform the following procedure to
clear the jammed paper.
The inside of the machine could be
very hot. Do not touch the parts with
a label indicating the “hot surface”.
Otherwise an injury might occur.

Important
❒ The fusing unit and surrounding

area inside the machine becomes
hot during printing. To avoid inju-
ry when removing paper jams, do
not touch any parts other than
those specified in this manual.

Note
❒ If paper jams occur in the optional

paper tray unit, see p.102 “Clear-
ing a Copy, Fax or Print Jam”, <Ad-
vanced Features> .

Inside the Machine

AAAA Open the right cover.

BBBB Open the blue cover.

CCCC Pull out the jammed paper.

When paper is caught in the 
lower unit

A Pull out the jammed paper. 

DDDD Close the right cover making sure
it clicks firmly into place.

StellaF1EN-3_FM.book  Page 73  Monday, November 12, 2001  11:38 AM



Troubleshooting

74

4

Error Messages

The following messages may appear while you are operating or programming
the machine.

Message Problem/Solution

No Files Exist No polling reception operations have been programmed.

There are no documents in memory waiting for transmis-
sion.

Incorrect file number. Check the file number and try again.

Cannot Combine : (currently se-
lected function)

Appears when you attempt to select a function that cannot 
be used in combination with another currently selected 
function. 

This Key is in Use as a Group Dial This Quick Dial Key has a Group stored in it.

This Key is in Use as a Program This Quick Dial Key has a Keystroke Program stored in it.

This Key is in Use as a Quick Dial This Quick Dial Key has a Quick Dial stored in it.

This Key is Not Programmed Either:

• This Quick Dial Key does not contain a number.

• This Quick Dial Key does not contain a Keystroke Pro-
gram.

This Speed Dial No. is Not Pro-
grammed

This Speed Dial number does not contain a number.

This Dest. is Already Selected Either:

• This number is already included in this Group.

• The same destination was specified more than once.

Insert Pause “-” After Area Code You must add a pause after your area code when you input 
your fax terminal's own telephone number.

Replace Toner The toner cassette is empty. Install a new cassette.

Clear Misfed Original(s) A document is jammed in the feeder.

Clear Misfed Paper Paper is jammed in the printer.

Close Front/Right Cover A cover is not closed properly. Check that all covers are 
closed.

Machine is in Use. Please Wait Machine cannot print a list/file, because the plotter is not 
ready.

Call Service Machine is out of order. Contact your service representa-
tive.

Check Paper Size. Press OK to 
Correct.

The size of the installed paper does not match the currently 
selected paper size.

Press the {{{{OK}}}} key, and then set the paper size or install the 
appropriate paper.

StellaF1EN-3_FM.book  Page 74  Monday, November 12, 2001  11:38 AM



Error Messages

75

4

This Dial is in Use. Cannot Delete. 
This Dial is in Use.  Cannot 
Change.

This Quick Dial is being used (such as for a Send Later 
Transmission).

Some Page(s) are Blank An almost entirely blank document was scanned. Check 
your document.

Reset Toner Correctly The toner cassette is not set correctly.

Toner is Almost Empty The toner cassette is nearly empty.

Copy Mode Locked Copy mode is disabled. Enable it with the User Parameters.

Change ADF Maintenance Kit Replace the ADF Maintenance Kit.

Scanner Needs Cleaning Wipe the exposure glass and the white strip.

Message Problem/Solution
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When the Receive File Indicator is Lit

If the Receive File indicator is lit, a message has been received but could not be
printed for some reason. The message was stored in memory (Substitute Recep-
tion). When you solve the problem, the message will be automatically printed
out. The table below lists some problems that could have caused Substitute Re-
ception to take place and their solutions.

Why Substitute Reception 
Occurred 

Indication/Status Solution

Paper has run out B is lit red. Load paper. 

See p.69 “Loading Paper in the Main 
Paper Tray”.

Toner is empty D is lit red. Replace the toner cassette.

See Cp.117 “Replacing the Toner 
Cassette”, <Advanced Features> .

Note
❒ Even if there is no toner left, you 

can still send fax messages.

Paper is jammed h is lit red. Remove the jammed paper.

p.73 “Clearing a Copy, Fax, or Print 
Jam”

Cover is open h is lit red. Close the cover.
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4

Solving Problems

This table lists some common problems and their solutions. 

Problem Required Action

Printed or sent image contains spots. The Document Feeder (ADF) or scanner is dirty. Clean 
them. 

Make sure that ink or correction fluid is dry before set-
ting the original.

Reference
See p.112 “Cleaning the Scanner”, <Advanced Fea-
tures> .

Received image is too light. Request the sender to increase the image density. 

When using moist, rough or processed paper, the 
printed image may be hard to see. Only use recom-
mended paper. 

Reference
See p.127 “Originals”, <Advanced Features> .

When D appears on the display, toner is beginning to 
run out. Replace the toner cassette soon. 

Reference
See p.117 “Replacing the Toner Cassette”, <Ad-
vanced Features> . 

Message appears blank at the other 
end. 

The original was set upside down. Set it properly.

Reference
See p.23 “Setting Originals”. 

You want to cancel a Memory Trans-
mission. 

If the original is being stored, press the {{{{Clear/Stop}}}} key. 

Reference
See p.27 “Canceling a Memory Transmission”. 

If the original is being sent, use "Cancel TX/RX" in the 
Job Information menu. 

Reference
See p.13 “Canceling Transmission or Reception”, 
<Advanced Features> .

You want to cancel an Immediate 
Transmission. 

Press the {{{{Clear/Stop}}}} key. 

Reference
See p.31 “Canceling an Immediate Transmission”. 

You cannot add any destinations to a 
Group, even though the maximum 
number of destinations has not been 
reached.

69 destinations have been programmed with the num-
ber keys. Program more numbers with Quick Dials or 
Speed Dials. 

Reference
See p.57 “Groups” 
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Add Toner indicator,   15
ADF Cover,   13
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Dialing,   70
Key Tone,   70
On Hook,   70
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Advanced Features,   11
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Basic Features (this manual),   11
Bypass Tray,   13

C

Cancel key,   15
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Entering,   67
Keys,   67

Clear Modes key,   16
Clear/Stop key,   16
Components,   13
Control Panel,   13, 15
Copy key,   16
CSI→Own Fax Number,   41

D

Deleting
Groups,   63
Quick Dial,   49
Speed Dial,   55

Detail,   32
Dialing,   34

Entering Numbers Directly,   34
Using Groups,   37
Using Quick Dials,   35
Using Speed Dials,   36

Dial label,   50
Display,   18
Document Feeder (ADF),   13, 24

E

Editing
Fax Header,   44
Groups,   60
Own Fax Number,   44
Own Name,   44
Quick Dial,   48
Speed Dial,   54

Energy Saver/Clear Modes key,   16
Energy Saver key,   16
Entering Characters,   67
Error Messages,   74
External Telephone Connector,   14

F

Fax Header,   41
Editing,   44
Registering,   42

Faxing,   21
Fine,   32
Front Cover,   13
Front View,   13

G

G3 Line Connector,   14
Getting Started,   13
Group Name,   60
Groups,   37, 57

Deleting,   63
Dialing,   37
Editing,   60
Registering,   57

H

Halftone,   33
Halftone key,   16
Handset (Option),   14
Help key,   16
How to Read this Manual,   10

I

Immediate Transmission,   21, 29
Canceling,   31
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Job Information key,   15

L

LCD display,   15
Loading Paper,   69
Load Paper Indicator,   15
Lower Right Cover,   13
Low-power Mode,   7

M

Main Paper Tray,   69
Manual Receive,   39
Manuals for This Machine,   11
Memory Card Slot,   14
Memory Trans. key,   16
Memory Transmission,   21, 25

Canceling,   27

N

NOTICE,   1
Number keys,   16

Dialing,   34

O

OK key,   15
On Hook Dial key,   16
Original guide,   14
Original Output Tray,   14
Original Tray,   14
Original Type,   32, 33
Output Tray,   13
Output tray guide,   14
Own Fax Number,   41

Editing,   44
Registering,   42

Own Name,   41
Editing,   44
Registering,   42

P

Paper Tray Unit,   13
Pause,   35
Pause/Redial key,   15
Power Switch,   14

Q

Quick Dial,   46
Deleting,   49
Dialing,   35
Dial label,   50
Editing,   48
Registering,   46

Quick Dial keys,   16

R

Receive File Indicator,   15, 76
Reception Mode

Selecting,   39
Reception Modes

Auto Receive,   39
Auto Select,   39
Manual Receive,   39

Registering
Fax Header,   41
Groups,   57
Own Fax Number,   41
Own Name,   41
Quick Dial,   46
Speed Dial,   52

Release Button,   13
Resolution,   32
Resolution key,   16
Right Cover,   14
RTI→Own Name,   41

S

Scan Settings,   32
Setting Originals,   23
Side View,   14
Solving Problems,   77
Speed Dial,   52, 54, 55

Deleting,   55
Dialing,   36
Editing,   54
Registering,   52

Speed Dial key,   15
Standard,   32
Starting the Machine,   17
Start key,   16
Status Indicators

Alarm,   16
Communicating,   16

Substitute Reception,   76
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T

Tone,   35
Transmission Modes,   21
Trans. Option key,   15
Troubleshooting,   69

Error Messages,   74
TTI→Fax Header,   41

U

User Function keys,   15
User Tools key,   16

V

Ventilation hole,   14
Volume,   70

W

Wild Cards,   68
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Paper type: Wood Free 80g/m2, Paper Thickness=100 µm // Pages in book=152 // Print scale=81%
Gap (when printed at 81% scale)  = Pages in book  ×  Paper thickness  /  2  = 7.600000 mm

In accordance with IEC 60417, this machine uses the following symbols for the main power switch: 

aaaa means POWER ON.

bbbb means POWER OFF.

Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information in the Basic Features manual before using this machine. It contains
important information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Warning: 

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Power Source:

115V, 60Hz

Please be sure to connect the power cord to a power source as above. For details about power source,
see Chapter 10, “Connecting the Power and Switching On” in the Advanced Features manual.

Copyright © 2001



i

TABLE OF CONTENTS
How to Read this Manual ........................................................................... 1

Symbols ......................................................................................................... 1

Manuals for This Machine.......................................................................... 2
Advanced Features (this manual) .................................................................. 2
Basic Features ............................................................................................... 2

1.Transmission Options

Sending at a Specific Time (Send Later) .................................................. 3

Fax Header Print ......................................................................................... 5

Sending Confidential Messages ............................................................... 6

Label Insertion............................................................................................ 8

Calling to Request a Message (Polling Reception) ................................. 9
File Reserve Report (Polling RX) ................................................................. 10
Communication Result Report (Polling RX) ................................................. 11

2.Job Information

Canceling Transmission or Reception................................................... 13

Printing a List of Files in Memory (Print File List)................................. 14

Printing a Stored Message (Print TX File) .............................................. 15

Printing a Confidential Fax Message...................................................... 16

Printing a Memory-locked Message ...................................................... 17

Printing the Journal.................................................................................. 18
Report Formats ............................................................................................ 19

3.Other Transmission Features

Handy Dialing Functions ......................................................................... 21
Chain Dial..................................................................................................... 21
Telephone Directory..................................................................................... 22
Redial ........................................................................................................... 22

On Hook Dial ............................................................................................. 23

Manual Dial................................................................................................ 24

Transmission Features ............................................................................ 25
SEP Code .................................................................................................... 25
SUB Code .................................................................................................... 26
Closed Network Transmission ..................................................................... 27
Blank Sheet Detect ...................................................................................... 27
Scanner Cleaning Message ......................................................................... 28

StellaF1EN-3_FM.book  Page i  Monday, November 12, 2001  11:40 AM



ii

More Transmission Functions ................................................................ 29
If Memory Runs Out While Storing an Original ............................................ 29
Checking the Transmission Result............................................................... 29
Broadcasting Sequence ............................................................................... 30
Sending a Fax Message Immediately .......................................................... 30
Broadcasting : Checking Progress............................................................... 30
Automatic Redial .......................................................................................... 30
Batch Transmission...................................................................................... 30
Dual Access ................................................................................................. 31
ECM (Error Correction Mode) ...................................................................... 31
Parallel Memory Transmission..................................................................... 31

Printed Reports......................................................................................... 32
File Reserve Report (Switch 03, Bit 2) ......................................................... 32
Communication Result Report (Switch 03, Bit 0) ......................................... 32
Communication Failure Report (Switch 03, Bit 0) ........................................ 32
Transmission Result Report (Immediate Transmission) (Switch 03, Bit 5) ... 33
Confidential File Report (Switch 04, Bit 0) ................................................... 33

4.Reception Features

General ...................................................................................................... 35
Immediate Reception ................................................................................... 35
Memory Reception ....................................................................................... 35
Printing Documents that have been Received into Memory (Substitute 

Reception).................................................................................................. 36
Screening Out Messages from Anonymous Senders................................ 36

Receiving Messages in Telephone Mode .................................................... 37

Printing Options ....................................................................................... 38
Center Mark ................................................................................................. 38
Checkered Mark........................................................................................... 38
TSI Print ....................................................................................................... 38
Reception Time ............................................................................................ 39
Page Separation and Length Reduction ..................................................... 39
When There is No Paper of the Correct Size............................................... 40

5.Copying

Copying ..................................................................................................... 43
Copying on special paper............................................................................. 44

StellaF1EN-3_FM.book  Page ii  Monday, November 12, 2001  11:40 AM



iii

6.Facsimile User Tools

Counters ................................................................................................... 45

Programs................................................................................................... 46
Storing a Program ........................................................................................ 46
Using a Program .......................................................................................... 47
Changing a Program ................................................................................... 47
Editing the Program Name........................................................................... 47
Deleting a Program ..................................................................................... 48

Storing an Often Used Document (Auto Document)............................. 49
Storing an Auto Document .......................................................................... 49
Sending an Auto Document as an Attachment ............................................ 50
Changing an Auto Document ...................................................................... 51
Editing an Auto Document Name................................................................. 51
Deleting an Auto Document ......................................................................... 52

User Function Keys.................................................................................. 53
Functions You Can Assign to User Function Keys ...................................... 53
Making a User Function Key Assignment .................................................... 54
Using a User Function Key .......................................................................... 54
Deleting a User Function Key ...................................................................... 55

Printing Reports/Lists .............................................................................. 56

Adjusting the Display Contrast ............................................................... 59

Setting the Date and Time ...................................................................... 60

Setting the Auto Ring Time .................................................................... 61

Changing the Paper Size Setting ............................................................ 62

Changing the Paper Type for Bypass Tray ............................................ 63

Setting the Fax Reset Timer .................................................................... 64

On Hook Timeout...................................................................................... 65

Selecting the Display Language ............................................................. 66

7.Key Operator Settings

Function List ............................................................................................. 67

Using Key Operator Settings................................................................... 69
Resetting the ADF Counter .......................................................................... 69
Authorized Reception................................................................................... 70
Memory Lock................................................................................................ 72
Specified Tray .............................................................................................. 74
Forwarding ................................................................................................... 76

Switching Forwarding On/Off..................................................................... 77
Registering Forwarding Stations................................................................ 78
Editing a Forwarding Station...................................................................... 79
Editing a Specified Sender ........................................................................ 80
Deleting a Forwarding Station ................................................................... 80
Deleting a Specified Sender ..................................................................... 81
Printing the Specified Sender list............................................................... 82

StellaF1EN-3_FM.book  Page iii  Monday, November 12, 2001  11:40 AM



iv

Energy Save Timer ...................................................................................... 83
User Parameters .......................................................................................... 85

Changing the User Parameters ................................................................. 89
Printing the User Parameter List................................................................ 90

Personal Codes............................................................................................ 91
Registering and Editing.............................................................................. 91
Deleting...................................................................................................... 92
Printing the Personal Code List ................................................................. 93
Restricted Access ...................................................................................... 94

ID Code ........................................................................................................ 94
Registering ................................................................................................ 95

Line Type ..................................................................................................... 96
Select Line ................................................................................................... 96
PSTN Access Number ................................................................................. 97
Memory File Transfer ................................................................................... 98
Margin Adjust ............................................................................................... 99
RDS (Remote Diagnostic System)............................................................. 100

8.Solving Operation Problems

Printing the Help List ............................................................................. 101

Clearing a Copy, Fax or Print Jam........................................................ 102
Clearing a Copy, Fax, or Print Jam in the Optional Paper Tray Unit.......... 102

Reading Reports..................................................................................... 103
Error Report .............................................................................................. 103
Power Failure Report ................................................................................. 103

9.Maintaining Your Machine

Loading paper in the Optional Paper Tray Unit ................................... 105

Loading paper in the Bypass Tray........................................................ 106

Changing the Paper Size in the Main Paper Tray ................................ 108

Changing the Paper Size in the Optional Paper Tray Unit.................. 110

Cleaning the Scanner............................................................................. 112

Replacing the ADF Maintenance Kit ..................................................... 113

Replacing the Photo Conductor Unit (PCU)......................................... 114

Replacing the Toner Cassette............................................................... 117

Toner Cassette Storage ......................................................................... 119

StellaF1EN-3_FM.book  Page iv  Monday, November 12, 2001  11:40 AM



v

10.Installation

Before Installation .................................................................................. 121

Machine Environment ............................................................................ 122
Location...................................................................................................... 122

Connecting the Power and Switching On ............................................ 123

Connecting to a Telephone Line and an External Telephone ............ 124
Connecting to a Telephone Line ................................................................ 124
Connecting an External Telephone............................................................ 124

11.Appendix

Specifications ......................................................................................... 125
Base Machine ............................................................................................ 125
Available Options ....................................................................................... 126
Originals ..................................................................................................... 127

Sizes and weights of Recommended Originals ....................................... 127
Originals unsuitable for the Document Feeder (ADF) ................................ 127
Paper.......................................................................................................... 128

Recommended Paper Sizes and Types .................................................. 128
Non-recommended Paper ....................................................................... 129
Paper Storage.......................................................................................... 130

Energy Saving............................................................................................ 130
Introduction .............................................................................................. 130
Entering Energy Saving mode ................................................................. 131
Exiting Energy Saving mode.................................................................... 131
Selecting the Energy Saving mode type.................................................. 132
Reception in Energy Saving mode .......................................................... 132

Maximum Values .................................................................................... 133

Advanced Transmission Features ........................................................ 134

Job Information ...................................................................................... 135

User Tools............................................................................................... 136

Key Operator Tools ................................................................................ 138

INDEX....................................................................................................... 140

StellaF1EN-3_FM.book  Page v  Monday, November 12, 2001  11:40 AM



vi

StellaF1EN-3_FM.book  Page vi  Monday, November 12, 2001  11:40 AM



1

How to Read this Manual

Symbols

The following set of symbols is used in this manual.

R WARNING:
This symbol indicates a potentially hazardous situation that might result in
death or serious injury when you misuse the machine without following the in-
structions under this symbol. Be sure to read the instructions, all of which are de-
scribed in the Safety Information section.

R CAUTION:
This symbol indicates a potentially hazardous situation that might result in mi-
nor or moderate injury or property damage that does not involve personal injury
when you misuse the machine without following the instructions under this
symbol. Be sure to read the instructions, all of which are described in the Safety
Information section.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates information or preparations required prior to operating.

Note
This symbol indicates precautions for operation, or actions to take after abnor-
mal operation.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

{ }
Keys built into the operation panel of the machine.
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Manuals for This Machine

Two Facsimile Reference manuals are provided, the Basic Features manual and
the Advanced Features manual. Please refer to the manual that suits your needs.

Advanced Features (this manual)

The Advanced Features manual describes more advanced functions and also ex-
plains settings for key operators.

Basic Features

The Basic Features manual explains the most frequently used fax functions and
operations. 

❖❖❖❖ Chapter 1 Getting Started
Names and describes the parts of the control panel and machine.

❖❖❖❖ Chapter 2 Faxing
Explains basic transmission. You can also learn about other types of transmis-
sions.

❖❖❖❖ Chapter 3 Registering
Explains how to make initial settings, such as the Own Name and Own Fax
Number settings. Also explains the Quick Dial, Speed Dial and Group keys.
These keys allow you to store numbers and save time when dialing. This
chapter also explains how to enter letters and symbols.

❖❖❖❖ Chapter 4 Troubleshooting
Explains clearing original jams, loading paper, changing the volume of audi-
ble signals by the machine, and how to interpret error messages. When the
display or indicator show unusual information, check the list and take appro-
priate action.
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1. Transmission Options

Sending at a Specific Time (Send Later)

Using the Send Later function, you
can delay transmission of your fax
message until a specified time. This
allows you to take advantage of off-
peak telephone line charges without
having to be by the machine at the
time of transmission.

Note
❒ You can not specify a time more

than 24 hours later.

AAAA Make sure that the machine is in
Facsimile mode and the standby
display is shown.

BBBB Place your original and select any
scan settings you require. 

CCCC Press the {{{{Trans. Option}}}} key. 

DDDD Confirm that " 1. Send Later " is
displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press 0000 or 1111 to select "On". 

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 to select “AM” or
“PM”.

IIII Press the {{{{OK}}}} key.

JJJJ Enter the time that you want to
send the fax message with the
number key.

Enter the hour setting (1 to 12).
Then press 0 or 1. 
Then enter a 2-digit number for the
minute setting (00 to 59).

Note
❒ If you make a mistake, press the

{{{{Clear/Stop}}}} key and try again.
❒ If the current time shown on the

display is not correct, change it.
See p.60 “Setting the Date and
Time”.

KKKK Press the {{{{OK}}}} key. 

The specified time is set. 

Transmitter

Send Later
at 21:00 (9:00PM)

Receiver

ND1X01E4
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1

LLLL Specify the destination.

If you want to specify another des-
tination, press the {{{{OK}}}} key and
repeat step L. 

MMMM Press the {{{{Start}}}} key. 

Note
❒ You can cancel a message trans-

mission set for Send Later. See
p.13 “Canceling Transmission
or Reception”.
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Fax Header Print

Normally,  the Fax Header pro-
grammed in your machine is printed
at the top of each of the pages you
transmit when they are received at
the other end. The top of the image
will be overprinted if there is no mar-
gin at the top of the transmitted page.

Note
❒ You can switch this function off

with the User Parameters. See p.85
“User Parameters” (Switch06,
Bit0).

AAAA Make sure that the machine is in
Facsimile mode and the standby
display is shown.

BBBB Place your original, and then se-
lect any scan settings you require. 

CCCC Press the {{{{Trans. Option}}}} key.

The Transmission Option menu
appears.

DDDD Press 0000 or 1111 until “2. Fax Header
Print” is displayed.

EEEE Press the {{{{OK}}}} key.

FFFF Press 0000 or 1111 to select "On".

GGGG Press the {{{{OK}}}} key.

HHHH Press the {{{{Trans. Option}}}} key. 

IIII Specify the destination.
If you want to specify another des-
tination, press the {{{{OK}}}} key and
repeat step I.

JJJJ Press the {{{{Start}}}} key.
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Sending Confidential Messages

This feature is called Confidential
Transmission. Use this feature if you
do not want your message to be
picked up casually by anybody at the
other end. The message will be stored
in the memory at the other end. It will
not be printed until the Confidential
ID is entered.
There are two types of Confidential
Transmission.

❖❖❖❖ Normal Confidential Transmission
The other party can print the mes-
sage by entering the ID that was
previously stored in the other par-
ty's terminal using the Confiden-
tial ID feature.

❖❖❖❖ Confidential ID Override
If you wish to send a confidential
message to a particular person at
the other end, you can specify the
Confidential ID that person has to
enter to see that message. Any-
body entering the machine's Confi-
dential ID will not be able to see
the message. Before you send the
message, do not forget to tell the
intended receiver what code must
be entered to print the message.

To set up a confidential transmission,
do the following:

Limitation
❒ The machine at the other end must

have memory space available and
it must have the Confidential Re-
ception feature.

❒ This is a proprietary function, and
as such it only functions with ma-
chines produced by the same man-
ufacturer that have this function.

Note
❒ A Confidential ID can be any 4-

digit number except 0000.
❒ Before sending a confidential mes-

sage, it is recommended that you
call the receiver and advise them
that you are sending a fax message
in this manner.

AAAA Place your original and select any
scan settings you require. 

BBBB Press the {{{{Trans. Option}}}} key. 

CCCC Press 0000 or 1111 until "3. Confiden-
tial TX" is displayed. 

DDDD Press the {{{{OK}}}} key. 

EEEE Press 0000 or 1111 to select "On". 

FFFF Press the {{{{OK}}}} key. 

GGGG Select the type of Confidential
Transmission.

Normal Confidential Transmission:

A Press 0000 or 1111 to select "De-
fault". 

B Press the {{{{OK}}}} key. 

Normal Confidential Transmis-
sion is set. 

C Specify the other party's fax
number. 
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Confidential ID Override Option:

A Press 0000 or 1111 to select "Over-
ride". 

B Press the {{{{OK}}}} key. 

Confidential ID Override is set. 
C Enter the Confidential ID (4-

digits) with the number keys. 

D Press the {{{{OK}}}} key.

E Specify the other party's fax
number.

HHHH Press the {{{{Start}}}} key. 

----When sending messages to 
fax machines produced by 
other manufacturers

Normally you can only send and re-
ceive confidential faxes between ma-
chines of the same make which
support confidential sending and re-
ceiving. However, if the other party's
fax is not the same as your own, you
can still send and receive confidential
fax messages if the other party's fax
machine supports the SUB/SID func-
tion. See p.26 “SUB Code”.
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Label Insertion

With this function, you can have the
receiver's name programmed in
Quick Dial or Speed Dial printed on
the message when it is received at the
other end. The name will be printed
at the top of the page and will be pre-
ceded by "To". 
If you program the Label Insertion
function in a Quick Dial or Speed Di-
al, the function is enabled when you
select “On”. This function cannot be
used if the other party's name is not
programmed. 
If you select the Label Insertion func-
tion and then enter your personal
code, your personal code will also ap-
pear on the page. "From" is automati-
cally inserted before your personal
code. This function is available when
personal code is registered and the
Restricted Access is turned on.

1. Name that is registered in the
Quick Dial or Speed Dial key.

2. Name that is assigned to the Per-
sonal Code.

Reference
To program the Label Insertion
function in a Quick Dial, see p.46
“Quick Dial”,  <Basic Features>.
To program the Label Insertion
function in a Speed Dial, see p.52
“Speed Dial”,  <Basic Features>.
For details about personal codes,
see p.91 “Personal Codes”.

Note
❒ You can set this function for each

destination. 

FEB.1.2002  9:15AM     ABC COMPANY
TO:DEF COMPANY

NO.005    P. 1
FROM:DEF

1 2

GFREPO3N
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Calling to Request a Message (Polling 
Reception)

Use this function if you want to poll a
message from another terminal. You
can also poll documents from many
terminals.

There are two types of Polling Recep-
tion: 

❖❖❖❖ Secured Polling Reception 
If the Polling ID is programmed in
your machine, any messages wait-
ing in the transmitting machine
with the same ID are received. If
the other machine does not have
any messages waiting with the
same Polling ID, any messages that
do not require an ID are received
(Free Polling). 

❖❖❖❖ Stored ID Override Polling Reception 
You must enter an Override Poll-
ing ID unique to this transmission.
This ID overrides the Polling ID.
Your machine will receive any
messages waiting in the transmit-
ting machine with matching ID's.
If no ID's match, any messages that
does not require an ID are received
(Free Polling). 

Limitation
❒ Polling Reception requires that the

other machine can perform Polling
Transmission. 

❒ To receive a message sent by any
Secured Polling Transmission or
Stored ID Override Polling Trans-
mission, it is necessary to specify
the same Polling ID as the sender's. 

❒ To receive a message sent by Se-
cured Polling Transmission or
Stored ID Override Polling Trans-
mission, the sender must be a ma-
chine of the same manufacturer
and equipped with the Polling Re-
ception function. 

Note
❒ The communication fee is charged

to the receiver. 

AAAA Make sure that the machine is in
Facsimile mode and the standby
display is shown.

BBBB Press the {{{{Trans. Option}}}} key. 

CCCC Press 0000 or 1111 until " 4. Polling RX
” is displayed. 

DDDD Press the {{{{OK}}}} key. 

EEEE Press 0000 or 1111 to select "On". 

Transmission
Request

Receiver
(This machine) Sender

ND1X01E8
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FFFF Press the {{{{OK}}}} key. 

GGGG Select the type of Polling Recep-
tion.

Secured Polling Reception

A Press 0000 or 1111 to select ”De-
fault”.

Stored ID Override Polling 
Reception

A Press 0000 or 1111 to select ”Over-
ride”.

B Press the {{{{OK}}}} key.

C Enter the Polling ID (4 digits)
with the number keys or Quick
Dial keys.

Note
❒ You can enter A to F by the

Quick Dial keys.
❒ You can enter 0 to 9 by the

number keys.
❒ 0000 and FFFF can not be en-

tered.
If you make a mistake, press the
{{{{Clear/Stop}}}} key and try again.

HHHH Press the {{{{OK}}}} key.

IIII Specify the other party's fax num-
ber.

JJJJ Press the {{{{Start}}}} key.

----Polling Documents from Other 
Manufacturer's Fax Machines:

Standard Polling Reception only
works with machines of the same
manufacturer that have the Polling
Reception function. However, if the
other party's fax machine supports
SEP Code Polling Reception, you can
receive documents from them using
SEP Code. (See p.25 “SEP Code”.) 

File Reserve Report (Polling RX)

This report is printed after Polling Re-
ception has been set up.
You can check the date and time, Fax
Header, File No., Transmission con-
dition and the Other party's name
with this report.

Note
❒ You can turn this function on or off

with the User Parameters. See p.85
“User Parameters” (Switch03,
Bit3).
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Communication Result Report 
(Polling RX)

This report is printed after a Polling
Reception has been completed and
shows the result of the Polling Recep-
tion.
You can check the date and time, Oth-
er party's name and result with this
report.

Note
❒ You can also check the result of a

Polling Reception with the Journal.
❒ You can turn this function on or off

with the User Parameters. See p.85
“User Parameters” (Switch03,
Bit4).
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2. Job Information

Canceling Transmission or Reception

Transmission files are originals that
have been stored in memory and are
awaiting transmission. The functions
that produce transmission files are
Memory Transmission and Polling
Reception. 
If you notice an error in the destina-
tion specified or the document con-
tent after scanning a document into
memory, you can cancel transmission
of that document. This is done by
searching for the document in the fax
machine's memory and deleting it.

Note
❒ You can cancel Memory Transmis-

sion even while files are being sent.
However, any pages that have al-
ready been sent cannot be can-
celed.

❒ To cancel transmission in progress,
press the {{{{Clear/Stop}}}} key.

❒ You can print out a File List to con-
firm the transmission files stored
in memory. 

Reference
For details about Memory Trans-
mission and Polling Reception, see
p.25 “Memory Transmission”,
<Basic Features>, and p.9 “Calling
to Request a Message (Polling Re-
ception)”. 

AAAA Make sure that the machine is in
Facsimile mode and the standby
display is shown.

BBBB Press the {{{{Job Information}}}} key. 

Confirm that " 1. Cancel TX / RX "
is displayed. 

CCCC Press the {{{{OK}}}} key. 

DDDD Display the file you want to can-
cel. 

To display the file, enter the file
number with the number keys or
press 0 or 1 until the file number
is displayed. 

Note
❒ If you make a mistake, press the

{{{{Cancel}}}} key and try again. 
❒ If you cannot find the file you

want to cancel, the document
has already been sent. 

EEEE Press the {{{{OK}}}} key. 

FFFF Confirm that you have selected
the correct file, and press the {{{{OK}}}}
key. 

" Trans. Cancelled File Deleted " is
displayed, and the machine re-
turns to the standby display. 
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Printing a List of Files in Memory (Print File List)

Print this list if you wish to find out
which files are stored in memory and
what their file numbers are. Knowing
the file number can be useful (for ex-
ample when erasing files).

Note
❒ The contents of an original stored

in memory can also be printed. See
p.15 “Printing a Stored Message
(Print TX File)”.

AAAA Make sure that the machine is in
Facsimile mode and the standby
display is shown.

BBBB Press the {{{{Job Information}}}} key. 

CCCC Press 0000 or 1111 until " 2. Print File
List " is displayed. 

DDDD Press the {{{{OK}}}} key.

EEEE Press the {{{{Start}}}} key. 

The File List is printed out and the
machine returns to the standby
display. 
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Printing a Stored Message (Print TX File)

If you wish to check the contents of a
fax that is stored in memory and has
not been sent yet, use this procedure
to print it out.

AAAA Make sure that the machine is in
Facsimile mode and the standby
display is shown.

BBBB Press the {{{{Job Information}}}} key.

The Information menu is shown.

CCCC Press 0000 or 1111 until " 3. Print TX
File " is displayed.

DDDD Press the {{{{OK}}}} key.

EEEE Display the file you want to print.

The registered name or fax number
appears on the lower line.

Note
❒ Enter the file number with the

number keys or search using 0
or 1. 

❒ If you make a mistake, press the
{{{{Cancel}}}} key and try again.

FFFF Press the {{{{OK}}}} key.

GGGG Press the {{{{Start}}}} key.

The document is printed and the
machine returns to the standby
display. 
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Printing a Confidential Fax Message 

This feature is designed to prevent
messages from being picked up casu-
ally by anyone when they are re-
ceived. If  someone sends you a
message using Confidential Trans-
mission, it is stored in memory and
not automatically printed. To print
the message, you have to enter the
Confidential ID code. When your ma-
chine has received a confidential mes-
sage, the "Receive File" indicator
flashes.

Note
❒ Before using this function, pro-

gram your Confidential ID. (See
p.94 “ID Code” .) 

❒ If you receive a fax by Confidential
ID Override Reception, enter the
override Confidential ID. 

❒ When the other party send fax
messages with SUB code, perform
the following steps for printing a
confidential fax message. Tell the
other party that SUB code is 8 dig-
its or less. This function is not
available in Germany and some ar-
eas.

Important
❒ If the power switch is off for a cer-

tain period of time, all Confidential
Messages are deleted. If this hap-
pens, use the Power Failure Report
to identify which messages have
been lost. (See p.103 “Power Fail-
ure Report”.) 

AAAA Press the {{{{Job Information}}}} key. 

BBBB Press 0000 or 1111 until "4. Print Conf.
RX" is displayed. 

CCCC Press the {{{{OK}}}} key. 

DDDD Enter the Confidential ID (4 dig-
its) with the number keys. 

The Confidential ID you entered is
not displayed. 

Note
❒ If the other party send fax mes-

sages with SUB code, enter SUB
code (8 digits or less).

EEEE Press the {{{{OK}}}} key. 

FFFF Press the {{{{Start}}}} key. 
The document is printed and the
machine returns to standby dis-
play. 
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Printing a Memory-locked Message 

This is a security function that pre-
vents unauthorized individuals from
reading printed messages. If Memory
Lock is switched on, all received mes-
sages are stored in memory and are
not automatically printed. To print
the messages, you have to enter the
Memory Lock ID code. When your
machine has received a message with
Memory Lock, the "Receive File" indi-
cator flashes. See p.72 “Memory
Lock” .

Note
❒ Before you start, register your

Memory Lock ID. (See p.94 “ID
Code”.) 

❒ Messages received by Polling Re-
ception are automatically printed
even if this function is switched on. 

❒ If the power switch is turned off
for a certain period of time, all
messages protected by Memory
Lock are deleted. If this happens,
use the Power Failure Report to
identify which messages have
been lost. (See p.103 “Power Fail-
ure Report”.) 

AAAA Make sure that the machine is in
Facsimile mode and the standby
display is shown.

BBBB Press the {{{{Job Information}}}} key. 

CCCC Press 0000 or 1111 until " 5. Print Mem.
Lock" is displayed. 

DDDD Press the {{{{OK}}}} key. 

EEEE Enter the Memory Lock ID (4 dig-
its) with the number keys. 

The Memory Lock ID you entered
is not displayed. 

FFFF Press the {{{{OK}}}} key. 

GGGG Press the {{{{Start}}}} key. 

The document is printed out and
the machine returns to standby
display. 
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Printing the Journal

When automatic communication report printing is turned on, the Journal is
printed automatically after every 50 communications (receptions + transmis-
sions). You can also print a copy of the Journal at any time by following the pro-
cedure below. 

Note
❒ The sender's name column of the Journal is useful when you need to register

a Specified Sender. 
❒ If you do not want the Journal to be printed automatically, you can turn au-

tomatic printing off. See p.85 “User Parameters” (switch 03, bit 7).

AAAA Make sure that the machine is in Facsimile mode and the standby display
is shown.

BBBB Press the {{{{Job Information}}}} key. 

CCCC Press 0000 or 1111 until "6. Print Journal" is displayed. 

DDDD Press the {{{{OK}}}} key. 

EEEE Press the {{{{Start}}}} key. 

The report is printed and the machine returns to the standby display.
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Report Formats

1. The Mode Column
Codes and alphabet on this column in-
form the type of communication. These
codes are explained on the bottom of the
report.

2. The Result Column
OK: Successful communication
E: An error occurred
D: Power Failure

3. The Footnote on the Journal
Transmission counter: Total number of
transmitted pages
Reception counter: Total number of re-
ceived pages

MAR. 10. 2002 11:07AM
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3. Other Transmission Features

Handy Dialing Functions

Chain Dial

This function allows you to compose
a telephone number from various
parts, some of which may be regis-
tered in Quick Dials or Speed Dials
and some of which may be entered
using the number keys.
You can program commonly used
area or country codes into Speed Di-
als or Quick Dial keys.
Example: 01133-1-5551234 (From the
United States to Paris).
Assume that the following Quick Dial
and Speed Dial numbers have al-
ready been programmed.
• Quick Dial {{{{03}}}} = 01133 (Overseas

to France)
• Quick Dial {{{{02}}}} = 1 (Paris)
• Speed Dial {{{{0}}}} {{{{1}}}} = 5551234

Note
❒ For Memory Transmission and Im-

mediate Transmission, insert a
pause between numbers. For On
Hook Dial and Manual Dial, no
pause is needed. 

❒ Maximum length of telephone or
fax number: 254 digits

Reference
For registering fax numbers to
Speed Dials or Quick Dial keys,
See p.52 “Speed Dial”,  <Basic Fea-
tures>or p.46 “Quick Dial”,  <Basic
Features>.

AAAA Set your original and select any
scan settings you require.

BBBB Press Quick Dial key {{{{03}}}}.

CCCC Press the {{{{Pause/Redial}}}} key.

DDDD Press Quick Dial key {{{{02}}}}. 

EEEE Press the {{{{Pause/Redial}}}} key. 

FFFF Press the {{{{Speed Dial}}}} key, and
then press {{{{0}}}} {{{{1}}}}.

If you want to send the same fax to
another party, press the {{{{OK}}}} key
and repeat the above steps from
step B.

GGGG Press the {{{{Start}}}} key.
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Telephone Directory

This function lets you find a regis-
tered Speed Dial quickly by just en-
tering a single letter, for example, the
first letter of the name registered for
that number.

Note
❒ Speed Dial codes cannot be

searched for by symbol or number.
❒ Names enclosed within brackets

are not searched.

AAAA Set your original, and then select
any scan settings you require. 

BBBB Press the {{{{Speed Dial}}}} key.

CCCC Enter the search letter by pressing
one of the Quick Dial keys (A to
Z).

Note
❒ The names or fax numbers reg-

is tered in  Speed Dials  are
shown in numerical order on
the display.

DDDD Press 0000 or 1111 until the destina-
tion you are searching for is dis-
played, and then press the {{{{OK}}}}
key.

Note
❒ If you make a mistake, press the

{{{{Cancel}}}} key and try again.
❒ If you wish to dial another des-

tination, press the {{{{OK}}}} key and
dial another fax number.

EEEE Press the {{{{Start}}}} key.

Redial

The machine can recall the last 10 des-
tinations that have been dialed. If you
wish to send a message to a destina-
tion which you faxed recently, the Re-
dial function saves you from finding
and entering the number again.

AAAA Place your original and select any
scan settings you require.

BBBB Press the {{{{Pause/Redial}}}} key.

CCCC Press 0000 or 1111 until the destina-
tion you want to redial is dis-
played.

DDDD Press the {{{{OK}}}} key.

EEEE Press the {{{{Start}}}} key.

Note
❒ The following kinds of destina-

tions can not be recalled. 
• Quick Dials
• Speed Dials
• Group Dials
• Any destinations if multiple

destinations were dialed
• Destinations dialed by Redi-

al (regarded as already mem-
orized)
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On Hook Dial

You can send a fax message without
lifting the receiver, while still listen-
ing to the dial tone. 
If the other party has a telephone fax
machine, you can talk by lifting the
receiver after your machine has con-
nected to theirs.

Reference
See p.70 “Adjusting Volume”,
<Basic Features>.

AAAA Place your original, and then se-
lect any scan settings you require.

BBBB Press the {{{{On Hook Dial}}}} key.

You will hear a tone from the inter-
nal speaker. If you wish to cancel
this operation, press the {{{{On Hook
Dial}}}} key again.

CCCC Dial.

The machine immediately dials the
destination. If you make a mistake,
press the {{{{On Hook Dial}}}} key and re-
turn to step B. 

Note
❒ You can change the volume of

sound with 0 or 1.

DDDD When the line is connected and
you hear a high-pitched tone,
press the {{{{Start}}}} key.

Note
❒ If you hear a voice, pick up the

external telephone before you
press the {{{{Start}}}} key and notify
the destination that you want to
send a fax message (ask them to
switch to Facsimile mode).

The originals are transmitted.

After transmission, the machine
will return to standby display. 
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Manual Dial

The external telephone is required.

You can send a fax message using an
external telephone.

Note
❒ The result of transmission with

manual dial is not mentioned in
the Transmission Result Report
(Immediate Transmission).

AAAA Place your original, and then se-
lect any scan settings you require. 

BBBB Pick up the external telephone.

You will hear a tone.

CCCC Dial.

If you make a mistake, replace the
external telephone and try again
from step B. 

DDDD When the line is connected and
you hear a high-pitched tone,
press the {{{{Start}}}} key to send your
fax message.

Note
❒ If the other party answers the

phone, inform them that you
are sending a fax.

EEEE Replace the handset of the exter-
nal telephone.

After transmission the machine
will return to standby display. 
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Transmission Features

SEP Code

If you want to receive a message
stored in the memory of another par-
ty's fax machine, use this function.
The machine will receive the message
with the SEP and PWD code that
matches the SEP and PWD code you
enter in the following procedure.

Preparation
You need to assign the Dial Option
function to a User Function key be-
forehand. See p.53 “User Function
Keys”.

Note
❒ The ID can be up to 20 digits long

and consist of numbers, spaces,
{{{{qqqq}}}} and {{{{pppp}}}}.

❒ Make sure the ID matches the oth-
er terminal of the fax you are re-
ceiving from.

❒ You can store IDs in Quick Dials,
Speed Dials, and Groups.

❒ Messages you receive using this
function are marked "SEP" on all
reports.

❒ When you send a fax message with
SEP Code to other makers' ma-
chines, sometimes a password
(PWD) is necessary. Use PWD
when it is necessary.

AAAA Dial the destination fax number
using the number keys.

BBBB Press the {{{{User Function}}}} key as-
signed with the Dial Option func-
tion. 

CCCC Press 0000 or 1111 until " 2. SEP " is
displayed.

DDDD Press the {{{{OK}}}} key.

EEEE Enter the SEP code with the num-
ber keys.

FFFF  Press the {{{{OK}}}} key.

When a password (PWD) is 
necessary

A Press the {{{{User Function}}}} key as-
signed with the Dial Option
function.

B Press 0000 or 1111 until " 4. PWD "
is displayed. 

C Press the {{{{OK}}}} key.

D Enter the PWD code with the
number keys.

E Press the {{{{OK}}}} key

GGGG Press the {{{{Trans. Option}}}} key. 
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HHHH Press 0000 or 1111 until " 4. Polling
RX" is displayed. 

IIII Press the {{{{OK}}}} key. 

JJJJ Press 0000 or 1111 to select "On". 

KKKK Press the {{{{OK}}}} key. 

LLLL Press 0000 or 1111 to select ”Default”.

MMMM Press the {{{{OK}}}} key.

NNNN Press the {{{{Start}}}} key.

SUB Code

If the other party's machine has func-
tions like Transfer Request and Confi-
dential Transmission with SUB/SID
Code, you can use those functions
with SUB/SID Code.

Preparation
You need to assign the Dial Option
function to a User Function key be-
forehand. See p.53 “User Function
Keys”.

Note
❒ The ID can be up to 20 digits long

and consist of numbers, spaces,
{{{{qqqq}}}} and {{{{pppp}}}}.

❒ Make sure the ID matches the
specification of the fax you are
sending to.

❒ You can store IDs in Quick Dials,
Speed Dials, and Groups.

❒  Messages you send using this
function are marked "SUB" on all
reports.

❒ When you send fax message with
SUB Code to other makers' ma-
chines, sometimes a password
(SID) is necessary. Use SID when it
is necessary.

AAAA Place your original and make any
changes to the scan settings if nec-
essary.

BBBB Dial the destination fax number
using the number keys.

CCCC Press the {{{{User Function}}}} key as-
signed with the Dial Option func-
tion. 

DDDD Confirm that " 1. SUB " is dis-
played.

EEEE Press the {{{{OK}}}} key.

FFFF Enter the SUB code with the num-
ber keys.

GGGG Press the {{{{OK}}}} key.

When a password (SID) is 
necessary

A Press the {{{{User Function}}}} key as-
signed with the Dial Option
function.
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B Press 0000 or 1111 until " 3. SID " is
displayed.

C Press the {{{{OK}}}} key

D Enter the SID code with the
number keys.

E Press the {{{{OK}}}} key

HHHH Press the {{{{Start}}}} key.

Note
❒ If you use Immediate Transmis-

sion and the destination fax ma-
chine does not support the Dial
Option function, a message will
appear on the display to inform
you of this. In this case, press
the {{{{OK}}}} key to cancel the trans-
mission.

Closed Network Transmission

This function ensures that you do not
send confidential messages to the
wrong machine. The ID Codes of the
c o m m u n i c a t i n g  m ac h i n e s  a r e
checked. If they are not the same, the
communication is stopped. 

Note
❒ Program the same ID Code in the

receiver's fax machine beforehand.
See p.94 “ID Code”. 

❒ You can specify whether you want
to send a fax by Closed Network
Reception with the User Parame-
ters. See  p.85 “User Parame-
ters”(switch 06, bit 2). 

Blank Sheet Detect

This function is designed to help you
avoid making mistakes while scan-
ning in originals.
If you try and scan in an almost com-
pletely blank original, an alarm
sounds and ”Some Page (s)  are
Blank” appears on the display. Make
sure the original is not blank.

Note
❒ Transmission is not cancelled even

if the original is blank.
❒ With Memory Transmission, the

alarm sounds as soon as the origi-
nal has been scanned. If you press
the {{{{Clear/Stop}}}} key while the
“Some Page(s) are Blank”is shown
on the display, “Storing Can-
celled”appears on the display.

❒ You can turn the Blank Sheet De-
tect function on or off with the
User Parameters. See p.85 “User
Parameters” (switch 11, bit 2).

❒ This function is not supported in
Copy mode.
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Scanner Cleaning Message

If dirt is stuck to the scanner, the other
party receives fax messages with
black lines. When the scanner is dirty,
the warning message "Scanner Needs
Cleaning" is displayed. If this mes-
sage is displayed, wipe the exposure
glass and white strip to remove the
dirt, and then press the {{{{OK}}}} key. You
can choose whether this message is
displayed with User Parameters. See
p.85 “User Parameters” (switch 20, bit
7). For cleaning the scanner, see p.112
“Cleaning the Scanner”.

Note
❒ If the dirty part of the scanner is

small, the machine corrects the
black line made when scanning
originals.  The black line does not
appear on the received message.
However, sometimes very small
parts of the image might be miss-
ing on the received message.  You
can turn this function on or off
with User Parameters. See p.85
“User Parameters”(switch 20, bit
4). 
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More Transmission Functions

If Memory Runs Out While 
Storing an Original

AAAA If you run out of memory while
storing an original (free space
r e a c h e s  0 % ) ,  “Memory is
Full.Storing Stopped.” is dis-
played.

BBBB Press the {{{{OK}}}} key.

When transmitting the stored pages

A Press 0000 or 1111 to select “Trans-
mit” and press the {{{{OK}}}} key.

Note
❒ Successfully scanned pages

are sent. Check the number
of transmitted  pages on
Communication Result Re-
port.

When deleting the stored pages

A Press 0000 or 1111 to select “Delete”
and press the {{{{OK}}}} key.

Checking the Transmission 
Result

• Turn on the printing of the Com-
munication Result Report if you
want a report to be printed after
every successful transmission. See
p.32 “Printed Reports”.
If you leave off the printing of the
Communication Result Report, the
report will not be printed after ev-
e ry  t ransm iss io n .  H ow eve r ,
should a transmission fail, a Com-
munication Failure Report will be
printed instead.

• If you turn off the printing of the
Transmission Result Report (Im-
mediate Transmission), the Error
Report will be printed when the
communication on fails.

• You can also check the transmis-
sion result by examining the Jour-
n a l .  Se e  p . 1 8  “P r i nt i ng  t h e
Journal”.

• You can assign the function of
printing Transmission Result Re-
port to User Function Keys.
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Broadcasting Sequence

If you dial several destinations for the
same message (Broadcasting), the
messages are sent in the order in
which they were dialed. If the fax
message could not be transmitted to a
destination, the machine redials that
destination after the last destination
specified for Broadcasting. For exam-
ple, if you specify four destinations A
through D for broadcasting, and if the
lines to destinations A and C are
busy, the machine dials the destina-
tions in the following order: A, B, C,
D, A, and C. 

Sending a Fax Message 
Immediately

To send a fax message immediately,
use Immediate Transmission. If you
have just set up an original for broad-
casting, Immediate Transmission will
interrupt the current communication. 
Your message will not be sent until
previously queued files have been
sent. 

Broadcasting : Checking 
Progress

To check which destinations the fax
message has been sent to so far, print
the TX file list.

Automatic Redial

If a fax message could not be trans-
mitted because the line was busy or
an error occurred during transmis-
sion, redialing is done 4 times at 5
minutes intervals (these figures vary
according to which country you are
in).
If redialing fails after four redials, the
machine cancels the transmission and
prints the Communication Result Re-
port or Communication Failure Re-
port.

Batch Transmission

If you send a fax message by Memory
Transmission and there is another fax
message waiting in memory to be
sent to the same destination, that
message is sent along with your mes-
sage. Several fax messages can be sent
with a single call, thus eliminating the
need for several separate calls. This
helps save communication costs and
reduces transmission time.
Fax messages for which the transmis-
sion time has been set in advance are
sent by Batch Transmission when that
time is reached.

Note
❒  You can switch this function on or

off with the User Parameters. See
p.85 “User Parameters” (Switch06,
Bit4).
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Dual Access

The machine can scan other messages
into memory even while sending a
fax message from memory, receiving
a message into memory , or automat-
ically printing a report. Since the ma-
chine starts sending the second
message immediately after the cur-
rent transmission terminates, the line
will be used efficiently. 
Note that during Immediate Trans-
mission or when in User Tools mode,
the machine cannot scan an original.

ECM (Error Correction Mode)

This function automatically resends
data that was not transmitted suc-
cessfully using a system that complies
with international standards.
ECM requires that the receiver has
the same function. 

Parallel Memory Transmission

This function dials while the original
is being scanned. Standard Memory
Transmission stores the original in
memory, then dials the destination.
Parallel Memory Transmission al-
lows you to quickly determine
whether a connection was made. In
addition, this function scans the orig-
inal faster than Immediate Transmis-
sion and is useful when you are in a
hurry and need to use the original for
another purpose.

Note
❒ You can switch this function on or

off with the User Parameters. See
p.85 “User Parameters” (Switch07,
Bit2).

❒ Standard Memory Transmission is
used instead of Parallel Memory
Transmission in the following cas-
es.
• When the line is busy and could

not be connected to
• With Send Later
• When you store an original for

Memory Transmission while
another communication is in
progress

• When Auto resolution is select-
ed

❒ If you press the {{{{Clear/Stop}}}} key,
the original jams, or memory be-
comes full during Parallel Memory
Transmission, the machine stops
transmitting and prints the Com-
munication Result Report. The file
is erased.

❒ Total stored page numbers are not
printed in the Parallel Memory
Transmission. Only the page num-
bers are printed, such as P.1, P.2
not 1/2, 2/2.

❒ If you run out of memory, normal
Memory Transmission takes place. 

❒ File Reserve Report will not be
printed with Parallel Memory
Transmission.
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Printed Reports

You can obtain reports from your ma-
chine either by having your machine
print them out automatically, or by
printing them out yourself.

Note
❒ You can switch on or off the print-

ing of the various reports with the
User Parameters. See p.85 “User
Parameters” (switch 03, bits 7–0).

❒ For reference purposes, the ma-
chine prints part of the original im-
age on the File Reserve Report,
Communication Result Report and
Communication Failure Report.
You can choose whether to include
part of the original image on re-
p o rt s  w i t h  Use r  P a r a m ete r s
(Switch 04. Bit 7).

File Reserve Report (Switch 03, 
Bit 2)

This report is printed after an original
is stored in memory. Use it to review
the contents and destinations of
stored originals. Even if the machine
is set up not to print this report, it is
still printed if an original could not be
stored.

Note
❒ File Reserve Report will not be

printed with Parallel Memory
Transmission.

Communication Result Report 
(Switch 03, Bit 0)

This report is printed when a Memo-
ry Transmission is completed so you
can check the result of the transmis-
sion. If two or more destinations are
specified, this report is printed after
the fax message has been sent to all
the destinations. If the machine is set
up not to print this report and the fax
message could not be successfully
transmitted, the Communication Fail-
ure Report is printed. See p.32 “Com-
munication Failure Report (Switch 03,
Bit 0)”.

Communication Failure Report 
(Switch 03, Bit 0)

This report is only printed if the Com-
munication Result Report is turned
off and a message could not be suc-
cessfully transmitted with Memory
Transmission. Use it to keep a record
of failed transmissions so you can
send them again.

Note
❒ The "Page" column gives the total

number of pages. The "Not Sent"
column gives the number of pages
that could not be sent successfully.
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Transmission Result Report 
(Immediate Transmission) 
(Switch 03, Bit 5)

If you turn on the printing of this re-
port, a report will be printed after ev-
ery Immediate Transmission so you
have a record of whether the trans-
mission was successful or not. If the
machine is set up not to print this re-
port and the fax message could not be
successfully transmitted, the error re-
port is printed instead.

Note
❒ If the page was sent successfully,

the "Page" column gives the total
number of pages that were sent
successfully. The "Not Sent" col-
umn gives the number of pages
that could not be sent successfully.

Confidential File Report 
(Switch 04, Bit 0)

This report is printed whenever your
machine receives a Confidential Mes-
sage.

Note
❒ You can turn this report on or off

with the User Parameters. See p.85
“User Parameters”(switch 04, bit
0)
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4. Reception Features

General

Immediate Reception

Each page of a received fax message is
printed as soon as it is received. This
method is used for standard fax mes-
sages.

❖❖❖❖ Display during reception
The sender's name or fax number
appears on the upper line.

❖❖❖❖ Reception resolution 
This machine supports Standard
and Detail resolutions for recep-
tion. A fax message may be printed
in a resolution different from the
one specified by the sender.

Note
❒ Reception will not take place if

there is not enough free memo-
ry left. If free memory reaches
0% during Immediate Recep-
tion, any further reception be-
comes impossible  and the
current communication is ter-
minated. 

Memory Reception

The machine waits until all pages of
the message have been received into
memory before printing the message.

This method is used with Substitute
Reception. See p.36 “Printing Docu-
ments that have been Received into
Memory (Substitute Reception)” .

Important
❒ All the messages stored in memory

a re  d e l e t e d  i f  t h e  p o w er  i s
switched off for a certain period of
time. See p.17 “Turning Off the
Power”,  <Basic Features>.

❒ The machine may not be able to re-
ceive large numbers of messages
or messages with a high data con-
tent. In such cases, we recommend
you switch the above functions off.

Limitation
❒ The machine may not be able to re-

ceive fax messages when the free
memory space is low.
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Note
❒ If the memory free space reaches

0% during Memory Reception, the
machine can no longer receive the
current fax message and stops
communicating. 

Printing Documents that have 
been Received into Memory 
(Substitute Reception)

If any of the conditions listed below
are met, the machine automatically
switches to Memory Reception mode
and stores messages in memory in-
stead of printing them. This reception
mode, in which a received fax mes-
sage is stored in memory unprinted,
is called Substitute Reception. Mes-
sages received using Substitute Re-
ception are automatically printed
when the condition which caused the
machine to use Substitute Reception
is rectified. Substitute Reception takes
place when:
• Paper runs out
• Toner runs out
• Paper is jammed
• A cover is open
• A fax is received during a copy or

print run
• Memory Lock
• Confidential Reception

Limitation
❒ Reception may not take place if

there is not enough free memory
left.

Note
❒ The Receive File indicator lights to

let you know when message(s)
have been received using Substi-
tute Reception.

❒ If free memory reaches 0% during
Substitute Reception, any further
reception becomes impossible and
the current communication is ter-
minated.

Screening Out Messages from 
Anonymous Senders

To help you screen out unwanted
messages that may fill up your mem-
ory, the machine can be programmed
to only use Substitute Reception for
messages that arrive with name or fax
number identification. 
Two settings are available: 
• When a name or fax number is re-

ceived 
• Free 

Note
❒ When "When a name or fax num-

ber is received" is selected, the ma-
chine only stores messages when
the name or fax number is present.
You can change this with User Pa-
rameters. See p.85 “User Parame-
ters” (switch 05, bit 1).

❖❖❖❖ When a name or fax number is re-
ceived
The machine switches to Substi-
tute Reception only when the
sender programs their name or fax
number. If the power is switched
off for a certain period of time, all
the messages received into memo-
ry are deleted. If this occurs, the
Power Failure Report or Journal
can be used to identify which mes-
sages were lost so you can ask the
senders to transmit them again.
See p.103 “Power Failure Report”
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Important
❒ If a sender does not program

their name or fax number, the
machine may reject an impor-
tant fax message. We recom-
mend that you ask important
senders to register their name or
fax number in advance.

❖❖❖❖ Free 
The machine switches to Substi-
tute  Reception regardless  of
whether or not the sender has pro-
grammed their name or fax num-
ber. 

Receiving Messages in 
Telephone Mode

In this mode you have to answer the
call yourself and decide whether it is
a fax or a telephone call.
The procedure for answering a call is
as follows:

AAAA Pick up the handset of the exter-
nal telephone and listen to the
other end.

BBBB If you hear a voice, continue your
conversation as you would nor-
mally. 

CCCC If you hear a fax tone, remove any
originals from the feeder. 

DDDD Make sure that the machine is in
Facsimile mode and the standby
display is shown.

EEEE Press the {{{{Start}}}} key. 

FFFF Replace the handset. 
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Printing Options

Center Mark

When this function is turned on,
marks are printed halfway down the
left side and at the top center of each
page received. This makes it easy for
you to position a hole puncher cor-
rectly when you file received messag-
es.

Note
❒ The center marks may deviate a lit-

tle from the exact center of the
edge.

❒ You can turn this function on or off
with the User Parameters (Switch
02 Bit 1). See p.85 “User Parame-
ters”.

Checkered Mark

When this function is turned on, a
checkered mark is printed on the first
page of fax messages to help you sep-
arate them.

Note
❒ You can turn this function on or off

with the User Parameters (Switch
02 Bit 4) See p.85 “User Parame-
ters”.

TSI Print

Usually the sender's Fax Header is
printed on received messages. If the
sender has not programmed their Fax
Header, you will not be able to identi-
fy them. However, if you turn this
function on, the sender's Name or Fax
Number is printed instead so you can
find out where the message came
from. See p.85 “User Parameters”
(Switch 02 Bit 3)

ND1X00E5
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Reception Time

When this function is turned on, you
can have the date and time when a
message was received printed at the
bottom of the received image. Turn it
on or off with the User Parameters
(Switch 02 Bit 2). See p.85 “User Pa-
rameters”.

Note
❒ When a received message is print-

ed on two or more sheets, the date
and time is printed on the last
page.

❒ The date and time when the mes-
sage was printed can also be re-
corded on the message. If you need
this function, please contact your
service representative.

Page Separation and Length 
Reduction 

When the size of a received message
is longer than the paper loaded in the
machine, each page of the message
can be split and printed on several
sheets, or reduced and printed on a
single sheet. For example, when the
paper size is A4 L, this function
splits the message if the message
length is 92mm (3.7”) or longer than
the paper used. The message is re-
duced if it is less than 92mm (3.7”).
When the paper size is 81/2"×11” L,
this function splits the message if the
message length is 85mm(3.4”) or
longer than the paper used. The mes-
sage is reduced if it is less than
85mm(3.4”). When a message is split,
the split mark (*) is inserted at the
split position and about 10mm (0.4”)
of the split area is duplicated on the
top of the second sheet.

Note
❒ This function is not available in

some countries.
❒ Your service representative can

customize this function with the
following settings.
• Reduction
• Print split mark 
• Overprinting 
• Guideline for split 

ABC
(Document)

ND1X01E1
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When There is No Paper of the Correct Size

If there is no paper in your machine that matches the size of a received message,
the machine will choose a paper size based upon the paper you have available.
For example, if your machine has A4L and 81/2”×11”L installed and you re-
ceive a A5K size message, check the A5K column of the table below. The paper
size at the top has the highest priority. In this case, since 81/2”×11”L is a higher
priority than A4L, the message is printed on 81/2”×11”L. 

❖❖❖❖ Priority Table

• KK and LL indicate that the message is split over two pages of paper with
the orientation and size shown.

Page Reduction Disabled

Reduction in Sub-scan Direction Enabled

Width or Length Priority Width
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Note
❒ The paper size used to print a received message may be different from the size

of the sent original.

Reference
p.39 “Page Separation and Length Reduction” 
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5. Copying

Copying

If you need to make a copy and there
is no copier available, use your fax
machine. Just place your original in
the feeder, and press the {{{{Copy}}}} key.

Important
❒ When making multiple copy sets,

copying starts once all originals
have been scanned into memory. If
memory runs out (free memory
reaches 0%) while scanning in, the
copy job is canceled and originals
that have been scanned in so far
are deleted from memory. 

Note
❒ If you frequently use the fax ma-

chine to make copies and do not
want to wait 40 seconds for the ma-
chine to warm up after it has en-
tered the Energy Saving mode, you
can change the setting of the Ener-
gy Saving feature so that the heater
cools only halfway. See p.85 “User
Parameters” (switch 05, bit 6).

❒ Place your original and select any
scan settings in the same way as
for fax transmission. 

❒ Multiple copy sets are sorted and
delivered in page order. 

❒ If you wish to prevent passersby
from freely making copies, you can
disable the copy feature with the
User Parameters. See p.85 “User
Parameters” (switch 12, bit 7). 

❒ You can specify between 1 and 99
copies. 

AAAA  Press the {{{{Copy}}}} key. 

Note
❒ Pressing the {{{{Copy}}}} key again

returns the machine to standby
display.

BBBB Place your original in the docu-
ment feeder face up. 

If you have the optional paper tray
or bypass tray, you can select the
paper tray by pressing 0 or 1. 

CCCC Adjust any scan settings as neces-
sary. 

Note
❒ If your original is longer than

the copy paper you choose, only
the length of the copy paper will
be copied. 

DDDD Enter the number of copies you
need with the number keys. 

If you make a mistake, press the
{{{{Clear/Stop}}}} key and try again. 

EEEE Press the {{{{OK}}}} key.
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FFFF Press the {{{{Start}}}} key. 

Copying starts. 
When copying has finished, the
machine returns to standby dis-
play. 

Note
❒ To stop copying while it is in

progress, press the {{{{Stop}}}} key.
Then open the right cover and
remove any paper left. 

Copying on special paper

You can copy the original on special
paper using the bypass tray. Place the
paper face down on the bypass tray.

Important
❒ When the paper is curved, flatten

the paper to avoid a paper jam.

Note
❒ Do not place more than one sheet

of special paper on the bypass tray.

❖❖❖❖ The following special paper can be
used for copying:
Envelopes
Transparent paper
OHP transparencies
Post cards
Adhesive labels

See p.63 “Changing the Paper Type
for Bypass Tray”
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6. Facsimile User Tools

Counters 

This function allows you to check the
total number of transmitted, received,
scanned, and printed pages on the
display.

❖❖❖❖ TX Pages
Total number of transmitted pag-
es. 

❖❖❖❖ RX Pages
Total number of received pages. 

❖❖❖❖ Scan Pages
The combined total number of
pages that have been scanned in
when copying and sending faxes. 

❖❖❖❖ Print Pages
The combined total number of
pages that have been printed
through fax reception, copying.  

AAAA Make sure that the machine is in
standby display. 

BBBB Press the {{{{User Tools}}}} key. 

Confirm that “ 1. Counter “ is dis-
played.

CCCC Press the {{{{OK}}}} key. 

The number of pages transmitted
is displayed. You can display the
n um be r  o f  p a g e s  r ec e i ve d ,
scanned, or printed by pressing 0
or 1.

DDDD Once you have confirmed the
number of pages, press the {{{{OK}}}}
key.

EEEE Press the {{{{User Tools}}}} key. 

The machine returns to standby
display. 
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Programs

If you regularly send messages to
particular destinations using the
same features, you can save a lot of re-
petitive keypad operation by storing
these settings in a Keystroke Pro-
gram.
Keystroke Programs are stored as
Quick Dial keys.
Keystroke programs can then be re-
called by just pressing a Quick Dial
key.

Note
❒ You cannot register a program in a

Quick Dial already used for anoth-
er function.

Example: Assume that you normally
send a daily report to locations A, B,
and C at 11:00 (using Sending at a
Specific Time). Store these instruc-
tions as a Keystroke Program. Then
every day, you will only have to place
the report in the document feeder,
and then press that key to set up the
transmission.

Reference
See p.3 “Sending at a Specific Time
(Send Later)” .
See p.56 “Printing Reports/Lists”.

Storing a Program 

You can register the following items
in Keystroke Programs: 
• Memory Transmission, Immediate

Transmission, Confidential Trans-
mission, Free Polling, Polling Re-
ception, Printing reports or lists,
destinations, Personal Codes, Con-
fidential ID codes, Polling ID
codes, SUB Code Transmission,
and SEP Code Polling Reception. 
Simply perform the usual proce-
dure, and then instead of pressing
the {{{{Start}}}} key or the {{{{OK}}}} key,
press the Quick Dial you want to
register the program in. 

AAAA Place your original and select any
scan settings you require. 

BBBB Specify the destination and press
the Quick Dial you want to regis-
ter the program in. 

CCCC Press 0000 or 1111 to select "Yes". 

DDDD Press the {{{{OK}}}} key.

EEEE Register the program name. 

If you make a mistake, press the
{{{{Clear/Stop}}}} key and try again. 
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FFFF Press the {{{{OK}}}} key. 

"Programmed" is displayed on the
screen and the original is scanned
in. 
If you only want to register the
program and do not want to send a
fax, press the {{{{Clear/Stop}}}} key right
after scanning. 

Using a Program

To use a program, perform the fol-
lowing procedure. 
Example: When using a program
stored in Quick Dial 07. 

AAAA Place your original and select any
scan settings you require. 

BBBB Specify Quick Dial 07. 

The machine starts scanning the
original and the program stored in
the Quick Dial begins. Once scan-
ning has finished, the original is
sent. 

Changing a Program 

You can change a program registered
in a Quick Dial by deleting the pro-
gram, and then registering a new pro-
gram. See p.48 “Deleting a Program”
and p.46 “Storing a Program”. 

Editing the Program Name 

To edit the program name, perform
the following procedure. 

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until “ 2. Fax Fea-
tures “ is displayed.

CCCC Press the {{{{OK}}}} key. 

Confirm that "1. Program / Delete"
is displayed. 

DDDD Press the {{{{OK}}}} key. 

EEEE Press 0000 or 1111 until “7. Change
Prog. Name“ is displayed.

FFFF Press the {{{{OK}}}} key. 

GGGG Press the Quick Dial that contains
the program whose name you
want to edit. 

Scroll using 0 or 1. 

HHHH Press the {{{{OK}}}} key. 
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IIII Press the {{{{Clear/Stop}}}} key, and
then enter the program's name. 

JJJJ Press the {{{{OK}}}} key. 

KKKK Press the {{{{User Tools}}}} key. 
The machine returns to standby
display. 

Deleting a Program 

To delete a program, perform the fol-
lowing procedure. 

Limitation
❒ You cannot delete a program if a

file using that program (destina-
tion) is stored in memory. 

❒ You cannot delete a program if a
group using that program (desti-
nation) is stored in memory. 

Note
❒ If you delete a program, the regis-

tered program name is also delet-
ed. 

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until “2. Fax Fea-
tures“ is displayed.

CCCC Press the {{{{OK}}}} key. 

Confirm that "1. Program / Delete"
is displayed. 

DDDD Press the {{{{OK}}}} key. 

EEEE Press 0000 or 1111 until “ 8. Delete Pro-
gram “ is displayed.

FFFF Press the {{{{OK}}}} key. 

GGGG Press the Quick Dial that contains
the program you want to delete. 

Press the Quick Dial, or scroll us-
ing 0 or 1. 

HHHH Press the {{{{OK}}}} key. 

The program is deleted. 

IIII Press the {{{{User Tools}}}} key. 

The machine returns to standby
display. 

StellaF1EN-3_FM.book  Page 48  Monday, November 12, 2001  11:40 AM



Storing an Often Used Document (Auto Document)

49

6

Storing an Often Used Document (Auto 
Document)

If you find that you often have to send
a particular page to people (for exam-
ple, a map, a standard attachment, or
a set of instructions), store that page
in the memory as an Auto Document,
using a Quick Dial key. This saves re-
scanning the document every time
you want to send it.
When you need to send that page to
somebody, press the Quick Dial key
that you stored it in, place any other
pages that you wish to send into the
feeder, dial, and press the {{{{Start}}}} key.
At the destination, the Auto Docu-
ment will be printed first. You can
also program a destination for each
Auto Document into the same Quick
Dial key.

Storing an Auto Document 

Important
❒ If the Power switch is turned off

for a certain period of time, the
contents of all Auto Documents are
deleted. If this happens, use the
Power Failure Report to identify
which messages have been lost.
(See p.103 “Power Failure Report”)

Note
❒ The maximum number of Auto

Documents you can register is 30. 
❒ You can only send one Auto Docu-

ment per transmission. 
❒ You cannot register Auto Docu-

ments in Quick Dials that are al-
ready programmed. 

❒ If you register Auto Documents, the
amount of memory reserved for
Memory Transmission decreases. 

To register a document in a Quick Di-
al, perform the following procedure. 

AAAA Set your document and select any
scan settings you require.

BBBB Press the {{{{User Tools}}}} key. 

CCCC Press 0000 or 1111 until “ 2. Fax Fea-
tures“ is displayed.

DDDD Press the {{{{OK}}}} key. 

Confirm that "1. Program / Delete"
is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press 0000 or 1111 until “ 9. Prog. Auto
Doc.“ is displayed.

GGGG Press the {{{{OK}}}} key. 
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HHHH Display the number of the Quick
Dial where you want to register
the document. 

Press the Quick Dial, or scroll using
0 or 1 and press the {{{{OK}}}} key. 
• If you select a Quick Dial that is

programmed with a destina-
tion, "This key is in Use as a
Quick Dial" is displayed, and
you can proceed to step I. If you
select the wrong Quick Dial,
press the {{{{Cancel}}}} key, and then
go back to step G.  

• If you specify a Quick Dial that
is used as a Group or Program,
"This key is in Use as a Group
Dial" or "This key is in Use as a
Program" is displayed, and you
cannot program that Quick Di-
al. Select a Quick Dial that is not
programmed. 

IIII Enter the name of the Auto Docu-
ment. 

• If you make a mistake, press the
{{{{Clear/Stop}}}} key and try again. 

• If you do not enter a name and
press the {{{{OK}}}} key, the name is
not programmed. 

JJJJ Press the {{{{OK}}}} key. 

KKKK Press the {{{{Start}}}} key. 
The document is stored in memory
and registered as an Auto Docu-
ment. 

LLLL Press the {{{{User Tools}}}} key. 

The machine returns to standby
display. 

Sending an Auto Document as 
an Attachment 

To send an Auto Document as an at-
tachment, perform the following pro-
cedure. (To send an Auto Document
only, perform the following proce-
dure from step B.) 

Note
❒ Although you can specify scan set-

tings when sending an Auto Docu-
ment, these settings will only
apply to the document you send
along with the Auto Document.
The set t ings  used when you
scanned in and stored the Auto
Document will apply to the Auto
Document itself. 

❒ If you send another document
with an Auto Document, the Auto
Document is sent first. 

AAAA Place your document and select
any scan settings you require. 

BBBB Press the Quick Dial where the
Auto Document is registered.

CCCC Specify the destination and press
the {{{{OK}}}} key. 

DDDD Press the {{{{Start}}}} key. 
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Changing an Auto Document 

You can change an Auto Document
registered in Quick Dial by deleting
the Auto Document, and then regis-
tering a new Auto Document. See
p.52 “Deleting an Auto Document”
and p.51 “Editing an Auto Document
Name”

Editing an Auto Document 
Name 

To edit an Auto Document's name,
perform the following procedure. 

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until “2. Fax Fea-
tures “ is displayed.

CCCC Press the {{{{OK}}}} key. 

Confirm that "1. Program / Delete"
is displayed. 

DDDD Press the {{{{OK}}}} key. 

EEEE Press 0000 or 1111 until the “ 9. Prog.
Auto Doc." is displayed. 

FFFF Press the {{{{OK}}}} key. 

GGGG Display the number of the Quick
Dial whose name you want to ed-
it. 

Press the Quick Dial, or scroll us-
ing 0 or 1 and press the {{{{OK}}}}
key.

HHHH Press the {{{{Clear/Stop}}}} key, and
then enter the Auto Document's
name. 

If you do not want to change the
name, go to step I. 

IIII Press the {{{{OK}}}} key. 

The name is changed. 
If you want to change another
Auto Document's name, repeat the
above steps from step F. 

JJJJ Press the {{{{User Tools}}}} key. 
The machine returns to standby
display. 
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Deleting an Auto Document

To delete an Auto Document, per-
form the following procedure.

Limitation
❒ You cannot delete an Auto Docu-

ment if a file containing that docu-
ment is stored in memory.

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until “ 2. Fax Fea-
tures“ is displayed.

CCCC Press the {{{{OK}}}} key. 

Confirm that "1. Program / Delete"
is displayed. 

DDDD Press the {{{{OK}}}} key. 

EEEE Press 0000 or 1111 until “ 10. Del. Auto
Doc.“ is displayed.

FFFF Press the {{{{OK}}}} key. 

GGGG Display the number of the Quick
Dial where the document you
want to delete is registered. 

Press the Quick Dial, or scroll us-
ing 0 or 1. 

HHHH Press the {{{{OK}}}} key. 

IIII Press 0000 or 1111 to select {{{{Yes (De-
lete)}}}}. 

JJJJ Press the {{{{OK}}}} key. 
If you want to delete another Auto
Document, repeat the above steps
from step F. 

KKKK Press the {{{{User Tools}}}} key. 

The machine returns to standby
display. 
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User Function Keys

You can program each of the User Function keys ({{{{F1}}}} to {{{{F5}}}}) with a function
that you use frequently. When you wish to use that function, instead of having
to search through several menus to find it, just press the appropriate User Func-
tion key. 

Important
❒ When registering and editing User Function keys, we recommend that you

print out a User Function List for reference. (See p.56 “Printing Re-
ports/Lists”.) 

Functions You Can Assign to User Function Keys

You can program each of the User Function keys with one of the following functions.

• The "b" notation indicates that the User Function key lights when that func-
tion is selected ”On”. 

To assign a function to a User Function key, perform the following procedure.

Function Name Function Contents Condition Reference 

Reception Mode Use this mode to switch Reception 
modes.

- See p.39 “Reception 
Modes”,  <Basic Fea-
tures>.

Print Journal Use when you want to print out a 
Journal. 

- See p.18 “Printing the 
Journal” 

TX Result Report Use this to have a result report 
printed after every transmission.

b See p.32 “Communica-
tion Result Report 
(Switch 03, Bit 0)” and 
p.33 “Transmission Re-
sult Report (Immediate 
Transmission) (Switch 
03, Bit 5)”

Fax Header Print You can turn this function on or off. b See p.5 “Fax Header 
Print” 

Group Use when you want to specify a 
group of destinations. 

- See p.37 “Using Groups”,  
<Basic Features>.

Tone Use when you want to enter a tone 
signal. 

- See p.35 “Tone”,  <Basic 
Features>.

Dial Option Use this function to attach various 
information to a fax message. 

- See p.25 “SEP Code”, 
p.26 “SUB Code” 

Batch Trans. You can turn this function on or off. b p.30 “Batch Transmis-
sion” 

Forwarding You can turn this function on or off. b p.76 “Forwarding” 

Prog. Quick Dial Use when you want to register the 
other party's number as a Quick 
Dial destination. 

- See p.46 “Quick Dial”,  
<Basic Features>.

Monitor volume Use this to adjust the volume for 
the monitor and buzzer. 

- See p.70 “Adjusting Vol-
ume”,  <Basic Features>.
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Making a User Function Key 
Assignment

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until ” 2. Fax Fea-
tures” is displayed.

CCCC Press the {{{{OK}}}} key. 
Confirm that “ 1. Program / Delete
” is displayed

DDDD Press the {{{{OK}}}} key.

EEEE Press 0000 or 1111 to scroll and display
" 11. User Functions ". 

FFFF Press the {{{{OK}}}} key. 

GGGG Press the User Function key ({{{{F1}}}}
to {{{{F5}}}}) you want to assign. 

HHHH Press 0000 or 1111 to display the func-
tion name you want to assign. 

IIII Press the {{{{OK}}}} key. 

If you want to register another
User Function key, repeat the
above steps from step F. 

JJJJ Press the {{{{User Tools}}}} key. 

The machine returns to standby
display. 

Using a User Function Key

To use a User Function key ({{{{F1}}}} to
{{{{F5}}}}), press the User Function key
that contains the desired registered
function.

The display for Group function is reg-
istered.
The display changes for each as-
signed function.
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Deleting a User Function Key

To delete a User Function key, per-
form the following procedure.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until "2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Confirm that " 1. Program / Delete
" is displayed.

EEEE Press the {{{{OK}}}} key

FFFF Press 0000 or 1111 until " 11. User
Functions " is displayed.

GGGG Press the {{{{OK}}}} key

HHHH Press the User Function key you
want to delete. 

IIII Press 0000 or 1111 to display " None  ". 

JJJJ Press the {{{{OK}}}} key. 
If you want to delete another User
Function key, repeat the above
steps from step G. 

KKKK Press the {{{{User Tools}}}} key. 

The machine returns to standby
display. 
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Printing Reports/Lists

This function allows you to print the
following reports and lists manually.
Select a report or list as needed.
• Journal

See p.18 “Printing the Journal”.
• TX File List

See p.15 “Printing a Stored Mes-
sage (Print TX File)”.

• Quick Dial List
See p.46 “Quick Dial”,  <Basic Fea-
tures>.

• Speed Dial List
See p.52 “Speed Dial”,  <Basic Fea-
tures>.

• Group Dial List
See p.57 “Groups”,  <Basic Fea-
tures>.

• All Lists
You can print all Dial lists (Quick
Dial List, Speed Dial List and
Group Dial List).

• Quick Dial Label
See p.46 “Quick Dial”,  <Basic Fea-
tures>.

• Program List
See p.46 “Programs”.

• Auto Document Original
See p.49 “Storing an Often Used
Document (Auto Document)”

• User Function List
See p.53 “User Function Keys” 

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 2. Reports /
Lists " is displayed.

EEEE Press the {{{{OK}}}} key.

Printing the Journal 

A Confirm that " 1. Journal " is
displayed and press the {{{{OK}}}}
key.

Note
❒ If you make a mistake, press

the {{{{Cancel}}}} key and try
again.

Printing a TX File List

A Press 0000 or 1111 until " 2. TX File
List " is displayed.

B Press the {{{{OK}}}} key.

Note
❒ If you make a mistake, press

the {{{{Cancel}}}} key and try
again.
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Printing the Quick Dial List 

A Press 0000 or 1111 until " 3. Dial List
" is displayed.

B Press the {{{{OK}}}} key.

Confirm that " 1. Quick Dial List
" is displayed. 

C Press the {{{{OK}}}} key.

Note
❒ If you make a mistake, press

the {{{{Cancel}}}} key and try
again.

Printing the Speed Dial List

A Press 0000 or 1111 until " 3. Dial List
" is displayed.

B Press the {{{{OK}}}} key

C Press 0000 or 1111 until " 2. Speed
Dial List " is displayed.

D  Press the {{{{OK}}}} key

Note
❒ If you make a mistake, press

the {{{{Cancel}}}} key and try
again.

Printing the Group Dial List

A Press 0000 or 1111 until " 3. Dial List
" is displayed.

B Press the {{{{OK}}}} key

C Press 0000 or 1111 until " 3. Group
Dial List " is displayed.

D Press the {{{{OK}}}} key

Note
❒ If you make a mistake, press

the {{{{Cancel}}}} key and try
again.

Printing the All Lists

You can print all Dial Lists (Quick
Dial List, Speed Dial List and
Group Dial List) by the following
operation.
A Press 0000 or 1111 until " 3. Dial List

" is displayed. 

B Press the {{{{OK}}}} key.

C Press 0000 or 1111 until “ 4. All Lists
” is displayed.

D Press the {{{{OK}}}} key.

Note
❒ If you make a mistake, press

the {{{{Cancel}}}} key and try
again.
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Printing the Quick Dial Label

A Press 0000 or 1111 until " 4. Quick
Dial Label " is displayed. 

B Press the {{{{OK}}}} key.

Note
❒ If you make a mistake, press

the {{{{Cancel}}}} key and try
again.

Printing the Program List

A Press 0000 or 1111 until “ 5. Pro-
gram List“ is displayed.

B Press the {{{{OK}}}} key.

Note
❒ If you make a mistake, press

the {{{{Cancel}}}} key and tray
again.

Printing the Auto Document 
Original

A Press 0000 or 1111 until “ 6. Auto
Doc. Orig.“ is displayed.

B Press the {{{{OK}}}} key.

Note
❒ If you make a mistake, press

the {{{{Cancel}}}} key and tray
again.

C Scroll 0000 or 1111, or press the
Quick Dial key that contains
the Auto Document Original
you want to print.

D Press the {{{{OK}}}} key.

Printing the User Function List

A Press 0000 or 1111 until " 7. U Func-
tion List " is displayed.

B Press the {{{{OK}}}} key.

Note
❒ If you make a mistake, press

the {{{{Cancel}}}} key and try
again.

FFFF Press the {{{{Start}}}} key.

GGGG Press the {{{{User Tools}}}} key.

The machine returns to the stand-
by display.
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Adjusting the Display Contrast

Use this function to adjust the bright-
ness of the display.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 3. Setup " is
displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press 0000 or 1111 until " 2. Display
Contrast " is displayed. 

GGGG Press the {{{{OK}}}} key. 

HHHH Press 0000 or 1111 to adjust the bright-
ness of the display.

IIII Press the {{{{OK}}}} key.

JJJJ Press the {{{{User Tools}}}} key to re-
turn to the standby display.
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Setting the Date and Time 

Use this function to set your ma-
chine's internal clock to the current
time and date. 
If the current date and time are
wrong, use this procedure to correct
them.  

Note
❒ If you make a mistake when enter-

ing numbers, press the {{{{Clear/Stop}}}}
key and try again. 

❒ The machine automatically sets the
internal clock one hour ahead
when daylight saving time begins,
and one hour back when it ends.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 3. Setup " is
displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press 0000 or 1111 until " 3. Date/Time
" is displayed. 

GGGG Press the {{{{OK}}}} key.

HHHH Use the number keys to enter the
year.

IIII  Press the {{{{OK}}}} key

JJJJ Press 0000 or 1111 to select the correct
month.

KKKK Press the {{{{OK}}}} key.

LLLL Use the number keys to enter the
correct number for the date (1 to 31).

MMMM Press the {{{{OK}}}} key.

NNNN Press 0000 or 1111 to select “AM” or “PM”.

OOOO Press the {{{{OK}}}} key.

PPPP Use the number keys to enter the
correct time.

Enter the current hour setting (1 to
12), and then use the number keys
to enter a 2-digit number for the
current minute setting (00 to 59)

QQQQ Press the {{{{OK}}}} key. 

RRRR Press the {{{{User Tools}}}} key to re-
turn to standby display.
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Setting the Auto Ring Time 

In Auto Select mode, the machine
rings a number of times to give you
the chance to pick up the handset be-
fore taking the call automatically.
You can change the number of rings
with the Auto Ring Time.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 3. Setup " is
displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press 0000 or 1111 until "5.No.of
Rings" is displayed.

GGGG Press the {{{{OK}}}} key.

HHHH Enter the new number using the
number keys.

Note
❒ If you make a mistake, press the

{{{{Clear/Stop}}}} key and try again.

IIII Press the {{{{OK}}}} key.

JJJJ Press the {{{{User Tools}}}} key to re-
turn to the standby display.
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Changing the Paper Size Setting

When you change a paper size on the
main paper tray, optional paper tray
unit, or the bypass tray, you need to
change the paper size setting. 
This section explains how to change
the size of paper set in the main paper
tray, the optional paper tray unit, or
the bypass tray. 

Note
❒ If you do not use standard size pa-

per for the bypass tray, you should
enter vertical and horizontal di-
mensions. The sizes that you can
enter are as follows:

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until “ 2. Fax Fea-
tures “ is displayed.

CCCC Press the {{{{OK}}}} key. 

DDDD Press 0000 or 1111 until "3. Setup" is
displayed.

EEEE Press the {{{{OK}}}} key.

FFFF Press 0000 or 1111 until "7. Tray Paper
Size" is displayed. 

GGGG Press the {{{{OK}}}} key. 

HHHH Press 0000 or 1111 to display the tray
whose paper size you want to
change. 

If the optional tray unit or bypass
tray are not installed, they are not
displayed. Proceed to step J. 

IIII Press the {{{{OK}}}} key. 

If you choose bypass tray on step
H, press 0 or 1 to choose “ Stan-
dard Size “ or “ Custom Size “, and
then press the {{{{OK}}}} key.

JJJJ Press 0000 or 1111 to display the paper
size you want to set. 

If you choose “ Custom Size “ on
step I, enter the horizontal size
with the number keys and press
the {{{{OK}}}} key. Then enter the verti-
cal size with the number keys.

KKKK Press the {{{{OK}}}} key. 

If you want to change the paper
size for another tray, repeat the
above steps from step H. 

LLLL Press the {{{{User Tools}}}} key. 

The machine returns to standby
display. 

Metric version • Vertical: 90 – 216mm

• Horizontal: 140 – 
356 mm

Inch version • Vertical: 3.5" – 8.5"

• Horizontal: 5.5" – 14"

StellaF1EN-3_FM.book  Page 62  Monday, November 12, 2001  11:40 AM



Changing the Paper Type for Bypass Tray

63

6

Changing the Paper Type for Bypass Tray

You can print the original to OHP
transparencies and thick paper using
the bypass tray. When you set these
kinds of paper on the bypass tray,
you need to set the paper type. 
Perform the following procedure to
set the paper type for bypass tray.

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until “ 2. Fax Fea-
tures“ is displayed.

CCCC Press the {{{{OK}}}} key. 

DDDD Press 0000 or 1111 until "3. Setup" is
displayed.

EEEE Press the {{{{OK}}}} key.

FFFF Press 0000 or 1111 until “8. Bypass Pa-
per Type“ is displayed.

GGGG Press the {{{{OK}}}} key.

HHHH Choose the paper type using 0000 or
1111 .

IIII Press the {{{{OK}}}} key.

JJJJ Press the {{{{User Tools}}}} key. 
The machine returns to standby
display. 
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Setting the Fax Reset Timer

This machine automatically returns
to the standby display if you do not
use the machine for a certain period
of time. You can select this period.
You can select  30 seconds,  one
minute, three minutes, or five min-
utes for the period.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 3. Setup " is
displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press 0000 or 1111 until "9. Fax Reset
Timer" is displayed. 

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 to select a period of
time.

IIII Press the {{{{OK}}}} key.

JJJJ Press the {{{{User Tools}}}} key to re-
turn to the standby display.
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On Hook Timeout

This machine automatically cancels
the On Hook Dial mode if you do not
dial a number from the number keys
for a certain period of time after
pressing the {{{{On Hook Dial}}}} key. You
can select this period.
You can select one minute, three min-
utes, five minutes, ten minutes for the
period.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 3. Setup " is
displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press 0000 or 1111 until "10. On Hook
Timeout" is displayed. 

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 to select a period of
time.

IIII Press the {{{{OK}}}} key.

JJJJ Press the {{{{User Tools}}}} key to re-
turn to standby display.
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Selecting the Display Language

If you would rather use another lan-
guage for messages and a display, fol-
low the procedure below.

Note
❒ Make sure that your machine is in

standby display before following
this procedure. If the standby dis-
play is not shown when you start,
the display may become tempo-
rarily jumbled up.

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 4. Language
" is displayed. 

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 to display the lan-
guage you want to select. 

EEEE Press the {{{{OK}}}} key.

FFFF Press the {{{{User Tools}}}} key. 
The machine returns to standby
display.
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Function List

Here is a list of the functions that are available for setting. Please refer to the ref-
erence page numbers for more information.

Display 
(Specs.)

Description Reference

1. ADF 
Counter Reset

Allows you to clear the counter after re-
placing the ADF Maintenance Kit.

p.69 “Resetting the ADF Counter”

2. Authorized 
RX

Allows you to limit receiving of fax mes-
sages to specified senders that your reg-
ister on your fax machine. All fax 
messages other than specified senders 
are not received, thus preventing you 
from receiving junk fax messages.

p.70 “Authorized Reception”

3. Memory 
Lock

Allows you to have messages from spec-
ified senders stored in memory and not 
printed as soon as they are received. To 
print the fax messages, you must enter 
an ID.

p.72 “Memory Lock” 

4. Specified 
Tray

Allows you to have messages from spec-
ified senders printed from a different 
tray. This item is available only after the 
optional Second Paper Cassette has been 
installed.

p.74 “Specified Tray”

5. Forwarding Allows you to automatically forward fax 
messages to the fax machines of speci-
fied senders.

p.76 “Forwarding” 

6. Energy Save 
Timer

Allows you to have the fax switch off 
and on at specified times to save energy.

p.83 “Energy Save Timer”

7. User Param-
eters

Allows you to customize various default 
settings as required.

p.85 “User Parameters” 

8. Personal 
Code

Allows you to set up personal codes for 
using the Restricted Access. Before us-
ing the fax machine, users must enter the 
Personal Code. This allows you to limit 
transmission to specified senders.

p.91 “Personal Codes” 

9. ID Code Allows you to register IDs required for 
various types of transmissions.

p.94 “ID Code” 

10. Line Type Allows you to match the fax machine to 
the type of line you use: a tone line or a 
pulse line. 

p.96 “Line Type”
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Copy this table and use it as a quick reference. 

11. Select Line Allows you to select an internal G3 com-
munication line or external telephone 
line for your fax machine.

p.96 “Select Line”

12. PSTN Ac-
cess No.

Allows you to specify the code used to 
access an outside line when dialing.

p.97 “PSTN Access Number” 

13. Mem. File 
Trans.

Allows you to send all messages stored 
in memory to another fax machine and 
print them out there, for example, when 
your fax machine runs out of toner.

p.98 “Memory File Transfer” 

14. Margin Ad-
just

Allows you to adjust paper settings 
when you receive fax messages that are 
blank or partially missing.

p.99 “Margin Adjust”

15. RDS 
On/Off

Allows you to switch on RDS (Remote 
Diagnostic System) so a service repre-
sentative can test your fax machine re-
motely from a service station, diagnose 
the problem, and can change your ma-
chine settings to correct the problem.

p.100 “RDS (Remote Diagnostic 
System)”

Display 
(Specs.)

Description Reference
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Using Key Operator Settings

This chapter explains about functions
the key operator handles.

Resetting the ADF Counter

You need to replace the ADF Mainte-
nance Kit when you are prompted to
do so by “Change ADF Maintenance
Kit” message is displayed.
If you replace the ADF Maintenance
Kit when this message is displayed,
you do not need to reset the counter.
However, if you replace the ADF
Maintenance Kit when this message
is not displayed, you must follow the
procedure below to reset the counter.

Reference
See p.113 “Replacing the ADF
Maintenance Kit”. 

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed.

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Confirm that "1. ADF Counter Re-
set " is displayed. 

IIII Press the {{{{OK}}}} key. 

JJJJ Press 0000 or 1111 to select "Reset". 

KKKK Press the {{{{OK}}}} key. 

The counters are cleared. 

LLLL Press the {{{{User Tools}}}} key. 

The machine returns to standby
display. 
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Authorized Reception

You can block junk fax messages and
save paper by limiting the fax mes-
sages that your fax machine receives
to a list of specified senders. If you re-
ceive a fax message from someone
who is not a specified sender, the line
is disconnected immediately as soon
as you receive the call. 
• To use this function you must

switch Authorized Reception on
after you register the specified
senders.

• You can select to receive fax mes-
sages only from Specified senders,
or you can select to receive all mes-
sages from senders other than
from specified senders. See p.85
“User Parameters” (switch 08, bits
3 and 2). 

• In order for this feature to operate
correctly, at least one specified
sender must be registered. 

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed.

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until  "2. Autho-
rized RX" is displayed. 

IIII Press the {{{{OK}}}} key.

JJJJ Follow the procedures below to
switch Authorized Reception
On/Off, register a Specified Send-
er, or print a list of Specified
Senders. 

Switching Authorized Reception 
On/Off

A Press the {{{{OK}}}} key. 

B Press 0000 or 1111 to select "On" or
"Off".

C Press the {{{{OK}}}} key.

Note
❒ If no specified senders are

registered when you select
“On”, you will be prompted
to register a specified sender.
Press the {{{{OK}}}} key and fol-
low the procedure (steps C
to F) for "Registering a Spec-
ified Sender for Authorized
Reception" below. 
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Registering a Specified Sender 
for Authorized Reception 

Follow this procedure to register
specified senders for Authorized
Reception. Registration uses the
other party's Own Name (for dis-
play) or fax number. If the other
party is using a fax machine of the
same manufacturer, then registra-
tion uses the Own Name of the
other party registered on their fax
machine. If the other fax machine
is of a different manufacturer, then
registration uses the other party's
fax number. 

Limitation
❒ Destinations that you select as

specified senders must have
their names and fax numbers
registered on your fax machine. 

Note
❒ You can register up to a total of

30 specified senders for Autho-
rized Reception, Memory Lock,
Specified Tray, and Memory
File Transfer.

❒ A specified sender name can be
up to 20 characters long. 

❒ You can confirm the names and
fax numbers of Specified Send-
ers by name in the printed Jour-
nal.

❒ You can also confirm Specified
Senders by printing a Specified
Sender list. 

❒ In order to change a Specified
Sender entry, you must first de-
lete the entry, and then re-enter
it. 

A Press 0000 or 1111  until "2. Program
Sender" is displayed. 

B Press the {{{{OK}}}} key. 

C Enter the name for the speci-
fied sender. 

Enter the other party's name or
fax number. 

Reference
For details about how to en-
ter names, see p.67 “Entering
Characters”,  <Basic Fea-
tures>.

D Press the {{{{OK}}}} key. 

E If you want to specify a wild-
card, press the 0000 or 1111 key to
select "Yes", or select "No". 

Reference
See p.68 “Wild Cards”,  <Ba-
sic Features>. 

F Press the {{{{OK}}}} key. 

The specified sender is regis-
tered. 
If you want to register another
specified sender, repeat from
step B. 

Deleting a Specified Sender for 
Authorized Reception

Follow this procedure to delete a
Specified Sender. 
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A Press 0000 or 1111  to select "3. De-
lete Sender". 

B Press the {{{{OK}}}} key. 

C Press the 0000 or 1111 key to select
the name of the Specified
Sender that you want to delete. 

D Press the {{{{OK}}}} key. 

The Specified Sender is deleted.
If you want to delete more Spec-
ified Senders, repeat the above
steps from step B. 

Printing a List of Specified 
Senders for Authorized Reception

Follow this procedure to print a list
so you can confirm the currently
registered specified senders. 
A Press 0000 or 1111  to display " 4.

Print Sender List ". 

B Press the {{{{OK}}}} key.
C Press the {{{{Start}}}} key. The list

prints. 

Note
❒ All the Specified Senders reg-

istered for Authorized Re-
c ep t i on ,  M e m o r y  Lo c k ,
Specified Tray, and Memory
File Transfer are printed in
the same list. 

KKKK Press the {{{{User Tools}}}} key. 

The fax machine returns to stand-
by display. 

Memory Lock

This is a security function to prevent
unauthorized individuals from read-
ing printed fax messages. When
Memory Lock is switched on, all re-
ceived messages are stored in memo-
ry and are not automatically printed.
To print the messages, you have to
enter the Memory Lock ID.

Limitation
❒ Memory Lock cannot be selected

until you have registered the
Memory Lock ID. 

❒ To use this function you must
switch Memory Lock on after you
register the Memory Lock ID.

Note
❒ Before you can use this function,

you must register the Memory
Lock ID. See p.94 “ID Code” 

❒ You can select to lock only messag-
es from specified senders, or you
can select to lock messages from
senders other than from specified
senders. See p.85 “User Parame-
ters” (switch 09, bits 1 and 0). 

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.
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DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until " 3. Memory
Lock " is displayed. 

IIII Press the {{{{OK}}}} key. 

JJJJ Follow the procedures below to
switch Memory Lock On/Off, reg-
ister a Specified Sender, delete a
Specified Sender, or print a list of
Specified Senders.

Switching Memory Lock On/Off 

A Press the {{{{OK}}}} key. 

B Press 0000 or 1111 to "On" to switch
this function on, or select "Off"
to switch this function off. 

C Press the {{{{OK}}}} key. 

Registering a Specified Sender 
for Memory Lock

You can register Specified Senders
for this function. 
A Press 0000 or 1111 to display " 2.

Program Sender ". 

B Press the {{{{OK}}}} key. 
C Enter “Own Name” or “Own

Fax Number” for the Specified
Sender. 

Enter the other party's “Own
Name” or “Own Fax Number” 

D Press the {{{{OK}}}} key. 

E If you want to specify a wild
card, press 0000 or 1111 key to select
"Yes". 

F Press the {{{{OK}}}} key. 

The Specified Sender is regis-
tered. 
If you want to register another
Specified Sender, repeat from
step B. 

Deleting a Specified Sender for 
Memory Lock 

You can delete Specified Senders
for this function. 
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A Press 0000 or 1111 to select " 3. De-
lete Sender ". 

B Press the {{{{OK}}}} key. 

C Press 0000 or 1111 to select the
name of the Specified Sender
that you want to delete. 

D Press the {{{{OK}}}} key. 

The Specified Sender is deleted.
If you want to delete more Spec-
ified Senders, repeat from step
B. 

Printing a List of Specified 
Senders for Memory Lock

You can print a list of Specified
Senders for Memory Lock. 
A Press 0000 or 1111 to display " 4.

Print Sender List ". 

B Press the {{{{OK}}}} key.

C Press the {{{{Start}}}} key. The list
prints. 

KKKK Press the {{{{User Tools}}}} key to re-
turn to the standby display.

Specified Tray

Use this function to have messages
from specified senders printed on dif-
ferent paper. For example, imagine
green paper placed in the main paper
tray, and white paper placed in the
optional paper tray unit. By choosing
to have fax messages from specified
senders printed on green paper and
all others printed on white paper, you
can distinguish between them at a
glance. 

Limitation
❒ This item is available only after the

optional paper tray unit has been
installed. 

Note
❒ To use this function you must

switch Specified Tray on after you
register the specified senders.

❒  You can select to print fax messag-
es from specified senders on the
paper loaded in the  main paper
tray or you can select to print fax
message from non-specified send-
ers on the paper loaded in the main
paper tray. See  p.85 “User Param-
eters” (switch 08, bits 5 and 4). 

❒ Make sure that you place the same
size paper in the main paper tray
and the optional Second Tray. If
you do not place the same size pa-
per for both paper supplies, the re-
ceived messages will be stored in
memory.

AAAA Press the {{{{User Tools}}}} key.
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BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed.

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until  " 4. Specified
Tray " is displayed. 

IIII Press the {{{{OK}}}} key. 

JJJJ Follow the procedures below to
switch Specified Cassette On/Off,
register a Specified Sender, delete
a Specified Sender, or print a list
of Specified Senders. 

Switching Specified Tray On/Off

A Press the {{{{OK}}}} key. 

B Press 0000 or 1111  to select "On" to
switch this feature on, or select
"Off" to switch this feature off. 

C Press the {{{{OK}}}} key. 

Registering a Specified Sender 
for Specified Tray

You can register Specified Senders
for this function. 
A Press 0000 or 1111  until "2. Program

Sender" is displayed. 

B Press the {{{{OK}}}} key. 

C Enter the name for the speci-
fied sender. 

Enter the other party's name or
fax number. 

Reference
For details about how to en-
ter names, see p.67 “Entering
Characters”,  <Basic Fea-
tures>.

D Press the {{{{OK}}}} key. 

E If you want to specify a wild-
card, press the 0000 or 1111 key to
select "Yes", or select "No". 

Reference
See p.68 “Wild Cards”,  <Ba-
sic Features>. 
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F Press the {{{{OK}}}} key. 

The specified sender is regis-
tered. 
If you want to register another
specified sender, repeat from
step B. 

Deleting a Specified Sender for 
Specified Tray 

You can delete Specified Senders
for this function. 
A Press 0000 or 1111  to select "3. De-

lete Sender". 

B Press the {{{{OK}}}} key. 

C Press the 0000 or 1111 key to select
the name of the Specified
Sender that you want to delete. 

D Press the {{{{OK}}}} key. 

The Specified Sender is deleted.
If you want to delete more Spec-
ified Senders, repeat the above
steps from step B. 

Printing a List of Specified 
Senders for Specified Tray 

You can print a list of Specified
Senders for Specified Tray. 
A Press 0000 or 1111  to display "4.

Print Sender List". 

B Press the {{{{OK}}}} key.

C Press the {{{{Start}}}} key. The list
prints. 

Note
❒ All the Specified Senders reg-

istered for Authorized Re-
c ep t io n ,  M e m o ry  L o c k ,
Specified Tray, and Memory
File Transfer are printed in
the same list. 

KKKK Press the {{{{User Tools}}}} key. 

The fax machine returns to stand-
by. 

Forwarding

Use this function to print fax specified
from Specified Senders on your own
machine and then forward the mes-
sages to other fax machines. This is
useful, for example, if you are visiting
another office and would like copies
of your messages from the head office
forwarded to you so you can read
them. 
In this section, the machines that mes-
sages are forwarded to are referred to
as Forwarding Stations. The locations
from which you would like messages
forwarded from are referred to as
Specified Senders.
You can register:
• 30 Forwarding Stations 
• 30 Specified Senders (maximum 10

per Forwarding Station, up to 20
characters each)

• Wild Cards 

Important
❒ We recommend that you print the

Forwarding/Sender list and keep
it when you register or change a re-
ceiver or sender. 
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Limitation
❒ The Forwarding function does not

forward messages received with
Polling Reception mode.

❒ You cannot register a sender who
does not have an Own Name or
Own Fax Number.

Note
❒ You can register up to 30 senders

for the Forwarding function. You
sometimes cannot register 30 send-
ers depending on the number of
senders registered with other func-
tions.

❒ To register a sender, use an Own
Name or Own Fax Number.

❒ You can find out the Own Name or
Own Fax Number of a sender by
looking in the destination name
column of the Journal.

----Forwarding Mark
You can print a forwarding mark on
forwarded messages. See p.85 “User
Parameters” (Switch02, Bit0).

Switching Forwarding On/Off

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until  " 5. Forward-
ing " is displayed. 

IIII Press the {{{{OK}}}} key. 

Confirm that ” 1. On/Off ” is dis-
played.

JJJJ Press the {{{{OK}}}} key.

GFMTEN0J
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KKKK Press 0000 or 1111 to “On” to switch
this function on, or select “Off” to
switch this function off. 

LLLL Press the {{{{OK}}}} key. 

Note
❒ If you select “On” and no for-

warding station is registered,
“Press OK to Program Forward-
ing Station” is displayed. Press
the {{{{OK}}}} key, and then register
a forwarding station by follow-
ing steps L to R on p.78 “Regis-
tering Forwarding Stations”.

MMMM Press the {{{{User Tools}}}} key to re-
turn to the standby display.

Registering Forwarding Stations

You can register a Forwarding Station
as follows.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools ” is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until " 5. Forward-
ing " is displayed. 

IIII Press the {{{{OK}}}} key. 

JJJJ Press 0000 or 1111 until " 2. Prog. Sta-
tion " is displayed. 

KKKK Press the {{{{OK}}}} key. 

LLLL Press 0000 or 1111 to display the num-
ber of the forwarding station you
want to register. 

If a forwarding station is already
registered, the fax number for that
station is displayed. 

MMMM Press the {{{{OK}}}} key. 

NNNN Enter the other party's fax number
with the number keys. 
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OOOO Press the {{{{OK}}}} key. 

The Forwarding Station's fax num-
ber is registered. 

PPPP Press the {{{{OK}}}} key.

QQQQ Enter the other party's name. 

RRRR Press the {{{{OK}}}} key. 

SSSS If you want to register the Speci-
fied Sender as a Wildcard, press
0000 or 1111 to select " Yes ".

TTTT Press the {{{{OK}}}} key. 

To register another Specified Send-
er, repeat the above steps from
step P. 
To register a different Forwarding
Station, press the {{{{Cancel}}}} key and
repeat the above steps from step K. 

Note
❒ Names for Specified Senders

can be up to 24 characters long. 
❒ You can confirm the names and

fax numbers of Specified Send-
ers on the Journal. 

❒ You can confirm registered
Specified Senders using the
Specified Sender list. 

UUUU Press the {{{{User Tools}}}} key to re-
turn to the standby display.

Editing a Forwarding Station

To edit a Forwarding Station that is
already registered, perform the fol-
lowing procedure.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until " 5. Forward-
ing ” is displayed. 

IIII Press the {{{{OK}}}} key. 
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JJJJ Press 0000 or 1111 until " 2. Prog. Sta-
tion " is displayed. 

KKKK Press the {{{{OK}}}} key.

LLLL Press 0000 or 1111 to display the fax
number of the Forwarding Sta-
tion you want to edit. 

MMMM Press the {{{{OK}}}} key. 

NNNN Press the {{{{Clear/Stop}}}} key, and
then enter the Forwarding Sta-
tion's correct fax number. 

OOOO Press the {{{{OK}}}} key. 

The fax number is registered. 
If you want to edit another For-
warding Station, press the {{{{Can-
cel}}}} key and repeat the above steps
from step K.

PPPP Press the {{{{User Tools}}}} key to re-
turn to the standby display.

Editing a Specified Sender

To edit a Specified Sender, delete the
Specified Sender you want to edit
(See p.81 “Deleting a Specified Send-
er”), and then register it as a new
Specified Sender. (See p.78 “Register-
ing Forwarding Stations”).

Deleting a Forwarding Station

To delete a Forwarding Station, per-
form the following procedure.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools “ is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until " 5. Forward-
ing " is displayed. 

IIII Press the {{{{OK}}}} key. 

JJJJ Press 0000 or 1111 until " 3. Delete Sta-
tion " is displayed. 
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KKKK Press the {{{{OK}}}} key. 

LLLL Press 0000 or 1111 to display the fax
number of the Forwarding Sta-
tion you want to delete. 

MMMM Press the {{{{OK}}}} key.

The Forwarding Station is deleted. 
If you want to delete another For-
warding Station, repeat the proce-
dure from step K. 

NNNN Press the {{{{User Tools}}}} key to re-
turn to the standby display.

Deleting a Specified Sender 

To delete a Specified Sender, perform
the following procedure.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until " 5. Forward-
ing " is displayed. 

IIII Press the {{{{OK}}}} key. 

JJJJ Press 0000 or 1111 until " 2. Prog. Sta-
tion " is displayed. 

KKKK Press the {{{{OK}}}} key. 

LLLL Press 0000 or 1111 to display the fax
number of the Forwarding Sta-
tion that contains the Specified
Sender you want to delete. 

MMMM Press the {{{{OK}}}} key. 

NNNN Press the {{{{OK}}}} key.

OOOO Press 0000 or 1111 until " 2. Delete
Sender " is displayed. 

PPPP Press the {{{{OK}}}} key. 
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QQQQ Use 0000 or 1111 to display the Speci-
fied Sender you want to delete. 

RRRR Press the {{{{OK}}}} key. 

The Specified Sender is deleted. 
If you want to delete another Spec-
ified Sender, repeat the above
steps from step P. 

SSSS Press the {{{{User Tools}}}} key to re-
turn to the standby display.

Printing the Specified Sender list

You can check which Specified Send-
ers are registered for a Forwarding
Address. 
Follow the steps below to print this
list.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until " 5. Forward-
ing " is displayed. 

IIII Press the {{{{OK}}}} key. 

JJJJ Press 0000 or 1111 until " 4. Print Send-
er List " is displayed. 

KKKK Press the {{{{OK}}}} key. 

LLLL Press the {{{{Start}}}} key. 

The list is printed. 

MMMM Press the {{{{User Tools}}}} key to re-
turn to the standby display.
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Energy Save Timer

Use this function to have the fax ma-
chine turn its heater on and off auto-
matically at specified times. For
example, by having the heater turned
off during the evening, on weekends,
and during long holidays, you can re-
duce power costs.

Note
❒ You can set the timer switch on

and off twice daily over a 1-week
period. 

❒ When the heater is off, incoming
faxes are received in memory with
Substitute Reception and printed
when the heater is switched on. 

❒ To use this function you must
switch Energy Save Timer on after
you specify times for the fax ma-
chine to automatically switch on
and off. By default, Energy Save
Timer is switched off.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed.

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until  " 6. Energy
Save Timer " is displayed. 

IIII Press the {{{{OK}}}} key. 

JJJJ Perform the settings below to
switch the timer On/Off, and pro-
gram the timers. 

Switching the Energy Save Timer 
On/Off

A Press the {{{{OK}}}} key. 

B Press 0000 or 1111  to select "On" to
switch this feature on, or select
"Off" to switch this feature off. 

C Press the {{{{OK}}}} key. 

Programming the Energy Save 
Timer 

A Press the 0000 or 1111 key to select
"2. Date/Time Set". 

B Press the {{{{OK}}}} key. 
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C Press 0000 or 1111  to select the day
of the week.

D Press the {{{{OK}}}} key. 

E Press 0000 or 1111  to select “AM”
or “PM”.

F Press the {{{{OK}}}} key.
G Use the number keys to enter

the first  time for the first
On/Off switching.

Enter the time in the 24-hour
(1~12) and the minute setting
(00~59).

Note
❒ If you make a mistake, press

the {{{{Clear/Stop}}}} key and en-
ter the number again. 

H Press the {{{{OK}}}} key. 

I Use the 0000 or 1111" key to select
"On" or "Off". 

J Press the {{{{OK}}}} key. 

K Now, repeat steps EEEE to JJJJ to
program the time for the sec-
ond switching. 

If you register only one setting,
repeat the procedure with the
same settings. 

L If you want to set switches for
another day of the week, repeat
from step CCCC.  

KKKK Press the {{{{User Tools}}}} key. 

The fax machine returns to stand-
by display. 

Note
❒ When the heater is powered off,

the display is blank. When the
fax machine heater is switched
off with the Energy Save Timer,
you can restore the fax machine
to normal operation temporari-
ly by pressing the {{{{Energy Sav-
er /Clear  Modes}}}}  key so fax
messages in the memory can
print. If the fax machine re-
mains idle for more than 5 min-
utes, the fax machine will once
again switch off the heater auto-
matically. 
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User Parameters

The User Parameters allows you to customize various settings to match your
needs.
To change the function settings, set the user parameter switches.

Preparation
Access to some User Parameter Settings requires installation of optional
equipment or that other settings be made beforehand.

❖❖❖❖ Switches and Bits
User Parameters are divided into switches and each switch is divided into
eight bits. The right most bit is bit 0 and the left most is bit 7.

The User Parameter switches are outlined below.

Bit 
Number

7 6 5 4 3 2 1 0

Bit Value ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓

0 1 0 0 0 0 0 0

Switch Bit Item 1 0

    00 5,4 5, 4: Default resolution when you send a message.

 RESOLUTION 

00: Standard 

01: Detail

10: Fine 

11: Auto

      6 Default setting for trans-
mission.

TRANSMISSION MODE 

 Immediate  Memory 

 7 Home position  for the 
Original Type.

HALFTONE

 Photo  Text

 01 7 Return the machine to the 
default settings after each 
communication (Re-
turn to default 
after transmis-
sion)

On Off
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02 0 Default setting for printing 
the Forwarding Mark.

FORWARDING MARK 

On Off

 1 Default setting for the Cen-
ter Mark. 

CENTER MARK 

On  Off

 2 Default setting for printing 
the Reception Time. 

RECEPTION TIME 

On  Off 

3 Print Sender Information 
(TSI Print)

 On  Off

 4 Default setting for the 
Checkered Mark. 

CHECKERED MARK 

 On  Off

03 0 Automatic printing of the 
Communication Result Re-
port (Memory TX)

On Off

2 Automatic printing of the 
File Reserve Report (Mem-
ory TX)

On Off

3 Automatic printing of the 
File Reserve Report (Poll-
ing RX)

On Off

4 Automatic printing of the 
Communication Result Re-
port (Polling RX)

On Off

5 Automatic printing of the 
Transmission Result Re-
port (Immediate TX)

On Off

7 Automatic printing of the 
Journal 

On Off

04 0 Print the Confidential File 
Reports.

On Off

7 Include a portion of the im-
age on the Communication 
Result Report, File Reserve 
Report, Communication 
Failure Report.

On Off

Switch Bit Item 1 0
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05 0 Store incoming faxes when 
machine is out of supplies.

SUBSTITUTE RECEP-
TION 

 On  Off

 1 Default setting for Substi-
tute Reception.

CONDITIONS OF MEM-
ORY RECEPTION 

 Reject (If no 
name or fax 
number is re-
ceived) 

 Accept (Free)

4 Restricts fax machine us-
age to specific users. 

RESTRICTED ACCESS 

On Off

6 Default setting for the En-
ergy Saving function

ENERGY SAVER

Fax Standby 
(Heater half-cool)

Energy Saving 
Standby 

(Heater Off)

06 0 Default setting for a header 
with each page. FAX 
HEADER PRINT 

 On  Off

2 Default setting for Closed 
Network Transmission-
CLOSED NETWORK 
TRANSMISSION 

 On  Off

4 Default setting for Batch 
Transmission. BATCH 
TRANSMISSION 

 On  Off

07 2 Parallel Memory Trans-
mission

On Off

 4 Assign the Tone key as the 
{{{{pppp}}}} key on the operation 
panel. TONE SWITCH BY 
ASTERISK KEY 

 On  Off

Switch Bit Item 1 0
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08 3,2 Authorized Reception 00: Off

01: Received messages only from 
senders whose Own Name/Own 
Fax Number are registered 

11: Received messages only from 
senders whose Own Name/ Own 
Fax Number are not registered 

5, 4 Specified Tray Selection 00: Off

01: Messages from senders whose 
Own Name/Own Fax Number are 
registered are printed from the main 
paper tray.

11: Messages from senders whose 
Own Name/Own Fax Number are 
not registered are printed from the 
main paper tray.

6 Forwarding On Off

7 Forwarding 

0: Forward messages from Specified Senders only. 

1: Forward messages from non-Specified Senders only.

 09 0 Memory Lock On Off

1 Memory Lock  

0: Messages from Specified Senders are not printed unless you en-
ter the Memory Lock ID.

1: Messages from non-Specified Senders are not printed unless 
you enter the Memory Lock ID.

6 ADD DESTINATIONS 
WITH A SERIES OF 
QUICK DIALS 

On  Off

10 5 Selection of purpose for 
bypass tray. 

Only for option-
al Printer 

All 

7 Selection of a method for 
halftone mode. HALF-
TONE METHOD 

Speed method Standard method

11 2 Blank sheet transmissions 
are detected. 

DETECTION OF BLANK 
SHEET TRANSMISSION

On Off

6 Print the received message 
when acting as a Forward-
ing Station  PRINT MEM-
ORY TRANSFER FILES 

On Off

Switch Bit Item 1 0

StellaF1EN-3_FM.book  Page 88  Monday, November 12, 2001  11:40 AM



Using Key Operator Settings

89

7

Changing the User Parameters

We recommend that you print the
User Parameter list and keep it when
you register or change a user parame-
ter. See p.90 “Printing the User Pa-
rameter List”.
Do not change any bit switches other
than those shown on the previous
pages.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until " 7. User Pa-
rameters " is displayed. 

IIII Press the {{{{OK}}}} key. 

12 1 Distinctive Ring On Off

2 Toner Saving Mode On Off

7 Copy Mode Not Possible Possible

 13 0 Use the G3 line as an internal extension, or an outside line. 

PABX/PSTN 

1: PABX

0: PSTN

19 7,6,5 Set the tray which is selected first when copying. 

001: Tray1 

010: Tray2

111: Bypass Tray

20 4 Correct the black line made 
when scanning originals.  

On Off

7 Show warning when scan-
ner is found dirty

On Off

Switch Bit Item 1 0
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JJJJ Press the {{{{OK}}}} key. 

For a list of the switches and set-
tings, see p.85 “User Parameters”.
Use the User Parameters table to
look up the number of the switch
that you want to change, and then
press the 0 or 1 key to display
the number of the switch. 
The bits are numbered 7~0. To
change a setting, press the corre-
sponding number key to toggle the
setting between "0" and "1" 

For example, if you want to change
the setting at bit 7, press the 7 num-
ber key to toggle the setting be-
tween "1" and "0". 

KKKK When you are finished making
adjustments, press the {{{{OK}}}} key. 

LLLL Press the {{{{User Tools}}}} key to re-
turn to the standby display.

Printing the User Parameter List

Print this list to see the current User
Parameter settings. 

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 4. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until " 7. User Pa-
rameters " is displayed. 

IIII Press the {{{{OK}}}} key. 

Key to 
Press

7 6 5 4 3 2 1 0

SW 00: 1 0 0 0 0 1 1 0
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JJJJ Press the 0000 or 1111 key until " 2.
Print List " is displayed.

KKKK Press the {{{{OK}}}} key.

LLLL Press the {{{{Start}}}} key to print the
list.

Note
❒ If you press the {{{{Cancel}}}} key be-

fore printing starts, the list will
not be printed and the display
shown in step J appears again.

MMMM Press the {{{{User Tools}}}} key to re-
turn to the standby display.

Personal Codes

This function allows you to keep
track of machine usage. When Per-
sonal Codes are programmed, users
have to enter their Personal Code be-
fore they send a fax. This function is
used for the Restricted Access. See
p.94 “Restricted Access”

Important
❒ We recommend that you print the

Personal Code List and keep it
when you register or change a Per-
sonal Code. See p.93 “Printing the
Personal Code List”.

Note
❒ Personal Codes can be up to 8-dig-

its long, and you can enter the fol-
lowing numbers and symbols : 0 to
9, #, p, and spaces. 

❒ You can register up to 30 Personal
Codes. Each Personal Code name
can be up to 20 characters long.

Registering and Editing

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.
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DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until " 8. Personal
Code " is displayed.

IIII Press the {{{{OK}}}} key. 

Confirm that " 1. Prog. Pers. Code "
is displayed.

JJJJ Press the {{{{OK}}}} key. 

KKKK To register a new Personal Code ,
enter the Personal Code (8 digits
or less) with the number keys. To
edit a registered personal code,
press 0000 or 1111 to display the de-
sired Personal Code. 

LLLL Press the {{{{OK}}}} key. 

MMMM Enter the user name. 

NNNN Press the {{{{OK}}}} key.

OOOO Press the {{{{User Tools}}}} key to re-
turn to the standby display.

Deleting

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until " 8. Personal
Code " is displayed. 

IIII Press the {{{{OK}}}} key. 
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JJJJ Press 0000 or 1111 until " 2. Delete " is
displayed. 

KKKK Press the {{{{OK}}}} key. 

LLLL Press 0000 or 1111 to display the Per-
sonal Code you want to delete. 

MMMM Press the {{{{OK}}}} key. 

The Personal Code is deleted. 
If you want to delete another Per-
sonal Code, repeat the above steps
from step K. 

NNNN Press the {{{{User Tools}}}} key to re-
turn to the standby display.

Printing the Personal Code List

Print this list to find out the registered
Personal Codes and their names.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until " 8. Personal
Code " is displayed. 

IIII Press the {{{{OK}}}} key.

JJJJ Press 0000 or 1111 until " 3. Print List "
is displayed. 

KKKK Press the {{{{OK}}}} key. 

LLLL Press the {{{{Start}}}} key. 

The list is printed. 

MMMM Press the {{{{User Tools}}}} key to re-
turn to the standby display.
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Restricted Access

Use this function to limit transmis-
sion to specific users. When turned
on, users must enter a previously as-
signed Personal Code in order to
transmit originals.
The Restricted Access function makes
it possible to monitor machine usage
by user or department.

Preparation
In order to use this function, you
need to register the Personal Code
and turn this function on with the
User Parameters beforehand. See
p.91 “Registering and Editing”.
and p.85  “User  Parameters”
(Switch 05, Bit 4).

Note
❒ The machine returns to the state

where a Personal Code must be en-
tered to use the machine in the fol-
lowing situations:
• The machine is not used for a

certain time
• A previously set original is re-

moved
• The current operation is com-

pleted
❒ When Restricted Access is turned

on, incoming faxes are received
and printed as normal.

AAAA Check that the Restricted Access
display is shown.

BBBB Enter your personal code with the
number keys.

CCCC Press the {{{{OK}}}} key.

ID Code

Use this procedure to register the fol-
lowing kinds of ID Codes: 

Important
❒ You can confirm ID Codes in the

Parameter Settings list. We recom-
mend you print a new list each
time you register or change ID
Codes. 

❒ You can edit registered ID Codes
by performing the steps for regis-
tering ID Codes in the following
procedure. Display the ID Code
you want to change, and then
press the {{{{Clear/Stop}}}} key and re-
enter the ID Code. 

❖❖❖❖ Polling ID
This ID is required for using De-
fault ID Polling Reception. See p.9
“Calling to Request a Message
(Polling Reception)” 

Note
❒ You can enter A to F by the

Quick Dial keys.
❒ You can enter 0 to 9 by the num-

ber keys.
❒ 0000 and FFFF can not be en-

tered.
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❖❖❖❖ Confidential ID
This ID is required for printing a
message received with the Confi-
dential Reception function. See
p.16 “Printing a Confidential Fax
Message””.

❖❖❖❖ Memory Lock ID
This ID is required for printing a
message received using the Memo-
ry Lock function. See  p.17 “Print-
ing a Memory-locked Message”.

Note
❒ You can enter 0 to 9 by the num-

ber keys.
❒ 0000 can not be entered.

Registering 

To register ID Codes, perform the fol-
lowing procedure.
The following example is for Memory
Lock ID.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until " 9. ID Code "
is displayed. 

IIII Press the {{{{OK}}}} key. 

JJJJ Press 0000 or 1111 until " 3. Memory
Lock ID " is displayed. 

KKKK Press the {{{{OK}}}} key.

LLLL Enter the Memory Lock ID (4-dig-
its) with the number keys. 

If you make a mistake, press the
{{{{Clear/Stop}}}} key and try again. 

MMMM Press the {{{{OK}}}} key. 

If you want to enter another item,
repeat the above steps from step K. 

NNNN Press the {{{{User Tools}}}} key to re-
turn to the standby display.
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Line Type

You must match the fax machine to
the type of line you use: a tone line or
a pulse line. Then, you should con-
nect the line to the machine.

Note
❒ This function is not available in

some areas.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed.

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until "10. Line
Type" is displayed. 

IIII Press the {{{{OK}}}} key.

JJJJ Press 0000 or 1111 to set your machine
for a tone dial line or a pulse dial
line. 

KKKK Press the {{{{OK}}}} key.

LLLL Press the {{{{User Tools}}}} key to re-
turn to the standby display.

Select Line

When your machine is connected
through a PABX, change the Select
Line setting to Extension. If it is con-
nected directly to the telephone net-
work, leave it set to Outside.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed.

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.
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GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until "11. Select
Line" is displayed. 

IIII Press the {{{{OK}}}} key. 

JJJJ Press 0000 or 1111 and select "Exten-
sion" or "Outside". 

KKKK Press the {{{{OK}}}} key. 

LLLL Press the {{{{User Tools}}}} key. 

The machine returns to standby
display. 

PSTN Access Number

Use this setting to save having to en-
ter a pause after the PSTN access
number when dialing. When you pro-
gram an access number, a pause is au-
tomatically added as soon as that
number is pressed. For example, if
you register "0" as the PSTN Access
Number, a pause will be inserted au-
tomatically after dialing "0". 

Limitation
❒ This function does not work when

using On Hook mode or when di-
aling from an external telephone. 

Note
❒ After you have registered PSTN

access number, select the line to
PABX on User Parameters (Switch
13 Bit 0). 

❒ PSTN access numbers can be up to
2 digits long. 

To register an PSTN access number,
perform the following procedure. 

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until " 12. PSTN Ac-
cess No. " is displayed. 

IIII Press the {{{{OK}}}} key.

JJJJ Enter the PSTN access number (1
or 2-digits) with the number keys. 
If you make a mistake, press the
{{{{Clear/Stop}}}} key and try again. 
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KKKK Press the {{{{OK}}}} key. 

LLLL Press the {{{{User Tools}}}} key to re-
turn to the standby display.

Memory File Transfer 

If the machine cannot print out a re-
ceived message, you can send all mes-
sages currently stored in memory to
another fax machine and have them
printed out there (for example, when
toner is empty, paper has run out, or
the printing function is out of order).
All messages in memory including
Memory-locked messages can be sent
to another fax machine. Use this func-
tion when you are in an urgent situa-
tion.

Note
❒ Even if a transmission error occurs,

messages are not resent. 
❒ All documents are not erased from

memory regardless of whether for-
warding was successful or not. 

❒ Details of the forwarding opera-
tion are not printed in the Journal. 

To transfer all of the messages cur-
rently stored in memory, perform the
following procedure.

AAAA Press the {{{{User Tools}}}} key. 

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed. 

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until "4. Key Op.
Tools" is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 to display "13.
Mem. File Trans.". 

IIII Press the {{{{OK}}}} key. 

If no files are available, "No Files
Exist" is displayed. 

JJJJ Enter the transfer destination's
fax number with the number
keys. 

KKKK Press the {{{{Start}}}} key. 

File transfer starts. 
Once file transfer has finished, the
machine returns to standby dis-
play. 
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Margin Adjust

If image positioning needs to be ad-
justed slightly, adjust the margins for
the appropriate tray (the main paper
tray, the optional paper tray unit, or
the bypass tray).
• You can adjust the margins in 13

steps up or down, left or right. 
• You can adjust the position of the

printed image in 0.5 mm steps. 
To adjust margins, perform the fol-
lowing procedure.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until " 2. Fax Fea-
tures " is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until " 4. Key Op.
Tools " is displayed.

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until  "14. Margin
Adjust" is displayed. 

IIII Press the {{{{OK}}}} key. 

JJJJ Press 0000 or 1111 to display the tray
you want to adjust the margins
for. 

Note
❒ The optional Tray Unit is dis-

played as "Tray 2", and the by-
pass tray as "Bypass". 

KKKK Press the {{{{OK}}}} key. 

LLLL Press 0000 or 1111 and select "1. Top
Margin" or "2. Left Margin". 

Note
❒ You can view the margins by

using 0 or 1 to select "3. Test
Print", and then press the {{{{OK}}}}
key.

MMMM Press the {{{{OK}}}} key. 

NNNN Press 0000 or 1111 and adjust the mar-
gins. 

Press the 0 key to move the arrow
(T) to the left and reduce the im-
age. 
Press the 1 key to move the arrow
(T) to the right and enlarge the im-
age. 
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OOOO Press the {{{{OK}}}} key.

The margins are set. 
If you want to adjust a margin for
the same tray, repeat the process
from step L. If you want to adjust a
margin for another tray, press the
{{{{Cancel}}}} key, and then repeat the
procedure from step J. 

PPPP Press the {{{{User Tools}}}} key. 

The machine returns to standby
display. 

RDS (Remote Diagnostic System)

If your machine has a problem, a ser-
vice representative can perform vari-
o us  d ia g n o s t i c  t a sk s  o v e r  t he
telephone line from the service sta-
tion to try to find out what is wrong
with your machine. The service repre-
sentative can also use RDS to change
some of your machine's settings if
you request it.

AAAA Press the {{{{User Tools}}}} key.

BBBB Press 0000 or 1111 until "2. Fax Fea-
tures" is displayed.

CCCC Press the {{{{OK}}}} key.

DDDD Press 0000 or 1111 until "4. Key Op.
Tools" is displayed. 

EEEE Press the {{{{OK}}}} key. 

FFFF Press {{{{2}}}}{{{{2}}}}{{{{2}}}}{{{{2}}}}.

GGGG Press the {{{{OK}}}} key.

HHHH Press 0000 or 1111 until "15. RDS
On/Off" is displayed. 

IIII Press the {{{{OK}}}} key. 

JJJJ Press 0000 or 1111 and select "On" or
"Off".

KKKK Press the {{{{OK}}}} key. 

LLLL Press the {{{{User Tools}}}} key to re-
turn to the standby display. 
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Printing the Help List 

Press the {{{{Help}}}} key and {{{{Start}}}} key
to print a copy of the Help List which
contains brief descriptions about the
following features: 
• Immediate/Memory Transmis-

sion 
• Canceling Memory Transmission 
• Programming/Clearing Quick Di-

als 
• Printing lists of Quick Dials and

User Function keys 
• Programming/Clearing Speed Di-

als 
• Printing the Speed Dial List
• Printing the Journal  
• Printing the Quick Dial Key Label

and User Function Key Label
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Clearing a Copy, Fax or Print Jam

Clearing a Copy, Fax, or Print 
Jam in the Optional Paper Tray 
Unit

To clear jams in the optional paper
tray unit, perform the following pro-
cedure. 

AAAA Open the lower right cover.

BBBB Pull the jammed paper out slow-
ly.

CCCC Close the lower right cover mak-
ing sure it clicks firmly into place.
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Reading Reports

Error Report 

An error report is printed when a
message could not be successfully
sent or received.
Possible causes include a problem
with your machine or noise on the
telephone line . If an error occurs dur-
ing transmission, re-send the original.
If an error occurs during reception,
ask the sender to re-send the message.

Note
❒ If the error happens frequently,

contact your service representa-
tive.

❒ The "Page" column gives the total
number of pages. The "Page Not
Sent" column gives the number of
pages that were not sent or re-
ceived successfully.

Power Failure Report

Even if the power switch is turned off,
the contents of the machine's memory
(for example, programmed numbers)
will not be lost. However, if power is
lost for a certain period of time
through the power switch being
turned off, a power cut or the power
cable being removed, contents of the
Fax memory will be lost. Lost items
will include any fax messages stored
in memory using Memory Transmis-
sion or Reception.

If a file has been deleted from memo-
ry, a Power Failure Report is auto-
matically printed as soon as power is
restored. This report can be used to
identify lost files. If a memory stored
for Memory Transmission was lost,
re-send it. If a message received by
Memory Reception or Substitute Re-
ception was lost, ask the sender to re-
send it.

Important
❒ Make sure that 100% is shown on

the Fax standby display before you
turn off the power switch or you
unplug the power cord. Fax files
programed in memory will be de-
leted 12 hours or more after you
turn off the power switch or you
unplug the power cord. The stor-
age time might be shorter if the
surrounding temperature is low or
the machine has been on for less
than a week.  

❒ Fax files programmed in memory
will not be deleted while the op-
tional memory card is installed.
When you install the memory card
to the machine, make sure that
100% is shown on the display and
turn off the power switch.

❒ Right after a power failure, the in-
ternal battery needs to be suffi-
ciently recharged to guard against
future data loss. Please keep the
machine plugged in and the main
power switch on for about one
week after the power loss occurs.
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----RDS (Remote Diagnostic 
System)

If your machine has a problem, a ser-
vice representative can perform vari-
o us  d ia g n o s t i c  t a sk s  o v e r  t he
telephone line from the service sta-
tion to try to find out what is wrong
with your machine. The service repre-
sentative can also use RDS to change
some of your machine's settings if
you request it.
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9. Maintaining Your Machine

Loading paper in the Optional Paper Tray 
Unit

AAAA Make sure that the optional paper
tray unit is not being used.

BBBB Pull out the paper tray until it
stops.

CCCC While pinching the release lever,
adjust the back fence and side
fences.

DDDD Push the metal plate down, and
then square the paper and load it
in the tray.

Important
❒ If paper is left in the paper tray

and then you add paper, a mis-
feed might occur.

❒ Do not stack paper over the lim-
it mark. Load paper so that the
paper touches the right side of
the tray, or misfeeds might oc-
cur.

Note
❒ Shuffle the paper before loading

it in the tray.
❒ If the paper is curled, load the

paper up side down.

EEEE Readjust the back fence and side
fences.

Important
❒ When loading small quantities

of paper,  be careful  not  to
squeeze in the side fence too
much or paper will not be fed
properly.

FFFF Push the paper tray in until it
stops.
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Loading paper in the Bypass Tray

The following procedure describes
how to load paper in the bypass tray.

AAAA Open the bypass tray.

BBBB Push up the paper guide release
lever.

1. Paper guide release lever

CCCC Gently insert the copy paper face
d own and  ad jus t  the  pap er
guides.

1. Horizontal size

2. Vertical size

3. Extender

4. Paper guides

Important
❒ If the guides are not flush with

the copy paper, a skew image or
paper misfeeds might occur.

Note
❒ Set the direction of the paper to

L.
❒ Swing out the extender to sup-

port paper sizes larger than
A4L, 81/2" × 14"L.

❒ Fan paper to get air between the
sheets and avoid a multi-sheet
feed.
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DDDD Push down the paper guide re-
lease lever.

Note
❒ If you set A4, 81/2" × 14" or larg-

er paper, hold the edge of the
paper and push down the paper
guide release lever.

❒ If you do not push down the pa-
per guide release lever, a mis-
feed might occur.

❒ You can specify the type of pa-
per used for the bypass tray. See
p.63 “Changing the Paper Type
for Bypass Tray”.
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Changing the Paper Size in the Main Paper 
Tray

AAAA Make sure that the paper tray is
not being used.

BBBB Pull out the paper tray until it
stops.

Note
❒ Remove any remaining paper.

CCCC Adjust the back fence.

Note
❒ When you load A4L paper,

place the back fence in the cor-
ner pocket on the left.

DDDD While pressing the release lever,
adjust the side fences.

EEEE Push the metal plate down.

FFFF Square the paper and load it in
the tray.

Important
❒ Do not stack paper over the lim-

it mark.
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GGGG Adjust the side and back fences to
the new paper size.

Important
❒ When setting small quantities of

paper, be careful not to squeeze
in the side fence too much or pa-
per will not be fed properly.

HHHH Push the paper tray in until it
stops.

IIII Before you can use it, you must
change the paper size setting for
this tray using ”Tray Paper Size “
function. See p.62 “Changing the
Paper Size Setting”.
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Changing the Paper Size in the Optional 
Paper Tray Unit

AAAA Make sure that the paper tray is
not being used.

BBBB Pull out the paper tray until it
stops.

Note
❒ Remove any remaining paper.

CCCC Adjust the back fence.

Note
❒ When you load 81/4" × 14"L or

81/2" × 14"L paper, place the
back fence in the corner pocket
on the left.

DDDD While pressing the release lever,
adjust the side fences.

EEEE Push the metal plate down, and
then square the paper and load it
in the tray.

Important
❒ Do not stack paper over the lim-

it mark.
❒ Load paper so that the paper

touches the right side of the
tray, or misfeeds might occur.

Note
❒ Shuffle the paper before loading

it in the tray.
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FFFF Adjust the side and back fences to
the new paper size.

Important
❒ When loading small quantities

of paper,  be careful  not to
squeeze in the side fence too
much or paper will not be fed
properly.

GGGG Push the paper tray in until it
stops.

HHHH Before you can use it, you must
change the paper size setting for
this tray using ”Tray Paper Size “
function. See p.62 “Changing the
Paper Size Setting”.
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Cleaning the Scanner

To maintain the machine, clean the
scanner regularly.

AAAA While pushing the release button,
open the ADF unit.

BBBB Wipe the white strip (1) and expo-
sure glass (2).

Use a soft dry cloth. If dirt is hard
to remove, wipe with a well-
wrung damp cloth, then wipe dry
with a soft, dry cloth.

CCCC Close the ADF unit making sure it
clicks firmly into place.
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Replacing the ADF Maintenance Kit

In order to ensure maximum perfor-
mance of your fax machine, the ADF
Maintenance Kit is provided. You can
replace the ADF Maintenance Kit af-
ter approximately 45,000 originals
have been scanned with the ADF.
You need to replace the ADF Mainte-
nance Kit when you are prompted to
do so by a message on the display: 

Follow the procedure below to re-
place the ADF Maintenance Kit. 

Note
❒ If your service representative is re-

sponsible for performing this oper-
ation, this message will not appear.

❒ If you do not have an ADF Mainte-
nance Kit when you are prompted
to replace the ADF Maintenance
Kit, or if you do not have time to
perform the maintenance at that
time, at step C below, select "No",
and then press the {{{{OK}}}} key to re-
turn to the standby display so you
can continue using the fax ma-
chine. However, after you scan an
additional 100 originals with the
ADF, you will be prompted once
again to replace the ADF Mainte-
nance Kit. 

❒ After “Change ADF Maintenance
Kit” message appears in the dis-
play, you can continue to send fax
messages and perform other oper-
ations. 

AAAA A message on the display prompts
you to replace the ADF Mainte-
nance Kit when it is time for re-
placement.

BBBB Press the {{{{OK}}}} key. 

CCCC Make sure that "Yes" is selected,
and then press the {{{{OK}}}} key. 

Note
❒ If you want to replace the ADF

Maintenance Kit later, press 0
or 1 to select "No", and then
press the {{{{OK}}}} key. If you re-
place the ADF Maintenance kit
when ”Change ADF Mainte-
nance Kit” message is not dis-
played, you must reset the ADF
counter. See p.69 “Resetting the
ADF Counter”

DDDD To replace the ADF Maintenance
Kit, follow the instructions in
"Replacing the ADF Maintenance
Kit"  supplied with the ADF
Maintenance Kit.

EEEE Press the {{{{OK}}}} key.
The ADF counter is reset automat-
ically.
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Replacing the Photo Conductor Unit (PCU)

AAAA Turn Off the Power Switch.

BBBB Open the right cover. 

CCCC Open the front cover.

DDDD Push the lever (AAAA) and pull out
the toner cassette holding AAAA and
BBBB. 

EEEE Take the cord off the hook and re-
move the connector.

FFFF Pull the PCU while pushing  AAAA. 

Note
❒ If the PCU can not be pulled,

make sure the right cover is
opened.
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GGGG Pull out the PCU holding the han-
dle.

HHHH Take out the new PCU from the
box and remove the black paper.

Do not touch the blue part.

IIII Insert the new PCU.

JJJJ Push the PCU until it locks into
place.

KKKK Insert the connector.

LLLL Place the cord on the hook.
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MMMM Pull the two red tags to remove
the plastic strips.

NNNN Return the toner cassette.
Push the toner cassette until it
locks into place.

OOOO Close the right cover and front
cover.
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Replacing the Toner Cassette

R WARNING:

R CAUTION:

Note
❒ When the Add Toner indicator

(D) starts to blink, the toner car-
tridge is almost empty. You will
make 50 more copies before you
have to change the toner cassette.

❒ When the Add Toner indicator
(D) remains lit, it is time to install
a new toner cassette.

AAAA Open the front cover.

BBBB Push the lever (AAAA) and pull out
the old toner cassette holding AAAA
and BBBB.

Important
❒ Do not incinerate waste toner.

Toner dust may ignite suddenly
when exposed to an open flame.

CCCC Prepare the new toner cassette.

Hold the cassette horizontally and
shake it gently from side to side a
few times.

• Do not incinerate spilled toner 
or used toner. Toner dust 
might ignite when exposed to 
an open flame.

• Dispose of the used toner car-
tridge in accordance with the 
local regulations.

• Keep toner (used or unused) and 
toner cartridge out of the reach of 
children.
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DDDD Remove the tape from the toner
cassette.

EEEE Replace the toner cassette and
make sure it locks securely into
place.

FFFF Close the front cover.
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Toner Cassette Storage

R WARNING:

R CAUTION:

• Store in a cool, dark place.
• Never store where they may be ex-

posed to heat.
• Keep out of the reach of children.
• Do not eat toner.
• Do not lay heavy objects on toner

cassette.
• Do not incinerate toner or toner

containers. Toner dust may cause
flashback when exposed to an
open flame.

• Do not incinerate spilled toner 
or used toner. Toner dust 
might ignite when exposed to 
an open flame.

• Dispose of the used toner car-
tridge in accordance with the 
local regulations.

• Keep toner (used or unused) and 
toner cartridge out of the reach of 
children.
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Before Installation

Before installing your machine, read
the safety instructions at the begin-
ning of this manual. To install the ma-
chine, follow these procedures:
A Find a suitable location for the ma-

chine.
B Remove all the pieces of tape at-

tached to the machine.
C Open the front cover and remove

the tapes from a toner cassette and
a photo conductor unit.

D Attach the accessories and load the
paper in the paper tray. 

E Connect the power. (See p.123
“Co nnec t ing  th e  Po w er  and
Switching On”.)

F Connect the phone line. (See p.124
“Connecting  to  a  Telephone
Line”.)

G Enter all necessary information
and settings in your machine's
memory. See p.41 “Registering”,
<Basic Features>. 

For details, see the "Before You Use
This Machine" manual.
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Machine Environment

When choosing a location for your
machine, please follow the safety in-
structions given in the first section.

Location

For the best possible performance, in-
stall your machine in a place which
satisfies the following conditions:
• Not exposed to direct sunlight
• Level
• Not subject to vibrations
• Away from other electronic equip-

ment, to avoid interference
• Away from areas containing corro-

sive gas
• Dust-free
• Condensation-free
• Temperature 15 to 25°C (59 to 77°F)
• Humidity 30 to 70 % RH (do not in-

stall near a humidifier)
• Away from heaters and air condi-

tioners, to avoid sudden changes
in temperature

• With the clearance as shown
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Connecting the Power and Switching On

R WARNING:

AAAA Plug in the cable to the outlet.

BBBB Turn the power switch on.

Important
❒ The supply from the wall outlet

must not fluctuate more than
10V either side of 115V.

❒ The power cord should not be
laid in a place where it might
trip somebody.

❒ Do not lay anything on the pow-
er cord.

❒ If you must use an extension
cord, make sure that it is capa-
ble of carrying 115V/7A, and
that your facsimile terminal is
the only piece of equipment
connected to that cord.

• Connect the power cord direct-
ly into a wall outlet and never 
use an extension cord.
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Connecting to a Telephone Line and an 
External Telephone

Connecting to a Telephone Line 

Following the instructions for con-
necting it to a telephone line. 
There are similar sockets located at
the rear of the machine. 
• TEL: For the optional handset or

an external telephone 
• LINE: Telephone line connection

Important
❒ By law in the United States, you

must program your phone number
identification (your OWN FAX
NUMBER) into your machine be-
fore you can connect the public
phone system. See p.41 “Own
Name/Fax Header/Own Fax
Number”,  <Basic Features>.

AAAA Insert the line cable into the sock-
et labeled "LINE".

BBBB Connect the other end of the line
cable to your telephone line. 

Connecting an External 
Telephone

AAAA Plug the handset jack into the
“TEL” socket at the rear of the ma-
chine.
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11. Appendix

Specifications

Base Machine

❖❖❖❖ Power Supply
115V, 60 Hz

❖❖❖❖ Power Consumption

❖❖❖❖ Noise Emission
Sound Power Level

Sound Pressure Level *1 

The above measurements made in accordance with ISO 7779 are actual value.
*1 It is measured at the position of the operator.

❖❖❖❖ Protocol: 
G3

❖❖❖❖ Memory Capacity
• Standard: 240 pages/ITU-T #1 test original (Slerexe letter) at standard res-

olution
• With optional 40Mbyte memory card:  1500 pages

Mode Standard With Option

Energy Saver Mode 1.2W and lower 10W and lower

Standby Mode 15W and lower 20W and lower

Transmission 25W and lower 30W and lower

Reception 400W and lower 400W and lower

Copying 400W and lower 400W and lower

Maximum 1000W and lower 1000W and lower

Mainframe Only

During Printing 60.8 (dB)

Standby 38.1 (dB)

Mainframe Only

During Printing 57.6 (dB)
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❖❖❖❖ Resolution:
•Standard: 8×3.85 lines/mm
•Detail: 8×7.7 lines/mm
•Fine: 8×15.4 lines/mm

❖❖❖❖ Transmission Time:
 3 seconds at 28,800bps, Standard resolution

❖❖❖❖ Data Compression Method:
MH, MR, MMR, JBIG

❖❖❖❖ Maximum Original Size:
216×600mm / 8.5”×23.7” 

❖❖❖❖ Maximum Scanning length:
600mm (23.7”) 

❖❖❖❖ Available Scanning Width:
210mm (8.3”)

❖❖❖❖ Print Process:
Printing on standard paper using a laser

❖❖❖❖ Transmission Speed:
33,600/31,200/28,800/26,400/24,000/21,600/19,200/16,800/14,400/12,000/
9,600/7,200/4,800/2,400bps (auto shift down system)

Available Options

❖❖❖❖ Memory Card (40MB)
Increases memory capacity.

❖❖❖❖ Paper Tray Unit 
Holds 500 sheets of paper.

❖❖❖❖ Handset (Handset Type 1018)
This permits voice communication.

❖❖❖❖ Printer Controller
Enables the machine to be connected to a personal computer and used as a
printer. Furthermore, if you also install the optional Network Interface Board,
the machine can be connected to a LAN environment and used as a network
printer.

Note
❒ For details, see the optional Printer manual.
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Originals

Make sure your originals are completely dry before placing them in the machine.
Originals containing wet ink or correcting fluid will mark the scanner and affect
the resulting image.

Note
❒ Even if an original is correctly placed in the Document Feeder, a margin of

3mm to 5mm (0.1” to 0.2”) around each edge of the original may not be sent.
❒ There may be a difference in the size of the image when it is printed at the oth-

er party uses different sized paper.

Sizes and weights of Recommended Originals

Originals unsuitable for the Document Feeder (ADF)

Do not set the following types of originals in the Document Feeder because they
may be damaged. 
• Originals containing staples or clips
• Perforated or torn originals
• Curled, folded, or creased originals
• Pasted originals
• Originals with any kind of coating, such as thermosensitive paper, art paper,

aluminum foil, carbon paper, or conductive paper
• Originals with index tabs, tags, or other projecting parts 
• Sticky originals, such as translucent paper
• Thin and soft originals
• Originals of inappropriate weight
• Originals in bound form, such as books
• Transparent originals, such as OHP transparencies or translucent paper

Where Original is 
Placed

Acceptable Original Size Maximum 
Number of 
Sheets

Paper Thickness

Document Feeder 
(ADF)

Fax transmission: A5LK to 
A4L, 51/2" × 81/2" LK to 
81/2"×14” L 

50 sheets 
(80g/m2, 20 lb)

52–105g/m2 
(45–90kg, 14-28 lb)
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Paper

Recommended Paper Sizes and Types

The following limitations apply to each tray:

*1 Paper weight: 80g/m2, 20 lb

Paper sizes Paper weight Paper capacity

Main Paper Tray A4L, A5K, 81/2" × 11"L, 51/2" × 
81/2"K

Note
❒ You can specify the paper size with 

the user tools. See p.62 “Changing 
the Paper Size Setting”.

60 – 90g/m2, 
16 – 24 lb

250 sheets *1 

Paper tray unit 
(option)

A4L, 81/2" × 14"L, 81/2" × 13"L, 81/4" 
× 14"L, 81/4" × 13"L, 81/2" × 11"L

Note
❒ You can specify the paper size with 

the user tools. See p.62 “Changing 
the Paper Size Setting”.

60 – 90g/m2, 
16 – 24 lb

500 sheets *1 

Bypass 
tray 

Standard 
sizes

A4L , A5KL, 81/2" × 11"L, 51/2" × 
81/2"KL, 81/2" × 14"L, 8" × 13"L, 
81/2" × 13"L, 81/4" × 13"L, 81/4" × 
14"L

Note
❒ You can specify the paper size. See 

p.62 “Changing the Paper Size Set-
ting”

60 – 157g/m2, 
16– 42 lb

100 sheets *1 

Custom 
sizes

Metric ver-
sion

Vertical: 90 – 216mm 
Horizontal: 140 – 356mm

Inch ver-
sion

Vertical: 3.5" – 8.5" Hori-
zontal: 5.5" – 14"

Envelopes: Com#10 Env (104.8 × 
241.3mm, 41/8" × 91/2"), CA Env (162 × 
229mm, 6.38" × 9.02"), C6 Env (114 × 
162mm, 4.49" × 6.38"), DL Env (110 × 
220mm, 4.33" × 8.66"), Monarch Env 
(98.4 × 190.5mm, 37/8" × 71/2")

72 – 90g/m2, 
19 – 24 lb

10 sheets

Translucent paper ( A4L), OHP trans-
parencies

– 10 sheets

postcards 10 sheets

Adhesive labels ( A4L) 1 sheet
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Non-recommended Paper

R CAUTION:

Important
❒ Do not use any of the following kinds of paper or a fault might occur.

• Thermal fax paper
• Art paper
• Aluminum foil
• Carbon paper
• Conductive paper

❒ Do not use copy paper that has been already copied on. Otherwise, a paper
misfeed might occur.

Note
❒ Do not use any of the following kinds of paper or a misfeed might occur.

• Bent, folded, or creased paper
• Damp paper
• Torn paper
• Slippery paper
• Perforated paper
• Rough paper
• Thin paper that has low stiffness
• Paper with much paper dust on its surface

❒ If you make copies on rough grain paper, the copy image might be blurred.
❒ Do not use envelopes in the following conditions.

• damp
• excessively curled or twisted
• stuck together
• damaged in any way
• with stamps attached
• with windows, holes, perforations, cutouts or embossing
• with metal clasps, string ties or metal folding bars
• designed to be interlocked
• with nicked edges or bent corners
• with rough, wrinkled or laid finishes
• with any exposed adhesive, when the flap is in the sealed or closed posi-

tion

• Do not use aluminum foil, carbon paper, or similar conductive paper to avoid 
a fire or machine failure.
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Paper Storage

Note
❒ When storing paper, the following precautions should always be followed:

• Do not store paper where it will be exposed to direct sunlight.
• Avoid storing paper in humid areas (humidity: 70% or less).
• Store on a flat surface.

❒ Keep open reams of paper in the package, and store as you would unopened
paper.

❒ Under high temperature and high humidity, or low temperature and low hu-
midity conditions, store paper in a plastic bag.

Energy Saving

Introduction

When your fax machine prints fax messages, it uses heat to fix the image on pa-
per. This heat is generated using a heating roller which must be hot enough to
fuse toner to the paper properly. Because keeping the roller hot all the time con-
sumes electricity, this machine is provided with an Energy Saving mode in
which the heating roller is heated to full temperature only when a message
needs to be printed.
 Two available types of Energy Saving mode are shown in the table below.

Values vary according to options installed and settings of the User Parameters.

Energy Saving mode Machine status in Energy 
Saving mode 

How long before 
you can print after 
exiting Energy Sav-
ing mode

Power consumption 
in Energy Saving 
Mode

Fax Standby (Heater 
half- cool)

Display turns off. The 
machine maintains the 
heating roller tempera-
ture at half the full tem-
perature; warm up takes 
less time.

Within about 
30 seconds

40 W

Energy Saving Stand-
by (Heater off)

Display turns off . The 
machine lets the heating 
roller cool to room tem-
perature; warm-up takes 
longer.

Within about 
40 seconds

1.2W

StellaF1EN-3_FM.book  Page 130  Monday, November 12, 2001  11:40 AM



Specifications

131

11

In Fax Standby mode, letting the heating roller cool to room temperature will re-
duce the amount of electricity the fax machine consumes. However, the fax ma-
chine will not print incoming messages right away, it will store them in memory
and print them out after the roller warms up.
In Energy Saving Standby mode, letting the heating roller cool halfway reduces
the amount of electricity the fax machine consumes, but not as much as letting it
cool to room temperature. On the other hand, since warming up takes only a
short time, incoming fax messages can be printed right away.

Note
❒ When the machine is in Energy Saving mode, the display goes blank.
❒ You can still send fax messages while the machine is in Energy Saving mode.
❒ The Manual Receive indicator goes out in Energy Saving mode even if Man-

ual Receive is turned on. 
❒ Even though the operation panel display goes out in Energy Saving mode, in-

dicators that flash or light during communication or reception still work.
When the Receive File indicator lights, exit Energy Saving mode and take ap-
propriate action.

Entering Energy Saving mode

The machine enters Energy Saving mode when: 
• Nobody uses the machine for about 5 minutes. 
• The user holds down the {{{{Energy Saver/Clear Modes}}}} key for about 2 seconds.

Note
❒ If you want to change the five minute period to one or three minutes, or if you

do not want your machine to enter the Energy Saving mode automatically,
please contact your service representative.

❒ Energy Saving mode cannot be entered when an original is placed. 

Exiting Energy Saving mode

Your machine exits Energy Saving mode when a fax is received.
To exit Energy Saving mode manually:
• In Energy Saving Standby mode, press the {{{{Energy Saver/Clear Modes}}}} key.
• In Fax Standby mode, press any key.
• Place an original.
• Pick up the external telephone handset.
• Pull out the main paper tray.
• Open the front cover.
• Open the right cover.
• Open the lower right cover of the optional paper tray unit.
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Selecting the Energy Saving mode type

To select the Energy Saving mode type, adjust the bit switch below with the User
Parameters. See p.85 “User Parameters” (switch 05, bit 6).

❖❖❖❖ Switch 05 Bit 6 
• Energy Saving Standby: To let the heating roller cool to room temperature,

set bit 6 to 0.
• Fax Standby: To let the heating roller cool halfway set bit 6 to 1.

Reception in Energy Saving mode

Once in Energy Saving mode, you can still receive messages. When a message is
received, the machine prints it and returns to Energy Saving mode. 
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Maximum Values

The following list contains the maximum value for each item. 

Item Standard With Optional 
Memory Card

Memory 3MB 40MB

The number of pages that you can store in mem-
ory (Using A4 size Standard <ITU-T #1Chart, 
Resolution: Standard, Original Type: Text > ) 

240 1500

Total number of Memory Transmission files 100 100

The number of pages per file 500 1500

The number of pages for all files 500 1500

The number of destinations you can specify for 
one file

140 140

The number of destinations you can specify for 
all files

300 300

The number of Quick Dials you can register 30 30

The number of Speed Dials you can register 50 50

The number of Group Dials you can register 5 5

The number of destinations you can specify by 
the number keys

69 69

The number of destinations you can register in a 
group

140 140

The number of destinations you can register in 
all groups

149 149

The number of personal codes you can register 30 30

The number of digits for Dials 254 254

StellaF1EN-3_FM.book  Page 133  Monday, November 12, 2001  11:40 AM



Appendix

134

11

Advanced Transmission Features

Functions selectable with the {{{{Trans. Option}}}} key are as follows.

Function name Description Reference

Send Later Sets the machine to automati-
cally start transmission or 
polling reception at an ap-
pointed time. 

p.3 “Sending at a Specific 
Time (Send Later)” 

Fax Header Print You can add a Fax Header 
(e.g. registered name) to the 
message you send so it ap-
pears on the message printed 
by the receiving machine. 

p.5 “Fax Header Print” 

Sending Confidential Messag-
es

Sends a confidential message. 
It will not be printed until the 
confidential ID is entered.

p.6 “Sending Confidential 
Messages”

Polling Reception Use this function if you want 
to poll a message from anoth-
er terminal.

p.9 “Calling to Request a Mes-
sage (Polling Reception)” 
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Job Information

Functions selectable with the {{{{Job Information}}}} key are as follows.

Function name Description Reference

Canceling Transmission 
or Reception

This function cancels a 
file (reservation) for 
Memory Transmission or 
Polling Reception. 

p.13 “Canceling Transmission or Recep-
tion” 

Printing the File List The transmission file list 
can be manually printed. 
This list allows you to 
know what files are 
stored in memory and 
the file numbers. 

p.14 “Printing a List of Files in Memory 
(Print File List)” 

Printing a Stored Message Prints the contents of a 
fax that is stored in mem-
ory and has not been sent 
yet. 

p.15 “Printing a Stored Message (Print 
TX File)” 

Printing a Confidential 
Fax Message

Prints messages received 
with the confidential re-
ception function. 

p.16 “Printing a Confidential Fax Mes-
sage”

Printing a Memory-
locked Message

The Memory-locked 
messages can be manual-
ly printed.To print the 
messages, you have to 
enter the Memory Lock 
ID. 

p.17 “Printing a Memory-locked Mes-
sage” 

Printing the Journal The Journal can be man-
ually printed. This report 
shows the results of the 
last 50 communications. 

p.18 “Printing the Journal” 
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User Tools

Function name Description Reference

Register/Delete Quick Dial When you register a destina-
tion in a Quick Dial, you can 
specify the destination by 
only pressing the Quick Dial 
key. 

p.46 “Quick Dial”,  <Basic Fea-
tures> 

Register/Delete Speed Dial When you register a destina-
tion in a Speed Dial, you can 
specify the destination by en-
tering the two-digit Speed 
Dial code after pressing the 
Speed Dial key.

p.52 “Speed Dial”,  <Basic Fea-
tures>

Register/Delete Group Dial If you program several desti-
nations into a Group, you can 
dial with just a few key-
strokes.

p.57 “Groups”,  <Basic Fea-
tures>

Programs Changes key stroke program 
names and deletes key stroke 
programs.

p.46 “Programs”

Auto Document Registers and deletes Auto 
Documents.

p.49 “Storing an Often Used 
Document (Auto Document)”

Assigning User Function Keys Stores a frequently used func-
tion in a User Function Key 
({{{{F1}}}} to {{{{F5}}}}). 

p.53 “User Function Keys” 

Reports/Lists This function allows you to 
print various reports and lists 
manually. You can print the 
following reports and lists:

• Journal

• Transmission File List

• Quick Dial list

• Speed Dial list

• Group Dial list

• Quick Dial Label

• Program List

• Auto Document

• User Function List

p.56 “Printing Reports/Lists” 

Monitor Volume Adjusts the volume of moni-
toring and beeper sounds 
from the speaker inside the 
machine. 

p.70 “Adjusting Volume”,  
<Basic Features>

Display Contrast Adjust the brightness of the 
display.

p.59 “Adjusting the Display 
Contrast” 
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Date/Time Adjusts the date and the time 
as a reference. 

p.60 “Setting the Date and 
Time” 

Reception Mode The machine can treat incom-
ing fax messages and tele-
phone calls in two ways.

p.39 “Reception Modes”,  <Ba-
sic Features>

Setting the Auto Ring Time You can alter the number of 
rings by changing the Auto 
Ring Time.

p.61 “Setting the Auto Ring 
Time” 

Fax Information Registers your Own Name, 
Fax Header and Own Fax 
Number. 

p.41 “Own Name/Fax Head-
er/Own Fax Number”,  <Basic 
Features>

Changing the paper size set-
ting

Explains how to change paper 
size setting.

p.62 “Changing the Paper Size 
Setting”

Changing the paper type for 
bypass tray

Explains how to set paper 
type for the bypass tray. 

p.63 “Changing the Paper 
Type for Bypass Tray”

Fax Reset Timer You can select a period of time 
before this machine automati-
cally returns to the standby 
display. 

p.64 “Setting the Fax Reset 
Timer” 

On Hook Timeout You can select a period before 
the machine cancels the On 
Hook Dial mode.

p.65 “On Hook Timeout” 

Selecting the Display Lan-
guage

Explains how to change the 
language for messages shown 
on display, lists and reports. 

p.66 “Selecting the Display 
Language”

Function name Description Reference
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Key Operator Tools

Function name Description Reference

Resetting the ADF Counter Explains how to reset the ADF 
counter. 

p.69 “Resetting the ADF 
Counter”

Authorized Reception Allows you to limit receiving 
of fax messages to Specified 
Senders that your register on 
your fax machine. All fax mes-
sages from other than Speci-
fied Senders are not received, 
thus preventing you from re-
ceiving junk fax messages.

p.70 “Authorized Reception”

Memory Lock All received messages are 
stored in memory and are not 
automatically printed.

p.72 “Memory Lock” 

 Specified Tray Allows you to have messages 
from Specified Senders print-
ed from a different tray. This 
item is available only after the 
optional Second Paper Cas-
sette has been installed.

p.74 “Specified Tray”

Forwarding Transfers received messages 
to a registered receiver (for-
warding destination). 

p.76 “Forwarding” 

Energy Save Timer Allows you to have the fax 
switch off and on at specified 
times to save energy.

p.83 “Energy Save Timer”

Changing User Parameters Allows you to change the 
function settings to meet your 
needs.

p.85 “User Parameters” 

Printing User Parameter List Allows you to print and check 
User Parameter settings.

p.90 “Printing the User Pa-
rameter List” 

Personal Code Personal Code is used for Re-
stricted Access. When turn the 
Restricted Access on, users 
must enter the Personal Code 
in order to transmit originals.

p.91 “Personal Codes” 

 ID Code Registers the ID required for 
using Polling Reception and 
Memory Lock.

p.94 “ID Code” 

Line Type Allows you to match the fax 
machine to the type of line 
you use: a tone line or a pulse 
line. 

p.96 “Line Type”
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Select Line Allows you to select an inter-
nal G3 communication line or 
external telephone line for 
your fax machine.

p.96 “Select Line”

PSTN Access Number Allows you to specify the code 
used to access an outside line 
when dialing.

p.97 “PSTN Access Number” 

Memory File Transfer You can send all messages 
currently stored in memory to 
another fax and have them 
printed out there.

p.98 “Memory File Transfer” 

Margin Adjust Allows you to adjust paper 
settings when you receive fax 
messages that are blank or 
partially missing.

p.99 “Margin Adjust”

RDS On/Off Allows you to switch on RDS 
(Remote Diagnostic system) 
to a service representative can 
test your fax machine remote-
ly from a service station, diag-
nose the problem, and can 
change your machine settings 
to correct the problem.  

p.100 “RDS (Remote Diagnos-
tic System)”

Function name Description Reference
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INDEX
A

ADF Counter
Resetting,   69

ADF Maintenance Kit,   113
Adjusting Volume→ Monitor Volume,   136
Advanced Transmission Features,   134
Assigning User Function Keys,   54, 136
Authorized Reception,   70, 138
Auto Document,   49, 136

Changing,   51
Auto Document Original,   56
Automatic Redial,   30
Auto Ring Time,   61, 137

B

Batch Transmission,   30
Blank Sheet Detect,   27
Broadcasting Sequence,   30

C

Canceling Transmission or Reception,   13, 135
Center Mark,   38
Chain Dial,   21
Changing

Auto Document,   51
Changing the Paper Size in the Main 

Paper Tray,   108
Changing the Paper Size in the Optional 

Paper Tray Unit,   110
Changing the paper size setting,   137
Changing the paper type for bypass tray,   137
Changing User Parameters,   138
Checkered Mark,   38
Closed Network Transmission,   27
Communication Failure Report,   32
Communication Result Report,   32
Communication Result Report (Polling RX),   11
Confidential File Report,   33
Confidential ID,   95
Confidential Messages,   134
Confidential Reception,   16
Confidential Transmission,   6
Connecting an External Telephone,   124
Connecting the Power,   123
Connecting to a Telephone Line,   124

Copying,   43
special paper,   44

Counters,   45

D

Date and Time,   60
Date/Time,   137
Deleting

Forwarding Station,   80
Specified Sender,   81
Specified Sender for Memory Lock,   73

Display Contrast,   59, 136
Display Language,   66
Dual Access,   31

E

ECM (Error Correction Mode),   31
Editing

Forwarding Station,   79
Specified Sender,   80

Energy Save Timer,   83, 138
Energy Saving,   130
Error Report,   103

F

Fax Header Print,   5, 134
Fax Information,   137
Fax Reset Timer,   64, 137
File Reserve Report,   32
File Reserve Report (Polling RX),   10
Forwarding,   76, 138
Forwarding Station,   78, 79, 80
Function List

Advanced Transmission Features,   134
Job Information,   135
Key Operator Settings,   67, 138

G

Group Dial,   136
Group Dial List,   57

H

Handset,   126
Handy Dialing Functions,   21
Help List,   101
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I

ID Code,   94, 95, 138
Immediate Reception,   35
Installation,   121

J

Jams
Clearing,   102

Job Information,   13, 135
Journal,   18, 56, 135

K

Key Operator Settings,   67
Key Operator Tools,   138
Keystroke Program,   46

L

Label Insertion,   8
Language Selection,   66
Line Type,   96, 138

Selecting,   96
Loading paper in the Bypass Tray,   106
Loading paper in the Optional Paper Tray 

Unit,   105
Location,   122

M

Machine Environment,   122
Manual Dial,   24
Margin Adjust,   99, 139
Maximum Values,   133
Memory Card (40MB),   126
Memory File Transfer,   98, 139
Memory Lock,   72, 73, 138
Memory-locked Message,   17, 135
Memory Lock ID,   95
Memory Reception,   35
Monitor Volume,   136
More Transmission Functions,   29

N

Noise Emission,   125

O

On Hook Dial,   23
On Hook Timeout,   65, 137
Operation Problems

Solving,   101

Options,   126
Originals,   127
Other Transmission Features,   21
Outside Line Access Number → PSTN 

Access Number,   97

P

Page Separation and Length Reduction,   39
Paper,   128
Paper Size

Changing,   62
Paper Tray Unit,   126
Paper Type for Bypass Tray

Changing,   63
Parallel Memory Transmission,   31
PCU

Replacing,   114
Personal Code,   91, 138
Personal Code List,   93
Photo Conductor Unit

Replacing,   114
Polling ID,   94
Polling Reception,   9, 134
Polling Reserve Report → File Reserve 

Report (Polling RX),   10
Polling Result Report → Communication 

Result Report (Polling RX),   11
Power,   123
Power Failure Report,   103
Printed Report,   32
Printer Controller,   126
Print File List,   14
Printing

Confidential Fax Message,   16, 135
Group Dial List,   56
Help List,   101
Journal,   18, 56, 135
List of Files in Memory,   14, 135
List of Specified Senders for Memory Lock,   74
Memory-locked Message,   17, 135
Quick Dial Label,   56
Quick Dial List,   56
Reports/Lists,   56
Specified Sender list,   82
Speed Dial List,   56
Stored Message,   15, 135
TX File List,   56
User Function List,   56
User Parameter List,   138

Printing Options,   38
Print TX File,   15
Program List,   56
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Programming
Auto Document,   49

Programs,   46, 136
Changing,   47
Deleting,   48
Storing,   46
Using,   47

PSTN Access Number,   97, 139
PWD,   25

Q

Quick Dial,   136
Quick Dial Label,   56
Quick Dial List,   57

R

RDS,   100, 104
RDS On/Off,   139
Reception

Immediate Reception,   35
Memory Reception,   35
Receiving Messages in Telephone Mode,   37
Screening Out Messages from 

Anonymous Senders,   36
Substitute Reception,   36

Reception Features,   35
Reception Mode,   137
Reception Time,   39
Redial,   22
Register/Delete

Group Dial,   136
Quick Dial,   136
Speed Dial,   136

Registering
Forwarding Station,   78
ID Codes,   95
Specified Sender for Memory Lock,   73

Replacing
PCU,   114
Photo Conductor Unit,   114
Toner Cassette,   117

Replacing the Toner Cassette,   117
Report,   103
Report Formats,   19
Reports,   32

Communication Failure Report,   32
Communication Result Report,   32
Confidential File Report,   33
Error Report,   103
File Reserve Report,   32

Journal,   18, 19
Power Failure Report,   103
Reports/Lists,   56
Transmission Result Report (Immediate 

Transmission),   33
Reports/Lists,   56, 136
Resetting the ADF Counter,   138
Restricted Access,   94

S

Scanner
Cleaning,   112

Scanner Cleaning Message,   28
Secured Polling Reception,   9
Selecting the Display Language,   137
Select Line,   139
Sending Confidential Messages,   6
Send Later,   3, 134
SEP Code,   25
SID,   26
Solving

Operation Problems,   101
Solving Operation Problems,   101
Specifications,   125
Specified Sender,   80, 81
Specified Sender list,   82
Specified Tray,   74, 138
Speed Dial,   136
Speed Dial List,   57
Stored ID Override Polling Reception,   9
Stored Message,   15
SUB Code,   26
Substitute Reception,   36
Switches and Bits,   85

T

Telephone Directory,   22
Telephone Mode,   37
Toner Cassette

Replacing,   117
Storage,   119

Transmission Features,   21, 25
Transmission Options,   3
Transmission Result Report (Immediate 

Transmission),   33
TSI Print,   38
TTI Print → Fax Header Print,   5
TX File List,   56
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U

User Function key
Deleting,   55
Using,   54

User Function Keys,   53, 136
Making key assignment,   54

User Function List,   56
User Parameter List,   85, 138
User Parameters,   85, 138
User Tools,   45, 136
Using Key Operator Settings,   69
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Note to users in the United States of America

Notice:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television reception, which can be determined by turn-
ing the equipment off and on, the user is encouraged to try to correct the interference by one more of
the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
Consult the dealer or an experienced radio/TV technician for help.

Warning
Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Caution(in case of IEEE1284 environment) :
Properly shielded and grounded cables and connectors must be used for connections to host computer
(and/or peripheral) in order to meet FCC emission limits.

Caution (in case of 100BaseTX environment):
Interface cable with ferrite core must be used for RF interference suppression.

Declaration of Conformity
Product Name: Printer Controller
Model Number: Type 1013
Responsible party: Ricoh Corporation
Address: 5 Dedrick Place, West Caldwell, NJ 07006
Telephone number: 973-882-2000
This device complies with part 15 of FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and
2. this device must accept any interference received,
including interference that may cause undesired operation.

Note to users in Canada

Note:
This Class B digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada

Avertissement:
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual.

Please keep this manual in a handy place near the machine.

Please read the Safety Information before using this machine. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Notes:

"PS2" stands for PostScript level2 Compatible in this manual.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or
other countries.

Ethernet is a registered trademark of Xerox Corporation.

Adobe, PostScript, Acrobat and PageMaker are registered trademarks of Adobe System Incorporated.

PCL is a registered trademark of Hewlett-Packard Company.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Copyright © 2001
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Manuals for This Machine

Manuals for This Machine

The following manuals separately describe the operational procedures for the
operation and maintenance of the machine.
Depending on the machine, some manuals are not provided. Confirm which
type of machine you have.
To enhance safe and efficient operation of the machine, all users should read and
follow the instructions contained in the following manuals.

❖❖❖❖ Copy Reference
Describes the procedures and functions for using this machine as a copier.

❖❖❖❖ System Settings
Describes the system settings of this machine.

❖❖❖❖ Facsimile Reference <Basic Features>
Describes the procedures and most frequently used functions for using this
machine as a facsimile.

❖❖❖❖ Facsimile Reference <Advanced Features>
Describes the procedures and more advanced functions for using this ma-
chine as a facsimile. And also explains settings for key operators.

❖❖❖❖ Printer Reference 1
Describes the system settings, procedures and functions for using this ma-
chine as a printer. (this manual)

❖❖❖❖ Printer Reference 2
Describes the procedures and provides necessary information about using
this machine as a printer. This manual is provided as a PDF file on the CD-
ROM labeled “Operating Instructions for Printer”.

❖❖❖❖ Network Interface Board Quick Configuration Guide
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. This manual is pro-
vided as a PDF file on the CD-ROM labeled “Operating Instructions for Print-
er”.

❖❖❖❖ Type 1018 PostScript level2 Compatible Kit Operating Instructions Supplement
Describes the functions of Printer Utility for Mac. This manual is provided as
a PDF file on the CD-ROM labeled “Operating Instructions for Printer”.
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❖❖❖❖ Network Interface Board Type 1018 Owner's Manual
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. This manual is pro-
vided as a PDF file on the CD-ROM labeled “Print Server Software and Doc-
umentation” which comes with optional Network Interface Board Type 1018.

Note
❒ Concerning UNIX printing information, please visit our web site or consult

your authorized reseller.
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's control panel.
Keys on the computer's keyboard.
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1. Getting Started

Features of This Machine

This machine is designed especially for office workgroups, both for shared us-
age within a network environment, and for one-to-one usage by being connected
directly to the computer.

❖❖❖❖ Compact Body
Its compact body requires minimum space to place it on your desk side.

❖❖❖❖ Network Connectivity
This printer is network ready with optional Network Interface Board Type
1018.

❖❖❖❖ Major Specifications

Maximum Print Quality True 600 × 600 dpi resolutions (PCL 6, 5e, PS2 
(option))

Printer Language PCL 6, PCL 5e, PS2 (option)

Maximum Input Paper Size Maximum input paper size depends on the 
machine. Confirm which type of machine 
you have. See the operating instructions that 
comes with this machine.

Standard Memory Size 16MB

Maximum Memory Size with Optional 
Memory

144MB
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Printer Drivers for This Machine

Printing requires installation of a printer driver for your operating system. The
following drivers are provided on the CD-ROM that comes with this machine.

*1 Microsoft Windows 95 operating system
*2 Microsoft Windows 98 operating system
*3 Microsoft Windows Millennium Edition
*4 Microsoft Windows 2000 Professional

Microsoft Windows 2000 Server
*5 Microsoft Windows XP Professional

Microsoft Windows XP Home Edition
*6 Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT

Workstation operating system version 4.0 in a computer using x86 processors.
*7 Required version is 8 or 9 operating system. With Mac OS X, the machine operates in

only Classic mode.
*8 Requires Service Pack 4 or later.
*9 PPD (PostScript Printer Description) files are provided on the CD-ROM.
*10 You can use the LaserWriter printer driver that comes with a Macintosh. Use the ap-

propriate printer driver that comes with the Macintosh operating system you are us-
ing. See the documentation that comes with the Macintosh for more information
about the LaserWriter functions.

❖❖❖❖ PCL printer drivers
Printer drivers allow the computer to communicate with the printer via a
printer language. Two kinds of PCL printer drivers, PCL 6 and PCL 5e, are
provided with this printer. We recommend PCL 6 as your first choice. 

Note
❒ Some of your applications might require the installation of the PCL 5e

printer driver. In this case, you can install PCL 5e in addition to PCL 6.
⇒ p.18 “Installing the PCL 6/5e Printer Driver”

Printer Language PCL 6 PCL 5e PS2

Operating system

Windows 95 *1 √ √ √

Windows 98 *2 √ √ √

Windows Me *3 √ √ √

Windows 2000 *4 √ √ √

Windows XP *5 √ √ √

Windows NT 4.0 *6 √ √ √ *8 

Mac OS *7 √ *9   *10 
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❖❖❖❖ PostScript Printer Driver for Windows
This is the PostScript Level 2 compatible driver. This printer driver allows the
computer to communicate with the printer via PostScript Level 2.
⇒ p.20 “Windows 95/98/Me - Installing the PostScript Printer Driver”
⇒ p.21 “Windows 2000/Windows XP - Installing the PostScript Printer Driv-
er”
⇒ p.23 “Windows NT 4.0 - Installing the PostScript Printer Driver”

❖❖❖❖ Post Script Printer Description (PPD) files for a Macintosh
PPD files, in combination with the LaserWriter driver, allow the computer to
communicate with the printer. The printer specific functions can be used by
installing a PPD file. You can use the LaserWriter printer driver that comes
with the Macintosh. Use the appropriate printer driver that comes with the
Macintosh operating system you are using. See the documentation that comes
with the Macintosh for more information about the LaserWriter functions.
⇒ p.27 “Macintosh”

Software and Utilities provided on the CD-ROM

❖❖❖❖ Agfa Monotype Font Manager 2000
Helps you to install new screen fonts, or organize and manage fonts already
installed on the system.

❖❖❖❖ SmartNetMonitor for Admin
SmartNetMonitor for Admin is software that uses the TCP/IP and IPX/SPX
protocols to monitor the printers in a network. It can monitor multiple net-
work printers having IP addresses. We recommend network administrators
to use this software.

Reference
For more information about SmartNetMonitor for Admin, see the Smart-
NetMonitor for Admin online Help file.

❖❖❖❖ SmartNetMonitor for Client
SmartNetMonitor for Client is software equipped with the following func-
tions. We recommend all users of this printer to install this software.
• Provides the function to print in a Peer-to-Peer network.
• Uses the TCP/IP and IPX/SPX protocols to monitor the status of devices

in a network constantly.

Reference
For more information about SmartNetMonitor for Client, see the Smart-
NetMonitor for Client online Help file.
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❖❖❖❖ Acrobat Reader
A utility that allows you to read PDF (Portable Document Format). This soft-
ware is provided as a PDF file on the CD-ROM labeled “Operating Instruc-
tions for Printer”.

Note
❒ Documentation about using the printer is provided as a PDF format on the

CD-ROM. See Acrobat Reader online Help for more information about us-
ing Acrobat Reader.

❖❖❖❖ Printer Utility for Mac
This utility allows users to download and manage a variety of fonts as well as
to manage their printers. For more information about this utility, see the Type
1018 PostScript level2 Compatible Kit Operating Instructions Supplement
which is provided as a PDF file on the CD-ROM labeled “Operating Instruc-
tions for Printer”.

Important
❒ If you upgrade to Windows 2000/Windows XP from Windows 95/98/Me or

Windows NT 4.0, the software and utilities must be uninstalled prior to in-
stalling Windows 2000/Windows XP. Then reinstall them in a Windows
2000/Windows XP environment.
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Guide to This Machine

Control panel is differ depending on
the machine. Confirm that which type
of machine you have.

Control Panel

❖❖❖❖ Copier based model
This panel display is for the installed Printer and Facsimile feature.

1. {{{{Printer Mode}}}} key
Press to use printer functions.

2. {{{{Job Reset}}}} key
When the printer is online, press this
key to cancel any ongoing print job.

3. Indicators
These indicators show errors or the
status of the machine.
The h symbol is displayed following
conditions and the message is dis-
played on the panel display.

❖❖❖❖ Loading Paper
There is no paper in the paper tray.

Note
❒ Appears only when you use the

machine as a Copier or Facsimile.

❖❖❖❖ Changing the Toner Cartridge
It is time to supply toner.

❖❖❖❖ Clearing Misfeeds
Paper misfeeds have occurred.

Reference
For more information about
solving above error, see "Trou-
bleshooting" in the Copy Refer-
ence.

4. {{{{Cancel}}}} key
Press to cancel an operation or return
to the previous display.

5. Display panel
Shows operation status, error messag-
es, and function menus.

ZENS062E
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6. 00001111 keys
Press to select an item on the panel
display.

7. {{{{OK}}}} key

8. {{{{User Tools/Counter}}}} key
Press to change the default settings
and conditions to meet your require-
ments.

9. Data In/Online indicator
Blinks while the printer is receiving
data from a computer or printing and
is on while the printer is online.

10. {{{{On Line}}}} key
Press this key to switch the printer be-
tween online and offline.

11. Number keys
Use to enter the desired number of
copies and data for selected modes.

12. Operation switch
Press this switch to turn the power on
(the On indicator goes on). To turn the
power off, press this switch again (the
On indicator goes off).

❖❖❖❖ Facsimile based model

1. {{{{Printer Mode}}}} Key
Press to use printer functions.

2. {{{{On Line}}}} key
Press this key to switch the printer be-
tween online and offline.

3. {{{{Job Reset}}}} key
When the printer is online, press this
key to cancel any ongoing print job.

4. Display panel
Shows operation status, error messag-
es, and function menus.

5. {{{{Cancel}}}} key
Press to cancel an operation or return
to the previous display.

6. Add Toner indicator
Blinks when toner is about to runout
and lights continuously when toner
has run out.

7. Load Paper indicator 
Lights when a paper tray is empty or
the paper tray is not fully inserted.

8. 00001111 key
Press to select an item on the panel
display.

9. Printer Error indicator
Lights when an error occurred on the
printer. Check the display and read
the message to identify the problem.

10. {{{{OK}}}} key

ZFWS031E
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11. {{{{User Tools}}}} key
Press to change the default settings and
conditions to meet your requirements.

12. Status Indicator
These indicators keep you informed
about the current status of the unit. 
• hAlarm 

When the alarm indicator flashes,
check the display and read the mes-
sage to identify the problem (such
as a paper jam or open cover).

• 0Communicating 
Lights during fax transmission or
reception. 

13. Number keys
Use to enter the desired number of
data for selected modes.

Panel Display

The panel display shows operational status, error messages, and function menus.

Important
❒ Do not apply a strong shock or force of more than about 30N (about 3kgf) to

the panel display or it may be damaged.

Online and Offline

Press the {{{{Printer Mode}}}} key on the control panel.
"Ready" appears on the panel display.

Online

When the machine is online, it can receive data from the computer.
Press the {{{{On Line}}}} key to switch the printer online. "Ready" appears on the pan-
el display. Data In/Online or On Line indicator is on while the printer is online.

Offline

When the machine is offline, it cannot receive data from the computer.
Press the {{{{On Line}}}} key to switch the printer offline. "Offline" appears on the pan-
el display. Data In/Online or On Line indicator is off while the printer is offline.
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Connecting the Machine

Confirm that the shape and the position of the connector are as shown in the il-
lustration.

1. 10BASE-T/100BASE-TX (option) 2. Parallel Port

Requirements

Requirements

Before using this machine, confirm that all the environmental and electrical re-
quirements have been met. Connect the machine to the computer using the par-
allel port, optional Network Interface Board Type 1018, or both.
Confirm that all the cables, connectors, and electrical outlets necessary to attach
the machine to the computer or network.

Important
❒ The interface cable is not supplied in the box. It is your responsibility to pro-

vide the interface cable appropriate for the computer that you are using.

Reference
For more information about using the parallel port, see p.9 “Parallel cable re-
quirements”.
For more information about using a network, see p.9 “Network cable require-
ments”.

ZFWH231E
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Network cable requirements

Optional Network Interface Board Type 1018 can be installed to allow direct
connection to a network.
The optional Network Interface Board supports 10BASE-T or 100BASE-TX con-
nections. 
You can use the machine in the following network environments: 
• Using the appropriate network management software and printer driver.
• Attaching the machine to a network (computer) set up as a server.

*1 Under Windows NT 4.0, only × 86 CPU is supported.
In a mixed network environment, the protocol switches automatically.

Reference
For more information about resolving network connection problems, see p.13
“Configuring the Printer for the Network”.

Note
❒ Consult your network administrator before connecting the machine to a net-

work.
❒ Be sure to use the interface cable with ferrite core for the connection to the

computer (and/or HUB) in order to meet FCC and EMC Directive
89/336/EEC emission guidelines.

Parallel cable requirements

The machine's parallel interface is a standard bidirectional interface. It requires
a standard 36-pin parallel cable compliant with IEEE 1284 and a parallel port
available on the host computer.
This machine does not provide the parallel cable to connect the machine to the
computer.

Note
❒ Do not use a parallel cable that is longer than 3 meters (10 feet).

Client Windows 95, 98, Me, Windows 2000, Windows XP, Windows NT 
4.0, *1 , Mac OS 8 or 9 (Type 1018 PostScript level2 Compatible Kit is 
required)

Driver PCL 6/5e, PS2

File Server NetWare 3.x, NetWare 4.x, NetWare 5.x

Protocol TCP/IP, IPX/SPX, AppleTalk
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Connecting the Network Interface Cable to the Network

Connect the machine to the network using optional Network Interface Board
Type 1018.
Follow these steps to connect the machine.

AAAA Confirm that you have the correct cable.

BBBB Confirm that the machine is turned off.

CCCC Loop the network cable. The loop should be about 15cm (6”) from the end
of the cable on the end closest to the printer.

DDDD Attach the ferrite core to the loop.

EEEE Attach the network cable to the 10BASE-T/100BASE-TX port on the ma-
chine.

Reference
See p.8 “Connecting the Machine” to confirm the position of the 10BASE-
T/100BASE-TX port.

Note
❒ Confirm that the cable is connected to the 10BASE-T/100BASE-TX port. 

FFFF Connect the other end of the cable to the network.
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Indicators on the optional Network Interface Board

1. Indicator (green)
Is on when the power of the machine is
on and on while the machine is in a net-
work environment.

2. Indicator (orange)
Is blinking while the machine is receiving
print jobs over the network environment
and off when the print jobs have been
sent to the controller.

----Status page
The status page of Network Interface Board will be automatically printed in the
following cases:
• when the printer is turned on.
• when Network Interface Board is reset.
This feature can be disabled with NIB Setup Tool which is included in the Smart-
NetMonitor for Admin program folder.
To disable this feature, check [Property Sheet] in the "NIB Setup Tool" screen.
Click [Detailed...] in the [General] tab and remove the check from the box for "Print
configuration page on start up".

ZENS510E
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Connecting the Machine to the Host Using the Parallel Interface 
Cable

Connect the machine to the host computer using a parallel interface cable com-
pliant with IEEE 1284 (supplied by you).
Follow these steps to connect the machine to the host computer.

AAAA Confirm that you have the correct cable. 

BBBB Confirm that both the machine and a computer are turned off.

CCCC Plug the 36-pin end of the parallel cable into the parallel port at the right
side of the back cover of the machine.

Reference
See p.8 “Connecting the Machine” to confirm the position of the parallel
port.

DDDD Squeeze the wire clips on each side of the connector together until they
snap into place. The clips hold the cable securely in place. 

EEEE Plug the other end of the parallel cable into the computer's parallel port.
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2. Configuring the Printer for
the Network

Configuring the Printer for the Network 
with the Control Panel

After installing the optional Network
Interface Board, configure it for the
network using the machine's control
panel.
If you use TCP/IP, you should assign
the IP Address and Subnet Mask. You
can also set the Gateway Address us-
ing the machine's control panel.

Note
❒ When you turn the machine's pow-

er switch on, it may take a few
minutes to initialize the optional
Network Interface Board. If the “2.
Network Setup” in the following
step 4. is shaded, wait for a few
minutes.

Reference
For more information about using
this machine as a network printer,
see the “Quick Configuration
Guide” which is provided as a PDF
file on the CD-ROM labeled “Op-
erating Instructions for Printer”.

AAAA Press the {{{{User Tools/Counter}}}} or
{{{{User Tools}}}} key.

The key is differ depending on the
machine. Confirm that which type
of machine you have.

BBBB Press the 0000 or 1111key to display
"Printer Features" .

CCCC Press the {{{{OK}}}} key.

The following screen appears on
the panel display.

DDDD Press the 0000 or 1111key until the fol-
lowing message appears on the
panel display.

EEEE Press the {{{{OK}}}} key.
The following screen appears on
the panel display.

FFFF Press the {{{{OK}}}} key.

The following screen appears on
the panel display.

GGGG Set the IP Address with the 0000 or
1111key and the number keys.

Note
❒ To get the IP Address for the

printer, contact your network
administrator.
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A Type the first three digits of the
IP Address, and the pointer
moves to the next entry field au-
tomatically.

Note
❒ 1 key : Press to go to the next

entry field.
❒ 0 key : Press to go back to

the previous entry field.
The following screen appears
on the panel display.

Repeat these procedures to
complete the IP Address set-
ting.

Note
❒ {{{{OK}}}}: Press to set the new

settings and return to the
previous menu.

❒ {{{{Cancel}}}}: Press to return to
the previous menu without
changing any data.

B Press the {{{{OK}}}} key.
The following screen appears
on the panel display for two sec-
onds.

The setting of the IP Address is
completed. Then return to the
previous screen.

HHHH Press the 0000 or 1111key to display
“Subnet Mask”and "Gateway Ad-
dress", then set "Subnet Mask"
and "Gateway Address" follow-
ing the same procedure for setting
the IP Address, if necessary.

----Address

❖❖❖❖ Subnet Mask
A number used to mathematically
"mask" or hide an IP Address on
the network by eliminating those
parts of the address that are alike
for all the machines on the net-
work.

❖❖❖❖ Gateway Address
A gateway is a connection or inter-
change point that connects two
networks. A gateway address is for
the router or host computer used
as a gateway.

Note
❒ To get the addresses, contact

your network administrator.
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3. Installing the Printer Driver
and Software

This manual assumes that you are familiar with general Windows procedures
and practices. If you are not, see the documentation that comes with Windows
for details.

Installation Method

The following table shows how to install the printer drivers and software.

*1 Available operating systems are as follows: Windows 95/98/Me, Windows 2000,
Windows XP, Windows NT 4.0

*2 Using custom installation, you can install various software separately.

Reference
For more information about the printer drivers, see p.2 “Printer Drivers for
This Machine”. For installing the printer drivers, see p.18 “Installing the PCL
6/5e Printer Driver” or p.20 “Installing the PostScript Printer Driver”.
For more information about the software and utilities, see p.3 “Software and
Utilities provided on the CD-ROM”.

Important
❒ Before starting this installation, close all documents and applications. In a net-

work environment, confirm that users who are logged on are disconnected.
Be sure to do this when it will create the least interference with other users. 

❒ After installing a printer driver, you must restart the computer. 

Note
❒ If the "plug and play" function is started, click [Cancel] in the [New Hardware

Found], [Device Driver Wizard] or [Found New Hardware Wizard] dialog box, and
then insert the CD-ROM. The [New Hardware Found], [Device Driver Wizard] or
[Found New Hardware Wizard] dialog box appears depending on the system ver-
sion of the Windows 95/98/Me, Windows 2000, Windows XP. 

Auto Run *1 

Quick Install Custom 
installation *2 

Network connec-
tion with TCP/IP 

Parallel 
connection

PCL 6 printer driver ❍ ❍ ❍

PCL 5e printer driver ❍

PostScript printer driver ❍

Agfa Monotype Font Manager 
2000

❍

SmartNetMonitor for Admin ❍

SmartNetMonitor for Client ❍ ❍
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Quick Install

Auto Run starts the installer automatically when you load the CD-ROM in the
CD-ROM drive. By selecting Quick Install, you can install the necessary software
easily.
TCP/IP requires the following: 
• This machine must be connected to the network through the network inter-

face cable.
• This machine must be turned on.
• The TCP/IP protocol must be configured.
• An IP address must be allocated to this machine and to the computer.

Limitation
❒ If your system is Windows 2000, Windows XP or Windows NT 4.0, installing

a printer driver by Auto Run requires Administrators permission. When you
install a printer driver by Auto Run, log on using an account that has Admin-
istrators permission.

Note
❒ Auto Run might not automatically work with certain OS settings. In this case,

launch "Setup.exe" located on the CD-ROM root directory.
If you want to cancel Auto Run, hold down the {{{{SHIFT}}}} key (when your system
is Windows 2000, hold down the left {{{{SHIFT}}}} key) while inserting the CD-ROM.
Keep the {{{{SHIFT}}}} key held down until the computer has finished accessing the
CD-ROM.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsh (German), English (English), Espanol (Spanish), Francais (French),
Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwe-
gian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska
(Swedish)
Default interface language is English.

DDDD Select [Quick Install].

EEEE The software license agreement appears in the [License Agreement] dialog
box.

After reading through all of the contents, click [I accept the agreement] to agree
with the License Agreement, and then click [Next].
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FFFF Click to select a model name you want to use when the "Select Printer" di-
alog box appears.

Note
❒ For a network connection with TCP/IP, select the printer whose IP address

is displayed in [Connect To].
❒ For parallel connection, select the printer whose printer port is displayed

in [Connect To].

GGGG Click [Install].

HHHH Follow the instructions on the screen.

Note
❒ During installation in Windows 2000, the [Digital Signature Not Found] dialog

box may appear. In this case, click [Yes] to continue the installation.
❒ During installation in Windows XP, the [Hardware Installation] dialog box

may appear. In this case, click [Continue Anyway] to continue the installa-
tion.

A message prompting you to restart your computer may appear. To complete
the installation, restart your computer.
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Installing the PCL 6/5e Printer Driver

Installing the PCL 6/5e Printer Driver

Two kinds of PCL printer drivers, PCL 6 and PCL 5e, are provided with this
printer. We recommend PCL 6 as your first choice.

Limitation
❒ If your system is Windows 2000, Windows XP or Windows NT 4.0, installing

a printer driver by Auto Run requires Administrators permission. When you
install a printer driver by Auto Run, log on using an account that has Admin-
istrators permission.

Important
❒ When updating the printer driver by installing the latest version, you should

uninstall that of former version if any. See “Uninstalling the Printer Driver
and Software” in Printer Reference 2.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].
The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsh (German), English (English), Espanol (Spanish), Francais (French), Ital-
iano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwegian),
Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska (Swedish)
Default interface language is English.

DDDD Select [PCL Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through all of the contents, click [I accept the agreement] to agree
with the License Agreement, and then click [Next].

FFFF Select the printer driver you want to install when the "Select Program" di-
alog box appears.

GGGG Follow the instructions on the screen.

Note
❒ During installation in Windows 2000, the [Digital Signature Not Found] dialog

box may appear. In this case, click [Yes] to continue the installation.
❒ During installation in Windows XP, the [Hardware Installation] dialog box may

appear. In this case, click [Continue Anyway] to continue the installation.
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Setting up options

Important
❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the

Memory Unit), you should set up the options with the printer driver.

Limitation
❒ In Windows 2000 or Windows XP, changing the printer settings requires

Manage Printers permission. Members of the Administrators and Power Us-
ers groups have Manage Printers permission by default. When you set up op-
tions, log on using an account that has Manage Printers permission.

❒ In Windows NT4.0, changing the setting of the printer requires Full Control
access permission. Members of the Administrators, Server Operators, Print
Operators, and Power Users groups have Full Control permission by default.
When you set up options, log on using an account that has Full Control per-
mission.

Note
❒ When setting up options, you should access the Printer Properties dialog box

from Windows. You cannot set up options by accessing the Printer Properties
dialog box from an application.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties]. 

The Printer Properties appear.

DDDD Click the [Accessories] tab.

EEEE Select options you have installed from the [Options] group.

FFFF Click [OK] .
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Installing the PostScript Printer Driver

This section describes basic instructions for installing the PostScript printer driv-
er. The actual procedure may differ depending on the operating system. Follow
the appropriate procedures below.

Important
❒ When updating the printer driver by installing the latest version, you should

uninstall that of former version if any. See “Uninstalling the Printer Driver and
Software” in Printer Reference 2.

Windows 95/98/Me - Installing the PostScript Printer Driver

Installing the printer driver

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsh (German), English (English), Espanol (Spanish), Francais (French),
Italiano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwe-
gian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska
(Swedish) 
Default interface language is English.

Note
❒ The printer driver with the selected language will be installed. The printer

driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Select [PostScript level2 Compatible Printer Driver].

[Add Printer Wizard] starts.

EEEE Click [Next].

FFFF Check [Local Printer] and then click [Next].

A dialog box for selecting the printer appears.

GGGG Select the printer you want to use and then click [Next].

HHHH Follow the instructions on the screen.
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Setting up options

Important
❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the

Memory Unit), you should set up the options with the printer driver.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].
The Printer Properties appear.

DDDD Click the [Accessories] tab.

EEEE Select options you have installed from the [Options] group.

FFFF Click [OK].

Windows 2000/Windows XP - Installing the PostScript Printer Driver

Installing the printer driver

Limitation
❒ Installing a printer driver requires Administrators permission. When you install

a printer driver, log on using an account that has Administrators permission.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsh (German), English (English), Espanol (Spanish), Francais (French), Ital-
iano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwegian),
Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska (Swedish) 
Default interface language is English.

Note
❒ The printer driver with the selected language will be installed. The printer

driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Select [PostScript level2 Compatible Printer Driver].
[Add Printer Wizard] starts.
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EEEE Click [Next].

FFFF Check [Local Printer] and then click [Next].

A dialog box for selecting the printer port appears.

Note
❒ With Windows XP, click [Local printer attached to this computer], and confirm

that [Automatically detect and install my Plug and Play printer] is unchecked. And
then click [Next].

GGGG Select the check box of the port you want to use, and then click [Next].

A dialog box for selecting the printer appears.

HHHH Select the printer you want to use and then click [Next].

IIII Follow the instructions on the screen.

Note
❒ During installation, the [Digital Signature Not Found] dialog box may appear.

In this case, click [Yes] to continue the installation.
❒ During installation in Windows XP, the [Hardware Installation] dialog box may

appear. In this case, click [Continue Anyway] to continue the installation.

Setting up options

Important
❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the

Memory Unit), you should set up the options with the printer driver.

Limitation
❒ Changing the printer settings requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].
The Printer Properties appear.

DDDD Click the [Accessories] tab.

EEEE Click [OK].
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Windows NT 4.0 - Installing the PostScript Printer Driver

Installing the printer driver

Limitation
❒ Installing a printer driver requires Administrators permission. When you install

a printer driver, log on using an account that has Administrators permission.

Important
❒ The CD-ROM containing the Windows NT Server operating system version

4.0, or the Windows NT Workstation operating system is required for install-
ing the printer driver.

❒ We recommend that you upgrade the Windows NT 4.0 operating system to
Service Pack 4 or later before installing the printer driver. Contact your Win-
dows retailer for more information about the latest version available.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].
The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsh (German), English (English), Espanol (Spanish), Francais (French), Ital-
iano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwegian),
Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska (Swedish) 
Default interface language is English.

Note
❒ The printer driver with the selected language will be installed. The printer

driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Select [PostScript level2 Compatible Printer Driver].

[Add Printer Wizard] starts.

EEEE Click [Next].

FFFF After confirming that the [My Computer] option is selected, click [Next].

A dialog box for selecting the printer port appears.

GGGG Select the check box of the port you want to use, and then click [Next].

A dialog box for selecting the printer appears.

HHHH Select the printer you want to use and then click [Next].

IIII Follow the instructions on the screen.
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Setting up options

Limitation
❒ Changing the printer settings requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

Important
❒ If the printer is equipped with certain options (e.g. the Paper Feed Unit or the

Memory Unit), you should set up the options with the printer driver.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].
The Printer Properties appear.

DDDD Click the [Accessories] tab.

EEEE Select options you have installed from the [Options] group.

FFFF Click [OK].

Using Adobe PageMaker Version 6.0 or 6.5

If you use the printer under Windows 95/98/Me, Windows 2000, Windows NT
4.0 with Adobe PageMaker, you need to copy the PPD file to the PageMaker
folder. 
The PPD file is the file with extension ".ppd". It is in the folder "DRIV-
ERS\PS\WIN9X_ME\(Language)\DISK1\" on the CD-ROM. 
The [WIN9X_ME] folder, inside the [PS] folder is for the Windows 95/98/Me op-
erating system. Use the folder at this level that is appropriate for the operating
system you are using.
The third folder, "(Language)" may be substituted by an appropriate language
name. 
Copy this file to the PageMaker folder.
For PageMaker 6.0 default installation, the folder is "C:\PM6\RSRC\PPD4",
a n d  fo r  P a ge M a k er  6 . 5  d ef au l t  i n s t a l l a t i o n ,  t h e  d i r ec t o r y  i s
"C:\PM65\RSRC\USENGLISH\PPD4". "USENGLISH" may differ depending
on your language selection.

Reference
For more information about the language name, see p.16 “Quick Install”.
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Installing the SmartNetMonitor for 
Client/Admin

Limitation
❒ If your system is Windows 2000, Windows XP or Windows NT 4.0, installing

software by Auto Run requires Administrators permission. When you install
a printer driver by Auto Run, log on using an account that has Administrators
permission.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].
The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsh (German), English (English), Espanol (Spanish), Francais (French), Ital-
iano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwegian),
Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska (Swedish)
Default interface language is English.

DDDD Select [SmartNetMonitor for Client / Admin].

EEEE The software license agreement appears in the [License Agreement] dialog
box.
After reading through all of the contents, click [I accept the agreement] to agree
with the License Agreement, and then click [Next].

FFFF Select the program you want to install when the "Select Program" dialog
box appears.

GGGG Follow the instructions on the screen.
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Installing the Agfa Monotype Font 
Manager 2000

Limitation
❒ If your system is Windows 2000, Windows XP or Windows NT 4.0, installing

software by Auto Run requires Administrators permission. When you install
a printer driver by Auto Run, log on using an account that has Administrators
permission.

AAAA Close all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

CCCC Select a language to change the interface language, and then click [OK].
The following languages are available: Cestina (Czech), Dansk (Danish),
Deutsh (German), English (English), Espanol (Spanish), Francais (French), Ital-
iano (Italian), Magyar (Hungarian), Nederlands (Dutch), Norsk (Norwegian),
Polski (Polish), Portugues (Portuguese), Suomi (Finnish), Svenska (Swedish)
Default interface language is English.

DDDD Select [Agfa Monotype Font Manager 2000].

EEEE Follow the instructions on the screen.
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Macintosh

Macintosh - Installing the PPD File

You can use the LaserWriter printer driver that comes with a Macintosh when
printing from a Macintosh. However, if you use the LaserWriter printer driver
alone, you cannot use the printer specific functions. The printer specific func-
tions can be used by installing the PPD file.

Note
❒ The LaserWriter printer driver for a Macintosh does not come with this print-

er. Use the appropriate printer driver that comes with the Macintosh you are
using.

❒ See the documentation that comes with the operating system for more infor-
mation about the functions of the LaserWriter 8 printer driver.

Installing the PPD File

AAAA Start the Macintosh.

BBBB Double-click the icon of the hard disk to open it.

CCCC Open the [Extensions] folder inside the [System Folder] by double-clicking it.

DDDD Insert the CD-ROM into the CD-ROM drive.

The icon of the CD-ROM appears.

EEEE Double-click the CD-ROM icon.

The contents of the CD-ROM are displayed.

FFFF Double-click the [Printer Descriptions] folder of the CD-ROM, and then dou-
ble-click the folder having the appropriate language name to open it.

GGGG Drag the PPD file for the printer and drop it into the [Printer Descriptions]
folder inside the [Extensions] folder on the Macintosh hard disk.
The PPD file is installed.

HHHH Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.
This completes PPD file installation.
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Setting up the PPD file

Preparation
Confirm that the printer is connected to an AppleTalk network before per-
forming the following procedure.

AAAA On the Apple menu, select [Chooser].

BBBB Click the [LaserWriter 8] icon.

CCCC In the [Select a PostScript Printer] list, click to select the name of the printer
you want to use.

DDDD Click [Create].

EEEE Click to select the printer you want to use, and then click [Select].

The PPD file is set up, and the LaserWriter 8 icon appears at the left of the
printer name on the list. Next, follow the procedure on p.28 “Setting up op-
tions” to make the option settings, or close the [Chooser] dialog box.

Setting up options

AAAA On the Apple menu, select [Chooser].

BBBB Click the [LaserWriter 8] icon.

CCCC In the [Select the PostScript Printer] list, click to select the name of the printer
you want to use, and then click [Setup].

DDDD Click [Configure].

A list of options appears.

EEEE Select the option you want to set up and select the appropriate setting for it.

Note
❒ If the option you want to set up does not appear, the PPD file has not been

set up correctly. Check the name of the PPD file shown in the dialog box.

FFFF Click [OK].
The list of options closes.

GGGG Click [OK].
The [Chooser] dialog box appears.

HHHH Close the [Chooser] dialog box.
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PRINTER Controller
Type 1013

Operating Instructions

Printer Reference 2 (option)
For safety, please read this manual carefully before you use this product and keep it
handy for future reference.



Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual.

Please keep this manual in a handy place near the machine.

Please read the Safety Information before using this machine. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Notes:

"PS2" stands for PostScript level2 Compatible in this manual.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or
other countries.

Ethernet is a registered trademark of Xerox Corporation.

Adobe, PostScript, Acrobat and PageMaker are registered trademarks of Adobe System Incorporated.

PCL is a registered trademark of Hewlett-Packard Company.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.



Manuals for This Machine

Manuals for This Machine

The following manuals separately describe the operational procedures for the
operation and maintenance of the machine.
Depending on the machine, some manuals are not provided. Confirm which
type of machine you have.
To enhance safe and efficient operation of the machine, all users should read and
follow the instructions contained in the following manuals.

❖❖❖❖ Copy Reference
Describes the procedures and functions for using this machine as a copier.

❖❖❖❖ System Settings
Describes the system settings of this machine.

❖❖❖❖ Facsimile Reference <Basic Features>
Describes the procedures and most frequently used functions for using this
machine as a facsimile.

❖❖❖❖ Facsimile Reference <Advanced Features>
Describes the procedures and more advanced functions for using this ma-
chine as a facsimile. And also explains settings for key operators.

❖❖❖❖ Printer Reference 1
Describes the system settings, procedures and functions for using this ma-
chine as a printer.

❖❖❖❖ Printer Reference 2
Describes the procedures and provides necessary information about using
this machine as a printer. This manual is provided as a PDF file on the CD-
ROM labeled “Operating Instructions for Printer”. (this manual)

❖❖❖❖ Network Interface Board Quick Configuration Guide
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. This manual is pro-
vided as a PDF file on the CD-ROM labeled “Operating Instructions for Print-
er”.

❖❖❖❖ Type 1018 PostScript level2 Compatible Kit Operating Instructions Supplement
Describes the functions of Printer Utility for Mac. This manual is provided as
a PDF file on the CD-ROM labeled “Operating Instructions for Printer”.
i
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❖❖❖❖ Network Interface Board Type 1018 Owner's Manual
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. This manual is pro-
vided as a PDF file on the CD-ROM labeled “Print Server Software and Doc-
umentation” which comes with optional Network Interface Board Type 1018.

Note
❒ Concerning UNIX printing information, please visit our web site or consult

your authorized reseller.



How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

{ }

Keys built into the machine's control panel.
Keys on the computer's keyboard.
iii
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1. Setting Up the Printer Driver
and Canceling a Print Job
PCL 6/5e - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

Changing the default printer settings

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Properties].

The Printer Properties appear.

DDDD Make any settings you require and click [Apply].

Note
❒ With some applications, the printer driver's settings are not used, and the

application's own default settings are applied.

EEEE Click [OK].

Making printer settings from an application

To make the printer settings for a specific application, open the Printer Proper-
ties dialog box from that application. The following example describes how to
make settings for the WordPad application that comes with Windows
95/98/Me.

Note
❒ The actual procedure you should follow to open the Printer Properties dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].
The [Print] dialog box appears.
1
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BBBB Select the printer you want to use in the [Name] list box, and then click [Prop-
erties].

The Printer Properties appear.

CCCC Make any settings you require and click [Apply].

DDDD Click [OK] to start printing.

Windows 2000/Windows XP - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Properties].
The Printer Properties appear.

DDDD Make any settings you require and click [Apply].

Note
❒ Settings you make here are used as the default settings for all applications.

EEEE Click [OK].
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Changing the default printer settings - Printing Preferences Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Printing Preferences...].
The Printing Preferences Properties appear.

DDDD Make any settings you require and click [Apply].

Note
❒ Settings you make here are used as the default settings for all applications.

EEEE Click [OK].

Making printer settings from an application

To make the printer settings for a specific application, open the [Print] dialog box
from that application. The following example describes how to make settings for
the WordPad application that comes with Windows 2000.

Note
❒ The actual procedures you should follow to open the [Print] dialog box may

differ depending on the application. For more information, see the documen-
tation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] box.

Note
❒ With Windows XP, click [Preference] to open the Printer Preference win-

dow.
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CCCC Make any settings you require and click [Apply].

Note
❒ With Windows XP, make any settings you require and click [OK].

DDDD Click [Print] to start printing.

Windows NT 4.0 - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of Administrators, Server Operators, Print Operators, and Power
Users groups have Full Control permission by default. When you set up op-
tions, log on using an account that has Full Control permission. 

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Properties].
The Printer Properties appear.

DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Changing the default printer settings - Default Document Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you set up
options, log on using an account that has Full Control permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

BBBB Click to select the icon of the printer whose default settings you want to
change.
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CCCC On the [File] menu, click [Document Defaults...].

The Default Document Properties appear.

DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make the printer settings for a specific application, open the Printer Proper-
ties dialog box from that application. The following example describes how to
make settings for the WordPad application that comes with Windows NT 4.0.

Note
❒ The actual procedure you should follow to open the Printer Properties dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Prop-
erties].
The Printer Properties appear.

CCCC Make any settings you require and click [OK].

DDDD Click [OK] to start printing.
5
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PostScript - Setting Up for Printing

Windows 95/98/Me - Accessing the Printer Properties

Changing the default printer settings

To make the Printer default settings, first open the Printer Properties dialog box
from the [Printers]window.

Note
❒ With some applications, the printer driver's settings are not used, and the ap-

plication's own default settings are applied.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Properties].

The Printer Properties appear.

DDDD Make any settings you require and click [Apply].

EEEE Click [OK].

Making printer settings from an application

To make the printer settings for a specific application, open the Printer Proper-
ties dialog box from that application. The following example describes how to
make settings for the WordPad application that comes with Windows
95/98/Me.

Note
❒ The actual procedure you should follow to open the Printer Properties dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ With some applications, the printer driver's settings are not used, and the ap-
plication's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.
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BBBB Select the printer you want to use in the [Name] list box, and then click [Prop-
erties].

The Printer Properties appear.

CCCC Make any settings you require and click [Apply].

DDDD Click [OK] to start printing.

Windows 2000/Windows XP - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Properties].
The Printer Properties appear.

DDDD Make any settings you require and click [Apply].

Note
❒ Settings you make here are used as the default settings for all applications.

EEEE Click [OK].
7
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Changing the default printer settings - Printing Preferences Properties

Limitation
❒ Changing the setting of the printer requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Printing Preferences...].
The Printing Preferences Properties appear.

DDDD Make any settings you require and click [Apply].

Note
❒ Settings you make here are used as the default settings for all applications.

EEEE Click [OK].

Making printer settings from an application

To make the printer settings for a specific application, open the [Print] dialog box
from that application. The following example describes how to make settings for
the WordPad application that comes with Windows 2000.

Note
❒ The actual procedures you should follow to open the [Print] dialog box may

differ depending on the application. For more information, see the documen-
tation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] box.

Note
❒ With Windows XP, click [Preference] to open the Printer Preference win-

dow.
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CCCC Make any settings you require and click [Apply].

Note
❒ With Windows XP, make any settings you require and click [OK].

DDDD Click [OK] to start printing.

Windows NT 4.0 - Accessing the Printer Properties

Changing the default printer settings - Printer Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of Administrators, Server Operators, Print Operators, and Power
Users groups have Full Control permission by default. When you set up op-
tions, log on using an account that has Full Control permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears .

BBBB Click to select the icon of the printer whose default settings you want to
change.

CCCC On the [File] menu, click [Properties].
The Printer Properties appear.

DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Changing the default printer settings - Default Document Properties

Limitation
❒ Changing the setting of the printer requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you set up
options, log on using an account that has Full Control permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

BBBB Click to select the icon of the printer you want to use.

CCCC On the [File] menu, click [Document Defaults...].
The Default Document Properties appear.
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DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make the printer settings for a specific application, open the Printer Proper-
ties dialog box from that application. The following example describes how to
make settings for the WordPad application that comes with Windows NT 4.0.

Note
❒ The actual procedure you should follow to open the Printer Properties dialog

box may differ depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].
The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list box, and then click [Prop-
erties].

The Printer Properties appear.

CCCC Make any settings you require and click [OK].

DDDD Click [OK] to start printing.
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Macintosh - Setting Up for Printing

Making paper settings from an application

AAAA Open the file you want to print.

BBBB On the [File] menu, click [Page Setup].
The [LaserWriter 8 Page Setup] dialog box appears.

CCCC Confirm that the printer you want to use is shown in [Format for:] box.

Then, use [Paper] to select the paper size you want to use.

Note
❒ If the printer is not shown in the [Format for:] box, use the pop-up menu to

display a list of available printers.

Reference
The actual appearance of the [Page Setup] dialog box depends on the appli-
cation you are using. See the documentation that comes with the Macin-
tosh for more information.

DDDD After configuring the settings, click [OK].

Setting up for printing from an application

AAAA Open the file you want to print.

BBBB On the [File] menu, click [Print].

The [Printer] dialog box appears.

CCCC Confirm that the printer is selected in the [Printer :] box, and make the print-
er settings.

DDDD After configuring the settings, click [Print] .
11
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Canceling a Print Job

Windows 95/98/Me, Windows 2000, Windows XP, Windows NT 4.0 
- Canceling a Print Job 

AAAA Double-click the printer icon on the Windows taskbar.

A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

BBBB Select the name of the job you want to cancel.

CCCC On the [Document] menu, click [Cancel]. 

Note
❒ You can also open the print job queue window by double-clicking the

printer icon in the [Printers] or [Printers and Faxes] window.

DDDD Press the {{{{Job Reset}}}} key on the control panel.

The message appears on the panel display indicating that the print job is be-
ing canceled. 

Important
❒ This procedure cancels the print job that is being processed by the printer.

In some cases, the printer may already be processing data for the next print
job following the one currently being output. In this case, the next print job
is also canceled when you press the {{{{Job Reset}}}} key.

❒ When the printer is being shared by multiple computers, be careful not to
accidentally cancel someone else's print job.

Note
❒ You cannot stop printing data that has already been processed internally

by the printer. Because of this, printing may continue for a few pages after
you press the {{{{Job Reset}}}} key.

❒ A print job that contains a large volume of data may take considerable time
to stop.
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Macintosh - Canceling a Print Job

AAAA Double-click the printer's icon on the desktop.
A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

BBBB Select the name of the job you want to cancel.

CCCC Click the pause icon, and then click the trash icon.

DDDD Press the {{{{Job Reset}}}} key on the control panel.
The message appears on the panel display indicating that the print job is be-
ing canceled.

Important
❒ This procedure cancels the print job that is being processed by the printer.

In some case, the printer may already be processing data for the next print
job following the one currently being output. In this case, the next print job
is also canceled when you press the {{{{Job Reset}}}} key.

❒ When the printer is being shared by multiple computers, be careful not to
accidentally cancel someone else's print job.

Note
❒ You cannot stop printing data that has already been processed internally

by the printer. Because of this, printing may continue for a few pages after
you press the {{{{Job Reset}}}} key.

❒ A print job that contains a large volume of data may take considerable time
to stop.
13
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2. Uninstalling the Printer
Driver and Software
15
Uninstalling the PCL 6/5e Printer Driver

This section describes how to uninstall the printer driver. The actual procedure
may differ depending on the operating system.
Follow one of the appropriate procedures below.

Windows 95/98/Me - Uninstalling the PCL 6/5e Printer Driver

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Click to select the icon of the printer you want to remove.

DDDD On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.

Windows 2000/Windows XP - Uninstalling the PCL 6/5e Printer Driver

Limitation
❒ Uninstalling a printer driver requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you uninstall a printer driver, log on using an account
that has Manage Printers permission.

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

CCCC Click to select the icon of the printer you want to remove.

DDDD On the [File] menu, click [Delete].
A confirmation dialog box appears. 

EEEE Click [Yes] to uninstall the printer driver.
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Windows NT 4.0 - Uninstalling the PCL 6/5e Printer Driver

Limitation
❒ Uninstalling a printer driver requires Full Control access permission. Mem-

bers of the Administrators, Server Operators, Print Operators, and Power Us-
ers groups have Full Control Permission by default. When you install a
printer driver, log on using an account that has Full Control permission.

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Click to select the icon of the printer you want to remove.

DDDD On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.
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Uninstalling the PostScript Printer Driver

This section describes how to uninstall the PostScript printer driver.
The actual procedure may differ depending on the operating system.
Follow one of the appropriate procedures below.

Windows 95/98/Me - Uninstalling the PostScript Printer Driver

AAAA Close all applications that are currently running. 

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

CCCC Click to select the icon of the printer you want to remove. 

DDDD On the [File] menu, click [Delete].
A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.

Windows 2000/Windows XP - Uninstalling the PostScript Printer 
Driver

Limitation
❒ Uninstalling a printer driver requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you uninstall a printer driver, log on using an account
that has Manage Printers permission.

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP, access the [Printers and Faxes] window from [Start] on

the taskbar.

CCCC Click to select the icon of the printer you want to remove.

DDDD On the [File] menu, click [Delete].

A confirmation dialog box appears. 

EEEE Click [Yes] to uninstall the printer driver.
17
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Windows NT 4.0 - Uninstalling the PostScript Printer Driver

Limitation
❒ Uninstalling a printer driver requires Full Control access permission. Mem-

bers of the Administrators, Server Operators, Print Operators, and Power Us-
ers groups have Full Control Permission by default. When you uninstall a
printer driver, log on using an account that has Full Control permission.

AAAA Close all applications that are currently running. 

BBBB Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

CCCC Click to select the icon of the printer you want to remove. 

DDDD On the [File] menu, click [Delete].

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.

Macintosh - Uninstalling the PostScript Printer Driver

AAAA Delete the “PPD” file inside the [Printer Description] folder in the [Extensions]
folder in [System Folder].



3. Troubleshooting
Error & Status Messages on the Control 
Panel

Messages/Second messages Description Solution

Add Toner.

Open Front Cover and

/Follow Instructions to

Replace it.

Toner is running out. It is time to supply toner.

Clear Missfeed(s)

/Follow Instructions in

Front Cover

There is misfeed at the front 
cover.

Remove the misfed paper fol-
lowing the instructions inside 
the front cover.

Close Front/Right

Cover

The front or right cover is 
open.

Close the front or right cover.

Load Bypass Tray

[Paper Size]

There is no paper left in the 
Bypass Tray or the Bypass 
Tray is not installed.

Load paper into the Bypass 
Tray or install the Bypass 
Tray. For more information 
about the Bypass Tray, see the 
Operating Instructions that 
comes with this machine.

Load Paper

[Paper Size]

The paper size setting on the 
tray differs from that of print-
er driver.

Load paper that matches the 
paper size settings. Printing 
will not automatically resume 
if the paper size and orienta-
tion settings are incorrect.

The optional paper tray unit is 
not installed.

Install the optional paper tray 
unit. For more information 
about optional paper tray 
unit, see the Operating In-
structions that comes with this 
machine.

Load Tray # 

[Paper Size]

There is no paper left in this 
tray.

Load paper into the tray indi-
cated.

Memory Overflow

Job Incomplete

A memory overflow has oc-
curred.

Add memory to the printer.

Memory Full

Job Incomplete

A memory full has occurred. Add memory to the printer.

Printing... The printer is printing. Wait for a while.
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Print Overrun

Job Incomplete

A print overrun occurred on a 
file being printed. Only a part 
of the data on the page will be 
printed, and the print job is 
suspended, or the current 
print job has been canceled.

To print the image correctly, 
add memory to the printer or 
simplify the actual data size. 
Set "Page Protect" to "On" on 
the printer driver. Be sure to 
return "Page Protect" to "Au-
to" after the print job. With 
"Page Protect" "On", the print-
er performance might be de-
creased. While using the 
PostScript printer driver, low-
er the resolution setting.

Processing... The printer is processing in-
ternally.

Wait for a while.

Ready The printer is online and 
ready to print.

If you want to set the printer 
offline, press {{{{Online}}}}.

Resetting Job... The print job is being reset. Wait for a while.

Toner is Almost Empty Toner is almost running out. Replace the toner early to pre-
vent poor print quality.

Waiting... The printer is waiting for the 
next print job.

Wait for a while.

Warming Up... The printer is warming up or 
toner is being supplied.

Wait until the panel display 
changes to "Ready".

Messages/Second messages Description Solution
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Machine Does Not Print

Possible Cause Solutions

Is the power on? Turn on the machine.

Is the interface cable properly connected? Connect the interface cable properly.

If there are any connectors or screws, make 
sure that they are fastened securely.

Are you using the correct interface cable? Be sure to use the correct one. If the cable is 
damaged or worn, replace it with a new one.

Did you connect the interface cable after turn-
ing on the main switch?

Be sure to connect the interface cable before 
turning on the main switch.

Is the machine Online? Make it Online by touching the {{{{On Line}}}} key.

Is the specified paper set? Set the specified paper in any of the input 
trays.

Are there any error messages on the panel dis-
play?

Check the error message, and take the re-
quired action.

Does the indicator above the Printer Mode key 
stay red? Or Alarm indicator is flashing?

Check the error message, and take the re-
quired action.

Is the Data-in or Communicating Indicator 
blinking or lit?

If not, the data does not reach the machine. 
Check the printer cable connection. 

Also confirm that the printer port settings are 
correct.

Can you print a configuration page? If you cannot, check the printer cable connec-
tion. 

Also confirm that the printer port settings are 
correct.

Can you make a "Print Test Page" from the 
printer driver?

If you cannot, the machine might be out of or-
der. Contact your sales or service representa-
tive.
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Other Printing Problems

Problem Action

An image is printed on the reverse side of the 
paper.

Set the paper upside down.

Multiple pages are fed through the printer at 
once.

Remove all the paper from the tray and fan 
them gently.

Paper misfeeds occur frequently. Check the paper size settings. Use the recom-
mended paper. Avoid using curled, folded or 
wrinkled paper, perforated paper, or glossy 
paper.

An control panel error message stays on after 
removing the misfed paper.

A paper misfeed message will remain until the 
front cover is opened and then closed. Open 
the front cover and close it.

It takes a long time for the printer to start 
printing.

The machine might be in Energy Saver mode 
or Low Power mode, which requires more 
time for warming up and resuming the print 
job.

It takes too much time to complete the print 
job.

The data is so large or complex that it takes 
time to process it.

If the Data In indicator is blinking, the data 
processing is being done.

Just wait until it is finished.

Windows 95/98/Me, Windows 2000, Win-
dows XP, Windows NT 4.0 :

The computer does not recognize the installed 
printer options.

If the printer is not connected to a network, 
specify which options you have installed us-
ing the printer driver.

See the HELP file of the printer driver.

No image is printed when loading paper on 
the bypass tray.

The machine operates the function that forces 
to feed the paper in three minutes after you 
load the paper on the bypass tray. Load the pa-
per on the bypass tray again.



4. Using the Control Panel
Though the factory default settings of the printer are suitable for most printing
jobs, the "Printer Features" gives you access to a number of settings that control
basic printer operations. "Printer Features" settings you make are retained even
when you turn off the printer.

Reference
For more information about the copy features, facsimile features and system
settings, see the Operating Instructions that comes with this machine.

Note
❒ Some of the settings accessed by the printer driver can be accessed by the

“Printer Features”. Settings made by the printer driver take priority over set-
tings by the“Printer Features”.

Adjusting Printer Features

Printer Features Menu

There are four menu items in the "Printer Features" menu.
• Job Control
• Network Setup
• Maintenance
• List Print
You can select functions in the following table.
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*1 This menu is not displayed if the Bypass Tray is not installed.
*2 Optional Network Interface Board is required.
*3 Optional PostScript level2 Compatible Kit is required.

Category Function menu

Job Control

⇒ p.26

Paper Input Tray Priority

Tray Locking

Bypass Paper 
Size *1 

Standard Size

Custom Size

Print Quality Edge Smoothing

Resolution PCL

PS

Toner Saving

System Print PS Errors

I/O Timeout

I/O Buffer

Page Protect

Auto Continue

Sub Paper Size

PCL Menu Orientation

Form Lines

Font Source

Font Number

Point Size

Font Pitch

Symbol Set

Network Setup *2 

⇒ p.32

IP Address

Subnet Mask

Gateway Address

Maintenance

⇒ p.33

Restart Printer

Menu Reset

Hex Dump

List Print

⇒ p.34

Configuration Page

Menu List

PCL Font List

PS Font List *3 
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Accessing the Printer Features Menu

Press the {{{{User Toors/Counter}}}} or {{{{User Tools}}}} key.
The key is differ depending on the machine. Confirm that which type of machine
you have.
Press the 0 or 1 key to display “Printer Features”, then press {{{{OK}}}}.
The following screen appears on the panel display.

Press the 0 or 1 key to display the following four items one by one.
• Job Control
• Network Setup
• Maintenance
• List Print

Note
❒ 1 key : Press to go to the next menu.
❒ 0 key : Press to go back to the previous menu
❒ After making the printer settings, be sure to return to the previous menu by

pressing the {{{{Cancel}}}} key.
❒ After making the printer settings, press the {{{{User Tools/Counter}}}} or {{{{User

Tools}}}} key to return to the initial display.
❒ The revised settings are not canceled even if the power switch is turned off.
25
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Printer Features Parameters

Job Control Menu

There are four menu items in the “Job Control” menu.
• Paper Input
• Print Quality
• System
• PCL Menu

Job Control Parameters

❖❖❖❖ Paper Input

Menu Description

Tray Priority If a print job does not have a paper size command, the paper size 
of the tray which is specified by the Tray Priority is used.

Tray 1, Tray 2

Note
❒ Default: Tray 1

❒ Only the installed trays appear on the panel display. 

❒ It is recommended that you load paper having the size and di-
rection you frequently use in the tray selected with “Tray Pri-
ority”.

Tray Locking If you use different kinds of paper, you can lock a tray to prevent 
printing on wrong paper such as letterhead or colored paper. 
When “Auto Select” is selected in the Paper Source selections 
from the printer driver, the locked tray will not be used. 

Tray 1, Tray 2, None

Note
❒ Default: None

❒ This menu is invalid if the optional tray is not installed.

❒ If you want to use the locked tray, you must select the tray 
from the printer driver.

❒ When a locked tray is selected from the printer driver, the 
printer does not search for any other tray.
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❖❖❖❖ Print Quality

Bypass Paper Size You can specify the paper size, standard or custom, for the bypass 
tray.

When the bypass paper size is not specified, the paper size you set 
on the control panel is used.

If you use PCL 6 or PS2 printer driver to print custom paper size, 
the paper size you set in the printer driver is used.

If you use PCL 5e printer driver to print custom paper size, paper 
size you set on the control panel is used.

If the Bypass Tray can hold paper of either the short edge feed size 
or the long edge feed size, use the short edge feed size.

Note
❒ This menu is not displayed if the Bypass Tray is not installed.

❒ Specifications of bypass tray depends on the machine. Con-
firm which type of machine you have. See the Operating In-
structions that comes with this machine.

Menu Description

Edge Smoothing You can set whether to enable Edge Smoothing.

• On

• Off

Note
❒ Default: On

❒ If “Toner Saving” is “On”, “Edge Smoothing” is ignored even 
if it is “On”.

❒ The setting in the printer driver takes priority of the setting on 
control panel.

Resolution You can set the print resolution in dots per inch.

❖❖❖❖ PCL
300 dpi, 600 dpi

❖❖❖❖ PS
300 dpi, 600 dpi

Note
❒ Default: 600 dpi

❒ The setting in the printer driver takes priority of the setting on 
control panel.

Menu Description
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❖❖❖❖ System

Toner Saving You can select whether to enable Toner Saving.

• Off

• On

Note
❒ Default: Off

❒ If “Toner Saving” is “On”, “Edge Smoothing” is ignored even 
if it is “On”.

❒ The setting in the printer driver takes priority of the setting on 
control panel.

Menu Description

I/O Timeout You can set how many seconds the printer should wait before 
ending a print job. If data from other port often appears in the 
middle of the print job, you should increase the timeout value.

15 seconds, 30 seconds, 60 seconds, 180 seconds, 300 seconds

Note
❒ Default: 30 seconds

I/O Buffer You can set the size of the I/O Buffer. Normally it is not necessary 
to change this setting.

16 KB, 32 KB, 64 KB, 128 KB, 256 KB, 512 KB

Note
❒ Default: 32 KB

Print PS Errors You can set whether the PS error sheet should be printed out.

• Off

• On

Note
❒ Default: Off

Page Protect When the "Print Overrun. Job Incomplete.” message appears on 
the panel display, set this function to "On”.

• Auto

• On

Note
❒ Be sure to return “Page Protect”to “Auto” after the print job. 

With “Page Protect” “On”, the printer performance might be 
decreased.

❒ Default: Auto

❒ The setting in the printer driver takes priority of the setting on 
control panel.

Menu Description
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❖❖❖❖ PCL Menu

Auto Continue You can set whether to enable Auto Continue. When it is set to 
“On”, the printing continues even if the following error messages 
appear on the display.

“Print Overrun. Job Incomplete.”, “Memory Overflow. Job In-
complete.”, “Memory Full. Job Incomplete.”

• Off

• On

Note
❒ When it is “On”, and a certain type of error occurs, the current 

job might be canceled, and the printer automatically resumes 
the next job.

❒ Default: Off

Sub Paper Size You can enable the Auto Substitute Paper Size feature between A4 
and letter size. When you select "On", the printer substitutes A4 
↔ letter size if the paper currently specified is not loaded.

• Off

• On

Note
❒ Default: Off

❒ This feature is canceled when Bypass Tray or Use Slip Sheet 
function is used.

Menu Description

Orientation You can set the page orientation.

• Portrait

• Landscape

Note
❒ Default: Portrait

Form Lines You can set the number of lines per page.

5-128

Note
❒ Default: 64 (Metric version), 60 (Inch version)

Font Source You can set the location of the default font.

• Internal

• Download

Note
❒ Default: Internal

❒ When you select "Download", you can select only fonts down-
loaded to printer RAM.

Menu Description
29



Using the Control Panel

30

4

Font Number You can set the ID of the default font you want to use.

• 0 to 54 (for Internal)

• 1 to 50 (for Download source)

Note
❒ Default: Internal

❒ Default: 0

Point Size You can set the point size you want to use for the default font.

4 to 999.75 by 0.25

Note
❒ Default: 12.00

❒ This setting is effective only for a variable-space font.

Font Pitch You can set the number of characters per inch you want to use for 
the default font.

0.44 to 99.99 by 0.01

Note
❒ Default: 10.00

❒ This setting is effective only for a fixed-space font.

Symbol Set You can specify the set of print characters for the default font. The 
available options are as follows.

Roman-8, ISO L1, ISO L2, ISO L5, PC-8, PC-8 D/N, PC-850, PC-
852, PC8-TK, Win L1, Win L2, Win L5, Desktop, VN Intl, VN US, 
MS Publ, Math-8, VN Math, Pifont, Legal, ISO 4, ISO 6, ISO 11, 
ISO 15, ISO 17, ISO 21, ISO 60, ISO 69, Win 3.0

Note
❒ Default: Roman-8

Menu Description
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Changing the Paper Input Menu

The following procedure describes changing the “Tray Priority” as an example
in the “Paper Input”menu.

AAAA Press the {{{{User Tools/Counter}}}} or {{{{User Tools}}}} key.
The key differ depending on the machine. Confirm that which type of ma-
chine you have.

BBBB Press the 0000 or 1111key to display "Printer Features".

CCCC Press {{{{OK}}}}.

The following screen appears on the panel display.

DDDD Press {{{{OK}}}}.

The following screen appears on the panel display.

EEEE Press {{{{OK}}}}.

The following screen appears on the panel display.

FFFF Press {{{{OK}}}}.
The following screen appears on the panel display.

GGGG Press the 0000 or 1111key to select the tray type you want to use.

HHHH Press {{{{OK}}}}.

“Programmed” is displayed for two seconds.

IIII The following screen appears on the panel display.

JJJJ Press the {{{{User Tools/Counter}}}} or {{{{User Tools}}}} key to return to the initial display.
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Network Setup Menu

There are three menu items in the “Network Setup” menu.
• IP Address
• Subnet Mask
• Gateway Address

Note
❒ This “Network Setup” menu appears only when installing the optional Net-

work Interface Board.

Network Setup Parameters 

Menu Description

IP Address You can set the IP Address.

Note
❒ Default: All zero

Reference
See “Configuring the Printer for the Network with the Control Pan-
el” in "Printer Reference 1".

Subnet Mask You can set the Subnet Mask. 

Note
❒ Default: 255.000.000.000

Reference
See “Configuring the Printer for the Network with the Control Pan-
el” in "Printer Reference 1".

Gateway Address You can set the Gateway Address.

Note
❒ Default: All zero

Reference
See “Configuring the Printer for the Network with the Control Pan-
el” in "Printer Reference 1".
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Maintenance Menu

There are three menu items in the “Maintenance” menu.
• Restart Printer
• Menu Reset
• Hex Dump

Maintenance Parameters 

 Restarting a Printer

The following procedure describes selecting the “Restart Printer” as an example
in the “Maintenance” menu.

AAAA Press the {{{{User Tools/Counter}}}} or {{{{User Tools}}}} key.

The key differ depending on the machine. Confirm that which type of ma-
chine you have.

BBBB Press the 0000 or 1111key to display "Printer Features".

CCCC Press {{{{OK}}}}.

The following screen appears on the panel display.

DDDD Press the 0000 or 1111key until the following message appears on the panel dis-
play.

Menu Description

Restart Printer You can restart the printer.

⇒ p.33 “Restarting a Printer”

Menu Reset You can reset the menu settings to the factory defaults except the 
optional Network Interface Board settings.

Hex Dump You can set to isolate the source of a print job problem. With this 
function “On”, all data sent to the printer is printed in hexadeci-
mal character representation.

• On

• Off

Note
❒ Default: Off
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EEEE Press {{{{OK}}}}.

The following screen appears on the panel display.

FFFF Press {{{{OK}}}}.

The following screen appears on the panel display.

GGGG Press {{{{OK}}}}. 

"Ready" appears on the panel display.

List Print Menu

There are four menu items in the “List Print” menu.
• Configuration Page
• Menu List
• PCL Font List
• PS Font List

List Print Parameters 

Menu Description

Configuration Page You can print a Configuration Page. ⇒ p.35 “Printing a Configu-
ration Page”

Menu List You can print the Menu List which shows the function menus of 
this machine.

PCL Font List You can print a PCL Font List.

PS Font List You can print a PS Font List.
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Printing a Configuration Page

The following procedure describes printing the “Configuration Page” as an ex-
ample in the “List Print”menu.

Reference
For more information, see p.36 “Interpreting the Configuration Page”.

AAAA Press the {{{{User Tools/Counter}}}} or {{{{User Tools}}}} key.
The key differ depending on the machine. Confirm that which type of ma-
chine you have.

BBBB Press the 0000 or 1111 key to display "Printer Features".

CCCC Press {{{{OK}}}}.

The following screen appears on the panel display.

DDDD Press the 0000 or 1111key until the following message appears on the panel dis-
play.

EEEE Press {{{{OK}}}}.

The following screen appears on the panel display.

FFFF Press {{{{OK}}}}.

The following screen appears on the panel display.

GGGG Press {{{{OK}}}}.

The following screen appears on the panel display.

In a short time, the printing of the configuration page will start.
After completion of printing, the "Printer Features" display is shown.
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Important
❒ If you cannot complete printing a configuration page correctly, make sure

an error message appears on the panel display. For more information
about error messages, see p.19 “Error & Status Messages on the Control
Panel”.

Interpreting the Configuration Page

Reference

❖❖❖❖ Printer ID
Shows the serial number assigned to the board by its manufacturer.

❖❖❖❖ Firmware Version
Shows the version number of the printer firmware.

❖❖❖❖ Pages Printed
Shows the total number of pages printed by the printer to date.

❖❖❖❖ Total Memory
Shows the total amount of memory (SDRAM) installed on the printer.

❖❖❖❖ Options
Show the options that you installed.

Job Control

Shows the settings made under the “Job Control” menu.

Reference
For more information, see p.26 “Job Control Menu”.

Network Setup

Shows the settings you made under the “Network Setup” menu.
When DHCP is active on the network, the actual IP Address, Subnet Mask and
Gateway Address appear in parentheses on the configuration page.

Reference
For more information, see p.32 “Network Setup Menu”.
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Maintenance

Shows the settings you made under the “Maintenance”. 

Reference
For more information, see p.33 “Maintenance Menu”.

Error Log

Shows the log of printer errors.
37
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Specifications

This section contains the electrical and hardware specifications for the printer,
including the information about the options.

Component Specification

Resolution 300 × 300 dpi; PCL 5e *1 , PS2 *2 

600 × 600 dpi; PCL 5e *1 , PCL 6, PS2

Parallel Interface Standard 36-pin printer cable and a parallel port on the host computer.

IEEE1284

Note
❒ Do not use a parallel cable that is longer than 3 meters (10 feet).

Printer Language PCL 5e , PCL 6

PS2 (option)

Fonts PCL 5e, PCL 6

35 Intellifonts, 10 True Type fonts

PS2 (option)

80 PS Resident fonts

Memory Standard : 16MB

Optional SDRAM : 32MB, 64MB, 128MB

Operation Systems sup-
ported by this printer

Windows 95 *3 /98 *4 /Me *5 

Windows 2000 *6 

Windows XP *7 

Windows NT 4.0 *8 

Mac OS *9 

Network Topology : Ethernet 10BASE-T/100BASE-TX 

Protocol : TCP/IP, IPX/SPX, AppleTalk

Network Cable 10BASE-T/100BASE-TX interface cable with ferrite core.

Paper Size Specifications of paper size depends on the machine. Confirm 
which type of machine you have. See the Operating Instructions 
that comes with this machine.

Note
❒ When you use this machine as a printer, the bypass tray and the 

optional paper tray unit do not support the standard size of 
81/4" × 14".

❒ When you use this machine as a printer, the bypass tray sup-
ports the following custom sizes:
• Metric Version

Vertical 90-216mm
Horizontal 148-355mm

• Inch Version
Vertical 3.54"-8.50"
Horizontal 5.83"-14.00"



Appendix

40

5

*1 For PCL 5e, only 600dpi is selectable from the printer driver.
*2 PostScript level2 Compatible
*3 Microsoft Windows 95 operating system
*4 Microsoft Windows 98 operating system
*5 Microsoft Windows Millennium Edition
*6 Microsoft Windows 2000 Professional

Microsoft Windows 2000 Server
*7 Microsoft Windows XP Professional

Microsoft Windows XP Home Edition
*8 Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT

Workstation operating system version 4.0 in a computer using x86 processors.
*9 Required version is 8 or 9 operating system. With Mac OS X, the machine operates in

only Classic mode.

Options

Network Interface Board Type 1018

❖❖❖❖ Topology:
Ethernet (10BaseT/100BaseTX)

❖❖❖❖ Protocols:
TCP/IP, IPX/SPX, AppleTalk

❖❖❖❖ Interface Connector:
RJ45

❖❖❖❖ Required Cable:
Interface cable with ferrite core
Interface cable is not provided with this option.

Memory Unit

❖❖❖❖ Module Type:
SO-DIMM (Small Outline Dual-in-line Memory Module)

❖❖❖❖ Memory Type:
SDRAM (Synchronous Dynamic RAM)

❖❖❖❖ Number of Pins
144 pins

❖❖❖❖ Compatible:
PC100 compatible

Type 1018 PostScript level2 Compatible Kit

PostScript level2 compatible.
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Note to users in the United States of America

Notice:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television reception, which can be determined by turn-
ing the equipment off and on, the user is encouraged to try to correct the interference by one more of
the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
Consult the dealer or an experienced radio/TV technician for help.

Warning
Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Caution(in case of IEEE1284 environment) :
Properly shielded and grounded cables and connectors must be used for connections to host computer
(and/or peripheral) in order to meet FCC emission limits.

Caution (in case of 100BaseTX environment):
Interface cable with ferrite core must be used for RF interference suppression.

Declaration of Conformity
Product Name: Printer Controller
Model Number: Type 1013
Responsible party: Ricoh Corporation
Address: 5 Dedrick Place, West Caldwell, NJ 07006
Telephone number: 973-882-2000
This device complies with part 15 of FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and
2. this device must accept any interference received,
including interference that may cause undesired operation.

Note to users in Canada

Note:
This Class B digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada

Avertissement:
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Copyright © 2001
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Network Interface Board
Type 1018 (option)

Quick Configuration Guide
Read this manual carefully before you use this product and keep it handy for future
reference.
For safety, please follow the instructions in this manual.



Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information before using this machine. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating
the machine.

Trademarks

NetWare is a registered trademark of Novell, Incorporated. 

Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.

Macintosh is a registered trademark of Apple Computer, Inc.

All other products referenced are trademarks or registered trademarks of their respective companies.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Notes:

Some illustrations might be slightly different from your machine.

Certain options might not be available in some countries. For details, please contact your local dealer.



How to Read this Manual

Symbols

In this manual, the following symbols are used:

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's operation panel.
Keys on the computer's keyboard.
i



ii
Manuals for This Machine

Manuals for This Machine

There are ten manuals that separately describe the operational procedures for
the operation and maintenance of the machine.
To enhance safe and efficient operation of the machine, all users should read and
follow the instructions contained in the following manuals.

❖❖❖❖ Copy Reference
Describes the procedures and functions for using this machine as a copies.

❖❖❖❖ System Settings
Describes the system settings of this machine.

❖❖❖❖ Facsimile Reference <Basic Features>
Describes the procedures and most frequently functions for using this ma-
chine as a facsimile.

❖❖❖❖ Facsimile Reference <Advanced Features>
Describes the procedures and more advanced functions for using this ma-
chine as a facsimile. And also explains settings for key operators.

❖❖❖❖ Printer Reference 1
Describes the procedures and functions for using this machine as a printer.

❖❖❖❖ Printer Reference 2
Describes the procedures and provides necessary information about using
the printer and its options. This manual is included as a PDF file on the CD-
ROM labeled “Operating Instructions for Printer”.

❖❖❖❖ Network Interface Board Quick Configuration Guide
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. This manual is in-
cluded as a PDF file on the CD-ROM labeled “Operating Instructions for
Printer”. (this manual)

❖❖❖❖ Type 1018 PostScript level2 Compatible Kit Operating Instructions Supplement
Describes the functions of Printer Utility for Mac. This manual is included as
a PDF file on the CD-ROM labeled “Operating Instructions for Printer”.

❖❖❖❖ UNIX Supplement
Provides information about setting up and using the printer in a UNIX envi-
ronment. This manual is included as a PDF file on the CD-ROM labeled “Op-
erating Instructions for Printer”.

❖❖❖❖ Network Interface Board Type 1018 Owner's Manual
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. This manual is in-
cluded as a PDF file on the CD-ROM labeled “Print Server Software and Doc-
umentation” which comes with Network Interface Board Type 1018.
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1. Getting Ready for Software
Installation
1

Support programs for the installation and configuration of the Network Inter-
face Board are included on two CD-ROMs. One is “Printer Drivers and Utilities”
and the other is “Print Server Software and Documentation” which come with
this machine.
You can select any of the programs listed in the Configuration Programs.

Configuration Programs

The CD-ROM labeled "Printer Drivers and Utilities" includes the following util-
ities.

❖❖❖❖ SmartNetMonitor for Admin
SmartNetMonitor for Admin is software that uses the TCP/IP and IPX/SPX
protocols to monitor the printers in a network. It can monitor multiple net-
work printers having IP addresses. We recommend network administrators
to use this software.

Reference
For more information about SmartNetMonitor for Admin, see the Smart-
NetMonitor for Admin Help file.

❖❖❖❖ SmartNetMonitor for Client
SmartNetMonitor for Client is software equipped with the following func-
tions. We recommend all users of this printer to install this software.
• Provides the function to print in a Peer-to-Peer network.
• Uses the TCP/IP and IPX/SPX protocols to monitor the status of devices

in a network constantly.

Reference
For more information about SmartNetMonitor for Client, see the Smart-
NetMonitor for Client Help file.

The CD-ROM labeled "Print Server Software and Documentation" includes the
following utilities.

❖❖❖❖ MAP
Web-based configuration utility

❖❖❖❖ IPX Peer-to-Peer
IPX Peer-to-Peer printing software

❖❖❖❖ IP Peer-to-Peer
IP Peer-to-Peer printing software

❖❖❖❖ NWSetup
NetWare Print Service Configuration



Getting Ready for Software Installation

2

1

The four utilities are included on the “Print Server Software and Documenta-
tion” CD-ROM, but you need this CD-ROM only if you use ”IPX Peer-to-Peer”
or “IP Peer-to-Peer” printing.
Although you can use the "MAP" or "NWSetup" utilities on the "Print Server
Software and Documentation" CD-ROM, it is easier to use the SmartNetMono-
tor for Admin/Client included on the "Printer Drivers and Utilities" CD-ROM.
To use “MAP” or “NWSetup” from the “Print Server Software and Documenta-
tion” CD-ROM, see the “Owner's Manual”on the CD-ROM labeled “Print Server
Software and Documentation” for instructions.
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1

SmartNetMonitor for Admin/Client

Utilities called SmartNetMonitor for Admin and SmartNetMonitor for Client are
provided to configure the printer to work in a network environment.

Limitation
❒ SmartNetMonitor for Admin/Client are supported to work with the follow-

ing operating systems.
• Microsoft Windows 95 *1 /98 *2 /Me *3 

• Microsoft Windows 2000 *4 

• Microsoft Windows NT 4.0 *5 

*1 Microsoft Windows 95 operating system
*2 Microsoft Windows 98 operating system
*3 Microsoft Windows Millennium Edition
*4 Microsoft Windows 2000 Professional

Microsoft Windows 2000 Server
*5 Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT

Workstation operating system version 4.0 in a computer using x86 processors.

❖❖❖❖ SmartNetMonitor for Admin
SmartNetMonitor for Admin is software that uses the TCP/IP and IPX/SPX
protocols to monitor the printers in a network. It can monitor multiple net-
work printers having IP addresses. We recommend network administrators
to use this software.

❖❖❖❖ SmartNetMonitor for Client
SmartNetMonitor for Client is software equipped with the following func-
tions. We recommend all users of this printer to install this software.
• Provides the function to print in a Peer-to-Peer network.
• Uses the TCP/IP and IPX/SPX protocols to monitor the status of devices

in a network constantly.

Installing SmartNetMonitor for Admin

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

The installer will start by Auto Run.

Note
❒ Auto Run might not automatically work with certain OS settings. In this

case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select "Custom" installation and then click [Next].
3
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E Remove the check mark from the [Printer Driver].

F Click to select [Utility] and then click [Detail].

G Click to select [SmartNetMonitor for Admin] and then click [OK].

H Click [OK].

I Follow the instructions on the screen.
After installation is completed, see P.34 “Setting Up as a Print Server” when
you use the printer as a print server.

Note
❒ If you require restarting the computer after installation of SmartNetMoni-

tor for Admin was completed, restart the computer and continue to config-
uration.

Installing SmartNetMonitor for Client

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

The installer will start by Auto Run.

Note
❒ Auto Run might not automatically work with certain OS settings. In this

case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select "Custom" installation, and then click [Next].

E Remove the check mark from the [Printer Driver].

F Click to select [SmartNetMonitor for Client], and then click [OK].

G Click [OK].

H Follow the instructions on the screen.

Note
❒ If you are required to restart the computer after the installation of Smart-

NetMonitor for Client, restart the computer and continue with necessary
configurations.



2. Windows 95/98/Me
Configuration
Windows 95/98/Me Configuration

This section describes how to configure the Peer-to-peer printing. The Peer-to-
peer printing software that is included on the CD-ROM labeled ”Printer Drivers
and Utilities”. “Print Server Software and Documentation” allows Windows 95/
98/Me PCs to communicate directly with network attached printers. A network
server, such as NetWare or Windows NT, is not required for Peer-to-peer print-
ing.
There are three types of Peer-to-peer printing. You can select ”SmartNetMonitor
for Admin/Client”, “IP Peer-to-Peer” and “IPX Peer-to-Peer” according to your
network environment.
The Peer-to-peer printing software must be installed on each PC that uses Peer-
to-peer printing. Once Peer-to-peer printing software is installed, all Network
Interface Boards on the network automatically appear in the list of available
printer ports.
The Peer-to-peer printing software can also be used in networks where servers
are present; however, server based print services are often utilized instead. Serv-
er based print services offer centralized printing management and spooling and
do not require software (other than the printer driver) to be installed on each PC.
If you use the printer in a network where servers are present, select either Peer-
to-peer printing or the server based print service.

Reference
For more information about setting IP parameters, see “Configuring the Printer
for the Network with the Operation Panel” in “Printer Reference 1”.
5
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Using SmartNetMonitor for Client

Preparation
To use SmartNetMonitor for Client, you must install it as [Network] installa-
tion and use TCP/IP or IPP protocol in a Peer-to-Peer Network.

Installing SmartNetMonitor for Client

Preparation
Select [Network] installation when you print without using a print server.
[Network] installation installs the PCL 5e and PCL 6 printer driver and Smart-
NetMonitor for Client. When you print using TCP/IP or IPP protocol in a
Peer-to-Peer Network, you must select this installation.
[Custom] installation allows you to install SmartNetMonitor for Client sepa-
rately.

Installing by "Network" installation

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

The installer will start by Auto Run.

Important
❒ Never have two versions of the same printer driver installed on your sys-

tem at the same time. When upgrading to a new version of the printer driv-
er, delete the old version, and then install the new one.

Note
❒ Auto Run might not automatically work with certain OS settings. In this

case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select [Network] installation when the selection screen appears.

E Follow the instructions on the screen.

F Select a printer you want to use when the [Select Printer] dialog box appears.

G Click [Add..] when the [Select Port] dialog box appears.

H Select [SmartNetMonitor for Client], and then click [OK].

Available printers will be listed.
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I Select a printer you want to use.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used. 

IPP

A Click [IPP].

The IPP setting dialog box appears.
B In [Printer URL], type “http://IP address:631/Print” as the printer's IP ad-

dress.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address typed in [Printer URL] will be set as the IPP port
name.

J Click [OK].

K Confirm that the selected port is highlighted, and then click [Next].

L Click [Finish].

M Restart the computer after the installation is complete.

N Set up the options with the printer driver.

Reference
For more information about settings for options, see “Installing the Printer
Driver and Software” in “Printer Reference 1”.
7
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Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to change the
settings of SmartNetMonitor for Client.

Reference
For more information about these settings, see SmartNetMonitor for Client
Help.

A Click [Start] on the taskbar, point to [Settings], and then click [Printers].

B Click to select the icon of the printer you want to use.

C On the [File] menu, click [Properties].

D Click the [Details] tab, and then click [Port Settings]. 

The SmartNetMonitor for Client settings dialog box appears.
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Using IP Peer-to-Peer

Important
❒ The TCP/IP protocol is required for IP Peer-to-Peer printing. Confirm that

the TCP/IP protocol is installed, if not, install it before starting the following
procedure.

Installing IP Peer-to-Peer

Follow these steps to install IP Peer-to-Peer.

Important
❒ Confirm that the printer power is turned on before starting the following pro-

cedure.

A  Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference
For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in “Printer Reference 1”. 

B Insert the CD-ROM labeled “Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

C Click [Install/Configuration Utilities].
The “Installation/Configuration Utilities” page appears.

D Click [Windows IP Peer-to-Peer Printing].

The “Windows IP Peer-to-Peer Printing” page appears. 
This page describes the functions of this utility. 

E At the bottom of the page, click the blue word [Install IP-P2P...] to begin in-
stalling.

F The [Welcome] dialog box appears.

G Click [Next].
The [Installation Notes] dialog box appears. 

H Click [Yes].

The [Choose Destination Directory] dialog box appears. 

I Click [Browse] to set a different folder. 

The default installation folder is C:\PROGRAM FILES\IP-P2P. 
9
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J Click [Next].

The [Select Program Folder] dialog box appears.
This allows you to set the name of the folder that contains the shortcut links
inside the Program Folder.

K Type the name that you wish to see in “Program Folder:” and click [Next].

The files are then copied to the computer in the specified directories.

L Follow the instructions on the screen.

M Click [OK] to complete the installation.

Reference
For more information about installing IP Peer-to-Peer, see the “Owner's
Manual” on the CD-ROM labeled “Print Server Software and Documenta-
tions”.

----For manual installation
Follow these steps to install the software on your operating system (Windows
95/98/Me).
A Insert the CD-ROM into the CD-ROM drive.
B Close all the applications that are currently running.
C Click [Start] on the task bar, and click [Run]. 
D Type <Drive>:\IP-P2P\SETUP.EXE (where <Drive> is your CD-ROM drive

name).
E Click [OK].

The [Welcome] dialog box appears.
The remaining steps are identical to G- L in the preceding procedure. ⇒ P.9 “In-
stalling IP Peer-to-Peer”
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Selecting the Printer Port

The Peer-to-peer printing software should be installed on each Windows 95/98/
Me PC that will use Peer-to-peer printing services.

A Install the printer driver you want to use.
If the printer drivers have already been installed, you can go to the next step.

Reference
For more information about the printer drivers, see “Installing the PCL 6/5e
Printer Driver” or “Installing the PostScript Printer Driver” in “Printer Refer-
ence 1”.

B Click [Start] on the taskbar, point to [Settings], and then click [Printers]. 
The [Printers] window appears.

C Click the icon of the printer you want to set for Peer-to-peer printing.

D On the [File] menu, click [Properties].
The Printer Properties appear.

E Click the [Details] tab.

F From the [Print to the following port:] list box, select the port of the printer you
want to use for Peer-to-peer printing.

• Select the IP address of the printer. If you do not find the IP address of the
printer, the printer is not in your local subnet. Then you need to configure
IP Peer-to-Peer port manually as described in the “Owner's Manual” on
the CD-ROM labeled “Print Drivers and Utilities”.

G Click [OK].

Deleting the Port

The following procedure allows you to delete the printer port. If you want to delete the
port which is currently used in Windows, switch the port to another such as "FILE",
then delete it. For more information about IP Peer-to-Peer, see the “Owner's Manual”.

A Click [Start] on the taskbar, point to [Programs], and then click [IP-P2P]. 

The [IP-Peer to Peer Setup] window appears.

B Click [Printers...].

C Click [Find Printers].

Available printers appear.

D Click to select the port you want to delete from “Unit Name” list.

E Click [Delete].
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Using IPX Peer-to-Peer

Important
❒ The IPX protocol is required for IPX Peer-to-Peer printing. Confirm that the IPX

protocol is installed, if not, install it before starting the following procedure.

Note
❒ IPX protocol can use with Windows 95/98/Me.

Installing IPX Peer-to-Peer

Follow these steps to install IPX Peer-to-Peer.

A Insert the CD-ROM labeled “Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

Note
❒ If Adobe Acrobat Reader is not installed, click [Install Adobe Acrobat Reader

4.0].

B Click [CD ROM Contents].

The “Introduction” page appears.

C Click [Installation/Configuration Programs].

The “Configuration Programs” page appears.

D Click [Windows 95/98/Me & NT 4.x IPX Peer-to-Peer Printing].
The “Windows 95/98/Me and NT 4.x IPX Peer-to-Peer Printing” page ap-
pears. 
This page describes the functions of this utility. 

E At the bottom of the page, click the blue word [here] to begin installing.

A dialog box appears asking if the “Setup.exe” program should be started.

F Click [Yes].

The [Welcome] dialog box appears.

G Click [Next].
The [Installation Notes] dialog box appears.

H Click [Yes].

The files are then copied to the computer in the specified directories.
The [Installation Complete] dialog box appears. 

I Click [Finish] to complete the installation.
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----For manual installation
Follow these steps to install the software on your operating system (Windows
95/98/Me).
A Insert the CD-ROM into the CD-ROM drive.
B Close all the applications that are currently running.
C Click [Start] on the taskbar, and click [Run]. 
D Type <Drive>:\IPX-P2P\SETUP.EXE (where <Drive> is your CD-ROM

drive name).
E Click [OK].

The [Welcome] dialog box appears.
The remaining steps are identical to G - I in the preceding procedure. ⇒ P.12 “In-
stalling IPX Peer-to-Peer”

Selecting the Printer Port

The Peer-to-peer printing software should be installed on each Windows 95/98/
Me PC that will use Peer-to-peer printing services.

A Install the printer driver you want to use.
If the printer drivers have already been installed, you can go to the next step.

Important
❒ Using IPX Peer-to-Peer printing, confirm that the printer power is turned

on before continuing the following steps.

Reference
For more information about the printer drivers, see “Installing the PCL 6/5e
Printer Driver” or “Installing the PostScript Printer Driver” in “Printer Refer-
ence 1”.

B Click [Start] on the taskbar, point to [Settings], and then click [Printers]. 

The [Printers] window appears.

C Click the icon of the printer you want to set for the Peer-to-peer printing.

D On the [File] menu, click [Properties].

The Printer Properties appear.

E Click the [Details] tab.
13
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F From the [Print to the following port:] list box, select the port of the printer you
want to use for Peer-to-peer printing.

• Select the printer name. The printer name is shown in "Peer-to-Peer Con-
nection Information" on the network configuration page. The default set-
ting of the printer name is “RDP_” followed by the 6 digit serial number.

G Click [OK].



3. Windows 2000
Configuration
Windows 2000 Configuration

This manual describes the procedures and provides necessary information
about setting up and using the printer under the network environment using
Windows 2000. 
• If a NetWare server is present, NetWare print services might be used by fol-

lowing the NetWare Configuration instructions in this guide.
15
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Using SmartNetMonitor for Client

Preparation
To use SmartNetMonitor for Client, you must install it as [Network] installa-
tion and use TCP/IP or IPP protocol in a Peer-to-Peer Network.

Installing SmartNetMonitor for Client

Preparation
Select [Network] installation when you print without using a print server.
[Network] installation installs the PCL 5e and PCL 6 printer driver and Smart-
NetMonitor for Client. When you print using TCP/IP or IPP protocol in a
Peer-to-Peer Network, you must select this installation.
[Custom] installation allows you to install SmartNetMonitor for Client sepa-
rately.

Installing by "Network" installation

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

The installer will start by Auto Run.

Important
❒ Never have two versions of the same printer driver installed on your sys-

tem at the same time. When upgrading to a new version of the printer driv-
er, delete the old version, and then install the new one.

Note
❒ Auto Run might not automatically work with certain OS settings. In this

case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select [Network] installation when the selection screen appears.

E Follow the instructions on the screen.

F Select a printer you want to use when the [Select Printer] dialog box appears.

G Click [Add..] when the [Select Port] dialog box appears.

H Select [SmartNetMonitor for Client], and then click [OK].

Available printers will be listed.
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I Select a printer you want to use.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used. 

IPP

A Click [IPP].

The IPP setting dialog box appears.
B In [Printer URL], type “http://(printer's IP address)/printer” as the printer's

IP address.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address typed in [Printer URL] will be set as the IPP port
name.

J Click [OK].

K Confirm that the selected port is highlighted, and then click [Next].

L Click [Finish].

Note
❒ During installation, the [Digital Signature Not Found] dialog box may appear.

In this case, click [Yes] to continue the installation.

M Restart the computer after the installation is complete.

N Set up the options with the printer driver.

Reference
For more information about settings for options, see “Installing the Printer
Driver and Software” in “Printer Reference 1”.

Note
❒ You can specify the "User Code" with the printer properties after installing

the printer driver. See the Help file for the printer driver.
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Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to change the
settings of SmartNetMonitor for Client.

Reference
For more information about these settings, see SmartNetMonitor for Client
Help.

A Click [Start] on the taskbar, point to [Settings], and click [Printers].

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

D Click the [Details] tab, and then click [Port Settings]. 

The SmartNetMonitor for Client settings dialog box appears.
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Printing with a Standard TCP/IP Port

Preparation
Select [Typical] installation when you use the printer with Standard TCP/IP
port.
[Typical] installation installs the PCL 5c and RPCS printer driver.

Installing the Printer Driver

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
The installer will start by Auto Run.

Important
❒ Never have two versions of the same printer driver installed on your sys-

tem at the same time. When upgrading to a new version of the printer driv-
er, delete the old version, and then install the new one.

Note
❒ Auto Run might not automatically work with certain OS settings. In this

case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select [Typical] installation, and then click [Next].

E Follow the instructions on the screen.

F Select [Standard TCP/IP] when the "Select Port" dialog box appears, and then
click [Next].

G Click [Next] in the "Add Standard TCP/IP Printer Port Wizard" window.

H Type the printer name or IP address in the "Printer Name or IP Address"
box.

I Click [Finish] in the "Add Standard TCP/IP Printer Port Wizard" window.

J Confirm that the selected port has been displayed in the "Port" box, and
then click [Next].

Note
❒ During installation, the [Digital Signature Not Found] dialog box may appear.

In this case, click [Yes] to continue the installation.
19
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K Click [Finish].

Note
❒ You can specify the "User Code" with the printer properties after installing

the printer driver. See the Help file for the printer driver.

L Restart the computer after the installation is complete.

M Set up the options with the printer driver.

Reference
For more information about settings for options, see “Installing the Printer
Driver and Software” in “Printer Reference 1”.



4. Windows NT 4.0
Configuration
Windows NT 4.0 Configuration

There are several options for setting up printing in a Windows NT environment.
• If a NetWare server is present, NetWare print services might be used by fol-

lowing the NetWare Configuration instructions in this guide.
• Peer-to-peer print services can be available by using “IP Peer-to-Peer”.
• LPR print services can be used via TCP/IP by following the instructions in

this section.
Windows NT printing is very flexible. It is possible to configure the individual
Windows NT or Windows 95/98/Me workstations to print using a different
protocol from the Windows NT server. For example, a Windows NT server
could be configured to print to the Network Interface Board via TCP/IP using
the instructions in this section. The Network Interface Board could then be des-
ignated as shared on the NT server, allowing workstations to print via the NT
server using a different protocol.
The optimum Windows NT printing configuration depends on the particular
environment and user as well as administrator experience and preferences. Gen-
erally, LPR printing over TCP/IP covered in the following instructions is the
best choice for environments where TCP/IP is already in use.
21



Windows NT 4.0 Configuration

22

4

Using the SmartNetMonitor for Client

Preparation
To use SmartNetMonitor for Client, you must install it as [Network] installa-
tion and use TCP/IP or IPP protocol in a Peer-to-Peer Network.

Installing the SmartNetMonitor for Client

Preparation
Select [Network] installation when you print without using a print server.
[Network] installation installs the PCL 5e and PCL 6 printer driver and Smart-
NetMonitor for Client. When you print using TCP/IP or IPP protocol in a
Peer-to-Peer Network, you must select this installation.
[Custom] installation allows you to install SmartNetMonitor for Client sepa-
rately.

Installing by "Network" installation

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

The installer will start by Auto Run.

Important
❒ Never have two versions of the same printer driver installed on your sys-

tem at the same time. When upgrading to a new version of the printer driv-
er, delete the old version, and then install the new one.

Note
❒ Auto Run might not automatically work with certain OS settings. In this

case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select [Network] installation when the selection screen appears.

E Follow the instructions on the screen.

F Select a printer you want to use when the [Select Printer] dialog box appears.

G Click [Add..] when the [Select Port] dialog box appears.

H Select [SmartNetMonitor for Client], and then click [OK].

Available printers will be listed.
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I Select a printer you want to use.

TCP/IP

A Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used. 

IPP

A Click [IPP].

The IPP settings dialog box appears.
B In [Printer URL], type “http://(printer's IP address)/printer” as the printer's

IP address.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

C As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address typed in [Printer URL] will be set as the IPP port
name.

J Click [OK].

K Confirm that the selected port is highlighted, and then click [Next].

L Click [Finish].

M Restart the computer after the installation is complete.

N Set up the options with the printer driver.

Reference
For more information about settings for options, see“Installing the Printer
Driver and Software” in “Printer Reference 1”.
23
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Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to change the
settings of SmartNetMonitor for Client.

Reference
For more information about these settings, see SmartNetMonitor for Client
Help.

A Click [Start] on the taskbar, point to [Settings], and click [Printers].

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

D Click the [Details] tab and click [Port Settings]. 

The SmartNetMonitor for Client settings dialog box appears.
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Using IP Peer-to-Peer

Important
❒ The TCP/IP protocol is required for IP Peer-to-Peer printing. Confirm that

the TCP/IP protocol is installed, if not, install it before starting the following
procedure.

Installing IP Peer-to-Peer

Follow these steps to install IP Peer-to-Peer.

Important
❒ Confirm that the printer power is turned on before starting the following pro-

cedure.

A  Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference
For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in “Printer Reference 1”. 

B Insert the CD-ROM labeled“Print Server Software and Documentation”
into the CD-ROM drive.

The main screen appears.

C Click [Install/Configuration Utilities].
The “Installation/Configuration Utilities” page appears.

D Click [Windows IP Peer-to-Peer Printing].

The “Windows IP Peer-to-Peer Printing” page appears. 
This screen describes the functions of this utility. 

E At the bottom of the page, click the blue word [Install IP-P2P...] to begin in-
stalling.

F The [Welcome] dialog box appears.

G Click [Next].
The [Installation Notes] dialog box appears. 

H Click [Yes].

The [Choose Destination Directory] dialog box appears.

I Click [Browse] to set a different folder.

The default installation folder is C:\PROGRAM FILES\IP-P2Puy
25
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J Click [Next].

The [Select Program Folder] dialog box appears.
This allows you to set the name of the folder that contains the shortcut links
inside the Program Folder.

K Type the name that you want to see in the Program Folder and click [Next].

The files are then copied to the computer in the specified directories.

L Follow the instructions on the screen.

M Click [OK] to complete the installation.

Reference
For more information about installing IP Peer-to-Peer, see the “Owner's
Manual” on the CD-ROM labeled “Print Server Software and Documenta-
tions”.

----For manual installation
Follow these steps to install the software on your operating system (Windows
NT 4.0).
A Insert the CD-ROM into the CD-ROM drive.
B Close all the applications that are currently running.
C Click [Start] on the taskbar, and click [Run]. 
D Type <Drive>:\IP-P2P\SETUP.EXE (where <Drive> is your CD-ROM drive

name).
E Click [OK].

The [Welcome] dialog box appears.
The remaining steps are identical to G- L in the preceding procedure. ⇒ P.25 “In-
stalling IP Peer-to-Peer” 
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Selecting the Printer Port

The IP Peer-to- Peer printing software should be installed on each Windows NT
4.0 PC that uses Peer-to-peer printing services.

Important
❒ The IP Peer-to-Peer printing software must be installed before selecting the

printer port.

A Close all the applications that are currently running.

B Insert the CD-ROM labeled "Printer Drivers and Utilities" into the CD-
ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
“Installing the PCL 6/5e Printer Driver” in “Printer Reference 1” to start the in-
stallation and then go to the next step.

C The [Printer Installation] dialog box appears.

D From the [Port] list, select the IP address of the printer you want to set up,
and click [Next >].

E Follow the instructions on the screen to finish the installation of the printer
driver.

Deleting the Port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about IP Peer-to-Peer, see the
“Owner's Manual”.

A Click [Start] on the taskbar, point to [Programs], and then click [IP-P2P].

The [IP-Peer to Peer Setup] window appears.

B Click [Printers...].

C Click [Find Printers].

Available printers appear.

D Click to select the port you want to delete from “Unit Name” list.

E Click [Delete].
27
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Setting Up LPR Printing

Follow these steps to set up LPR printing.

Note
❒ In the following instructions, some fields or dialog box names may differ de-

pending on the NT service pack in use.

A Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference
For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in “Printer Reference 1”. 

B Click [Start] on the taskbar, point to [Settings], and then click [Control Panel].

C Double-click [Network] and select the [Protocols] tab to confirm that the TCP/
IP protocol is installed.

If the TCP/IP protocol is not in the list of Network Protocols, click [Add] to in-
stall it.

D Select the [Services] tab.
If Microsoft TCP/IP Printing is not on the list of Network Services, click [Add]
to install it.

E Click [Close] when all protocols and services have been added.

If the TCP/IP protocol has just been added, set the IP address and other TCP/
IP parameters.
The new protocols and services will be available after the system is restarted.

Important
❒ If the printer driver has not been installed yet, install it before continuing.

F Click [Start] on the taskbar, point to [Settings], and then click [Printers].

G Right click the appropriate printer and select [Properties].

H On the [Ports] tab, click [Add Port].

I Double-click [LPR Port] in the list of available printer ports.

J In the [Name or address of server providing lpd:] field, type the IP address of the
Network Interface Board (that was assigned with the operation panel).

K In the [Name of printer or print queue on that server:] field, type “PORT1” (quo-
tation marks are not included) in capital letters and click [OK].



Setting Up LPR Printing
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L Click [Close] to close the [Printer Ports] dialog box.

The IP address of the Network Interface Board is now displayed and current-
ly selected on the list of ports.

M If the printer is to be shared, click the [Sharing] tab, select Shared and type
the Share name.

N Click [OK].
29
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5. Dynamic Host Configuration
Protocol (DHCP)
Dynamic Host Configuration Protocol 
(DHCP)

The Dynamic Host Configuration Protocol (DHCP) provides a mechanism for
delivering IP configuration parameters, including the IP address, subnet mask
and default gateway, to devices (hosts) on an IP network. A DHCP server man-
ages the pool of available IP addresses and grants device requests for an IP ad-
dress.
At power-up, the Network Interface Board broadcasts a DHCP request for an IP
address. If a DHCP server is present, the request might be processed, and an IP
address might be returned to the Network Interface Board. Upon receipt of the
IP address, the Network Interface Board resets, and prints a network configura-
tion page. The network configuration page might list the new IP address (and
Subnet mask and default gateway). Once an IP address has been assigned to the
Network Interface Board, it might no longer broadcast DHCP requests.

Important
❒ The IP address of the Network Interface Board assignment by DHCP works

only if the Network Interface Board does not have an existing IP address.
The DHCP server leases a temporary IP address which expires after a period of
time, or leases a permanent or unlimited lease which does not expire.
Devices that are granted a temporary lease are notified before the lease expires
and asked if they want to extend the lease. The Network Interface Board contin-
ues extending its lease indefinitely (unless prohibited by your DHCP server con-
figuration) and thus maintains a consistent IP address.

Important
❒ If the Network Interface Board is not turned on or is not connected to the net-

work during the period when the DHCP server is sending requests to extend
the lease, the lease will not be extended. The DHCP server might cancel the
lease and might assign the IP address to another device. Therefore, it is highly
recommended that you reserve an IP address for the Network Interface Board
in your DHCP server configuration.

If you do not to use DHCP for IP address assignment, it can be disabled using
the NIB Setup Tool. The NIB Setup Tool allows you to use a Wizard or a Prop-
erty Sheet to configure the Network Interface Board. Use the Property Sheet to
disable this feature. After you select the Network Interface Board with the NIB
Setup Tool, click [Configure] and then click the [TCP/IP] tab. If you do not to use
DHCP, select [Specify an IP Address] and set the IP address, the subnet mask and
the default gateway address.
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6. NetWare Configuration
This chapter describes how to configure the printer to use as a print server in a
NetWare environment.

❖❖❖❖ SmartNetMonitor for Admin
To use a printer in a NetWare environment, configure the NetWare printing
environment by using SmartNetMonitor for Admin.

Note
❒ If you configure NetWare printing environment by using SmartNetMoni-

tor for Admin under following environment, NetWare Client which is pro-
vided by Novell is required.
• NDS mode in Windows 95/98/Me
• NDS or Bindary mode in Windows 2000/Windows NT4.0

❖❖❖❖ Printers listed by SmartNetMonitor for Admin
SmartNetMonitor for Admin displays a list of printers, which are connected
to the network.
If you cannot find out the printer from the displayed list, refer to the config-
uration page printed from the printer. For more information about printing a
configuration page, see “Printing a configuration page” in "Printer Reference
1".

NetWare 3.x - Advanced Settings

This section describes how to configure your printer to use as a print server in
the NetWare 3.x environment.

Note
❒ This section assumes NetWare is functional and that the necessary environ-

ment for the NetWare Print Service is available.

Basic Procedure

Installing the NIB Setup Tool

Configuring Network Interface Board

Configuring NetWare

Turning the power off and on
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Setting Up as a Print Server

Follow these steps to set up the printer as a print server.

Preparation
Install the SmartNetMonitor for Admin first in accordance with the steps ex-
plained. See P.3 “Installing SmartNetMonitor for Admin”

A Log on to the file server as a Supervisor or a Supervisor equivalent.

B Run SmartNetMonitor for Admin.

C Click the [Group] menu and click [Open LAN] and select [IPX/SPX].

A list of printers appears

Note
❒ If you cannot identify which printer to configure from the list of printers,

print Configuration Page from the printer and find the desired printer. For
more information about printing Configuration Page, see “Printing a con-
figuration page” in "Printer Reference 1". 

D Click to select the printer you want to configure, and then click [NIB Setup
Tool] on the [Tools] menu.

E Click to select [Wizard], and then click [OK].

F Type the device name into the [Device Name] box and comment into the [Com-
ment] box as necessary, and then click [Next].

G Select the [NetWare] check box, and then click [Next].

H Click to select [Bindery], type the file server name into the [File Server Name:]
box, and then click [Next].

In the [File Server Name:] box, type the name of the file server in which a print
server is to be created. You can also select a file server from the list that ap-
pears by clicking [Browse].

I Type the print server name into the [Print Server Name] box, printer name into
the [Printer Name] box, and print queue name into the [Print Queue Name] box,
and then click [Next].
• In the [Print Server Name] box, type the name of the NetWare print server

within 47 characters.
• In the [Printer Name] box, type the name of the NetWare printer.
• In the [Print Queue Name] box, type the name of the print queue to be added

to NetWare.

J After confirming the settings, click [Next].

The settings take effect, and the NIB setup tool exits.
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K Exit SmartNetMonitor for Admin.

L Turn the printer power off and on.

Note
❒ To confirm that the printer is configured correctly, type as follows from the

command prompt.
F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
an attached user.
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NetWare 4.x, 5.x - Advanced Settings

This section describes how to configure your printer to use as a print server in
the NetWare 4.x, 5.x environment.

❖❖❖❖ To use NetWare 5.x
• If you use Pure IP, use the printer as a print server. You cannot use the

printer as a remote printer when you use Pure IP.
• You cannot use the NDPS (Novell Distributed Print Services) mode.

Setting Up as a Print Server

Follow these steps to set up the printer as a print server.

Preparation
Install the SmartNetMonitor for Admin first in accordance with the steps ex-
plained. See P.3 “Installing SmartNetMonitor for Admin”

A Log on to the file server as a Supervisor or a Supervisor equivalent.

B Run SmartNetMonitor for Admin.

C Click the [Groupe] menu and click [Open LAN] and select [IPX/SPX] or [TCP/IP].
A list of printers appears

Note
❒ If you use Pure IP, select [TCP/IP].
❒ If you cannot identify which printer to configure from the list of printers,

print Configuration Page from the printer and find the desired printer. For
more information about printing Configuration Page, see “Printing a con-
figuration page” in "Printer Reference 1".

Basic Procedure

Installing the NIB Setup Tool

Configuring Network Interface Board

Configuring NetWare

Turning the power off and on
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D Click to select the printer you want to configure, and then click [NIB Setup
Tool] on the [Tools] menu.

Note
❒ If you use Pure IP, see P.38 “Using Pure IP in the NetWare 5.x environment”.

E Click to select [Wizard], and then click [OK].

F Type the device name into the [Device Name] box and comment into the [Com-
ment] box as necessary, and then click [Next].

G Select the [NetWare] check box, and then click [Next].

H Click to select [NDS], type the file server name into the [File Server Name:] box,
the NDS tree name into the [Tree:] box and the context into the [Context:]
box, and then click [Next].

In the [File Server Name:] box, type the name of the file server in which a print
server is to be created. You can also select a file server from the list that ap-
pears by clicking [Browse].
Clicking [Browse], you can select a NDS context among those listed in the
[Browse] dialog box.
As a context, object names are typed from a lower object and divided by a period.
For example, if you want to create a print server into NET under DS, type "NET.DS".

I Type the print server name into the [Print Server Name] box, printer name into
the [Printer Name] box, print queue name into the [Print Queue Name] box, and
print queue volume into the [Print Queue Volume], and then click [Next].

• In the [Print Server Name] box, type the name of the NetWare print server
within 47 characters.

• In the [Printer Name] box, type the name of the NetWare printer.
• In the [Print Queue Name] box, type the name of the print queue to be added

to NetWare.
• In the [Print Queue Volume], type the volume of print queue. As a volume,

object names are typed from a lower object and divided by a period. You
can select a volume by clicking [Browse].

J After confirming the settings, click [Next].
The settings take effect, and the NIB setup tool exits.

K Exit SmartNetMonitor for Admin.

L Turn the printer power off and on.

Note
❒ To confirm that the printer is configured correctly, type as follows from the

command prompt.
F:> NLIST USER /A/B

❒ If the printer works as configured, the name of the print server appears as
an attached user.
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Using Pure IP in the NetWare 5.x environment

A Log on to the file server as an Admin or an Admin equivalent.

B Run SmartNetMonitor for Admin.

C Click [Property Sheet] and click [OK].

The [NIB Setup Tool] dialog box appears.

D Click the [NetWare] tab, and make the following settings.

A In the [Print Server Name:] box, type the name of the print server.

B In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

C In the [NDS Context:] box, type the context of the print server.

Clicking [Browse], you can select a NDS tree and a NDS context among
those listed in the [Browse Context] dialog box.
As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type "NET.DS".

D In the [Print Server Operation Mode] group, click [As Print Server].
E Click [OK] to close the property sheet.

F After a confirmation dialog box appears, click [OK].

E Exit SmartNetMonitor for Admin.
After this step, go to step I on P.36 “Setting Up as a Print Server”.



Setting Up a Client Computer

6

Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.
After installing the printer driver, change the print port to NetWare queue.

Note
❒ This section assumes that the client has NetWare client applications installed

and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setup procedure.

Windows 95/98/Me

Follow these steps to set up a Windows 95/98/Me client. 

Preparation
Log on to the NetWare file server before starting the following procedure.

A Install the printer driver you want to use as “Local printer”.

Reference
For more information about installing the printer driver, see“Installing the
PCL 6/5e Printer Driver” and “Installing the PostScript Printer Driver” in
“Printer Reference 1”.

Note
❒ Any port is selected during the installation, however, LPT1 is recommend-

ed.

B Click [Start], point to [Settings], and then click [Printers].

C In the [Printers] window, click the icon of the printer you want to use. 

D On the [File] menu, click [Properties].

E Click the [Details] tab, and click [Add Port].

F Click [Network] and click [Browse].

G On the network tree, double-click the name of the file server.

The queues appear.

H Click the queue you want to print, and click [OK].

I Click [OK].

In the [Print to the following port] box, a network path to the printer appears.

J Click [OK] to close the Printer Properties, and again, open it.
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K Click the [Printer Settings] tab.

L Clear the [Form feed] and [Enable banner] check boxes.

Note
❒ You should not select these check boxes because they should be specified

using the printer driver. If they are selected, the printer might not print
correctly.

When Using the PostScript Printer Driver

Follow these steps to set up for the PostScript Printer Driver.
A Click the [PostScript] tab. 
B Click [Advanced].

C Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

M Click [OK] to close the Printer Properties.

Windows 2000

Follow these steps to set up a Windows 2000 client.

Preparation
Log on to the NetWare file server before starting the following procedure. To
use the NetWare server, select [Typical] installation.

A Close all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
The installer will start by Auto Run.

Important
❒ Never have two versions of the same printer driver installed on your sys-

tem at the same time. When upgrading to a new version of the printer driv-
er, delete the old version, and then install the new one.

Note
❒ Auto Run might not automatically work with certain OS settings. In this

case, launch "INSTTOOL.EXE" located on the CD-ROM root directory.

C Follow the instructions on the screen.

D Select [Typical] installation, and then click [Next].

E Follow the instructions on the screen.
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F Click [Add] when the "Select Port" dialog box appears.

G Select [network printer], and then click [OK].

H Double-click the computer name you want to use as a print server in the
"Browse for Printer" window.

I Select the printer you want to use, and then click [OK].

J After confirming that the pass indicates the selected printer has been dis-
played, click [Next].

K Follow the instructions on the screen.

L Restart the computer after installation is complete.

Note
❒ If the [Digital Signature Not Found] dialog box appears, click [Yes] to continue

the installation.

M Click [Start] on the task bar, point to [Settings], and then click [Printers].
The [Printers] window is displayed.

N Click to select the icon of the printer you want to use, and then click [Prop-
erties] on the [File] menu.

The printer driver's property is displayed.

Limitation
❒ Changing the printer settings requires Manage Printers permission. Mem-

bers of the Administrators and Power Users groups have Manage Printers
permission by default. When you set up options, log on using an account
that has Manage Printers permission.

O Click the [NetWare Settings] tab.

P Click to clear the [Form feed] and [Enable banner] check boxes, and then click
[OK].

When using the PostScript printer driver

Follow these steps to set up for the PostScript printer driver.
A Click the [PostScript] tab.

B Click [Advanced].
C Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check

boxes.

Q Click [OK] to close the [Printer properties] dialog box.
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----If a message is displayed during installation of the printer driver
When there is a driver in the computer that is newer than the one currently being
installed, the warning dialog box appears.
In such a case, you cannot install with the Auto Run program. Use the driver that
was used in installing the driver that is displayed in the message, and reinstall
with [Add Printer].
A Click [Start], point to [Settings], and then click [Printers].
B Double-click the [Add Printer] icon.
C Follow the wizard to install the driver.

If the printer driver disk is a CD-ROM, the sources of installation are as fol-
lows. If the installer starts up, click [Cancel] to quit it.
• PCL 5e

DRIVERS\PCL5C\WIN2000\(Language)\DISK1
• PCL 6

DRIVERS\PCL6\WIN2000\(Language)\DISK1
• PostScript

DRIVERS\PS\WIN2000\(Language)

Windows NT 4.0

Follow these steps to set up a Windows 2000/Windows NT 4.0 client.

Preparation
Log on to the NetWare file server before starting the following procedure.

A Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.
The [Printers] dialog box appears.

B Click [No].

C Close all the applications that are currently running.

D Insert the CD-ROM labeled "Printer Drivers and Utilities" into the CD-
ROM drive.
If the setup menu starts automatically, you can go to the next step. If not, see
“Installing the PCL 6/5e Printer Driver” and “Installing the PostScript Printer
Driver” in “Printer Reference 1” to start the installation and then go to the next
step.

E The [Printer Installation] dialog box appears.

F From the [Port] list, select the queue you selected in step AAAA, and click [Next >].

G Follow the instructions on the screen to finish the installation of the printer
driver.



7. Macintosh Configuration
Configuring Macintosh

This section describes how to configure a Macintosh to use EtherTalk. The actual
procedures to configure a Macintosh may differ depending on the version of the
Mac OS. The following procedure describes how to configure Mac OS 8. If you
are not using Mac OS 8, see the manual that comes with your version of the Mac
OS for more information.

Limitation
❒ For use with Macintosh OS 8 or 9.

Changing to EtherTalk

Follow the procedure to configure a Macintosh to use EtherTalk.

Reference
For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

A Open [Control Panel], and then double-click the [AppleTalk] icon.

B From the [Connect via:] pop-up menu, select "Ethernet".

C If you change zones, select a name from the [Current zone:] pop-up menu.

D Close the [AppleTalk] control panels.

E Restart the computer.

Change to EtherTalk

Basic Procedure

Configure the printer

Change the printer name

Change the zone
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Configuring the Printer

Use the operation panel to activate the AppleTalk protocol. (The factory default
is active.)

Changing the Printer Name

If the network has several same model printers, the names will be the same.
Printers that have the same name will have their names changed slightly in the
Chooser. For example, three printers named "printer" will appear in the chooser
as "printer0", "printer1" and "printer2".
For more information about changing the printer name, see the “Type 1018 Post-
Script level2 Compatible Kit Operating Instructions Supplement”.

Changing the Zone

It may be necessary to change the zone configuration.
For more information about changing the printer name, see the “Type 1018 Post-
Script level2 Compatible Kit Operating Instructions Supplement”.
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Conventions used in this manual

Acronyms used in this manual

Convention Description

 Italic type Indicates placeholders where you specify a value, such as a file 
name, address, or other value. Italics are also used for book titles 
and cross-references to other chapters or sections of this manual.

Bold type Indicates specific choices within instructions or procedures, such 
as keys, buttons, or other dialog box options. For example: Click 
on Software Installation.

Choose File -> Open Indicates a menu selection (such as choosing the Open command 
from the File menu).

monospace bold type Indicates file names, path names, and so on. Code examples are 
also shown in a monospace font.

Press Enter On some keyboards, the Enter key is marked Return. (Similarly, 
some keyboards may use different key labels such as Esc or 
Escape.) Unless it is otherwise noted, you terminate all typed 
commands (such as in a DOS command box) by pressing Enter 
or Return.

Acronym Meaning

arp Address Resolution Protocol

DIB Directory Information Base

DHCP Dynamic Host Configuration Protocol

ESD Electrostatic Discharge

FTP File Transfer Protocol

HTML HyperText Markup Language

HTTP HyperText Transfer Protocol

IP Internet Protocol

IPP Internet Printing Protocol
 



IPX Internetwork Packet Exchange

MAP Management Access Program

MIB Management Information Base

NIC Network Interface Card

NDS NetWare Directory Services

NOS Network Operating System

PCL Printer Control Language

PDS Print Device Subsystem

PPD PostScript Printer Driver

rarp Reverse Address Resolution Protocol

SAP Service Advertising Protocol

SMIT System Management Interface Tool

SNMP Simple Network Management Protocol

SPX Sequenced Packet Exchange

STP Shielded Twisted Pair

TCP/IP Transmission Control Protocol/Internet Protocol

UTP Unshielded Twisted Pair

Acronym Meaning
 



Structure of this manual
• Chapter 1, Introduction, contains information about the Network Interface Board, its 

features, and the hardware and NOS requirements.

• Chapter 2, Installing the Network Interface Board, explains how to install the card.

• Chapter 3, Monitoring the Network Interface Board, explains how to use the Management 
Access Program (MAP) or a Web browser to configure and monitor the Network Interface 
Board.

• Chapters 4 through 7 explain how to configure the Network Interface Board for specific 
environments.

• Chapter 8, Operation and Troubleshooting, contains information on the LED status 
indicators, printing status reports, and resetting the print server to factory defaults. It also 
contains troubleshooting checklists.

• Appendix A, Jumper Settings, describes the jumper settings and locations.

• Appendix B, Network Interface Board Specifications, lists the general specifications for 
the Network Interface Board, including the specifications for the 10/100BaseT cables.
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Chapter 1
Introduction

The Network Interface Board is a Network Interface Controller that you install into 
compatible printers to provide Ethernet® network connectivity.

This chapter describes:

• Network Interface Board features

• Contents of the Network Interface Board package

• Hardware and NOS requirements

1.1 Network Interface Board Features

The Network Interface Board has the following features:

• Automatic selection of 100BaseT Fast Ethernet connection or 10BaseT Ethernet 
connection

• Fully-transparent AppleTalk™ printing support for Macintosh™ systems

• IP Peer-to-Peer (serverless) discovery and printing from Microsoft® Windows™ 
95/98/Me or Windows NT™ 4.0 workstations

• IPX Peer-to-Peer (serverless) discovery and printing from Windows 95/98/Me 
workstations, without a Novell® file server present and without using IP

• Novell NetWare® PSERVER on Bindery based configurations and Novell 
Directory Services (NDS)

•  lpr/lpd over TCP/IP for UNIX™-based systems and Windows systems

• IP and IPX Simple Network Management Protocol (SNMP) support of 
Management Information Base-2 (MIBII) and proprietary NIC-MIB

• SNMP support of standard MIB, MIBII, proprietary NIC-MIB, and proprietary 
printer MIBs on compatible printers

• Integral HTTP server to allow monitoring and management of your Network 
Interface Board from a Web browser such as Internet Explorer or Netscape® 
Navigator, Communicator

• Management Access Program (MAP) to allow Windows-based HTML viewing 
for monitoring and managing your Network Interface Board
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• FTP printing directly from a Web browser or other FTP client

1.2 Network Interface Board Package Contents

The Network Interface Board package contains the following:

• Network Interface Board

• CD-ROM containing:

— This manual

— MAP

— IPX Peer-to-Peer Windows Redirector

— IP Peer-to-Peer Windows Redirector

— NWSetup Utility

Check each directory for a README file containing the latest information about the 
installation and operation. Read these files before installing.
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Note: Each Network Interface Board has a unique six-digit serial number with a three-letter 
prefix — for example, “RDP”. The serial number is listed on the bottom of the Net-
work Interface Board and displayed on the box.

1.3 Hardware and NOS Requirements

The Network Interface Board hardware and software require the following:

Version of protocol or NOS

• Novell NetWare Version 3.x (or higher), 4.x, or 5.x

• Apple Macintosh System 8.x or 9.x.

• UNIX, Windows, or LAN Server systems supporting lpr over TCP/IP

• Sun™ Solaris™ 2.5.1 or 2.6, 7, 8

• Hewlett Packard HP-UX™ 8.x, 9.x, 10.x, 11.0

• RED HAT Linux 6.2

Software

• NetWare printing requires NetWare Capture, NPRINT, and either PCONSOLE 
(later than 1.0) or NWADMIN.

• NWSetup requires Windows 95/98/Me, Windows2000 or Windows NT 4.0 and 
the Novell 32-bit client.

• The IP Peer-to-Peer utility requires Windows 95/98/Me or Windows NT 4.0.

• The IPX Peer-to-Peer utility requires Windows 95/98/Me.

• The MAP utility requires Windows 95/98/Me, Windows 2000 or Windows NT 
4.0. MAP also requires a Web browser such as Internet Explorer or Netscape 
Navigator, Communicator.

• AppleTalk printing requires the appropriate PostScript® Printer Description 
(PPD) for the printer.

• TCP/IP setup and maintenance can be done with Telnet. To monitor and maintain 
with HTTP requires a Web browser.

Hardware

• Support for 10 Mbps Ethernet networks: 10BaseT (twisted pair) cables and 
hardware
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• Support for 100 Mbps Ethernet networks: 100BaseT (twisted pair) cables and 
hardware

• CD-ROM drive on the workstation to accept Windows, Macintosh, or UNIX-
based utilities
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Chapter 2
Installing the Network Interface Board

This chapter describes:

• Installing an Network Interface Board in your printer

• Connecting the Network Interface Board to an Ethernet network

• Powering up the printer

2.1 Installing an Network Interface Board in Your Printer

1. Before installing the board, generate a printer status or test page, if possible.

This gives you detailed information on the identification and configuration of 
your printer, and ensures the printer is set up and operating properly.

2. Make sure the printer is operating properly, there is paper in the paper tray, and the 
toner bottle is setting correctly.

3. Turn off the printer and remove the power cord.

4. Install the Network Interface Board in the option port, according to the printer 
manufacturer’s instructions.

Note: The Network Interface Board is designed to protect sensitive components from dam-
age due to electrostatic discharge during normal operation. When installing the card, 
however, take proper static-control precautions to prevent damage to equipment.
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2.2 Connecting the Network Interface Board to an Ethernet Net-
work

Connect the Network Interface Board to your Ethernet network using the 10BaseT or 
100BaseT Ethernet interface. This network connection uses a 4-wire RJ cable to plug into 
the RJ45 network connector on the Network Interface Board. For a description of the 
signals, see Appendix B, Network Interface Board Specifications.

2.3 Powering up the Printer

1. Plug in the power cord.

2. Turn on the power and wait for the printer to warm up.

The printer may print a status or start-up page if this option is not disabled.

The Network Interface Board then sends a print job to the printer that contains the 
Network Interface Board status information. For more information, see Section 
8.2 Status Report.

3. Check the Network Interface Board status report. Record the serial number (six 
digits with a three-letter prefix) and the network address or save the status report.

You need this information when you configure the printer for your network.

Refer to the chapters relevant to your particular network setup for instructions on 
configuring the network for the Network Interface Board.
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Chapter 3
Monitoring the Network Interface Board

This chapter describes:

• Overview of the Management Access Program (MAP)

• MAP requirements

• Where to install MAP

• Installing MAP in Windows 95/98/Me, Windows 2000 or Windows NT

• Using MAP to monitor and maintain the Network Interface Board

• Using a Web browser to monitor and maintain the Network Interface Board

3.1 MAP Overview

The Management Access Program (MAP) provides a Windows-based HTML viewer 
linked to a proprietary bi-directional IPX/IP channel program to allow access to the 
Network Interface Board’s HTML pages for monitoring and maintenance capabilities.

Using MAP lets you:

• Configure your network protocols for the Network Interface Board

• Reset the Network Interface Board remotely or return it to its factory default 
settings

• Troubleshoot problems in the Network Interface Board

• Enable or disable the status sheet printout

• Access a context-sensitive help menu that explains how to use each Network 
Interface Board HTML feature

You can also access the monitoring and maintenance capabilities by using a Web browser 
such as Internet Explorer or Netscape Navigator. The Network Interface Board must have 
an IP address for access with a Web browser.

Note: To change parameter values with MAP or with a Web browser, you must know the 
Network Interface Board management password. The factory default password is 
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sysadm.

3.2 MAP Requirements

To use MAP, your workstation must have the following installed:

• Microsoft TCP/IP protocol

It is not necessary for the network to support TCP/IP. However, the TCP/IP 
protocol must be installed even if the network does not support it.

• A Web browser — such as Internet Explorer or Netscape Navigator

• IPX — if you want to use the IPX search functions

Both the Microsoft standard stacks and Novell 32-bit stacks are supported.

3.3 Installing MAP

You can install MAP on any workstation hard drive or network drive.

To install MAP:

1. Put the supplied CD-ROM into the CD drive of your workstation.

2. Choose Start> Run.

3. Type the following command and click OK:

drive:\MAP\SETUP.EXE

where drive is your CD drive.

4. Read the information in the MAP installation notes.

5. At the prompt “Do you wish to install MAP?,” click Yes.

6. Select a destination directory for the program (default is 
C:\Program Files\MAP) and click Next.

7. Select a program folder (default is MAP) and click Next.

Note: You cannot use MAP with Windows 3.1.
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3.4 Monitoring with MAP

1. To start MAP on your workstation, choose Start -> Map -> Map.

MAP lists IP print servers by their IP address and lists IPX print servers by their 
SAP identification.

2. Select the print server you want to access.

MAP sets up a link to the print server and obtains its HTML page.

3.5 Monitoring with a Web Browser

Once you have assigned an IP address to your Network Interface Board, you can use a 
Web browser, such as Netscape Navigator or Internet Explorer, to view the Network 
Interface Board HTML pages for monitoring and maintenance as follows:

1. In your Web browser, choose File -> Open.

2. Enter the IP address of the Network Interface Board and click OK.

For example:

    http://192.9.200.200

The HTTP Server screen opens.

If you have problems, make sure you are using the correct IP address.
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Chapter 4
NetWare Configuration

This chapter describes configuring the Network Interface Board as follows:

• Using PCONSOLE with NetWare 3.x

• Using PCONSOLE with NetWare 4.x Bindery Services (there is no bindery 
function in Version 5.x )

• Using NWADMIN with NetWare 4.x and 5.x Directory Services

• Using MAP or a Web browser to access parameters for NetWare

• Using standard NW Setup utilities to change the configuration

Note: These instructions assume that your NetWare environment is set up correctly accord-
ing to the Novell documentation.

4.1 Configuring NetWare 3.x

Before configuring NetWare, use MAP or a Web browser to determine if the Network 
Interface Board has the name you want — either the default name or a user-defined name. 
See Chapter 3, Monitoring the Network Interface Board.

Note: Novell recommends upgrading to 4.2 and no longer supports versions lower than 3.2.

The general procedure for configuring the Network Interface Board for NetWare is as 
follows. Refer to the relevant sections in this chapter for detailed information.

• Using PCONSOLE, select the file server you want to use

• Create the print queues

• Specify the Network Interface Board as a print server

• Configure the print server and printer

• Assign the print queues

• Set Notify options
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Note: You must have supervisor privileges to configure the queue. When you are finished, 
turn the printer off and on again. The printer prints a status page that lists the file serv-
ers attached to the unit and the queues it services.

Before you begin:

• Verify that you have supervisor privileges on the file servers on which you are 
entering the Network Interface Board print server and queue.

• Verify that your version of PCONSOLE is later than 1.0.

4.1.1 Using PCONSOLE to Select a File Server
1. Log in as a supervisor or ADMIN.

2. At the command prompt, enter the PCONSOLE command.

3. Choose Change Current File Server from the Available Options menu.

A list of file servers is displayed.

4. Select the file server on which you want to install the print server.

If the name of the file server you want is not displayed, type h to display a list of 
file servers.

5. Log in to the file server.

6. Press the Esc key to return to the Available Options menu.

4.1.2 Creating Print Queues
A print server takes the print jobs from queues and sends them to the printer. The print 
server must be assigned to at least one print queue on the file server.

If the print queue that you want the Network Interface Board to service already exists, and 
you know the name of this queue, refer to Section 4.1.3 Entering the Print Server Name.

If you do not know the name of the queue or it does not exist, create a queue.

To create a queue:

1. In PCONSOLE, choose Print Queue Information from the Available Options 
menu.

A list of existing queues is displayed.

2. Press the Insert key.

3. Enter the name of the queue.
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4. Press the Esc key to return to the Available Options menu.

4.1.3 Entering the Print Server Name
1. In PCONSOLE, choose Print Server Information from the Available Options 

menu.

A list of existing print servers is displayed.

2. Press the Insert key.

The New Print Server Name box is displayed.

3. Enter the name of the print server.

On the printer status sheet, the print server name will appear under NetWare 
information. The default name is the Network Interface Board serial number (six 
digits with a three-letter prefix).

Note: You can change the print server name using the MAP utility or a Web browser. See 
Chapter 3, Monitoring the Network Interface Board.

4.1.4 Configuring the Print Server
1. In PCONSOLE, choose the print server name from the Print Servers list.

The Print Server Information menu is displayed.

2. Choose Print Server Configuration from the menu.

3. Choose Printer Configuration.

The Configured Printers menu appears. Since this is a new Print Server entry, all 
printers are labeled “Not Installed.”
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4. Choose Printer 0.

The Printer 0 Configuration screen appears with a title of “Printer 0.”

5. To change the name that the print server uses in its messages in the Notify list to 
users, select Name and enter a name.

This name helps you identify the printer — for example, LASER_PRINTER.

6. Choose Type.

A list of printer types is displayed.

In the list of printer types, choose Remote Other/Unknown.

This creates default entries in the other fields. These defaults are usually optimal, 
so do not change them without specific knowledge of the effects.

7. Press the Esc key and save your changes. Then continue to press Esc to return to 
the Print Server Configuration menu.  If you have finished the configuration, save 
your changes and exit from PCONSOLE.

4.1.5 Assigning Print Queues to the Printer
When you assign queues to the defined printer, you authorize the print server to service 
these queues.

Note: Do not assign the same queue to two different print servers. If a queue is assigned to 
multiple print servers, print jobs might not go to the intended printer.

To assign print queues to the printer:

1. In PCONSOLE, choose Queues Serviced By Printer from the Print Server 
Configuration menu.

2. Choose the printer name from the list of defined printers.

The Available Queues list for the printer is displayed.

3. Choose the queue you want and then assign a priority level from 1 to 10 (where 1 
is the highest priority. It is also the default).

The queue is displayed on the list for the printer.

You can press Enter again to assign additional queues.

4. When you finish assigning queues, press the Esc key and save your changes.  
Then continue to press Esc to return to the Print Server Configuration menu.  If 
you have finished the configuration, save your changes and exit from 
PCONSOLE.
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4.1.6 Setting Up Notify Options for the Printer
You can specify users or groups of users that are notified if a problem occurs when a print 
job is sent to the printer. The print server supports the enhanced Notify options for 
printers, including informing users when the printer —

• Is off-line, jammed, opened, or out of paper

• Requires a manual paper feed or a form change

• Has had an engine failure

If the print server services queues on multiple file servers, you must set up a Notify list for 
each file server.

To configure the Notify options:

1. In PCONSOLE, choose Notify List for Printer on the Print Server Configuration 
menu.

2. Choose the printer from the Defined Printers list.

3. Press Enter to view a list of Notify Candidates.

4. Select the user or group from the list.

5. Set the First and Next intervals in the Notify Intervals screen by entering a number 
for each interval.

The First interval is the number of seconds the network waits before it notifies 
candidates about a print job problem. The Next interval specifies how often, in 
seconds, candidates are notified.

6. After entering the intervals, press the Esc key and save your changes.  Then 
continue to press Esc to return to the Print Server Configuration menu.  If you 
have finished the configuration, save your changes and exit from PCONSOLE.

4.1.7 Installing the Print Server on Multiple File Servers
To install the print server on more than one file server, perform the procedures described 
in sections 4.1.1 through 4.1.6 for each file server. You must use the same name and 
password (or no password) on all file servers. You can set the password for the Network 
Interface Board using MAP (see Section 4.3 Configuring the Network Interface Board). If 
you use a password, specify it on each file server using the Change Password option on the 
Print Server Information menu of the PCONSOLE utility.

A hop is an intermediate connection in a string of connections linking two network 
devices. For example, on a network, some data packets must go through several routers 
before reaching their final destination. Each time a packet is forwarded to the next router, 
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a hop occurs. The more hops, the longer it takes the data to go from the source to the 
destination.

A tick is 1/100 of a second for the Network Interface Board (Novell has a different value). 
Propagation delay is the time it takes for the data to travel through the network, from the 
source to the destination.

At startup, the Network Interface Board automatically searches for and attaches to the file 
servers that are no more than four hops away and that have no more than eight ticks 
propagation delay. For extremely large or complex networks, this allows a bounded search 
time on startup.

If the print server must attach to file servers beyond this range, or if you want to accelerate 
start up by eliminating the need to search all file servers within the four hops/eight ticks 
radius, enter the name of the file server operating with the print server in the Print Server 
Configuration of a primary file server. The primary file server is a server close to the 
printer and contains a list of file servers that it services. The primary file server can be any 
file server within the four hops/eight ticks propagation time limits but ideally is as close as 
possible to the print server. Once the print server locates the primary file server and the list 
of file servers to be serviced, the automatic search stops and the print server goes directly 
to those file servers listed (and to no others).

4.1.8 Setting Up a Primary File Server
1. Log in to the server you want to designate as the primary server and run 

PCONSOLE on that server.

2. Choose File Server To Be Serviced from the Print Server Configuration menu.

3. Press the Insert key to display the Available File Servers list.

4. Select the name of each file server to be serviced and press Enter to add it to the 
list.

5. When the list is complete, press Esc to return to the menu.

6. Install the Network Interface Board on each primary file server.

4.1.9 Setting Up Preferred File Servers
You can specify a preferred file server on the Network Interface Board (see Chapter 3, 
Monitoring the Network Interface Board). If a preferred file server is listed, the Network 
Interface Board attaches to this identified file server instead of initiating the automatic 
search. If the preferred file server is also a primary file server (for example, has file servers 
listed under File Servers to Be Serviced), the Network Interface Board connects directly to 
these file servers.
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Note: The Preferred File Server applies only to bindery-based queues. There is no effect on 
NDS queues.

4.2 Configuring NetWare Bindery Emulation

NetWare 4.x can operate in two modes:

• NetWare Directory Services (NDS)

• Bindery Services Emulation

For NDS, refer to Section 4.3 Configuring the Network Interface Board.

These services run simultaneously and transparently to each other. You can configure the 
Network Interface Board to operate with Bindery Services Mode only or to operate under 
NDS. When configured under NDS, the Network Interface Board also services older file 
servers operating in Bindery Mode.

Note: If the Network Interface Board is not properly set up for NDS and the Bindery Ser-
vices Mode is not running, the Network Interface Board cannot find its file servers. 
The status page then indicates the NetWare protocol is not active.

4.2.1 Confirming Bindery Context
Before installing the Network Interface Board on a Novell NetWare 4.x server in Bindery 
Emulation Mode, check that the server has a Bindery Context (name for the server under 
Bindery Services Mode). If the server does not have a Bindery Context, you can install the 
Network Interface Board in NDS mode. If the Network Interface Board must be installed 
in Bindery Emulation Mode, the server must have a Bindery Context.

1. At the system console on the 4.x server, enter the load install command.

2. Choose Maintenance/Selective Install from the menu.

3. Choose NCF Files Options from the menu.

4. Choose Edit AUTOEXEC.NCF from the menu.

5. Search the file to see if you have a statement similar to the following:

SET BINDERY CONTEXT=0U=context

where context is the name of your file server context. If this string is not present, 
you can enter it in the autoexec.ncf file.
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6. If you entered a new string in autoexec.ncf, then at the console prompt, enter 
the SET BINDERY CONTEXT statement that you entered in the file.

Note: The command at the console prompt takes effect immediately. The definition in 
autoexec.ncf takes effect when the server is restarted.

4.2.2 Configuring in Bindery Mode with PCONSOLE
Once you confirm the server has Bindery Context, use the following procedures to 
configure the Network Interface Board.

To configure the Network Interface Board with PCONSOLE:

1. Log in as a supervisor or ADMIN.

2. At the command prompt, enter the PCONSOLE command.

3. Press the F4 key to switch to Bindery mode.

Note: If you receive a message asking you to log in to a server with Bindery connections, the 
server you are attached to does not have Bindery Mode enabled. Follow the steps in 
Section 4.2.1 Confirming Bindery Context or log in to a server with Bindery Services 
activated.

4. Choose Quick Setup from the Available Options list.

5. Use Quick Setup to connect your print server, print queue, and printer correctly. 
You can modify these later if necessary.

6. Select Print Server and press F3 or Insert to modify the entry.

7. Enter the name of the print server in the Print Server field.

The print server name appears under Novell Network Information on the Status 
and Configuration report. The default name is the Network Interface Board serial 
number (six digits with a three-letter prefix).

8. Enter a name in the New Printer field.

9. Enter a name in the New Print Queue field.

10. In the Printer Type field, choose Other/Unknown from the list of printer types.

11. When you are finished, press Esc to save the configuration.
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Repeat steps 5 through 11 for each file server that the print server services.

To view, add, delete, or modify print servers or queues after the initial setup, select 
either Print Queues or Print Servers on the Available Options menu.

4.3 Configuring the Network Interface Board

NDS offers a more advanced approach to network management than previous NetWare 
versions. It stores and tracks all network objects. As a rule, all 4.x and 5.x servers must 
have NDS loaded in order to function. In this way, every NetWare 4.x or 5.x server is a 
directory server, because it services named directory objects such as printers, print servers, 
and print queues. With the appropriate privileges, you can create a print server object 
which, once configured in its context (or location) on the network, eliminates the 
cumbersome setup of print servers on every network server. NDS provides true enterprise 
networking based on a shared network database rather than an individually defined 
physical site. The result is greatly improved print server setup and management.

The Directory Information Base (DIB) stores information about servers and services, 
users, printers, gateways, and so on. It is a distributed database, allowing access to data 
anywhere on the network wherever it is stored. NetWare versions earlier than 4.x provide 
the same data found in the DIB, but the NetWare Bindery stores the data. The DIB was 
designed with more flexible access and more specific security; moreover, since it is 
distributed, it was designed to be partitioned. The DIB uses an object-oriented structure 
rather than the flat-file structure of the Bindery, and offers network-oriented access rather 
than the server-oriented access found in the Bindery.

The DIB is backward-compatible with the NetWare Bindery through Bindery Emulation 
Mode. Section 4.2 Configuring NetWare Bindery Emulation describes Print Server 
Operation with a NetWare 4.x system in Bindery Emulation Mode. When Bindery 
Emulation is enabled, Directory Services accept Bindery requests and respond as if a 
Bindery exists on the NetWare server being accessed. Information obtained from the 
Bindery query may not be stored in the server because the DIB is a partitioned and 
distributed database. Even though the NetWare 4.x server is not operating from a Bindery, 
the applications making Bindery requests do not know the difference.

You can use NWADMIN to configure the printer in NDS. Before you can print, NDS must 
be set up as described in the following sections and the Network Interface Board must be 
set up with NDS Context and Tree. See Section 4.4 Configuring the Network Interface 
Board.

The following sections describe using NWADMIN to create printer, print server, and print 
queue objects. You can assign or associate these objects with each other. You can keep 
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Bindery resources on any server under NetWare 4.x if you include a SET statement in your 
autoexec.ncf file.

Alternatively, you can use PCONSOLE to set up static information about print servers, 
such as the queues to service and whom to notify in the event of a problem. Refer to the 
NetWare documentation for more information about the use of PCONSOLE for NDS.

4.3.1 Creating the Printer Object
1. Start NWADMIN. (For example, double-click the NWADMIN icon in the 

NetWare Tools group.)

The NetWare Administrator window opens.

2. Choose Object -> Browse.

Your directory tree is displayed.

3. Select the Organizational Unit or Organization where you want to create the 
printer in the Directory Tree, and choose Object -> Create.

The New Object windows appears.

4. In the Class of New Object list, choose Printer and click OK.

5. When the Create Printer window appears, enter a value in the Printer Name field 
and click Create.

4.3.2 Creating the Print Server Object
To create a print server object:

1. In NWADMIN, choose Object -> Browse.

2. Select the Organizational Unit where you want to create the print server in the 
directory tree and choose Object -> Create.

3. In the New Object window, scroll down the Class of New Object list, choose 
Print Server and click OK.

4. When the Create Printer window appears, enter a value in the Print Server Name 
field and click Create.

4.3.3 Creating the Print Queue Object
1. Start NWADMIN.

2. Choose Object -> Browse.

3. Select the Organizational Unit where you want to create the print queue in the 
directory tree and choose Object -> Create.
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4. In the New Object window, scroll down the Class of New Object list, choose 
Print Queue and click OK.

5. In the Create Print Queue window, click Directory Service Queue, enter values 
for Print Queue Name and Print Queue Volume and click Create.

If you do not know the Print Queue Volume name (the hard drive you are 
accessing), click the icon to the right of the volume field. The Select Object 
window opens with the volume listed in Objects. If the volume is not listed, scroll 
through the Directory Context items to find the volume where you want the queue 
to reside.

6. Click the object (hard drive) of your choice.

The object appears in the Selected Object field. 

7. Click OK and then click Create.

4.3.4 Assigning the Printer Object
1. In NWADMIN, choose Object -> Browse.

2. In the NWADMIN directory tree, double-click the printer object created in 
Section 4.3.3 Creating the Print Queue Object.

The Printer window opens.

3. Click Assignments and then click Add.

4. When the Select Object window opens, find the print queue object just created 
and select it.

5. Click OK.

The print queue just created appears in the Print Queues list in the Printer window.

6. Click OK.

4.3.5 Assigning Print Server Object
1. In NWADMIN, choose Object -> Browse.

2. In the NWADMIN directory tree, double-click the print server object you just 
created.

The Print Server window opens.

3. Click Assignments and then Add.

4. When the Select Object window opens, select the printer object just created in the 
Objects list and click OK.

The printer (with its context) appears in the Printers list.
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5. Click OK.

4.3.6 Checking Assignments
1. In NWADMIN, choose Object -> Browse.

2. In the NWADMIN directory tree, double-click the print queue object.

The Print Queue window opens.

3. Click Assignments.

If you configured the print queue and printer correctly, they will appear in the 
proper boxes in the Print Queue window.

4. Click Cancel.

4.3.7 Setting Up and Resetting the Printer
After completing the NWADMIN configuration, you must set up and reset (power cycle) 
the printer before you can begin printing.

4.4 Configuring the Network Interface Board

Use the MAP utility or a Web browser to:

• Define the context and tree of the Print Server

• Change the Print Server name

• Set a password

• Set values for Bindery Mode

For more information, see Chapter 3, Monitoring the Network Interface Board.

To configure the Network Interface Board:

1. Access the setup pages for the Network Interface Board using MAP or a Web 
browser.

2. Once you have accessed the Network Administration pages or the Main Menu, 
choose Setup NetWare under Protocols.

3. Confirm that there is a check mark in the Enable NetWare option. If necessary, 
put a checkmark in that option.

4. Optionally, enter a name in the Print Server Name field.

To use the default name, leave the field blank.
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The default name is the Network Interface Board serial number (six digits with a 
three-letter prefix). This is also the default name of the printer in peer-to-peer 
mode.

Note: If you make any changes, you will be prompted for a password. The default password 
is sysadm.

5. Optionally, to secure the Network Interface Board with a password, enter a 
password in the Print Server Password field and again in the Password Retype 
field.

If you are using a password, use the same password for all bindery-based and 
NDS-based Print Server entries.

If you enter a password, you must also enter the same password in the password 
field on your file server setup using PCCONSOLE or NWADMIN.

6. For Bindery emulation, enter the name of a preferred bindery-based file server in 
the Preferred File Server field.

The Preferred File Server entry applies only for Bindery- or Bindery Emulation-
based operations. See Section 4.1.9 Setting Up Preferred File Servers for the 
significance of a Preferred File Server. The Print Server must be configured on the 
preferred file server. Incorrect setup of a Preferred File Server can interfere with 
NetWare printing.

7. If the Print Server operates under Novell Directory Services, enter a Context and 
Preferred NDS Tree in the appropriate fields.

Be sure to give the whole context, whether typed or typeless, and do not begin 
your context path with a leading period.

An example of a typed context name is ou=standard.ou=organization_1.

(If you do not know your tree, open a DOS command box and enter the whoami 
command.)

An example of a typeless context name is organization_1.

You must use a typeless context if the Network Interface Board is on the same 
network segment as the file server.

8. Enter the time intervals, in seconds, in which the Print Server will scan the queues 
that it services in the Print Queue Scan Rate field.

The default scan rate is once per second.

9. If your network uses multiple frame types for Novell, you can bias the frame 
search to the desired type by setting the radio button next to the designation under 
Ethernet Frame Type.
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The Network Interface Board normally monitors the network to determine which 
frame type is used for Novell. When it recognizes a type, it assumes the same 
frame type. Once it selects a frame type, the Network Interface Board only 
operates over that Novell frame type. Monitoring normally starts looking for 
IEEE 802.3, then Ethernet II, then 802.3 SNAP, and so on.

10. If you are operating in NDS mode only, you can disable Bindery Mode on the 
Print Server by putting a checkmark in the Disable Bindery checkbox.

If you disable Bindery Mode, the Network Interface Board does not support Print 
Servers on a Bindery file server.

11. Once you have selected all desired settings and entered the desired NetWare 
information, click Accept Settings to save this information in the Network 
Interface Board NVRAM.

If you have not entered the Network Interface Board Management password 
previously during this session, you must enter it in the appropriate space before 
clicking Accept Settings.

The values you entered do not take effect until the Network Interface Board is reset or 
power cycled. You can reset from MAP or the Web browser by returning to the home page 
or Network Administration page, and clicking Reset under System, and then clicking 
Reset Unit. Alternatively, you can power cycle the printer. The new NetWare values are 
now in effect.

4.5 Using the Novell PCONSOLE Utility

You can use the PCONSOLE utility to:

• Attach and select a file server

• Select or delete queues for the print server

• Set up the Notify function

See the NetWare Print Server Manual for detailed information on this utility.

Note: You must have Supervisor privileges to perform many PCONSOLE operations.

4.5.1 Changing the File Server
1. Log in to the file server and run PCONSOLE on that server.

2. Choose Change Current File Server from the Available Options menu.

3. Press the Insert key to display the available file servers.
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4. Select the file server you want.

5. Enter your username.

If the username requires a password, the Password screen appears. Enter the 
password.

The name of the file server appears in the status header at the top of the 
PCONSOLE window.

4.5.2 Changing Print Queues
When you print a file, your system sends the file to a print queue. The print server 
assigned to that queue extracts the print job and sends it to the assigned printer. If a print 
server services queues on multiple file servers, you must assign queues to the printer on 
each file server.

To change the print queues:

1. Log in to the file server and run PCONSOLE on that server.

2. Choose Print Servers from the Available Options menu.

3. Select the print server you want.

4. Choose Printers from the Print Server Information window.

5. Select the printer you want.

6. In that printer’s Configuration Menu, choose Print Queues Assigned.

7. Select a queue from the list.

8. Select the priority for the print queue.

The highest priority queue is 1 (which is the default); the lowest is 10.

9. Press Esc and save all changes.

4.5.3 Setting Up a Notify List
You can specify users or groups of users that are notified if a problem occurs when a print 
job is sent to the printer. The print server supports the enhanced Notify options for 
printers, including informing users when the printer —

• Is off-line, jammed, opened, or out of paper

• Requires a manual paper feed or a form change

• Has had an engine failure

If the print server services queues on multiple file servers, you must set up a Notify list for 
each file server.
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To set up a Notify list:

1. Log in to the file server and run PCONSOLE on that server.

2. Choose Print Servers from the Available Options menu.

3. Select the print server you want.

4. Choose Printers from the Print Server Information window.

5. Select the printer you want.

6. In that printer’s Configuration Menu, choose Notification and press Enter.

7. Press the Insert key to get a list of available options.

The Notify Candidates screen appears.

8. Select the notification candidate you want.

The Notify Interval screen appears.

9. Specify the notify intervals you want.

The First interval is the time the network waits before it notifies users about a 
print job problem. The Next interval specifies how often users are notified.

10. Press Esc and save all changes.

4.6 Configuring NetWare and Print Servers Using NWSetup

The NWSetup program lets you set up NetWare and your network interface card (NIC) 
using one program. NWSetup combines the following configuration steps:

• Setting up the Novell file servers and print servers for NetWare printing (without 
using NWSetup utilities)

• Setting up your print server printers for network printing

4.6.1 Installing and Running NWSetup
1. Put the CD-ROM into your CD drive on your workstation.

2. Choose Start -> Run.

3. Type the following command and click OK:

drive:\NWSETUP\SETUP.EXE

where drive specifies your CD drive.

4. Follow the instructions in the Setup program.

After you install NWSetup, a program icon appears in your Start menu. To start the 
program, choose Start -> NWSetup -> NWSetup.
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Note: If you are configuring for NDS, make sure you are logged in to the correct tree and 
context before running NWSetup.

4.6.2 Selecting a Print Server
NWSetup displays a list of all NICs available on your network. Each NIC is listed with its 
serial number.

Note: NWSetup allows configuration of NICs that are connected to the same context of your 
NetWare server as the workstation running NWSetup.

To choose the NIC you want to configure, do either of the following:

• Highlight the NIC you want and click Select.

• Double-click the NIC you want.

The Print Server Settings screen appears. This screen lets you set up your version of 
NetWare for the NIC.

4.6.3 Configuring the Network Interface Board for NetWare
There are two Settings screens that you need to complete to configure the Network 
Interface Board for NetWare, including Directory and Bindery Services.

The following table describes the fields on the Settings screens.

Field Description

Print Server 
Name

Indicates the NetWare print server name that the Network 
Interface Board uses to log in to NetWare. You can enter any 
name that does not already exist in the network directory or 
server bindery.

The maximum length is 48 characters.
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Print Queue Scan 
Rate

Specifies the rate at which a Network Interface Board polls 
print queues for a new print job. For example, if you put 1 in 
the field, the Network Interface Board polls for new print jobs 
each second.

The minimum value is 1 and the maximum is 250.

Print Server 
Password and 
Print Server 
Password Retype

Indicates the password for a Network Interface Board used to 
log in to NetWare. When you change this field, NWSetup sets 
the password in both NetWare and the Network Interface 
Board.

The maximum length is 32 characters.

Note: The values in the Password and Password Retype 
fields must be identical before you can choose Finish on 
this screen.

Ethernet Frame 
Type 

Indicates the Ethernet frame type that should be used by the 
NetWare protocol stack by default. Only one frame type can be 
selected.

Enable NDS 
Mode

Indicates whether the Network Interface Board supports 
Directory Services. When the box is checked, the Network 
Interface Board supports Directory Services.

If this box is not checked, all other fields on this screen are not 
enabled.

Preferred NDS 
Context

Enter a text string to set the NDS directory context that the 
Network Interface Board uses to log in to the network. The 
maximum length is 128 characters.

Preferred NDS 
Tree

Enter a text string to set the NDS tree that the Network 
Interface Board uses to log n. The maximum length is 48 
characters.

Enable Bindery 
Mode

Determines whether the Network Interface Board should 
attempt to service the NetWare network in Bindery Mode.

If this option is not enabled, the Primary File Server option is 
not enabled.
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4.6.4 Entering Print Server Settings
NWSetup also lets you set up each print server and queue. This information is usually 
entered using NWADMIN or PCONSOLE. NWSetup eliminates the need for configuring 
the file server with any NetWare utility.

The following table contains a description of the NWSetup dialog box options.

Primary File 
Server

Specifies the NetWare file server that the Network Interface 
Board uses as the primary file server. If no primary file server 
has been selected yet, or if an unavailable server is selected, 
the first file server in the list is selected.

Dialog Box Option Description

Enable Printer Indicates whether support for the Network Interface Board 
and printer is enabled.

• If this box is checked, then the printer is enabled.

• If the box is not checked, then the printer is not enabled. 
and the remaining fields on the screen are disabled.

Printer Displays the name of the printer. This is a read-only field.

Queues Serviced by 
printer-name

Lists all the queues that are to be serviced by the printer.

• Queues associated with bindery connections are listed in 
the format bindery server name: queue name.

• Queues associated with NDS connections are listed by 
their distinguished names.

For example: If a printer services a queue named 
YOURPTR_Q on a bindery server named OLD_SERVER, the 
queue is named OLD_SERVER:YOURPTR_Q. If an NDS 
server has a distinguishing name such as 
ENGINEERING.CORP and a queue named 
ENGINGEERING_Q servicing the printer, the queue is listed 
as ENGINEERING_Q.ENGINEERING.CORP.
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Users/Groups 
Notified by printer-
name

Lists all users and user groups who are notified when a 
printer error is detected.

• Users and groups associated with bindery connections 
are listed in the format bindery server name: user name.

• Users and groups associated with NDS connections are 
listed by their distinguished names.

For example: If a user named Susan on the bindery server 
OLD_SERVER is listed on the printer’s notify list, the user is 
listed as OLD_SERVER:SUSAN. If a user named Albert 
with an NDS context of ENGINEERING.CORP is on the 
printer’s notify list, that user is listed as 
ALBERT.ENGINEERING.CORP. When you double-click an 
entry in this field, the Notify Settings screen appears. See 
Section 4.6.5 Configuring the Notify Settings.

Note: The Network Interface Board supports the Notify 
function only in Bindery Mode.

Add Queue/
Delete Queue

Select Add Queue and/or Delete Queue to make changes. 
See Sections 4.6.4.1 Adding a Queue and 4.6.4.2 Deleting a 
Queue for detailed information.

Add User/
Delete User

Select Add User or Delete User to add or remove users or 
groups for notification. See Section 4.6.4.3 Adding Users/
Groups for Notification.

Dialog Box Option Description
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4.6.4.1 Adding a Queue

To add a queue to the printer, click Add Queue.

A dialog box opens containing the following buttons and fields:

Create Queue • Queue Name — Enter the name of the new queue. This 
field must be completed in order to create a new queue. 
The maximum length is 48 characters.

• File Server Volume — Indicates the volume on which 
the queue should be created. This field is enabled only if 
the current connection is an NDS connection. When 
enabled, it contains a list of all available volumes. For 
Bindery Services, the default volume name is SYS.

• NDS Context — Specifies the NDS context in which 
the queue is created. This field is enabled only when an 
NDS connection is being used. When this field first 
appears, it lists the NDS context specified in the Add 
Queue dialog box. If you change the context, NWSetup 
verifies that the new context exists on the directory tree. 
Click OK to start the verification process.

Dialog Box Option Description
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Dialog Box Option Description

Create Queue • Queue Name — Enter the name of the new queue. This 
field must be completed to create a new queue. The 
maximum field length is 48 characters.

• File Server Volume — Indicates the volume on which 
the queue should be created. This field is enabled only if 
the current connection is an NDS connection. When 
enabled, it contains a list of all available volumes. For 
Bindery Services, the default volume name is SYS.

• NDS Context — Specifies the NDS context in which 
the queue is created. This field is enabled only when an 
NDS connection is being used. If you change the 
context, NWSetup verifies that the new context exists 
on the directory tree. Click OK to start the verification 
process.

Connection/Server Selects a server connection. This list includes the NDS 
connection and all of the bindery file server connections 
that the user has. The NDS connection is always listed first, 
by default. When a new connection is selected, the Queue 
field is automatically updated.

NDS Context Specifies an NDS context for the queue. NWSetup lists all 
the queues within this context or the subcontexts in the 
Queue field. This field is only enabled when NDS support 
is enabled. By default, the NDS Context should be set to the 
preferred NDS context specified in the Print Server Settings 
screen.
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4.6.4.2 Deleting a Queue

1. In NWSetup, highlight the queue you want to delete.

2. Click Delete Queue.

A confirmation screen asks if you really want to delete the highlighted queue.

3. Select Yes to delete or No to cancel.

Note: Deleting a queue does not physically remove it from the file server. To remove the 
queue from a file server, you must use the NetWare utility to delete the queue from the 
file server queue list.

4.6.4.3 Adding Users/Groups for Notification

To add users and groups for notification, click Add Users/Groups. A dialog box opens, 
containing the following buttons and fields:

Queue Lists all queues available on the currently selected 
connection.

• If an NDS connection is specified, then a list of all 
queue names in the selected context and all subcontexts 
displays.

• If you change the context in the NDS Context field or 
change the connection in the Connection/Server field, 
the queue list refreshes to reflect the new connection or 
context.

• If you double-click a queue in the list, the queue is 
automatically added to the printer’s service and you exit 
this screen.

Dialog Box Option Description

Connection Selects a connection from this field. This list includes the 
NDS connection and all of the bindery file server 
connections that a user can access. The NDS connection is 
always listed first, by default.

Dialog Box Option Description
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4.6.5 Configuring the Notify Settings
To configure the Notify function for the users or group, double-click an entry in the Users/
Groups Notified by Printer field on the Print Server screen. The Notify Settings screen 
appears with the following options.

NDS Context Specifies the NDS context to use when generating a list of 
users and/or groups. This field is enabled only for NDS 
connections. When first displayed, this field lists the 
preferred NDS context specified in the Print Server Settings 
screen. If you change this value, NWSetup verifies that it is 
correct when you attempt to move to another field or when 
you click OK.

Users/Groups Lists all the users and groups available on the selected 
connection. Any entry on this list can be added to a 
printer’s service list. The list includes print job owner (the 
user whose job is currently being printed).

• If an NDS connection is selected, NWSetup generates a 
list of all users and groups in the currently selected 
context and all subcontexts.

• When you double-click an entry in the list, the entry is 
added to the printer’s service list.

• The user/group list is updated whenever the Connection 
or NDS Context field is changed.

Delay in seconds for 
first

Indicates how long the Network Interface Board should 
wait before sending a notification message that an error 
condition has been detected.

Delay in seconds for 
repeat

Indicates how long the Network Interface Board should 
wait before sending a repeat notification of an error 
condition.

Note: The Network Interface Board supports Notify in 
Bindery Mode only.

Field Description
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User/Group 
name

Indicates the name of the user or group that is being edited. 
This field cannot be changed.

Delay in seconds 
for first

Indicates how long the Network Interface Board should wait 
before sending a notification message to the user that an error 
condition has occurred.

Delay in seconds 
for repeat

Indicates how long the Network Interface Board should wait 
before sending a repeat notification message to a user or group 
when an error condition has occurred.

Note: The Network Interface Board supports Notify in 
Bindery Mode only.
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Chapter 5
Windows Peer-to-Peer Printing

This chapter describes:

• Windows IPX Peer-to-Peer Printing, including preparing for the installation, 
installing, operating, setting up printing, and adding printers.

• Windows IP Peer-to-Peer Printing, including preparing for the installation, 
installing, setting up printing, and adding printers.

5.1 Windows IPX Peer-to-Peer Printing

Windows IPX Peer-to-Peer printing allows workstations to print to Network Interface 
Board printers without an intervening server and without using IP. The main features of 
Windows IPX Peer-to-Peer printing are:

• Runs on Windows 95/98/Me workstations “out of the box”

• Runs on networks with or without a NetWare file server

• Implements IPX peer-to-peer bi-directional printing between Windows 
workstations and Network Interface Board printers

5.1.1 Introduction and Preparation
The Peer-to-Peer implementation uses the IPX/SPX stacks provided with Windows
95/98/Me. The redirector software provided establishes a connection with the printers 
supporting IPX Peer-to-Peer, without using an intermediate file server, whether your 
network uses NetWare or not.

When configuring the network capabilities for Windows, you must include the 
IPX/SPX Compatible Protocol. If you are not using NetWare, you need not activate any 
NetWare Client application.

You can include IPX/SPX after the initial Windows installation by choosing Start -> 
Settings -> Control Panel -> Network. You will also need the Windows disks or 
CD-ROM.
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Note: Peer-to-Peer printing uses the IPX/SPX protocol. Therefore, Novell operation must 
remain enabled on the Network Interface Board even if you are not using Novell print-
ing facilities. The name of the Peer-to-Peer printer in the Windows Port List is the 
same as the Novell Print Server name. You can change the Novell Print Server name 
using MAP or a Web browser. See Chapter 3, Monitoring the Network Interface 
Board.

On power-up, the Network Interface Board checks the network for any Novell activity. If 
there is activity, the Network Interface Board uses the frame type and the local network 
number that it senses. In addition, if the Network Interface Board can log in to a file 
server, it assumes Novell is normally used and stores this frame type and new number in 
NVRAM. Thus, when the Network Interface Board comes up again, it does not have to 
spend time sensing (which can cause a delay).

However, if the Network Interface Board cannot attach to a file server, it will use the 
sensed values but will not store them.

If the Network Interface Board does not see any Novell activity, it uses 802.2 on 802.3 as 
a frame type and assigns itself a network number of 0 (zero). The status and configuration 
sheet contains information on the frame type and network number used.

If you move Network Interface Board from a site that has active NetWare to a site that 
does not, you should reset the Network Interface Board to factory default values to clear 
the frame type and network number information.

5.1.2 Installing the IPX Peer-to-Peer Redirector
1. Put the CD-ROM labeled “Print Server Software and Documentation” into your 

CD drive.

2. Choose Start -> Run.

3. Type the following command and click OK:

drive:\IPX-P2P\SETUP.EXE

where drive specifies the CD drive on your system.

4. Follow the instructions in the Setup program.

Note: If there is a previous installation of the IPX Peer-to-Peer Redirector, the Setup pro-
gram prompts you to have Setup delete the old driver and continue the installation 
procedure. Click Yes or No.
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Once the redirector is installed, each printer on the network that supports this peer-to-peer 
capability appears as a port under Printer Properties.

5.1.3 Setting Up IPX Peer-to-Peer Printing
IPX Peer-to-Peer printing allows you to print to a network printer for networks without a 
file server or for networks where you do not want to use the server for printing. Use peer-
to-peer printing on Windows 95/98/Me systems.

To set up IPX Peer-to-Peer printing, choose Start -> IPX-P2P -> IPX-P2P. The IPX 
peer-to-peer printing setup screen appears. The following table describes the fields and 
buttons in the screen.

Field or Button Description

Available 
Printers

The list of printers detected on the network. To clear this list, 
click Clear. To update the list, click Find Printers.

• Unit Name — The Print Server Name defined in the printer. 
The default name is the Network Interface Board serial 
number (six digits with a three-letter prefix).

• Description — Typically, the manufacturer’s name and the 
printer's model number.

• Flags — Selected (S) or Permanent (P)

Any printers flagged with S appear in the Windows Port List. 
When you are adding or changing a printer, only selected 
printers are listed. Only 30 printers can be selected at one time.

Any printer flagged with P remains in the Available Printers list 
even if the printer is physically removed from the network or if 
you click Clear.

OK Accepts changes made to setup and exits the program.

Cancel Discards any changes made to setup and exits the program.

Clear Clears the Available Printers list. This does not clear any printer 
marked with the Permanent flag (P).
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5.1.4 Adding Printers for IPX Peer-To-Peer Printing
You can add printers manually if the program cannot find printers automatically because 
of router setup or hop count setting. In general, this should not be necessary.

Using IPX-P2P to Add Printers to the port list:

1. Choose Start -> IPX-P2P -> IPX-P2P.

The IPX Peer-to-Peer Setup screen appears. A list of available IPX-enabled 
printers appears after a brief pause while the program searches the network.

2. Highlight one or more printers you want to display in the Windows Printer Port 
listing and click Select.

This ensures that these printers are included in the Windows Printer Port listing. 
You can have a maximum of 30 printers selected at a time.

3. Click OK when you have finished selecting all the printers you want to display in 
the Windows Printer Port list.

Using the Add Printers Wizard:

1. Choose Start -> Settings -> Printers.

Delete Deletes the highlighted printers from the Available Printers list. 
Printers deleted this way no longer appear in the Windows Port 
List when you are adding a printer. However, the printer is not 
actually deleted from the network — it is only removed from the 
list. You can put the printer back on the list by clicking Find 
Printers, so long as the printer is still connected to the network.

Permanent Flags the highlighted printers with a P. These printers remain in 
the Available Printers list even if the printers are physically 
removed from the network or you click Clear.

Find Printers Searches the network for printers and lists them by their Print 
Server Name (defined in the printer). The default name is the 
Network Interface Board serial number (six digits with a three-
letter prefix).

Select Flags the highlighted printers with an S. Only 30 printers can be 
selected at one time. When the Windows Port List is displayed 
during the process of adding or changing a printer, only selected 
printers are listed.

Field or Button Description
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2. Double-click Add Printer.

The Add Printer wizard appears. Click Next to proceed.

3. Choose the Local Printer option and click Next.

4. Select the make and model of the printer you want to use and click Next.

A list of printer ports appears. Any IPX peer-to-peer printers that have been 
selected from IPX-P2P Setup appear in this list.

5. Select the IPX printer you want to use.

6. Complete the remainder of the printer setup procedure as you would normally.

To change the printer port:

1. Right-click the printer icon.

2. Choose Properties and then choose the Details tab (it can take up to 15 seconds 
to access).

3. Select the printer address you want to use from the Print to the Following Port 
list. (In Windows NT and Windows 2000, you must first deselect the previous 
printer port.)

4. Click OK.

5.2 Windows IP Peer-to-Peer Printing

Windows IP Peer-to-Peer printing allows Windows 95/98/Me workstations or Windows 
NT 4.0 workstations and servers to print to Network Interface Board printers without an 
intervening server and without using IPX. The main features of Windows IP Peer-to-Peer 
printing are:

• Runs on Windows 95/98/Me workstations and on Windows NT 4.0 workstations 
or servers “out of the box”

• Implements IP peer-to-peer bi-directional printing between Windows 
workstations and Network Interface Board printers
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5.2.1 Introduction and Preparation
The Peer-to-Peer implementation uses the TCP/IP stacks provided with Windows 
95/98/Me or Windows NT. The redirector software provided establishes a connection with 
the printers supporting Peer-to-Peer, using a direct IP connection over the network.

When configuring the network capabilities for the Windows computer, you must include 
the TCP/IP Protocol. You do not need to activate any TCP/IP Client application.

You can include TCP/IP after the initial Windows installation by choosing Start -> 
Settings -> Control Panel -> Network. You will also need the Windows CD-ROM.

For more detailed information on TCP/IP setup and printing, see Chapter 7, TCP/IP 
Configuration.

Note: Peer-to-Peer uses TCP/IP. Therefore, TCP/IP operation must remain enabled on the 
Network Interface Board, and the Network Interface Board must be assigned a valid 
IP address. By default, the name of the Peer-to-Peer printer as it appears in the Win-
dows Port List is the same as the IP Address assigned to the Network Interface Board. 
You can change the IP address by using a Web browser or MAP. Refer to Chapter 3, 
Monitoring the Network Interface Board, for details.

If you are moving the Network Interface Board from a site that had active TCP/IP to a site 
that does not have it, you should restore the Network Interface Board to the factory default 
settings to clear the IP address and other network information.

5.2.2 Installation and Operation
To install the Windows IP Peer-to-Peer redirector:

1. Put the Network Interface Board CD-ROM into the CD drive on your 
workstation.

2. Choose Start -> Run.
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3. Type the following command and click OK:

drive:\IP-P2P\SETUP.EXE

where drive specifies your CD drive.

4. Follow the instructions in the Setup program.

Note: If the Setup program detected a previous installation of the IP Peer-to-Peer 
Redirector, the program asks whether to delete the old driver and continue the installa-
tion procedure. Click Yes or No.

Once the redirector is installed, each printer on the network that supports this peer-to-peer 
capability appears as a Port under Printer Properties.

5.2.3 Setting Up IP Peer-to-Peer
IP Peer-to-Peer printing allows you to print to a network printer on networks without a file 
server or on a network where you do not want to use the server for printing. You can use 
peer-to-peer printing on Windows 95/98/Me or Windows NT 4.0.

To set up IP Peer-to-Peer printing, choose Start -> IP-P2P -> IP-P2P. The Peer-to-Peer 
printing setup screen appears. The following table describes the fields in the setup screen.

Field or Button Description

Max Hops for 
Search

The hop count determines how many networks the program 
searches to find units. The default count is 2. An entry of 0 
(zero) means the program searches only the network wire 
directly connected to the workstation. An entry of 2 searches 
the wire directly connected to the workstation and also 
searches all networks accessible through two routers. Entries 
of 15 or higher cause an automatic search of every connected 
network. (This is not recommended due to the network traffic 
it could generate.)
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IP Port Base The starting port number for the print server. Each print server 
is assigned an IP port number. By default, the Network 
Interface Board is assigned port number 10001. However, the 
network administrator can change this setting. If the print 
servers on your network have been configured to use a 
different set of port numbers, then you should configure the IP 
Peer-to-Peer software accordingly. Note that IP Peer-to-Peer 
uses the new port number to communicate with all print 
servers.

Note: The IP Port selected here and in the print server should 
be one less than the actual port. For example, if port 10001 is 
desired, the IP Port on the this screen and on the Network 
Interface Board’s HTML pages should be defined as 10000.

Printer Names Lets you select how the printer names are displayed in the 
Windows Port List:

• Based on Serial Number — Uses the print server serial 
number to identify the printer names. For example, if 
SN991354 is the serial number of the unit, SN991354 
would be the printer port.

• Based on IP Address — Uses the IP address to identify the 
printer port. For example, if the IP address for the unit is 
199.99.92.99, the printer port is also 199.99.92.99. (This is 
the default.)

• Based on DNS — Uses the Domain Name Server (DNS) 
name to identify the printer name.

• Based on Unit Name — Uses the Network Interface Board 
Peer-to-Peer name set in the Novell section of the print 
server setup. This is the name used to identify the printer. 
The default name is the Network Interface Board serial 
number (six digits with a three-letter prefix).

Note: If you have both the IP Peer-to-Peer and IPX Peer-to-
Peer Redirector Programs installed, you should not select the 
option to display IP Peer-to-Peer units based on Unit Name. 
This conflicts with the IPX Peer-to-Peer redirector and may 
cause conflicts in the Windows Printer Port List.

Field or Button Description
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When you click Printers, the Windows Port List appears, allowing you to list, search, 
remove and manually add printers.

The following table contains an explanation of the fields and buttons in the Windows Port 
List:

Printers Displays the next program screen.

OK Accepts changes made to setup and exits the program.

Cancel Discards any changes made to setup and exits the program.

Help Displays a description of the Hop Count and IP port number.

Field or Button Description

IP Address Allows you to manually enter the IP address of a printer you 
want to add to the list.

Name The name you want the printer to be listed by in the Unit 
Name field.

Port The actual port for communicating with the printer. Default is 
10001.

Description The description you want listed in the Description field for the 
printer.

Field or Button Description
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Available 
Printers

The list of printers detected on the network. To clear this list, 
click Clear. To update the list, click Find Printers.

• Unit Name — The Printer Name based on the method 
defined in the previous screen. The default Printer Name 
method is by IP address. Printers can also be displayed by 
the Network Interface Board serial number, by the DNS 
Name of the printer, or by the Unit Name. The Unit Name 
is the Print Server Name defined in the Network Interface 
Board.

• Unit IP — The actual IP address of the unit. This appears 
regardless of the selected Unit Name method.

• Port Number — The IP port number used to connect with 
the printer over the network. The default port number is 
10001.

Note: The IP Port selected on the previous screen and in the 
printer should be one less than the number displayed here (that 
is, if port 10001 displays here, the IP Port in the previous 
screen and in the printer should be defined as 10000).

• Description — Typically, the manufacturer's name and the 
printer's model.

• Flags — Selected (S) or Permanent (P)

Any printers flagged with S appear in the Windows Port List. 
When you are adding a or changing a printer, only selected 
printers are listed. Only 30 printers can be selected at one time.

Any printer flagged with P remains in the Available Printers 
list even if the printer is physically removed from the network 
or if you click Clear.

OK Applies the changes you have made to setup and returns to the 
previous screen.

Cancel Discards any changes you have made and returns to the 
previous screen.

Field or Button Description
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5.2.4 Manually Adding Printers for IP Peer-to-Peer Printing
You can add printers manually whenever the program cannot find printers automatically 
because of the router setup or hop count setting. In general, this should not be necessary.

Using IP-P2P to Add Printers to the port list:

1. Choose Start -> IP-P2P -> IP-P2P.

The IP Peer-to-Peer Setup screen appears.

2. Click Printers.

3. Enter information for the printer in all the following fields:

— IP Address
Enter the IP address of the printer you want to add.

Add Lets you manually add a printer to the Available Printers list by 
entering information in the fields to the left of the button. This 
bypasses the Find Printers function. The port is not checked to 
see if it is actually available on the network.

Delete Deletes the highlighted printers from the Available Printers 
list. Printers deleted this way no longer appear in the Windows 
Port List. However, the printer is not actually deleted from the 
network — it is only removed from the list. You can put the 
printer back on the list by clicking Find Printers so long as 
the printer is still connected to the network.

Find Printers Searches the network for printers. The default method for 
displaying the list of printers is by IP Address.

Clear Clears the Available Printers list. This does not clear any 
printer marked with the Permanent flag (P).

Select Flags the highlighted printers with an S. Only 30 printers can 
be selected at one time. When the Windows Port List is 
displayed during the process of adding or changing a printer, 
only selected printers are listed.

Permanent Flags the highlighted printers with a P. These printers remain 
in the Available Printers list even if the printers are physically 
removed from the network or you click Clear.

Field or Button Description
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— Name
Assign a name to identify the printer you want to add.

— Port Number
Enter the port number of the printer. Default is 10001.

— Description
Use this field to describe the printer’s physical location, the users who can ac-
cess the printer, or other convenient description information.

4. When you have entered all the information, click Add.

The printer is listed in the Available Printers field at the bottom of the screen.

5. Highlight the printer you have just added and click the S flag for this printer.

Using the Add Printers Wizard:

1. Choose Start -> Settings -> Printers.

2. Click Add Printer.

The Add Printer wizard appears. Click Next to proceed.

3. Choose the Local Printer option and click Next.

4. Select the make and model of the printer you want to use and click Next.

A list of printer ports appears. Any IP peer-to-peer printers that have been selected 
from IP-P2P Setup appear in this list.

5. Select the IP printer you want to use.

6. Complete the remainder of the printer setup procedure normally.

To change the printer port:

1. Right-click the printer icon.

2. Choose Properties and then choose the Details tab (it can take up to 15 seconds 
to access).

3. Select the printer address you want to use from the Print to the Following Port 
list. (In Windows NT and Windows 2000, you must first deselect the previous 
printer port.)

4. Click OK.
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Chapter 6
AppleTalk Configuration

This chapter describes:

• Creating the printer

• Configuring the Network Interface Board using AppleTalk

• Changing the device names and AppleTalk zones

• Displaying the error log

• Configuring network protocols other than AppleTalk

• Setting up status report printing

6.1 Choosing the Printer

To verify that AppleTalk is enabled:

1. Make sure you have loaded the print driver and file drivers appropriate to your 
printer.

2. Choose Control Panel from the Apple menu.

3. Choose AppleTalk.

4. Choose Connect via Ethernet and close the window.

To create a printer:

1. Choose Chooser from the Apple menu.

A list of AppleTalk zones is displayed (unless your network has only one zone).

2. Select the zone containing the printer from the AppleTalk Zones list, and then 
select the device driver type corresponding to your printer from those in the list in 
the upper left of the screen.

The choice of driver determines the name of the list — Select PostScript Printer, 
Select LaserWriter Printer, and so on.
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3. Select the printer from the Select a Printer list.

The AppleTalk printer name for your printer appears in the Status and 
Configuration report under AppleTalk Connection Information.

4. Click Create.

A dialog box appears so you can choose the PostScript Printer Description (PPD) 
you want.

5. Choose the PPD you want and click Select.

(An additional dialog box may appear depending on the options available for that 
printer.)

The printer now appears both on your desktop and in the list in Chooser.

6. To view printer information, change PPDs, or change other configuration options, 
click Setup.

7. If you are finished, exit from Chooser.
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Chapter 7
TCP/IP Configuration

7.1 Overview

This chapter describes configuring the Network Interface Board and your network for use 
with TCP/IP communication in various environments.This includes:

• Installing in a Windows environment

• Dynamic Host Configuration Protocol (DHCP)

• Windows Internet Name Service (WINS)

• FTP printing

• Printing on UNIX-based systems, including Linux

• Running Telnet

• Using the Internet Printing Protocol (IPP)

The Network Interface Board TCP/IP capability also operates with lpr spoolers on other 
systems, and with spooler/supervisor capabilities that communicate raw print jobs to the 
TCP/IP port.

The IP Peer-to-Peer redirector provided with the Network Interface Board for Windows 
95/98/ME or Windows NT uses this TCP/IP port. The default port number is 10001 but 
can be changed by using Telnet or SNMP or by accessing the Network Interface Board 
HTML pages with MAP or a Web browser. For information on using Telnet, see Section 
7.7 Running Telnet. For information on MAP and the HTML pages, see Chapter 3, 
Monitoring the Network Interface Board.

7.2 Installing in a Windows Environment

Several versions and variations of Windows can be used on NetWare and TCP/IP 
networks, as well as in a native Windows network. This flexibility provides you with 
various options for setting up the network printing system even though this Network 
Interface Board does not support NetBEUI.
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If the Windows workstations are connected to a NetWare network, configure the printer 
interfaces for NetWare and use standard Windows and NetWare utilities to provide access 
to the printer. See Chapter 4, NetWare Configuration.

If you are not using NetWare, you can access the printer using TCP/IP. 

If you are using Windows 95/98 or Windows NT 4.x, you can also use the Network 
Interface Board Peer-to-Peer capability described in Chapter 5, Windows Peer-to-Peer 
Printing.

7.2.1 Installing TCP/IP on Windows
Windows 95/98/ME and Windows NT come with TCP/IP and lpr capabilities, although 
these must be installed when the unit is configured. You must install the TCP/IP Protocol, 
Simple TCP/IP Services, and Microsoft TCP/IP Printing prior to entering the network 
printer on the workstation.

Once lpr is installed on a Windows system and you have allowed printer sharing, other 
workstations can use the printer through the Microsoft Windows Network without having 
to have separate lpr queues installed on each workstation.

7.2.2 Setting Up the Network Interface Board
1. Install the Network Interface Board in your printer.

2. Power up the printer.

Keep the status sheet handy for the Ethernet (MAC) address. It shows that TCP/IP is 
enabled but that the IP address is not configured.

If the unit already has an IP address, these procedures do not work. However, you can use 
Telnet to access the unit and change the IP parameters.

7.2.3 Assigning an IP Address
The Network Interface Board must be given an IP address and routing information to be 
used with TCP/IP. To do this:

• If you have a NetWare connection, use MAP (see Chapter 3, Monitoring the 
Network Interface Board).

• Otherwise, use arp (see Section 7.2.3.1 Using arp) 
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7.2.3.1 Using arp
The Network Interface Board must be on the same network segment as the workstation 
you are using to configure it. The TCP/IP stack must be installed and operating.

To assign an IP Address with arp:

1. Open a DOS command box and enter the following command:
ping psc-ip-address

where psc-ip-address is the IP address you want to use for the Network Interface 
Board. The request should time out with no response (which indicates that the 
address is unused).

2. Enter the following command:
ping ip-address

where ip-address is any valid IP address on your network. The identified unit 
should reply.

3. After the response, enter the following command:
arp -s psc-ip-address mac-address

where psc-ip-address is the IP address of the Network Interface Board and mac-
address is its MAC address.

The entry should be accepted.

4. Enter the ping command from Step 1 again. The request should time out.

5. Let the Network Interface Board reset itself.

The Network Interface Board generates a status page that should include the 
entered IP address.

6. When the Network Interface Board is up again, re-issue the ping command from 
Step 1. Continue until you get a reply.

Note: This only enters the IP address. To enter other IP parameters, use Telnet (Section 7.7 
Running Telnet) or use MAP or a Web browser (see Chapter 3, Monitoring the Net-
work Interface Board).

7.2.4 Setting Other IP parameters
The Network Interface Board provides for a setup connection through the standard Telnet 
port. To make changes to a unit with factory default settings, you must log in as the system 
administrator. You can change this password using Telnet (see Section 7.7 Running 
Telnet).
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To set up IP and lpr parameters:

1. Use Telnet to access the Network Interface Board.

The default login and password are both sysadm.

2. Turn off the protocols you are not using (Option 3).

3. Set up the subnet mask and default gateway for the Network Interface Board, if 
applicable (Option 1).

4. Exit, save, and reset the Network Interface Board.

Alternatively, you can set up IP and lpr parameters by accessing the Network Interface 
Board HTML pages with MAP or a Web browser (see Chapter 3, Monitoring the Network 
Interface Board). The password to change parameters with the HTML pages is the same as 
the Telnet password.

7.2.5 Setting Up lpr on Windows NT or Windows 2000
1. Choose Start -> Settings -> Printers.

2. Click Add Printer.

The Add Printer wizard appears. Click Next to proceed.

3. On Windows NT:

— Choose the My Computer option and click Next.

— Click Add Port. A list of printer ports is displayed.

— Select LPR Port in the list of ports and click New Port. The Add LPR
Compatible Printer window appears.

On Windows 2000:

— Choose the Local Printer option and click Next.

— Choose Create a New Port and select LPR Port from the list.

— Click Next.

4. Specify the IP address of the Network Interface Board. For the name of the printer 
or queue, specify PORT1 (all uppercase, no space) and click OK.

5. On Windows NT: In the list of available ports, put a checkmark next to the LPR 
port you created and click Next.

6. Select the printer manufacturer and printer and click Next.

7. Optionally, specify the printer name and click Next.

8. You can choose the Shared option and select one or more operating systems that 
will print to this printer. Click Next.
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9. Print a test page and click Finish.

7.3 Dynamic Host Configuration Protocol (DHCP)

DHCP is a service that provides a method for assigning and maintaining IP addresses. The 
Network Interface Board obtains IP information from this service.

There are two user-defined variables related to the DHCP function:

• DHCP enable

• Use IP info in NVRAM

These variables are accessible in the TCP section of Network Administration, in the 
HTML pages.

If DHCP is not enabled:

• The Network Interface Board makes no DHCP requests under any circumstances.

If DHCP is enabled:

• The Network Interface Board makes DHCP requests when the Network Interface 
Board is reset or on power up, provided that the Network Interface Board does not 
have an IP address stored or that “Use IP info in NVRAM” is OFF. 

• If the Network Interface Board has an IP address in NVRAM and “Use IP 
info in NVRAM” is ON, the Network Interface Board uses the IP information 
from NVRAM and there is no DHCP activity on the part of the Network Interface 
Board.

The factory default is DHCP disabled and “Use IP info in NVRAM” is set ON. 
When DHCP is enabled and IP address in NVRAM is set OFF, the Network Interface 
Board issues DHCP requests if it does not already have IP identification information 
stored in NVRAM.

7.4 Windows Internet Name Service (WINS/DHCP)

Windows Internet Name Service (WINS) allows a device, such as your print server, to 
register a NetBIOS name such as the Network Interface Board serial number (six digits 
with a three-letter prefix) along with its current IP address (for example, 199.92.187.171). 
A client that wants to contact the printer uses the WINS server to match the NetBIOS 
name with an IP address. Most users find it easier to remember the NetBIOS name for the 
printer rather than its IP address.
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7.4.1 Using WINS with Your Print Server
To use WINS with your Print Server, enter the IP address of the WINS Server on the 
TCP/IP configuration screen. You can access this screen with a Web browser or MAP 
utility (refer to Chapter 3, Monitoring the Network Interface Board).

7.4.2 Configuring the WINS Server
You can configure your DHCP Server to automatically provide WINS Server information 
to the print server, or you can use the print server’s TCP/IP Configuration Menu to 
manually enter the necessary information. Refer to your DHCP Server’s documentation 
for further information on automatic configuration through the DHCP Server.

To manually configure your print server to work with the WINS server:

1. Assign an IP address to the print server.

To assign the address, you can use MAP, Address Resolution Protocol (arp), 
DHCP, Reverse Address Resolution Protocol (rarp).

2. Run your Web browser — Internet Explorer or Netscape Navigator.
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3. Choose File -> Open.

The Open dialog box opens.

4. Enter the print server’s IP address to access the print server’s TCP/IP 
Configuration Menu.

5. Choose TCP/IP Configuration from the main menu.

The NetBIOS Name for the print server is shown on this screen. The default name 
is the Network Interface Board serial number (six digits with a three-letter prefix) 
unless you have previously configured a name for the print server with DHCP.

6. Optionally, specify a new NetBIOS name (15 characters or less).

7. If you have previously configured a DHCP Server to provide the print server with 
the IP address of the Primary WINS Server, the address is shown on the TCP/IP 
Configuration Menu. Otherwise, specify the IP address of the Primary NetBIOS 
Name Server here.

8. Optionally specify the IP address of a Secondary NetBIOS Name Server as well. 
If you have configured your DHCP Server to provide the address of a Secondary 
WINS Server to the print server, the address fields are automatically completed 
for you.

9. Reboot the printer/print server.

The printer’s status page now shows that the print server has successfully 
registered with the WINS server. The check boxes labeled “Primary Server 
Logged in” and “Secondary Server Logged in” on the TCP/IP 
Configuration Menu now indicate any WINS Servers with which the print server 
has registered.

Normally, the print server automatically renews its registration with the WINS 
Server before its lease expires.

7.5 FTP Printing

7.5.1 FTP Printing Using Netscape
FTP printing with Netscape requires Navigator 2.0 or higher.

To print from Netscape:

1. Connect to the port you want to send the print job to on your print server.
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2. Enter the command:
ftp://PORT1@dest-srvr-addr

where dest-srvr-addr is the IP address of the print server to which you want to 
send the print job.

3. Run Netscape.

4. Choose File -> Upload File and specify the file, or drag and drop the file to your 
browser window and click OK.

Note: FTP printing does not support selecting multiple file names. Only one user can be 
logged on to a port at any particular time.

7.5.2 Printing from an FTP Client
1. Open a DOS Command window and enter the following command:

ftp dest-srvr-addr

where dest-srvr-addr is the IP address of the print server to which you want to 
send the print job.

2. Specify PORT1 as the login.

3. Enter the following FTP command:
put filename

where filename is the file you want to print.

7.6 UNIX Printing

The Network Interface Board can support UNIX TCP/IP printing in the following mode:

• Printer-based lpd where the printer appears as a host running a line printer 
daemon

In general, printer-based lpd is easiest to use on BSD UNIX systems, requiring an entry 
in the printcap file once the Network Interface Board has its IP information. 

7.6.1 Configuring the IP Address on the Network Interface 
Board

The Network Interface Board must be given IP address and routing parameters. You can 
configure the IP address for the Network Interface Board in one of the following ways:

• Use MAP, as described in Chapter 3
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• Use the reverse ARP (rarp, Ethernet II frame type only).

• Use arp and ping

For each method, you need to provide the Ethernet address of the Network Interface 
Board. The Ethernet address is the 12-character code that is printed under Network 
Address on the configuration status report each time the printer is turned on.

You can use the rarp, or ping procedures only when the Print Server is in its factory 
default state (no IP information entered.) After the Print Server has an IP address, you 
must use the Telnet utility or the Network Interface Board HTML management pages 
accessed through the MAP utility or a web Browser to change an IP address, Subnet Mask 
and Default Gateway.

7.6.1.1 Using rarp
The Reverse Address Resolution Protocol (rarp) allows network devices to query a 
server for their IP addresses on start up. For this procedure, there needs to be a workstation 
with a rarp server. To store the IP address, use the following procedure:

1. Turn off the printer.

2. Log in as superuser on a host on the same subnet as the print server.

However, if the server resides on another subnet, complete this procedure to store 
the IP address in the print server. Reconnect the print server anywhere on the 
network, and then use the TelNet or the HTML pages accessed by MAP or a Web 
Browser to adjust the IP parameters for the subnet on which the Network Interface 
Board is operate.

3. Find the Ethernet address of the Network Interface Board. The address is printed 
on the configuration status report when you power on the printer.

4. Edit the hosts file (usually /etc/hosts) or use NIS or DNS to add the IP 
Address and Network Interface Board’s node name. See the network 
administrator for the IP address.

For example, a print server with the name of printfast has the following entry:
192.9.200.200 printfast

5. Edit the /etc/ethers file or use NIS or DNS to add the Ethernet address.

To continue the example, for the printfast card with an Ethernet address of 
00:40:c8:00:00:ff, make the following entry:

0:40:c8:0:0:ff printfast

6. If the rarp daemon is running, stop it and restart it. Verify that the daemon is 
running.

7. Check the printer to see that the print server is connected to the network. Turn on 
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the printer.

8. Wait until the printer powers up and finishes initializing to allow enough time for 
the IP address to become known and to be saved in non-volatile memory. The 
Network Interface Board should then reset itself.

9. After the Network Interface Board has reset, use the ping command to verify that 
the print server obtained its IP address. For example:

ping 192.9.200.200

If the server has the address, the result is a confirmation message:
192.9.200.200 is alive

10. Remove, or comment out, your changes to the /etc/ethers file.

11. Stop the rarp daemon and, if you want it to run, restart it.

7.6.1.2 Using ping
Use the following procedure to enter the IP Address:

1. Turn off the printer.

2. Log in as superuser on a host on the same subnet as the print server.

However, if the server resides on another subnet, complete this procedure to store 
the IP address in the print server. Reconnect the print server anywhere on the 
network, and then use Telnet or the HTML pages accessed by MAP or a Web 
Browser utility to change the IP Address.

See 7.7 Running Telnet, for instructions on using Telnet.

3. Find the Ethernet address of the Network Interface Board. The address is printed 
on the configuration status report each time you turn the printer on.

The address is printed on the configuration status report each time you turn the 
printer on.

4. Edit the hosts file (usually /etc/hosts) or use NIS or DNS to add the IP address 
and print server's node name. See the network administrator for the IP address.

For example, a print server with the name of printfast has the following entry:
192.9.200.200 printfast

5. Add an entry to the arp cache for the Print Server’s IP address and Ethernet 
address.

For example:
arp -s 192.9.200.200 0:40:c8:0:0:ff

6. Check the printer to see that the Print Server is connected to the network. Turn on 
the printer.
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7. Send a ping command the Network Interface Board to verify it is running on the 
network.

For example:
ping 192.9.200.200 or

ping printfast

The Network Interface Board will not respond to this ping command but it will 
read its IP address from the packets.

8. Turn the printer off and back on again and then send the ping command again to 
verify that the print server obtained its IP address. If the Print Server has the 
address, the result is a confirmation message:

192.9.200.200 is alive

9. Remove the entry from the arp cache using the following command. Specify the 
Print Server either by its IP address or by its name.

For example:
arp -d printfast

7.6.2 lpd/lpr Printing
The lpd/lpr is an implementation of the standard UNIX line printer daemon which lets 
you print across a TCP/IP network without installing software on your workstation with 
all filtering and banners done by the Network Interface Board. Remote printing uses the 
same commands (lpr, lpq, lpc) as local printing.

The process begins when the lpr call finds a printer on a remote system by looking at the 
remote (rm) entry in the /etc/printcap file for that printer. The lpr handles a print job 
for a remote printer by opening a connection with the lpd/lpr process on the remote 
system and sending the data file (followed by the control file containing control 
information for this job) to the remote system. The printer-based lpd then filters the data 
and prints the job according to information contained in the control file and its own 
printcap file.

The Network Interface Board lpd recognizes the format of certain printer emulations and 
filters the data, if possible, so the data can be printed on the printer type you specify.

You can indicate to the Network Interface Board lpd what type of printer is attached to by 
either:

• Accept the default port setting (PCL, PostScript, and other)

• Change the listed emulations via the Telnet or the HTML pages accessed by MAP 
or a Web Browser utility

The following sections give specific lpd/lpr setup instructions for various systems.
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7.6.2.1 Setting Up a BSD Remote Printer to Use lpd
To set up a remote printer on the host that sends jobs to Network Interface Board using 
printer-resident lpd, add an entry to the /etc/printcap file on your host for each 
printer you use.

The steps are described below.

1. Open the /etc/printcap file. Make an entry naming the Network Interface 
Board as the remote host and PORT1 as the remote printer name. A typical 
printcap entry is shown below:

<printer_name>\

(for example, lprprinter)
:lp=:\
:rm=<remote_host>:\

(for example, name as entered in /etc/hosts)
:rp=PORT1:\
:sd=/usr/spool/lpd/<printer_name>:

(for example, spool directory on system used to 
spool data and control files)

This entry will send jobs spooled at /usr/spool/lpd/<printer_name> to the 
printer designated <printer_name> to be printed at lp(the internal connection to 
the printer) of the Network Interface Board designated as <remote_host>.

2. Create the spooling directory. For example, type:
mkdir /usr/spool/lpd/<printer_name>

3. To print via the spooler, use the lpr command. Type:

lpr -P<printer_name> <file_name>

Installation and testing is done. You are now ready to print.

7.7 Running Telnet

The Telnet utility uses the standard remote terminal protocol to configure the IP address, 
lpd/lpr printers, and other parameters on your system. You have the same functionality 
with Telnet as with accessing the Network Interface Board HTML pages with MAP or a 
Web browser (see Chapter 3, Monitoring the Network Interface Board).

Use the following guidelines to run Telnet:

• Typically you make selections from menus by toggling between one choice or 
another, by selecting/deselecting or enabling/disabling an item.

• Press Enter when not selecting an item. This returns you to a previous menu.
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• If you do not make a menu selection for two minutes, you get a two-minute 
warning that within two more minutes your Telnet session ends. This ensures that 
no one user leaves a session idle for too long.

7.7.1 Making the Connection and Accessing the Main Menu
To make the connection and access the Main menu:

1. At the prompt, type the following command:
telnet ip-address

where ip-address is the IP address of the card.

2. When the login prompt appears, type guest if you are interested in only browsing 
the menus, or type sysadm if you want to change the configuration.

3. When the password prompt appears, again type guest or sysadm.

The main menu is displayed. This utility lets you change the IP parameters, 
lpd/lpr printers, protocols, and password, and lets you restore to factory 
defaults.

4. Type the number for the parameter you want to check or change and press Enter.

5. To end your Telnet session, type E at the Main Menu.

If you have made any changes you are prompted to either Save Changes and Exit 
or Exit Without Saving Changes. Choose the appropriate option and press Enter.

Note: To get online help in Telnet, type ? (question mark).

1. IP Parameters
2. LPD Printers
3. Protocols
4. Restore Factory Defaults
5. Change Password
E. Exit
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7.7.2 Configuring IP Parameters
Although the Network Interface Board must have an IP address before a Telnet connection 
can be made, you can use the Telnet utility to change the address or the other IP 
parameters. The Network Interface Board automatically initiates a soft reset when it 
senses the IP address change.

Note: This causes the Telnet connection to be broken. It is advisable to make all other 
desired changes before changing the IP address.

To configure IP parameters:

1. At the main menu, type 1 and press Enter to display the IP Parameters menu.

2. Type 1 again and press Enter.

The IP Address submenu is displayed:

3. Type the number for the parameter you want to change and press Enter.

Note: The base port number is one less than the actual TCP/IP port number used by the 
printer. For example, to set the port number to 9100, enter 9099.

7.7.3 Selecting Printer Languages
Selection 2 in the main menu lets you designate the emulations (printer interpreter 
languages) that the printer supports. This lets the resident lpd/lpr modify files intended 
for other emulations so they can be printed. The menu also allows you to enable or disable 
banners attached to lpd/lpr handled jobs.

The emulation choices are:

• Printer Control Language (PCL)

• PostScript (PS)

• ASCII (simple text)

• Other (any print job not recognized as PCL, PS, or ASCII)

1. IP Address              199.92.187.37
2. Subnet Mask           255.255.255.0
3. Default Gateway     199.92.187.254
4. Base Port Number   10000
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The file modifications and conditions are:

To select the printer language:

1. To access the LPD Printers menu, type 2 and press Enter.

For a unit at factory default, the following menu appears.

2. To change the set of emulations, type 1 and press Enter.

The following options are displayed.

3. To delete an emulation, select the number opposite the language listed and press 
Enter.

4. From the LPD Printers menu, type 2 to toggle Banners between Enabled/
Disabled.

Print Server Setup Job detected as Action

PCL, (PostScript) ASCII <CR> changed to <CR><LF>

PostScript PCL, Other PostScript header added

not PostScript PostScript Job discarded

PostScript ASCII PostScript  header added, <CR> 
changed to <CR><LF>

PCL, PS, ASCII any No action

LPD Printers

1. Printer 1            PCL PS OTHER
2. Banners             DISABLED

Printer 1                  PCL PS OTHER

1. PCL
2. PS
3. ASCII
4. OTHER
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7.7.4 Enabling/Disabling Network Protocols
To enable network protocols, type 3 at the main menu.

You are given the choice of disabling either NetWare or AppleTalk since both network 
OSs are enabled by default. For example, to disable Appletalk, type 2 and press Enter.

7.7.5 Restoring Factory Defaults
When you need to restore factory defaults on your print server, type 4 at the Main Menu 
and press Enter. All NVRAM stored parameters are returned to their factory default 
values. The factory default values do not take effect until you exit the Telnet program or 
the unit is powered off and on.

7.7.6 Changing a Password
1. Type 5 at the main menu.

2. Type up to eight characters at the New Password query and press Enter.

3. Retype the same characters at the Retype New Password query and press Enter.

4. Choose the Save Changes and Exit option.

Once you have set your password, the sysadm password is no longer valid.

Note: There is a single maintenance access password to the Network Interface Board. You 
use this password with Telnet or when accessing the Network Interface Board HTML 
pages with MAP or a Web browser.

7.7.7 Exiting Telnet
1. Type E at the main menu.

If you have made any changes, the exit menu is displayed:

Exit

1. Save Changes and Exit
2. Save Changes and Reset
3. Exit Without Saving Changes
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7.8 Internet Printing Protocol (IPP) Printing
2. Choose an exiting option and press Enter.

7.8 Internet Printing Protocol (IPP) Printing

7.8.1 Setting Up a Printer Using IPP
You can use the IPP with Windows 2000.

To set up a printer for IPP printing:

1. Assign an IP address to your print server.

2. Reset the print server.

3. Use the ping command to make sure the print server responds.

7.8.2 Setting Up the IPP Functions of the Printer 
You can set up the IPP functions of the printer by using MAP or a Web browser. For IPP 
printing, your workstation must have an IPP client installed (either from Microsoft or a 
third-party).

To configure the printer for printing:

1. Choose Start -> Settings -> Printers.

2. Click Add Printer.

The Add Printer wizard appears. Click Next to proceed.

3. Choose the Network Printer option and click Next.

4. On the Locate Your Printer screen, select Connect to a printer on the Internet 
or on your intranet and type the correct printer path. (case sensitive)

The format is:
URL: http://ip-addr:631/Print

where ip-addr is the IP address of the printer. For example:
URL: http://199.92.186.97:631/Print

Note: Your printer port number is listed on the NIB Status Page next to the Internet Printing 
Protocol.

5. Click Next and finish printer setup.

For example, select the appropriate printer type.

6. Perform a Test Print from your printer and check the printer for the test page.
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The printer configuration is complete.
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Chapter 8
Operation and Troubleshooting

This chapter describes:

• Normal operation of the Network Interface Board in the printer

• LED status indicator

• Status reports

• Resetting the Print Server to factory defaults

• Troubleshooting any problems you might have with the Network Interface Board

8.1 LED Status Indicators

The Network Interface Board has two LED status indicators: orange and green. The 
orange LED generally indicates job activity. The green LED indicates the operating 
condition of the Network Interface Board.

8.1.1 Normal Operating Condition

Green LED

• When you first power on the printer, the green LED is on solid (that is, not 
blinking). This indicates that the Network Interface Board is performing self tests. 
The green LED may also be on solid when the printer is awaiting a print job and 
the Network Interface Board is functioning properly.

• When the printer finishes the self-tests, the green LED blinks, and may blink 
again after initialization with the printer is completed. If the Print Status Report on 
Power up feature is enabled, the Network Interface Board generates a status 
report.

Orange LED

• When the printer is receiving print jobs over the network, the orange LED blinks. 
It is off when there is no activity.

• The orange LED is on solid (not blinking) to indicate that the network connection 
has been lost — typically, because the server has been shut down.
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8.2 Status Report
8.1.2 Error Conditions
Combinations of blinking LEDs — 1 to 7 orange blinks followed by 1 to 12 green blinks 
— indicate various hardware failures. You should then notify the supplier of your printer 
according to whatever arrangements you have for technical support or replacement of 
defective equipment.

8.2 Status Report

The Status/Configuration report is generated when the print server is powered on (if the 
Print Status Report on Power up feature is enabled). The following sample report shows 
the configuration of the print server immediately before the report is printed. Some 
printers also allow you to use a command from the front panel that produces a status 
report.

You should generate and review a status report after installation and any time the setup 
changes. If your status report does not include a protocol that was configured, make sure 
the procedure was done properly.

Sample Status Report
---------------------------------------------------------------------
Unit Serial No: 123456               Version: 05.60
Network Address:  00:11:22:33:44:55
Network Topology: Ethernet           Connector: RJ45
Network Speed: 100 Megabits

Novell Network Information           enabled
    Novell Print Server Name: RDP_123456
    Password Defined: No
    Directory Services Context not defined
    Frame Type: 802.3
Peer-to-Peer Information             enabled
    Frame Type: 802.2 on 802.
    Network ID: 6
TCP/IP Network Information           enabled
    Frame Type: Ethernet II          Protocol Address: 123.123.123.123
    Subnet Mask: 123.123.123.123     Default Gateway:  123.123.123.123
    WINS Name:
IPP Network Information              enabled
    Internet Printing Protocol       http://123.123.123.123:631/Print
AppleTalk Network Information        enabled
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8.3 Returning the Network Interface Board to Factory Default Settings
    Frame Type: 802.2 SNAP on 802.3
    Protocol Address: Net Number 123 Node Number:45 Socket Number 678
    Preferred AppleTalk Zone:        Default Zone
Novell Connection Information
    Printer Name: Assigned Name
    File Server: NameOfFileServer
        Queue:  NameOfQueue  Priority: 1     Attached: yes
        Notify: Supervisor   First:    30    Repeat:   60
Peer-to-Peer Connection Information
    Port Name: RDP_123456
AppleTalk Connection Information
    AppleTalk Printer Name: RDP_123456
TCP/IP Connection Information
    Port Number: 10001
---------------------------------------------------------------------

8.3 Returning the Network Interface Board to Factory Default Set-
tings

You can restore parameters on the Network Interface Board to their factory default 
settings. You should do this before the Network Interface Board is moved to a new 
location where the environment (AppleTalk network zones, NetWare file servers, IP 
subnets, and so on) is different.

Note: Returning to factory default settings means that the print server loses all data such as 
names and IP addresses. It does not lose its serial number or MAC (Ethernet or Token 
Ring hardware) address.

To restore the factory default settings, you can use Telnet or the Network Interface Board’s 
HMTL pages (via MAP or a Web browser). If the network is not available, you can use the 
following method.

To reset the Network Interface Board:

1. Power off the printer and remove the Network Interface Board from the printer.

The removal process is the reverse of the installation process described in Chapter 
2, Installing the Network Interface Board.

2. Locate the Reset Jumper (labeled OP2. Refer to the diagram in Appendix A). 
Move this jumper to the ON position.
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8.4 Troubleshooting Checklists
3. Reinstall the Network Interface Board as described in Chapter 2 but do not 
connect the printer to the network.

4. Power on the printer.

The Network Interface Board performs self-diagnostic tests. The green LED 
blinks 3 times and then goes into an alternating green/orange sequence. When you 
see this LED pattern, do the following steps.

5. Power off the printer.

6. Remove the Network Interface Board from the printer.

7. Move the OP2 jumper to its OFF position, so that the jumper covers the center pin 
and the pin nearest the OFF designation.

8. Reinstall the Network Interface Board according to Chapter 2, Installing the 
Network Interface Board.

9. Reconnect to the network and power on the printer.

8.4 Troubleshooting Checklists

8.4.1 General Troubleshooting
Use the following list to determine the cause of printing problems:

• Verify that the printer is functioning properly:

— Is the printer printing? To check whether the printer is operating properly, 
make it generate a test page. See your printer’s owner’s manual for instructions 
on generating a test page.

— Is the printer on-line?

— Does the control panel indicate an error? Refer to your printer documentation 
for an explanation of the error messages.

— Did you get a Network Interface Board status page (if the Print Status Report 
on Power up feature is enabled)? On preppy, the Network Interface Board 
sends a status page which contains information that is useful for troubleshoot-
ing. Keep the status page available until the problem is resolved.

— Check the Network Interface Board’s LED status indicators to make sure there 
is no error condition. See Section 8.1 LED Status Indicators for more informa-
tion.

— Check the status report to see what protocols are enabled and active.
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• See the appropriate chapter of this manual to confirm that you have installed and 
configured your network protocol correctly for the Network Interface Board. See 
Section 8.2 Status Report for a sample status report.

• If you added, changed, or removed any hardware on the network, verify that it 
was installed or removed correctly.

• If you added any new software applications, make sure the program is compatible 
and installed correctly on the network. See your network protocol documentation 
for more information.

• Can other users print? If they cannot print and they are all using the same network 
protocol, go to the troubleshooting section for that protocol.

When you have determined the nature of the problem, use the checklists in the next 
section.

8.4.2 Troubleshooting Network Hardware Connections
• Make sure the Network Interface Board has properly selected the connector type 

that you are using. The connector type is on the status/configuration report — 
RJ45 or BNC.

• For Thinnet, check that the network connector is plugged into the BNC connector 
on the Network Interface Board. If the printer is at the end of a run, ensure that a 
50-ohm terminator is installed.

• For 100BaseT or 10BaseT, check that the network connector is plugged into the 
RJ45 connector on the Network Interface Board.

• If the network connectors are properly plugged in and the problem persists, try 
another cable.

• If you are using a 10BaseT Network Interface Board connected to a concentrator 
hub that does not support the link signal, use Manual Ethernet Port selection 
instead of the factory default of Automatic Ethernet Port selection. See Appendix 
A, Jumper Settings.

8.4.3 NetWare Troubleshooting
Use MAP to get the NetWare setup and parameter values. If you cannot resolve the 
problem after running MAP, go through the checklists in this section.
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8.4 Troubleshooting Checklists
8.4.3.1 NetWare Checklist

• Is the print server name entered correctly?

• The default name is the Network Interface Board serial number (six digits with a 
three-letter prefix). This number is located on the card.

• Did you assign print queues to the printer?

• It is recommended you assign each print queue to only one Network Interface 
Board-connected printer. If print queues are assigned to other network printers, 
the print jobs might be going to another network printer.

• Did you assign the printer to the type Remote Other/Unknown?

• If the server settings are correct, the connection between the printer and network 
might have been broken. In this case:

— Turn the printer off and, using NWADMIN or PCONSOLE, wait for the status 
message Not Connected.

— Turn the printer on and the status should change to Waiting for Job.

8.4.3.2 File Server Checklist

• Is there enough disk space on the file server and is it running?

• Is  the correct file server associated with the printer? Use NWADMIN or 
PCONSOLE to check this.

• Did you have the proper rights to configure the printer?

• Are the File Server and the Print Server communicating? Run the NetWare 
COMCHECK utility from any network workstation to check this.

• Are there enough user positions on the File Server? The Print Server function logs 
on as a user.

8.4.3.3 Workstation Checklist

• Is the network loaded onto the workstation?  See your Novell documentation.

• Is the application set up to print to the printer?  For example, are you using the 
correct driver?

• Is the workstation connected to the correct print queue?  Print a file and verify that 
the file goes to the queue.

• Are the print queues assigned to the Network Interface Board-connected printer 
also assigned to another network printer? If so, the print jobs may be going to that 
printer.
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• From NWADMIN or PCONSOLE, enter a sample print job directly into an 
assigned queue. Does the job become Active? Is the job printed?

• Is AUTO ENDCAP enabled? This option lets you send data to a network printer. 
Use PRINTCON to check.

8.4.3.4 Network Interface Board Configuration Checklist

If all your hardware connections are correct, check the following:

• Use MAP to check the status of the print server. 

The Report Print Server Status screen shows the status for the selected Network 
Interface Board. This report includes a status of file servers and queues assigned 
to a printer along with a description of any problems.

• The printer might not be assigned to the correct print queues. 

Use NWADMIN or PCONSOLE to direct print jobs to the correct queues, then 
check to see if the print job is in the queue.

• If devices were added or changed, use NWADMIN or PCONSOLE to make sure 
you configured the new devices correctly.

• Make sure the Network Interface Board’s name has been entered correctly. If you 
changed the name in MAP, you must also change the name in NWADMIN or 
PCONSOLE before you can print.

• Use NWADMIN or PCONSOLE to check the printer status. Make sure it is not 
stopped or paused.

8.4.3.5 Printer Server, File Server, and Printer Checklist

• Can the Network Interface Board log in to the file server, and can it service jobs 
from a file server?

• Is the print server name listed on that file server?

• Does the print server password assigned to the Network Interface Board through 
NWADMIN or PCONSOLE match the print server password assigned through 
MAP?

(Use MAP to update the password stored in the network print server’s memory.)

• Is the print job in the print queue and waiting to be printed? Use NWADMIN or 
PCONSOLE to check whether the print jobs are being sent to the printer.
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8.4.3.6 Workstation to Network Interface Board Connection Checklist

To make sure the workstation is communicating with the Network Interface Board:

• Print a file from the workstation. Use NWADMIN or PCONSOLE to verify that 
the print job gets to the print queue. If the print job does get to the queue, the 
problem is not with the workstation/print server connection.

• Use CAPTURE to send data to the printer from a software application. See your 
Novell documentation for information.

• Make sure another printer is not taking the print jobs from the queues before the 
Network Interface Board can service the job. Disable the other printer until you 
can verify the Network Interface Board-connected printer setup.

8.4.3.7 If the Network Interface Board Loses Its File Server Connection

If the network interface board loses its connection to the file server, it can take 
approximately 5–10 minutes to reconnect.  If the connection is not made after some 
reasonable time, check the error conditions to troubleshoot the problem.

8.4.3.8 Cannot Print from a Different Context

The Network Interface Board does not support printing from a context different from the 
context you are installed in. If you want to do this, you must create an alias queue. See 
your Novell documentation for more information.

8.4.4 AppleTalk Troubleshooting
• Is the Macintosh connected to the network through Ethernet and has the 

AppleTalk driver been selected? To check, choose Control Panel from the Apple 
menu and then choose Networks.

• Did you select the correct Network Interface Board and correct zone?

• Is AppleTalk enabled on the Macintosh? Use Chooser to check this.

• If you are on a network with multiple zones, is the zone correct?

• Did you select the correct printer driver in Chooser? You must first select the 
printer icon and then select the printer name. (Not all printers communicate with 
the default Macintosh driver.)

• If you renamed the printer in the AppleTalk program, did you re-select the printer 
under its new name?

• If you put the printer in a new zone, did you re-select the zone?

• Are there other printers with similar names in Chooser? Make sure you chose the 
Network Interface Board-connected printer.
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8.4.5 TCP/IP Troubleshooting
Problem: Cannot access the Network Interface Board from the network

• Make sure the Network Interface Board has a valid IP address. Use ping to check 
the IP address assigned to the card.

• Check the TCP/IP parameters (subnet mask, gateway, and so on).

• If your network supports DHCP or WINS:

— Are the server names set correctly on the Network Interface Board Status Con-
figuration page?

— Is the DHCP Server or WINS Server running?

— If the DHCP Server or WINS Server is running, is it configured properly? Re-
fer to your network documentation for more information on configuring serv-
ers.

Problem: Cannot print from lpr

• Do you have the correct drivers?

• Is the print job directed to the correct IP address?

• Is the lpr channel full because of other jobs in the queue?

Problem: Cannot print from IP-P2P or Windows 2000 direct IP

• Do you have the correct drivers?

• Is the print job directed to the correct IP address?

• Is the correct port number being used for Raw Sockets printing? (The default for 
the Network Interface Board is 10001.)

• Is the printer reporting any errors?

• Was the print job removed from the spooler? (Check the Windows spooler for any 
details on the status of a failed job.)

Problem: Cannot print from IPP

• Do you have the correct drivers?

• Is the print job directed to the correct IP address in the IPP client (that is, 
http://ip-address:631/Print)?

• Was the print job removed from the spooler? (Check the Windows spooler for any 
details on the status of a failed job.)
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Appendix A
Jumper Settings

This appendix describes:

• Changing jumper settings

• Network Interface Board and jumper locations 

• Reset to factory defaults

• BUS handshake

• Ethernet-specific jumpers (10BaseT only)

A.1 Changing Jumper Settings

The Network Interface Board normally configures the network configuration 
automatically without the need to access internal jumpers. However, there are certain 
jumpers on the board that you might have to access under certain circumstances. If you 
need to change the jumpers, follow the steps in this section.

Note: Handling Precautions for Static Sensitive Devices: The Network Interface Board is 
designed to protect sensitive components from damage due to electrostatic discharge dur-
ing normal operation. When installing the card, however, take proper static-control pre-
cautions to prevent damage to equipment.

Make sure you do not have the printer plugged into a wall outlet. If it is plugged in, unplug 
the power cord before you open the unit. Remove the Network Interface Board according 
to the printer instructions.

A.2 Reset to Factory Defaults

The Network Interface Board can be restored to factory default conditions by jumper OP2. 
The function of OP2 is to reconfigure NVRAM. Do this when a unit is moved from one 
site to another and should be restored to as-new condition.

If the unit is powered up with jumper OP2 in the FACT position (opposite of the CUST 
position), the board resets all parameters to their factory default values. This is indicated 
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A.2 Reset to Factory Defaults
by the three quick green flashes followed by the alternating amber and green indications 
(once per second rate). You should then turn off power and shift the OP2 jumper to the 
CUST or OFF position (opposite of the FACT or ON position). The unit operates normally 
when you turn the power on again.
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Appendix B
Network Interface Board Specifications

This appendix describes:

• General specifications for the Network Interface Board

• 10/100BaseT cables

B.1 General Specifications for the Network Interface Board

Size: Length: 123.7 mm Width: 95 mm

Weight: 8 ounces

Environment: 0–50° C 5%–80% humidity

Controls and Indicators: One green LED and one amber LED

Configuration: Stored in NVRAM

Connectors: Any of the following:

• Ethernet: 8-wire RJ45 10/100BaseT
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B.2 10/100BaseT Cables
B.2 10/100BaseT Cables

Use the following universal Ethernet standard when configuring your 
10/100BaseT cables to connect to the RJ45 connector on the Network Interface Board. 
The cable should be Category/Type 5 or better (depending on length).

Pin Color Ethernet

8 Blue/white

7 Blue

6 Orange/white Receive –

5 Green/white

4 Green

3 Orange Receive +

2 Brown/white Transmit –

1 Brown Transmit +
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